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Preface

Thank you for choosing RSView Machine Edition. RSView� is an
integrated package for developing and running automation projects.

Designed for use with Microsoft� Windows� 2000 and on
RAC6182� computers running Microsoft Windows CE 3.0,
RSView gives you all the tools you need to create effective
machine-level monitoring and control projects.

About the documentation

The RSView Machine Edition documentation set includes:

Release Notes: Information to read before you begin installing or
working with the software.

RSView Machine Edition Installation Guide: A guide to installing
and activating the various components of RSView.

RSView Machine Edition User’s Guide: Comprehensive
information about RSView, procedures for creating and running an
automation project, and reference information.

Help: Online procedures and reference information.

Finding the information you need

You have many options for finding information about how to use
RSView, or how to solve problems with RSView.

Try the User’s Guide and Help first

The User’s Guide and Help provide comprehensive information
about typical uses of RSView. Chances are, your question is
answered in the documentation.

P
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To find the answer, use the table of contents and the index in the
User’s Guide and Help.

You can also perform a full-text search on both the Help and the
.pdf version of the User’s Guide. For information about using
Help, see Chapter 5, “Getting the information you need,” in the
RSView Machine Edition Installation Guide.

Information on the Internet

If you can’t find the answer to your question or problem in the
User’s Guide or Help, you can also find information on the World
Wide Web.

The RSView Forum

http://www.rsviewforum.com

The RSView Forum is a web site for users like you. The RSView
Forum offers:

patches and updates that provide the latest fixes for problems in
RSView

an RSView frequently-asked questions (FAQ) list, for
information about how to solve the problems our technical
support teams encounter most often

discussion groups, for exchanging tips and questions with other
RSView users
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design resources, to help you put together graphic displays, and
ready-made ActiveX� objects you can use in your own RSView
projects

information about what’s new, including product
announcements, new articles, and information provided by
Rockwell Software

The Rockwell Software Support Library

http://www5.software.rockwell.com/kbmenu/knowbasehome.htm

The Rockwell Software Support Library is a comprehensive
searchable database of support information for all Rockwell
Software products.

You can also access the Support Library from within RSView
Studio. To do so, you must have a web browser installed on your
computer, and you must have an active Internet connection.
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To access support pages from RSView Studio:

� On the Help menu, select Rockwell Software on the Web, and
then click the name of the web page you want to view.

Contacting Rockwell Software Technical
Support

If you can’t find the answer to your question using any of the
resources suggested above, contact Rockwell Software Technical
Support at:

Telephone: 440-646-5800

Fax: 440-646-5801

World Wide Web: http://www.software.rockwell.com or
http://support.rockwellautomation.com

Support staff are available Monday to Friday from 8 AM to 5 PM

Eastern Standard Time, except on statutory holidays.

When you call

When you call, you should be at your computer and ready to give:

the product serial number

You’ll find this number on the Activation disk label and in the
About dialog box that you access from the Help menu in
RSView.

the product version number

the type of hardware you are using

the exact wording of any messages that appeared on your screen

a description of what happened and what you were doing when
the problem occurred

a description of how you tried to solve the problem
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Introducing RSView
Machine Edition

RSView Machine Edition is software for developing and running
human-machine interface (HMI) projects. RSView Machine Edition
is designed for monitoring and controlling automated processes and
machines.

For information about installing RSView Machine Edition, see the
RSView Machine Edition Installation Guide.

The parts of RSView Machine Edition

RSView Machine Edition includes two products:

RSView Studio� is configuration software for developing
machine-level HMI projects. This software runs on the Windows
2000 operating system.

RSView ME Station� is a stand-alone runtime environment for
machine-level HMI projects. Use RSView ME Station to run the
projects you develop in RSView Studio.

You can run machine-level projects on RAC6182 computers with
the Windows CE 3.0 operating system, and on computers that use
the Windows 2000 operating system.

Additional software

The RSView Machine Edition CD also includes two additional
software products:

RSLinx� for RSView Enterprise Series is software that provides
communications to a wide range of direct drivers. RSLinx is an
OPC�-compliant data server.

Adobe� Acrobat� Reader 5.0 is software for reading the online
RSView Machine Edition User’s Guide. If desired, you can also use
the software to print the User’s Guide.

1
Chapter
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The RSView Machine Edition tools

These tools are installed with RSView Studio:

Project Transport Wizard is software for renaming, copying,
deleting, backing up, and restoring projects.

Tag Import and Export Wizard is software for importing or
exporting the RSView tag database.

Transfer Utility is software for moving a runtime machine-level
project from the development computer to the RAC6182
terminal.

This tool is installed with RSView ME Station:

DeskLock is software that prevents Windows 2000 users from
exiting the RSView program at runtime. You cannot use
DeskLock if you are running your project on a RAC6182.
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Exploring RSView
Studio
This chapter describes:

opening and closing RSView Studio

opening sample projects

exploring the RSView Studio main window

using the Project Explorer

working with editors

entering information in spreadsheets

working with components

printing information in editors and components

Opening and closing RSView Studio

Opening RSView Studio

To open RSView Studio:

� On the Windows Start menu, select Programs, and then click
RSView Studio.

RSView comes with several sample projects. We suggest you open
the Malthouse sample project now to use while you try out the
instructions in the remainder of this chapter. See the instructions on
page 2-2.

Closing RSView Studio

To close RSView Studio:

� On the File menu, click Exit.

If there are any unsaved changes in open editors, RSView Studio
asks you whether to save the changes before closing the
program.

2
Chapter
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Opening sample projects

The sample projects are designed for two screen resolutions: 640 x
480 and 800 x 600. Select the project that matches the screen
resolution of your runtime monitor.

To open the Malthouse sample project:

1. Open RSView Studio.

2. Click the Existing tab.

3. Click Malthouse_640x480 or Malthouse_800x600.

4. Click Open.

RSView Studio displays the sample project in the Project
Explorer.
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Exploring the RSView Studio main window

Title bar

Project Explorer

Menu bar

Toolbar

Activity bar

Status bar

Work area

The menu bar

The menu bar contains the menu items for the active window. Each
editor has its own set of menus.

The toolbar

The toolbar contains buttons for commonly used menu items so
you can quickly access the items without opening the menu. When
you point to a button on the toolbar, the button name is displayed
in a tooltip and in the status bar.

Tooltip

All editors use the Standard toolbar. The Graphics Display,
Graphics Library, User Accounts, Nodes, and Tag Database editors
have additional toolbars.
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The Project Explorer

The Project Explorer contains the editors for creating and editing
your project. For more information about the Project Explorer, see
page 2-6.

The activity bar

The activity bar shows messages about system activities when you
test your graphic displays. You can specify the types of messages to
display in the activity bar, move the bar, resize it, and clear the
messages in it.

For information about moving and resizing the activity bar, see
page 8-6. For information about testing graphic displays, see
page 8-9.

Messages in the activity bar

The types of messages that appear in the activity bar depend on
how you set up activity logging on the development system. For
information about specifying the types of activities to display, see
page 15-2.

Activity messages are preceded by a white, yellow, or red icon.
White indicates information, yellow indicates a warning, and red
indicates an error.

To clear the selected message in the activity bar, click Clear. To
clear all the messages in the activity bar, click Clear All.

The status bar

The status bar displays information about the active window or
about the selected tool or menu item. The information that is
displayed depends on where the mouse pointer is. For example,
when you select a graphic object in the Graphics Display editor, the
status bar displays information about the selected object.

Workbook tabs

If you select Workbook Mode on the View menu, the work area
displays tabs at the bottom for each open editor or component.
Workbook Mode allows you to bring forward an open item more
quickly than by using the Window menu.
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Workbook tabs

Showing and hiding items in the main
window

You can display or hide all the items in the main window (except
the menu bar) by clicking the items on the View menu.

The status bar, Project Explorer,

activity bar, and Standard toolbar

are visible. Workbook Mode is

turned off.
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To hide or display the Project Explorer:

� On the View menu, click Explorer Window, or click the
Explorer Window tool on the toolbar.

Using the Project Explorer

The Project Explorer is the main tool for working with RSView
Studio. It lists the editors you use to develop your project, as well
as the components, such as graphic displays, you’ve created. When
you create or open a project, the project name appears in the title
bar of the Project Explorer.

Click the - symbol to close

a folder.

Components are listed

below the editor’s icon.

Click the + symbol to

see the list of

components for an editor.

You can resize the Project Explorer by dragging its edges.

Explorer Window tool
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Viewing the Project Explorer

You can view the Project Explorer in a number of ways:

As a docked window. When docked, the explorer is always on
top of other windows that it overlaps. You can dock the
explorer to any edge of the main window.

As a floating window. When floating, the explorer is always on
top of other windows that it overlaps, but you can move it to
different locations in the middle of the main window.

As a “child” window. When the explorer is in child mode, you
can minimize the explorer or position other windows in front of
it. This mode is particularly useful when you are working in
multiple editors or working with the Help open.

To put the explorer in child mode, right-click the Project
Explorer title bar, and then click MDI Child.

Moving the Project Explorer

You can move the Project Explorer in a number of ways:

Click the title bar and drag.

Double-click the title bar to float the explorer in the middle of
the main window, then drag it to a new position.

Right-click the title bar, then select a new docking location,
floating, or child mode.

Working with editors

When developing a project, you will use many different editors, but
they have many similar features and often require similar
information. Knowing how to use these features saves time.

For information on working with particular editors, see the
chapters later in this guide.
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Locating editors

The editors are grouped in folders in the Project Explorer (see the
illustration on page 2-6). Each editor is displayed with an icon to
the left of the editor name.

To open a folder in the Project Explorer:

� Click the + symbol to the left of the folder icon, or double-click
the folder name.

Viewing an editor’s components

With some editors you enter information in a single window or a
tabbed dialog box. Other editors allow you to create multiple
components, such as graphic displays or message files. Each
component is stored in a separate file, with its own name.

You can create components in these editors:

Graphics Display

Graphics Library

Parameters

Local Messages

Information Messages

Data Log Models

Macros

The Project Explorer lists the components you create under the
icon for the editor you used to create the component.

You can use the Images editor to copy bitmap images into your
project (but not to create new images). Each image you copy is
listed as a component under the editor.

To view a list of components for an editor:

� Click the + symbol to the left of the editor icon, or double-click
the editor name.

Opening editors

To open an editor:

� Right-click the editor, and then click Open or New.

If there are no components in the editor, you can double-click
the editor to open it.



� 2-9Exploring RSView Studio

Closing editors

To close an editor:

� Click the close button on the editor’s title bar, or on the File
menu click Close.
Some editors have an OK or Close button that you can click to
close the editor.

Entering information in spreadsheets
Some editors contain spreadsheets for entering information. You
can enter information in the white columns. Gray columns display
information; you cannot enter information in them.

Enter information in

this column.

This column is for display

purposes only.

These editors contain spreadsheets:

Nodes*
Tag Database*

User Accounts

Global Connections
Local Messages

Alarm Setup
Information Setup

Information Messages
Macros

* You cannot make changes in the spreadsheets in the Nodes and
Tag Database editors. In these editors, you must use the Form
section of the editor to create and edit components.
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In the Graphics Display editor, many of the properties dialog boxes
for configuring graphic objects contain spreadsheets for assigning
tags or expressions to the objects.

To enter information in a cell in a spreadsheet:

� Click the cell, and then type the information. If the cell already
contains text, the new information is added after the current
text.

In the Property Panel, double-click the cell and then type the
information. If the cell already contains text, double-clicking
highlights the text and typing replaces the highlighted text.

To move to the next cell in the row:

� Press Tab or Enter.

The method to use depends on which editor you’re working in.

To move to the first cell in the next row:

� Press Enter or Down Arrow.

The method to use depends on which editor you’re working in.

To delete a cell’s contents:

� Click the cell, and then press Delete or Backspace. Pressing
Backspace removes the characters one by one.

The method to use depends on which editor you’re working in.

Working with components

This section describes how to perform basic operations that are
common to all components.

For information on working with components in particular editors,
see the chapters later in this guide.
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Creating components

To create a new component:

� Right-click the editor and then click New, or on the File menu
select New and then click the type of component to create.

Opening components

To open a component:

� Double-click the component, or right-click the component and
then click Open, or drag and drop the component from the
Project Explorer to the work area.

Saving components

The Save tool is enabled when the active component contains
unsaved changes.

To save a component:

1. On the File menu, click Save, or click the Save tool.

2. If this is the first time you’re saving the component, type a name
in the Component name box, and then click OK.

Closing components

To close a component:

� On the File menu, click Close, or click the Close button on the
component’s title bar.

Some components have a Close button that you can click to
close the component.

Before the component closes you are prompted to save unsaved
changes, if there are any.

Save tool

Close button on title

bar

Close button in

component
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Adding components into a project

You can use the same components in more than one project by
adding components into a project.

For example, if you want to use the same graphic display in
Project A and Project B, create the display in Project A, then add
the graphic display component from Project A to Project B.

When you add the component into Project B, changes you make to
the component in Project B are not reflected in the component in
Project A.

To add a component from Project A into Project B:

1. In Project B, right-click the type of editor that was used to
create the desired component. For example, to add a graphic
display component, right-click the Displays icon in the
Graphics folder.

2. Click Add Component Into Project.

3. In the dialog box, navigate to the component to add (in
Project A’s folder), and then click the component’s file name.

Click and Shift-click to select a group of components, or
Ctrl-click to select multiple individual components.

For information about project folders and files, see Chapter 4.

4. Click Open. The components are listed under the editor in the
Project Explorer in Project B.

If you later modify the component in Project A, you can add the
component into Project B again using the same steps as described
above.
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Using Add Component Into Project with graphic displays

and graphic libraries

The Add Component Into Project menu command is also useful
for:

adding graphic displays to your project’s Libraries folder

using libraries as graphic displays in your project

For information about graphic libraries, see page 8-16.

Deleting components

Deleting a component deletes it from the Project Explorer and from
the hard disk.

To delete a component:

� Right-click the component, and then click Delete.

Removing components

You can remove a component from the Project Explorer but leave it
on the hard disk, in case you want to use the component in another
project.

To remove a component:

� Right-click the component, and then click Remove.

Renaming components

To rename a component:

1. Right-click the component, and then click Rename.

2. In the To box, type the new name.

3. Click OK.
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Duplicating components

The Duplicate option is useful for creating multiple similar
components. For example, you could create a graphic display to use
as a template, then duplicate the display each time you want to use
the template.

To duplicate a component:

1. Right-click the component, and then click Duplicate.

2. In the Component name box, type a name for the duplicate
component.

3. Click OK.

Printing

Each editor has a Print item on its File menu.

To print an editor or component’s contents:

1. Open the editor or component.

2. On the File menu, click Print.

3. Click OK.

Selecting a printer

You must install a printer before you can select it. For information
on installing a printer, see your Windows documentation.

IMPORTANT The Print Setup menu item in RSView Studio applies to
your development computer only.

To print at runtime, set up a printer on the computer
you’ll be using to run your project. For information
about printing at runtime, see page 2-15.
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To select a printer:

1. On the File menu in any editor or component, click Print Setup.

2. If you don’t want to use the default printer, specify another
printer.

3. Choose the appropriate paper and orientation options.

4. Click OK.

Selecting printer setup options

For detailed information about printer options, refer to your
Windows documentation.

Selecting a network printer

RSView Studio can print to a network printer. For detailed
information about setting up network printers, refer to your
Windows documentation.

Printing at runtime

You can print graphic displays at runtime using the Display Print
button object or using a remote display print. You can also send
activity and alarm messages to a printer at runtime.

For information about See

Display Print buttons Page 8-35

Printing graphic displays Chapter 8

Printing displays remotely Chapter 19
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For information about See

Printing alarm messages Chapter 13

Printing activity messages Chapter 15

Specifying the printers to use at
runtime

Chapter 23
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Planning projects

A well-designed project requires planning. To help you plan, this
chapter describes:

understanding the machines and processes you’re automating

collecting data

designing a tag database

planning graphic displays and navigating between them

planning alarms

providing information for the operator

using trends

designing a secure system

RSView comes with several sample projects that can give you
guidance when planning your project. For instructions on opening
the sample projects, see page 2-2.

Understanding the process

Gather information from a variety of sources so you have a
complete and detailed understanding of the machines and processes
you’re automating.

To gather information:

Talk to machine operators and other experts who are going to
use the system. Find out what information they need to
optimize machine operations and processes.

Talk to management and MIS (Management Information
Systems) staff to find out what information they need to support
planning decisions.

Break up each section of the process into its constituent parts.

Determine what type of communications you’ll be using—OPC
or direct driver.

3
Chapter
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Determine which process variables need to be accessed and
identify their locations in the programmable controllers.

For information about setting up direct driver communications, see
Chapter 5. For information about setting up OPC communications,
see Chapter 6.

Collecting data

When planning data collection, design your system so only essential
data is collected. Limiting data collection is important because
collection activities require substantial processing power and
generate a lot of traffic on the communication channel or network.

Keep data collection requirements in mind when designing the
layout of the programmable controller data tables and the tag
database. Ideally, tag addresses should reference contiguous blocks
of programmable controller data tables to reduce highway traffic
and optimize system response. If you’re going to use data from an
OPC server, read the server documentation to find out how to
optimize traffic.

Designing a tag database

Take the time to plan your tag database. A good design helps reduce
the time required for maintenance and can improve programmable
controller-to-RSView response time.

For information about creating a tag database, see Chapter 7.

Collecting information

Before you begin creating the database, collect:

flowcharts of your processes (or process and instrument
diagrams)

a list of programmable controller data table or register addresses
your project will be accessing

machinery systems documentation

alarm requirements (for more detail, see “Planning alarms,” later
in this chapter)
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Organizing tags

Before creating tags:

Develop naming conventions for tags, choosing names that are
familiar and logical to everyone. This makes troubleshooting
easier.

Group related tags.

Group tags in the way that makes most sense for your project.
For example, group all similar devices or group related areas of
the plant floor.

When creating tags, place related tags into folders. For greater
organization, nest folders.

Planning graphic displays

When planning displays, determine the best way for users to
navigate through your displays and develop a template to establish
a common look and feel for your displays.

Also consider factors about the runtime terminal that affect how
the project is displayed and used, such as:

screen size

whether the operator will be using a keyboard, touch screen,
mouse, or combination of navigation and data entry methods

For information about creating graphic displays, see Chapter 8.

Developing a hierarchy of displays

A hierarchy of displays is a series of graphic displays that provide
progressively more detail as users move through them. Design your
display hierarchy to meet the needs of the various users, including
managers, supervisors, and operators.

Well-organized graphic displays present information clearly and
consistently and guide users through the system. Before designing
individual graphic displays, plan an overall display hierarchy and
plan how users will navigate through the hierarchy.

For information about navigation methods and developing a
hierarchy of displays, see Chapter 19.
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Creating a template to ensure consistency

It is possible to keep a consistent appearance among all the displays
in a project by presenting the same pieces of information in the
same place on each graphic display. To ensure uniformity, develop a
display with common elements that acts as a template. Each time
you develop a new display, start with a duplicate of the template.

For example, the template could contain:

company logo

title

date and time

navigational buttons

The template does not use a special file format like a Microsoft
Word template does, but is simply a graphic display that you
duplicate for each new display.

When designing displays, applying good visual design principles
helps users and increases their efficiency. Remember these
important design principles:

Consistency

Be consistent with your use of symbols and color.

Be consistent with button labels and button placement.

When you design several displays, place the same kinds of
buttons in the same positions. For example, if you have a Start
button in a certain position in one display, don’t put a Stop
button in the same position in the next display.

Clarity

Use symbols that are easily recognizable. For example, use the
conventional ISA symbols for tanks and valves.

Don’t overload the screen with information.

Use standard, clear terminology, and avoid abbreviations or
acronyms that the user might not understand.

Use colors with recognizable meanings. For example, in North
America the colors red and green usually mean stop and start.
Keep color meanings consistent by assigning red only to Stop
buttons, and green only to Start buttons.
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Some people are color blind to red and green so don’t rely on
color alone to establish meaning.

Use high contrast color combinations, such as yellow on blue.

Usability

If you’re designing for a touch screen, don’t place important
buttons where they’ll be blocked by an On Top display. The
user can’t press a covered button. Also, ensure the button is
large enough for users to touch easily.

Ensure there is always a clear way to move between displays.

Planning alarms

Before setting up alarms, plan:

what conditions will trigger alarms

how operators will be notified of alarms

what information you want alarm messages to contain

how operators will respond to alarms

For information about setting up alarms, see Chapter 13.

Providing information for the operator

In addition to notifying the operator of alarm conditions, you can
provide information and instructions about plant processes, and
inform the operator about system activities.

Before setting up information notification, plan:

what system activity the operator needs to be informed about

what conditions will trigger information messages

what information you want the messages to contain

Local and information messages

Use local messages to give the operator information in a specific
graphic display while the display is open. Use information messages
to give the operator information no matter which display is open.

For information about setting up local messages, see page 8-29. For
information about setting up information messages, see Chapter 14.



Preface

3-6 � RSView Machine Edition User’s Guide

Activity logging

Set up activity logging to notify the operator of system activity such
as tag reads and writes, communication problems, macros, or
problems opening displays.

For information about setting up activity logging, see Chapter 15.

Using trends

When planning trends, consider how they will be used. For
example, will the trend be used to:

analyze process trends?

monitor production efficiency?

archive process variables to ensure compliance with government
regulations?

Based on such considerations, you can determine:

which tags need to be plotted on the same trend

which tags need to be logged by using a data log model

For information about setting up data logging, see Chapter 16. For
information about creating trend graphic objects, see Chapter 17.

Designing a secure system

When deciding on your security requirements, consider whether to:

restrict access to every graphic display to prevent accidental
changes

restrict access to certain graphic displays

have everyone log on

use the DeskLock tool to prevent users from switching to
another application at runtime (Windows 2000 runtime projects
only)

Based on these considerations, you can set up security for
individual users or groups of users. For example, you might want to
set up groups of users, such as a manager group and an operator
group.

For more information about setting up security, see Chapter 18.
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Working with projects

This chapter describes:

project files

creating, opening, and closing projects

copying, deleting, backing up, renaming, and restoring projects

specifying project settings

viewing project properties

What is a project?

A project is the software application you create in RSView Studio to
monitor and control your plant processes.

During project development, the project consists of a folder on your
hard disk that contains the main project file (with the extension
.med) and a set of folders containing additional project files. The
project folder is located in this directory:

C:\Documents and Settings\All Users\Documents\RSView
Enterprise\ME\HMI projects

The .med file contains general project information such as a list of
project components and the project’s directory location and version
numbers. You open this file to work on the project in RSView
Studio.

When you create a project, some of the folders are empty until you
start setting up your project. When you finish developing the
project, RSView uses the information in the project’s folders and
files to create the runtime project.

The runtime project consists of a file with the extension .mer. For
information about creating the runtime project, see Chapter 20.

4
Chapter
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Project files

The following table lists the project folders and the types of files
they contain.

This folder Contains File

extensions

Project name Main project file and the folders
described below

.med

Accounts User account file .act

ActivityLog Activity log setup file .alg

cache\RDMDATA Internal communication files .ctl, .dat, .idx

CommStatus Internal communication file
(created when you test run the
project)

.stg

comprf Internal information on
channels, nodes, and scan classes

.csv, .ctl

DLG Data log models (component
files)

.mdf

Gfx Graphic display component files .gfx

GlobalConn Global connections file .gcn

Images Image files .bmp

Information Information setup file
Information message
component files

.ifo

.ifm

Local Local message component files .loc

M_Alarms Alarm setup file .mal

Macros Macro component files .mcr

PAR Parameter component files .par

Project Settings Project setting file .pts

Startup Startup settings file .stp

TAG Tag database files

Tag cache file

.crc, .ctl, .dat,

.db

.cac

Component file locations

Component files are located in folders in the project folder, as
described in the previous table. For example, graphic display
component files (with the extension .gfx) are stored in the Gfx
folder.
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External folders

The following table lists RSView folders that are external to the
project folder, and the types of files they contain.

The folders are located in this directory:

C:\Documents and Settings\All Users\Documents\RSView
Enterprise

This folder Contains File

extensions

Images Image files for use on
graphic objects

.bmp

ME\Libraries Graphic library
component files and
image files used in the
library displays

.gfx

.bmp

ME\Logs\Runtime Project
Name\Dlg\Data Log Model
Name

Data log files for
projects that have run
on the development
computer

.log, .tag

ME\Logs\Runtime Project
Name\M_Alarms

Alarm log file for
projects that have run
on the development
computer

.alm

ME\Runtime Runtime project files .mer

ME\HMI projects Sample project folders,
including all files and
folders needed for the
sample

If desired, you can specify a different directory in which to store
graphic library component files. For more information, see
page 8-18.

Default log file locations for RAC6182
projects

On the RAC6182, alarm and data log folders are located by default
in this directory:

\Storage Card\Rockwell Software\RSViewME\Logs\

Data log file locations

You can also store data log files in a different location on the runtime
computer, on a networked computer, or on a PCMCIA card. For
more information, see Chapter 16.
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Naming files

File names, including the path, can be up to 200 characters long (file
names can contain spaces). For example, the following path and file
name contains 114 characters:

C:\Documents and Settings\All Users\Documents\RSView
Enterprise\ME\HMI projects\Malthouse_640x480\
Gfx\Steeping.gfx

Creating, opening, and closing projects

Creating projects

You can create a new project when you open RSView Studio, or
once RSView Studio is already open.

To create a new project when you open RSView Studio:

1. Open RSView Studio.

2. In the New tab, in the Project name box, type a name for your
project.

If desired, type a description of the project. If you don’t type a
description now, you can add one later, as described on
page 4-14.

3. Click Create.

RSView Studio creates the project’s folders and files, and then
displays the new project in the Project Explorer.
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The project is created in the ME\HMI projects directory, in a folder
with the same name as the project name.

This is the path to the ME\HMI projects directory:

C:\Documents and Settings\All Users\Documents\RSView
Enterprise\ME\HMI projects

IMPORTANT
Once you create the project, specify the project
settings. These settings determine the general
appearance of your runtime project, and affect how
your graphic displays look. For more information, see
page 4-7.

To create a new project when RSView Studio is already

open:

1. On the File menu, click New Project, or click the New Project
tool.

If a project is already open, RSView Studio asks you whether to
close the project that is currently open. Click Yes.

2. Follow steps 2 and 3 in the previous procedure.

Opening projects

You can open a project when you open RSView Studio, or once
RSView Studio is already open.

For information about opening a sample project, see page 2-2.

To open an existing project when you open RSView Studio:

1. Open RSView Studio.

New Project tool
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2. Click the Existing tab, and then click the project to open.

If the project you want to open is not displayed in the list, click
Browse, navigate to the folder containing the project’s .med file,
and then click the file name.

3. Click Open.

RSView Studio displays the project in the Project Explorer.

To open an existing project when RSView Studio is already

open:

1. On the File menu, click Open Project, or click the Open Project
tool.

If a project is already open, RSView Studio asks you whether to
close the project that is currently open. Click Yes.

2. Follow steps 2 and 3 in the previous procedure.

To open a project you used recently:

� On the File menu, select Recent Projects, and then click the name
of the project to open.

If a project is already open, RSView Studio asks you whether to
close the project that is currently open. Click Yes.

Opening multiple projects

To open two projects at the same time, for example to copy images
and graphic objects between projects, open two instances of RSView
Studio.

Closing projects

To close a project:

� On the File menu, click Close Project.

If there are any unsaved changes in open editors, RSView Studio
asks you whether to save the changes before closing the project.

To close a project and close RSView Studio at the same

time:

� Click the Close button at the right end of the RSView Studio title
bar.

If there are any unsaved changes in open editors, RSView Studio
asks you whether to save the changes before closing.

Open Project tool

Close button
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Copying, deleting, backing up, renaming, and
restoring projects

Use the Project Transport Wizard tool to:

copy projects

delete projects

create a compressed backup copy of the project, with the file
extension .mea

rename projects

restore a project from the backup file

To start the wizard, do one of the following:

In RSView Studio, on the Tools menu click Project Transport
Wizard.

On the Windows Start menu, select Programs, Rockwell
Software, RSView Enterprise, Tools, and then click ME Project
Transport Wizard.

For details about using the wizard, see the wizard’s Help.

About project settings
Project settings determine the general appearance of your runtime
project, such as the size of the project window and whether a title
bar appears in the project window.

Since project settings affect how your graphic displays look, specify
the settings before creating graphic displays.

Project window size and runtime screen
resolution

This section describes the difference between project window size
and runtime screen resolution, and describes how these two settings
can affect the behavior of your project at runtime.

The project window size is the amount of room your project
occupies on the runtime terminal or computer screen, in pixels. The
runtime screen resolution is the actual size of the runtime terminal
or computer screen, in pixels. Therefore, the project window size
must be less than or equal to the runtime screen resolution.
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Project window size

(640 x 480 pixels)

Screen resolution

(1024 x 768 pixels)

Usually, a project is designed to completely fill the runtime terminal
or computer screen. If you want your project to do this, set the
project window size to the resolution of the screen in pixels. For
information on setting the project window size, see page 4-12.

Specify the screen resolution in the Display Properties dialog box in
the Windows Control Panel of your runtime computer.

Changing the project window size after creating graphic

displays

The project window size is used for all graphic displays of the
Replace type. If you decrease the window size after you have
designed any graphic displays, Replace displays are resized, but any
objects in the displays remain the same size and in the same position
as before. On Top displays are not resized.

For more information about Replace and On Top displays, see
page 8-10.
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How the runtime screen resolution affects the pop-up

windows

RSView comes with a pop-up Login window, as well as numeric and
string pop-ups for runtime data entry. You cannot control the size or
position of these pop-up windows. If you plan to use the Login
window or numeric or string pop-ups at runtime, the runtime screen
resolution must be at least as big as the minimum size for the
pop-ups that you want to use.

Pop-up Minimum width

in pixels

Minimum height

in pixels

Login window 280 84

Numeric pop-up keypad 124 240

Numeric pop-up scratchpad 124 68

String pop-up keyboard 236 208

String pop-up scratchpad 236 64

RSView automatically sizes the pop-ups based on the runtime screen
resolution. If the runtime screen resolution is smaller than the
minimum pop-up size, the pop-up cannot open at runtime.

RSView sizes the

pop-up to occupy the

center of the screen
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How the project window size affects the default message

displays

Your project comes with preconfigured, default graphic displays for
activity, alarm, and information messages. If the project window size
is smaller than the default displays, the edges of the displays are cut
off at runtime.

The right edge of the

[ALARM] display is

cut off.

These are the sizes of the default displays:

Graphic display Width in pixels Height in pixels

[ACTIVITY] 640 160

[ALARM] 640 215

[INFORMATION] 640 80

If your project window size is smaller than the default message
display sizes, you can resize the displays, or use your own displays
instead.

Title bar

If you select this option, a title bar is used for all Replace graphic
displays. For information about graphic display types, see page 8-10.

If desired, you can also use a Control box, Minimize button, and
Close button on the title bar. The Close button appears only if you
select the Control box in the Project Settings editor.
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Title Graphic display name Minimize button

Control box Close button

If you plan to set up security for your project and want to prevent
unauthorized users from stopping the project, do not use a title bar.

For information about setting up security, see Chapter 18.

Title bar for On Top displays

For On Top displays, you can specify a different name to use in the
title bar. Use the Display Settings dialog box to specify the name (for
details, see page 8-10).

The title you specify in

the Project Settings

editor applies to all

Replace displays.

You can specify a

different title for each

On Top display (using

the Display Settings

dialog box in the

Graphics Display

editor).
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Specifying project settings

To specify project settings:

1. Open the Project Settings editor.

2. In the General tab, specify these settings:

Project window size

Select a standard window size, or to use a different size, select
Custom size.

Width

If you select Custom size, type the width of the window in
pixels.

Height

If you select Custom size, type the height of the window in
pixels.
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3. Click the Runtime tab, and then specify these settings:

Title bar

Select this check box to display the name of the project (or other
title) in a title bar at the top of the window. Type the title in the
box below the check box.

If you select this option, the window border is automatically
displayed with the title bar.

Border

Select this check box to display a border around the project
window. If you select Title bar, this option is selected
automatically.

Control box

Select this check box to display a Control box at the left end of
the title bar. The user can click the Control box to display the
Control menu, which contains options for displaying, moving,
sizing, and closing the window.

If you select this option, a Close button appears at the right end
of the title bar.

This option is available only if you select Title bar.

Minimize button

Select this check box to display a Minimize button at the right
end of the title bar. The Minimize button reduces the window to
an icon.

Control menu
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This option is available only if you select Title bar and Control
box.

Project window position

Type the number of pixels from the top left corner of the screen
to position the window. If the project window occupies the
whole screen, accept the default values of 0.

4. Click OK to save the settings and close the editor.

Viewing project properties

You can use the Project Explorer to view this information about
your project:

Project name

Project description, if any

Location of the project file

Number of graphic displays in the project

Maximum number of displays you’re licensed to use

To view project properties:

1. In the Project Explorer, right-click the project name (at the top
of the Explorer tree), and then click Properties.
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2. If desired, enter or modify the description for the project.
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Setting up direct driver
communications
This chapter describes:

when to use direct driver communications

how the communication channel, network, device, driver, and
nodes work together

steps for setting up direct driver communications

configuring channels

creating direct driver nodes

configuring scan classes

monitoring communications

When to use direct driver communications
Use direct drivers to communicate with Allen-Bradley controllers
over these network types:

DH+�

DH-485

TCP/IP (Ethernet�)

ControlNet�

Use OPC (OLE for Process Control) to connect to third-party
devices or servers. For details, see Chapter 6.

Overview of direct driver communications at
runtime

Communication through direct drivers involves:

channels

communication devices

communication driver software

nodes (control devices)

5
Chapter
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The following illustration shows an RSView ME Station installation
and its channel and nodes.

RSView ME Station

Communication channel

Nodes

Programmable controller

Network

ControlLogix processor

Communication channel

The communication channel is the connection from RSView ME
Station computer through the network to the data source.

A data source can be memory or a device such as a programmable
controller or OPC server. However, you don’t need to use channels
to communicate with memory tags or OPC servers. Channels are
required for communication with direct driver devices only.

When you configure a channel you specify the network type and the
communication driver that the runtime computer uses.

Communication device

The communication device is a piece of hardware that connects the
runtime computer to the communication channel.

You can use these communication devices with RSView ME Station:

serial port

Ethernet port

Allen-Bradley card in the PCI or ISA slot

The network type and communication driver to use depends on the
communication capabilities of the device connected to the runtime
computer. See the table in the next section.
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For installation information, see the documentation that comes with
the communication device you’re using.

Communication driver

The communication driver is the software that permits the runtime
computer to communicate with the communication device.

Windows 2000

For projects that will run on the Windows 2000 operating system,
see RSLinx for a list of available driver types and devices.

RAC6182

For projects that will run on the RAC6182, you can use these
communication drivers:

Use this

driver

For this network

type
Using this device

AB_DF1-1 DH+ RS-232 serial port connected to
a KF2 box, or connected
directly to a DF1 serial port on
a device

AB_ETH-1 TCP/IP: 10Base-T or
100Base-TX Ethernet

RJ45 connector (Ethernet port),
communicating with a PLC-5

AB_KT-1 DH+ or DH-485 A-B 1784-PKTX card in the
PCI slot

Using SoftLogix 5 controllers

You can use SoftLogix� 5 controllers with Windows 2000 projects
only.

To communicate with a SoftLogix 5 controller using RSLinx and
RSView, configure a TCP/IP channel and use one of these drivers:

SOFT5 driver

AB_ETH driver.

Configuring the SOFT5 driver

For the SOFT5 driver, when configuring the SoftLogix 5 driver in
RSLinx, enter the IP address or UNC name of the SoftLogix 5
controller in the Station Mapping tab.
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If the SoftLogix 5 controller is not running on the same computer as
RSLinx, the Windows 2000 user account that is running RSLinx
must be a member of the SoftLogix Administrators group on the
SoftLogix 5 computer.

Configuring the AB_ETH driver

For the AB_ETH driver, when configuring the Ethernet driver in
RSLinx, enter the IP address of the SoftLogix 5 controller in the
Station Mapping tab. You must also enable the WinSock TCP/IP
driver in SoftLogix 5.

Drivers on the development system versus
drivers on the RAC6182

The Transfer Utility that you use to download the project to the
runtime computer uses an RSLinx driver on the development
system. This driver is used for the transfer only.

Therefore, you must configure an RSLinx driver on the development
computer when you download the project to the runtime computer,
then configure a driver on the RAC6182 before starting the project.

If you will be using an Ethernet network to communicate at
runtime, you don’t need to configure the communication driver on
the RAC6182. If you will be using a DH+ or DH-485 network, you
must enable the appropriate communication driver and ensure that it
is configured correctly before you begin running your project.

For information about configuring an RSLinx driver for the
download, see Chapter 21. For information about configuring a
driver on the RAC6182, see Chapter 23.

Node (control device)

The node is a data source attached to a network. When your project
is running, RSView must periodically update tag values in the value
table. This is done by scanning the nodes.

When you configure a node you specify the channel the node is on,
its station address, and the type of node (for example, PLC-5�).

Example: Configuring communications with a PLC-5

This example shows how to set up communications via Ethernet to a
PLC-5.
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RSView

ME Station
PLC-5

Ethernet

Adding an RSLinx device driver

Use RSLinx to configure the Ethernet driver AB_ETH-1:

1. In RSLinx, on the Communications menu, click Configure
Drivers.

2. In the Available Driver Types box, select Ethernet devices, and
then click Add New.

3. In the Add New RSLinx Driver dialog box, accept AB_ETH-1
by clicking OK.
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4. In the Host Name column, type the IP address of the PLC-5,
and then click OK.

5. Click Close to close the Configure Drivers dialog box.

6. Close RSLinx.

Setting up a channel in RSView Studio

Use the Channels editor to set up a TCP/IP channel.
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1. In the Channels editor, select a channel, and then select the
TCP/IP network type.

2. In the Communication Driver box, select the Ethernet device
driver, AB_ETH-1, and then click OK.

Creating a node

Use the Nodes editor to set up a direct driver node to connect to the
PLC-5:

1. In the Nodes editor, create a direct driver node called
Controller1.
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Click the PLC-5 to select it.

2. Select the TCP/IP channel you created, and then click the
Browse button beside the Station box.

3. In the RSWho dialog box, browse the AB_ETH-1 driver to the
PLC-5.

4. Click the IP address for the PLC-5 (in either pane), and then
click OK.

5. In the Type box, select PLC-5, and then click Accept.

Creating a tag

Use the Tag Database editor to create a tag that uses the node you
just created:

1. In the Tag Database editor, create a digital tag named
Pump1_start.

Browse button
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2. Select Device as the data source, click the Browse button next to
the Node Name box, and then select the Controller1 node.

3. In the Address box, type the address in the PLC-5: B3:0/0.

4. Click Accept to save the tag.

If desired, you could create additional tags to connect with other
addresses in the PLC-5.

Setting up direct driver communication to
programmable controllers

The instructions below summarize the steps for setting up direct
driver communication with programmable controllers.

You can set up communications in RSView even if you do not have
communication drivers and communication hardware installed.

Summary of steps

1. Start RSView Studio and create or open a project.

2. In the Channels editor, select a channel and assign the
appropriate network type to it.

Browse button
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In the Communication Driver box, assign a driver to the channel.
If you do not have drivers loaded on the development computer,
select None Loaded.

For details, see page 5-11.

3. In the Nodes editor, create nodes for each programmable
controller you wish to communicate with.

For details, see page 5-15.

4. If you want to change the default rate at which tags are scanned,
open the Scan Classes editor and edit the scan classes.

For details, see page 5-17.

5. In the Tag Database editor, create tags. For each tag, select Device
as the data source and assign the nodes and scan classes that you
have defined.

For details, see Chapter 7.

6. Set up communication monitoring.

For details, see page 5-19.

7. Develop the other features of your project.

For details, see the chapters in this book relating to the features
you plan to use.

8. Create the runtime project.

For details, see Chapter 20.

9. Transfer the runtime project to the runtime computer.

For information about transferring projects to the RAC6182, see
Chapter 21. For information about transferring Windows 2000
projects, see Chapter 22.

10. Configure the communication driver in RSView ME Station.

For details, see Chapter 23.
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Configuring channels

To configure a channel:

1. Open the Channels editor.

2. Select a channel, and then fill in this information:

Network Type

If you don’t want to use the channel, or want to clear a channel
configuration, select Unassigned.

Otherwise, using the table as a guide, select a network type.

You can use direct drivers to communicate with ControlLogix
processors if you map the ControlLogix addresses to the
equivalent PLC-5 addresses. For information about PLC-5
addressing syntax, see Appendix B.

To communicate with ControlLogix processors using their native
addressing, use an RSLinx OPC server. For more information,
see page 6-4.
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To communicate with this controller Select

� PLC 5/C

� SLC 5/03�, SLC 5/04�, or SLC 5/05�
(through bridging modules)

� ControlLogix processors (with PLC-5 mapping)

ControlNet

� PLC-5

� SLC 5/04 (specify the controller as a PLC-5 in
RSLinx)

� ControlLogix using 1756-DHRIO card (with
PLC-5 mapping)

DH+

� SLC� controllers

� MicroLogix� controllers

DH-485

� PLC-5E

� SLC 5/05E

� ControlLogix (with PLC-5 mapping; Windows
2000 projects only)

� SoftLogix 5 (Windows 2000 projects only. For
details, see page 5-3.)

TCP/IP

IMPORTANT If you set up channels for both DH+ and DH-485,
at runtime make sure the driver is configured for the
channel you are using. You can configure only one
driver at a time for these network types, because
both use the same card but with different settings.

Messages

Type a number between 1 and 10. This specifies the maximum
number of outstanding messages (that is, programmable
controller reads and writes) RSView sends to a channel before
sending new requests and waiting for a reply.

These messages are stored in the buffers of the programmable
controllers on the channel (each controller has its own buffer). If
a buffer overflows at runtime, a communication error is
generated. If this happens, reduce the number of messages. For
example, some older programmable controllers can handle only
one message at a time.

Communication Driver

Select the driver that is appropriate for the type of network you
will be using.

For details about the drivers you can use, see page 5-3.
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To configure communications without the appropriate hardware
or software installed, select None Loaded as the driver, and then
assign a driver to the channel when you start the project at
runtime.

Or, you can add the driver in RSLinx even though the hardware
is not installed (just disregard the error messages in RSLinx). This
will allow you to select the correct driver when you set up your
channel.

3. When you finish configuring channels, click OK.

Changing the channel configuration

To change the channel configuration once nodes have been
assigned—for example, to move a project from a computer using
DH+ to a computer using TCP/IP—create a new channel of the
correct type. Re-assign the channel number for each node, and then
delete the original channel.

Editing channels at runtime

You can change a channel’s configuration on the runtime computer.
For example, if you set up a channel without specifying a
communication driver, you can specify the driver at runtime. For
more information, see page 23-3.

Using the Nodes editor

A node allows you to assign a logical name and address to each data
source you want to communicate with. Each data source is then
referred to throughout RSView by the node name.

Use the Nodes editor to set up nodes for each data source the
project will communicate with at runtime.
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Spreadsheet area

Form area

Use the scroll bar or drag

the border of the editor to

see more columns.

The information you enter in the form area is displayed in the
spreadsheet area.

Using the View menu

Use the items on the View menu to control the appearance of the
Nodes editor.

To do this On the View menu, click this

Show or hide the spreadsheet area Spreadsheet

Show or hide the form area Form

Change the font used in the
spreadsheet area

Spreadsheet Font. In the Font
dialog box, specify the font, style,
and size to use.

Restore the default font Restore Default Settings

Using the Accept and Discard buttons

When you enter information, the Prev and Next buttons change to
Accept and Discard buttons. Click Accept to save node information.
Click Discard to cancel changes to a node.
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Using the tools

The Nodes editor has these tools for working in the editor:

Use this tool To do this

Delete Delete the selected node.

Duplicate Create a duplicate of the selected
node, with all the same settings,
except that the name is blank.

Insert Row Insert a blank row above the
selected row.

Creating direct driver nodes

Before you can create a node, you must set up communication
channels. For details, see page 5-11.

To create a node:

1. Open the Nodes editor.

2. If the editor already contains node definitions, click the last
(blank) row in the spreadsheet, or click Next to scroll to a blank
row.

3. Fill in this information for each node:

Data Source

Select Direct Driver.

For details about the OPC Server data source, see Chapter 6.

Name

Type a name up to 40 characters long. This name represents the
device on the network. When you create a device tag, you must
assign a node to the tag, and this name identifies the node.

The name can have upper and lower case letters, numbers,
dashes, and underscores. Spaces are not permitted.

Enabled

Normally nodes are enabled, allowing data collection. However,
during setup or troubleshooting you might want to disable a
node to prevent communication timeouts or invalid data. When a
node is disabled, tag values can still be read and written, but the
values are read from and written to the value table in memory
instead of the data source.
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To disable nodes, clear the Enabled check box.

Channel

Select the channel number on which this node resides. If the
channel isn’t configured yet, it is designated Unassigned in the
list. Configure the channel in the Channels editor.

Station

For TCP/IP networks, type the IP address.

For programmable controllers on other network types, type the
physical station address of the programmable controller on the
communication channel. The address depends on the channel this
node is attached to, and the type of network it is.

Refer to your programmable controller’s documentation for
details about addressing syntax, or see the help file or manual for
the installed drivers. For information about station addressing
syntax for nodes connecting to Allen-Bradley devices, see
Appendix C.

If RSLinx 2.0 or later is installed on your computer, click the
Browse button to open the RSWho dialog box, which displays all
active stations for the selected channel. (Expand the nodes in the
tree to see the active devices.) When you select a station from the
RSWho window, the Station and Type boxes are filled in
automatically. Verify the entry in the Type box.

The addresses assigned in RSWho are relative to the development
computer RSWho is running on, not the runtime computer. If
both computers are not on the same physical network, you may
have to update your node addresses at runtime.

For the SOFT5 driver, enter the UNC name of the SoftLogix 5
controller without the backslashes. For example, if the UNC
computer name is \\ORION, type ORION. The computer name
must be 8 characters or less.

For SoftLogix 5 controllers using the AB_ETH driver, enter the
controller’s IP address.

Type

Select the type of programmable controller you are using.

For this device type Select

PLC-5/10, PLC-5/12, PLC-5/15, PLC-5/25 PLC-5

PLC-5/11, PLC-5/20�, PLC-5/20C,
PLC-5/30, PLC-5/40�, PLC-5/40C,
PLC-5/60, PLC-5/80�

PLC-5 (Enhanced)

Browse button
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For this device type Select

SLC 5, SLC 5/01�, SLC 5/02�, SLC 5/03
(OS 300)

SLC 5

MicroLogix, SLC 5/03 (OS 301), SLC 5/04,
SLC 5/05

SLC 5 (Enhanced)

SoftLogix 5 (Windows 2000 projects only) SoftLogix 5

Timeout

Type the number of seconds you want RSView to wait before
reporting a communication error. A timeout period of three
seconds is usually enough. You must use a decimal point (.) as the
decimal symbol in this box, regardless of which decimal symbol
is specified in Regional Options in the Windows Control Panel.

4. Click Accept to save the node configuration.

5. To configure another node, click Next.

6. When you finish configuring nodes, click Close.

Editing nodes at runtime

You can change a node’s configuration on the runtime computer.
For example, you can change the node’s IP address to use the project
with a different processor than was specified during project
development. To do this, stop the project and then use the Nodes
editor to specify another IP address. For more information, see
page 23-4.

Configuring scan classes
When your project is running, it must periodically update the tag
values in the value table. This is done by scanning.

For projects communicating through direct drivers, values are
updated by scanning the data source address at the foreground and
background scan rates specified by the scan class.

Scan classes

Any tag that communicates with programmable controllers through
direct drivers must be assigned to a scan class, to determine how
often the tag’s value is updated.

A scan class has two scan periods: the foreground period and the
background period. The foreground period applies to all tags except
tags used for data logging. The background period applies only to
tags used for data logging.
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Guidelines for configuring scan classes

A scan period of zero means scan as quickly as possible.
However, using zero is not recommended because this setting can
result in so much traffic that overall system communication
slows down.

RSView also scans as quickly as possible if scan rates are
configured to be faster than it can handle. For example, if you
configure 1,000 tags at 0.1 seconds, no errors are generated and
the tags are scanned as quickly as possible. There is no guarantee
that the specified scan rate will be met.

Set the scan period to match the expected rate of change for the
tag’s data. For example, if you scan every five seconds for a
change of state that occurs once an hour, the system is needlessly
burdened. Conversely, if you scan too slowly, the system cannot
monitor value changes that might occur between scans.
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To configure a scan class:

1. Open the Scan Classes editor.

2. Select a scan class and type a foreground and background period
in seconds.

Assign a background period only if the scan class will be assigned
to tags used for data logging.

You can use fractional seconds. For example, if you type .6 the
address is scanned every six tenths of a second.

3. To save the configuration for a scan class without closing the
editor, select another scan class.

4. When you finish configuring scan classes, click OK.

Monitoring communications
Use any or all of these methods to monitor direct driver
communications:

Activity logging—In the Activity Log Setup editor, ensure that
the errors, warnings, and information settings are enabled and are
set up to log to the Activity list or printer. At runtime, messages
about communications are sent to the specified destination.

For more information about activity logging, see Chapter 15.

Communication status—If communication status is on, when
communication errors occur, a communication error banner
opens to inform the operator about the error. By default,
communication status is turned on.
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For more information about the communication error banner,
see page 24-15.

To check the communication status setting, open the Startup
editor. Communication status is on when the Communication
status check box is checked.

For more information about the Startup editor, see Chapter 20.

System tags—System tags are preconfigured tags created by
RSView. The system\Com tags provide information about
communication status. You can display these tags as needed in
your project’s graphic displays.

For a complete list of system tags, see Appendix A.
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Setting up OPC
communications

This chapter describes:

when to use OPC communications

steps for setting up OPC communications

creating OPC nodes

scanning for new tag values

monitoring communications

When to use OPC communications

OPC (OLE for Process Control) connections allow you to
communicate with a wide range of local and remote devices through
vendor-specific OPC servers and devices, with RSView ME Station
as the OPC client.

RSView supports the OPC 2.0 specification.

If you will be connecting to communication devices using direct
drivers, see Chapter 5.

OPC for Windows 2000 projects

If your project will run in Windows 2000, the OPC server can be
local or remote.

You can use these types of OPC servers with Windows 2000
projects:

communication devices, using RSLinx as an OPC server

third-party communication devices, using vendor-specific OPC
servers (such as Siemens or Modicon�)

a third-party application with OPC server support, either on the
same computer or on a network

6
Chapter
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For example, you can communicate with a DeviceNet device using
RSLinx as an OPC server. Configure RSLinx to communicate with
the device, and set up an OPC node in RSView to communicate with
RSLinx.

OPC for RAC6182 projects

If your project will run on a RAC6182, the project can communicate
with:

third-party applications with OPC server support

the built-in RSLinx OPC server that supports ControlLogix

third-party communication devices, using vendor-specific OPC
servers

The OPC server must be local (that is, on the RAC6182), in the
form of a .dll file.

Setting up the OPC server

If RSLinx is the OPC server, you must configure the OPC node on
the development computer, specifying the IP address of the
controller that will be used at runtime. When you create the node,
the development computer must be online with the controller (that
is, have live communications via RSLinx to the controller that will
be used at runtime).

Example: Configuring an OPC node

The following example shows how to create a node to connect to a
local OPC server using RSLinx.

Server Name: RSLinx OPC Server. Because the server is RSLinx,
you don’t need to specify a vendor or version
number.
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This is how the node looks in the Nodes editor:

Columns that

do not apply to

OPC nodes

are left blank.

Once you have created the node, assign it to a tag in the Tag
Database editor. The address tells RSView where to get the data.

Address: TransportBlower.Status
The ControlLogix controller called Filterstation
has been previously set up as an OPC topic in
RSLinx; TransportBlower.Status is the address in
the controller.

This is how the tag looks in the Tag Database editor:
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Example: Configuring an OPC node to connect with a
ControlLogix processor

This example shows how to create an OPC node in RSView Studio
to connect to a ControlLogix processor.

The development computer must be connected to the same network
as the ControlLogix processor.

Adding an Ethernet communication driver and topic

Use RSLinx to configure the Ethernet driver AB_ETH-1:

1. In RSLinx, on the Communications menu, click Configure
Drivers.

2. In the Available Driver Types box, select Ethernet devices, and
then click Add New.

3. In the Add New RSLinx Driver dialog box, click OK to accept
the name AB_ETH-1.

If this driver has already been used, RSLinx assigns the next
available number, for example, AB_ETH-2.
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4. In the Host Name column, type the IP address of the
1756-ENET module connected to the ControlLogix processor,
and then click OK.

5. Click Close.
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6. To verify that communications are working, use RSWho to
browse to the ENET module, open the Backplane, and select the
ControlLogix processor.

If RSWho is not open, on the Communications menu click
RSWho.

7. On the DDE/OPC menu, click Topic Configuration.
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8. Click the ControlLogix processor in the tree in the right pane,
and then click New.

9. In the Topic List, type the topic name CLGX5550.

10. Click the Data Collection tab.

11. Make sure the Polled Messages check box is selected, clear the
Unsolicited Messages check box, and then click Done.

12. In the confirmation dialog box, click Yes.



Preface

6-8 � RSView Machine Edition User’s Guide

Creating a node in RSView Studio

Use the Nodes editor to set up an OPC node to connect to the
ControlLogix processor:

1. In the Nodes editor, in the Name box type Clgx.

2. Click the Browse button next to the Server Name box, and then
select RSLinx OPC Server.

3. Click Close.

Creating a tag

Use the Tag Database editor to create a tag to connect to the topic in
the ControlLogix processor:

1. In the Tag Database editor, create an analog tag named ClgxTag1.

2. Click the Browse button next to the Node Name box, and then
select the Clgx node.

3. Click the Browse button next to the Address box.

Browse button
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4. In the OPC Address Browser box, browse to the item to connect
the tag to, click the item to select it, and then click OK.

If desired, you could create additional tags to connect with other
items in the ControlLogix processor.

Summary of steps

The instructions below summarize the steps for setting up RSView
as an OPC client.

1. Start RSView Studio and create or open a project.

2. In the Nodes editor, create nodes for each OPC server or topic
you wish to communicate with. Select the OPC Server data
source.

3. In the Tag Database editor, create tags. For each tag, select Device
as the data source and assign the OPC nodes that you have
created.

For details, see Chapter 7.
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Creating OPC nodes

An OPC node allows you to assign a name, server name, and update
rate to each OPC server you want to communicate with. The OPC
node name can then be used throughout RSView.

For general information about using the Nodes editor, see page 5-13.

To create an OPC node:

1. Open the Nodes editor.

2. If the editor already contains node definitions, click the last
(blank) row in the spreadsheet, or click Next to scroll to a blank
row.

3. Fill in this information for each node:

Data Source

Select OPC Server.

The Tag Database editor does not check addressing syntax for
programmable controllers that communicate through an OPC
server. If the syntax is invalid, an error is generated at runtime.

For details about the Direct Driver data source, see Chapter 5.

Name

Type a name up to 40 characters long to represent the OPC node.
When you create an OPC tag, you must assign a node to the tag,
and this name identifies the node.
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The name can have upper and lower case letters, numbers,
dashes, and underscores. Spaces are not permitted.

Enabled

Normally nodes are enabled, allowing data collection. However,
during setup or troubleshooting you might want to disable a
node to prevent communication timeouts or invalid data. When a
node is disabled, tag values can still be read and written, but the
values are read from and written to the value table instead of the
device.

To disable nodes, clear the Enabled check box.

Server Name

Do one of the following:

Click the Browse button beside the Server Name box and
select a server from the list of registered servers. The list
displays servers on the development computer.

Type the name of the OPC server that your project will
communicate with, in this format:

<Vendor>.<DriverName>.<Version>

If the OPC server is RSLinx, you don’t need to specify a
version number or vendor name.

You can type the name of an OPC server that has not been
installed yet and install the server later.

If you type the name of a remote computer and then click the
Browse button, the list displays the OPC servers on the
remote computer.

Browse button
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For RAC6182 projects, the server must be on the RAC6182 (you
cannot use the RSLinx Remote OPC server).

Remote Computer Name or Address (Windows 2000

projects only)

If the OPC server is remote, check this box, and then do one of
the following:

Click the Browse button and select a server computer from
the list.

Type the server computer’s name or address.

You can use these formats to specify the name or address:

Use this syntax For this

format

Example

\\ComputerName UNC
(Universal
Naming
Convention)

\\Line1

ComputerName.Domain.c
om

DNS (Domain
Name System)

Comp.NET2.COM

XXX.XXX.XXX.XXX TCP/IP
address

134.87.167.148

You set up the computer’s name or address in the Windows
Control Panel. For more information, see your Windows
documentation.

Browse button
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Access Path

If your project will run on the RAC6182, do not specify an
access path.

For Windows 2000 projects, the access path is maintained for
compatibility with older projects. If you are defining a new node,
do not specify an access path.

If you specify an access path for the node, the OPC Address
Browser in the Tag Database editor is not available.

Update Rate

Specify the fastest rate at which the OPC server sends data to the
OPC client. The default is every 1 second.

To specify that the server use the fastest possible rate, type 0.

If the OPC server is RSLinx, the update rate should not be faster
than the topic poll rate.

4. Click Accept to save the node configuration.

5. To configure another node, click Next.

6. When you finish configuring nodes, click Close.

Editing nodes at runtime

You can change a node’s configuration on the runtime computer.
For example, you can change the node’s IP address to use the project
with a different processor than was specified during project
development. To do this, stop the project and then use the Nodes
editor to specify another IP address. For more information, see
page 23-4.

For projects running on the RAC6182 and using the RSLinx OPC
Server, the only setting you can change at runtime is the node’s
update rate.

Scanning for new tag values
When your project is running, it must periodically update the tag
values in the value table. This is done by scanning.

For projects using OPC, values are updated by the OPC server at
the rate specified in the server product. The update rate you specify
in the Nodes editor is the requested data rate. The server uses this
rate to determine the fastest rate at which to notify your project (the
OPC client) of tag value changes, if there are any changes. For more
details about setting the poll rate, see your server documentation.
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Scan class rates have no effect on OPC communications. They affect
only direct driver communications.

Monitoring communications

Use any or all of the following methods to monitor OPC
communications:

Activity logging—In the Activity Log Setup editor, ensure that
the errors, warnings, and information settings are enabled and are
set up to log to the Activity list or printer. At runtime, messages
about communications are sent to the specified destination.

For more information about activity logging, see Chapter 15.

Communication status—If communication status is on, when
communication errors occur, a communication error banner
opens to inform the operator about the error. By default,
communication status is turned on.

For more information about the communication error banner,
see page 24-15.

To check the communication status setting, open the Startup
editor. Communication status is on when the Communication
status check box is checked.

For more information about the Startup editor, see Chapter 20.

System tags—System tags are preconfigured tags created by
RSView. The system\com*OPC tags provide information about
OPC communication status. You can display these tags as needed
in your project’s graphic displays.

For a complete list of system tags, see Appendix A.
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Creating tags

This chapter describes:

tags and the tag database

tag types and data sources

organizing tags

using the Tag Database editor

searching for tags

using folders to group tags

viewing, creating, editing, duplicating, and deleting tags

configuring analog, digital, string, and block tags

other methods for creating tags

importing tags

using tags and expressions in your project

logging tag values

using macros to assign values to tags

Tags and the tag database

In the tag database, you define the data you want RSView to
monitor. Each entry in the database is called a tag. Set up tags
corresponding to the addresses at the data source that will store the
values you want to monitor when your project is running.

The current value of a tag, when required, is updated from the device
it is connected to and stored in computer memory—referred to as
the value table—so it is immediately accessible to all parts of
RSView. For example, graphic displays use tag values to control
animation or update a trend, and data logging stores tag values to
create a historical record.

7
Chapter
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The data source

The data source can be memory or a device such as a programmable
controller or an OPC server. RSView writes values to and reads
values from the data source. The data source is configured to
exchange information (in the form of numeric or string values)
between the RSView value table and the physical machine that your
project is controlling.

Tag types

You can use these types of tags in RSView:

This tag

type

Stores this type of data

Analog Range of values.

Use analog tags to represent variable states such as
temperature or the position of rotary controls.

Digital 0 or 1.

Use digital tags to represent devices that can only be on or
off, such as switches, contacts, and relays.

String ASCII string, series of characters, or whole words
(maximum of 82 characters).

Use string tags to represent devices that use text, such as a
bar code scanner that uses an alphanumeric product code.

Block A contiguous bit string of up to 1024 bits. Each bit has a
value of either 0 or 1.

Block tags allow RSView to process and read an array of
values associated with a single tag reference.

You can assign block tags to alarm triggers only. Using block
tags, alarm triggers can monitor multiple active alarm
conditions.

Block tags are read only. Block tags are not supported on
OPC nodes.

System Information generated while the system is running, such as
communication status, system time and date, and so on.

RSView creates system tags when you create a project, and
when you create channels or OPC nodes. The system tags
are stored in the folder called “system” in the tag database.
You cannot edit system tags. You can use system tags
anywhere you would use any other type of tag. For a list of
system tags, see Appendix A.
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Analog tags that use floating point values

You can assign analog tags to most of the controls in RSView. If the
analog tag uses the floating point data type but an integer value is
required, the floating point value is rounded.

For information about the data types available for analog tags, see
page 7-16.

How values are rounded

When a floating point value must be rounded to an integer, this is
how the value is rounded:

If the number after the decimal is 4 or less, the value is rounded
down. For example, 8.495 is rounded to 8.

If the number after the decimal is 6 or more, the value is rounded
up. For example, 8.6 is rounded to 9.

If the number after the decimal is 5, the value is rounded using a
“banker’s algorithm,” to average out the rounding over time:

If the number before the decimal is 0, the value is rounded
down. For example, 10.5 is rounded to 10.

If the number before the decimal is an odd number, the value
is rounded up. For example, 11.5 is rounded to 12.

If the number before the decimal is an even number, the value
is rounded down. For example, 12.5 is rounded to 12.

Floating point values are rounded to a maximum of seven digits.
Therefore, using a floating point data type and adding to it a
value that exceeds the seven significant digits will result in a
rounding error. For example, adding any number to 9,999,999
will result in a rounding error.

This rounding method is also used for Numeric Input Enable
buttons that use the Implicit decimal position, if an integer tag is
assigned to the button’s Value control.

Data sources

When defining a tag, you must specify a data source. The data source
determines whether the tag receives its values externally or
internally.
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Device

A tag with Device as its data source receives its data from a source
external to RSView. The data can come from a direct driver
(connected to a programmable controller) or from an OPC server.
You can use up to 5,000 device tags.

Memory

A tag with Memory as its data source receives its data from (and
stores values in) the RSView internal value table. Tags with Memory
as the data source do not count toward the total tag limit.

Organizing tags

Organizing tags makes database creation faster and simpler. To
organize your tags, try these tips:

Establish naming conventions.

Naming conventions enable you to use wildcards most
effectively when searching for and displaying tags during
development.

Use folders to group related tags.

Naming tags

Tag names can be up to 40 characters long. If you create a folder, the
folder name becomes part of the tag name.

The tag name can contain the following characters:

A to Z

0 to 9

underscore (_) and dash (-)

Tag names cannot contain spaces. The tag name can be mixed case.
Tag names preserve upper and lower case for readability but are not
case sensitive. For example, the tag name MixerValve1 is the same as
mixervalve1.

When a tag name starts with a number or contains a dash, enclose
the name in braces { } when you use it in an expression, for example,
{N33-0}. For more information about using tags in expressions see
Chapter 14.
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Using folders to group tags

To organize tags, create a folder to store tags that are related to one
another. To separate the folder name from the rest of the tag name,
use a backslash (\). For example, tags in the folder called Pump
would start with Pump\.

For greater organization, you can nest folders. For example, you can
organize the tag database first by area, then by machines in the area,
and finally by devices in each machine. The result might be
Area1\Machine1\Pump.

To create similar groups of tags quickly, create one folder with its
tags and then duplicate the folder.

Using the Tag Database editor

To open the Tag Database editor:

� Double-click the Tag Database icon.

The Tag Database editor has these parts: form, query box, folder
hierarchy, and spreadsheet.

Form area

Query box

Folder hierarchy

Spreadsheet area
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The information you enter in the form area is displayed in the
spreadsheet area.

Using the View menu

Use the items on the View menu to control the appearance of the
Tag Database editor.

To do this On the View menu, click this

Show or hide the spreadsheet area Spreadsheet

Show or hide the form area Form

Change the font used in the
spreadsheet area

Spreadsheet Font. In the Font
dialog box, specify the font, style,
and size to use.

Restore the default font Restore Default Settings

Update the contents of the editor
(for example, when you’ve created
tags in other editors). For details,
see page 7-7.

Refresh

View information about the tag
database. For details, see page 7-7.

Tag Statistics

Using the Accept and Discard buttons

When you enter information, the Prev and Next buttons change to
Accept and Discard buttons. Click Accept to save tag information.
Click Discard to cancel changes to a tag.

Using the tools

The Tag Database editor has these tools for working in the editor:

Use this tool To do this

Delete Delete the selected tag. For details,
see page 7-14.

Duplicate Create a duplicate of the selected
tag, with all the same settings,
except for the name. For details, see
page 7-13.

Insert Row Insert a new tag above the selected
row. For details, see page 7-13.

Refresh Update the contents of the database
with changes from other editors.
For details, see page 7-7.
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Use this tool To do this

Delete Folder Delete the selected tag folder,
including all the tags in the folder.
For details, see page 7-12.

Duplicate Tag Folder Create a copy of the selected tag
folder, including all of the tags in
the folder. For details, see
page 7-11.

Create Folder Create a tag folder. For details, see
page 7-9.

DB Browser Import tags from a PLC database.
For details, see page 7-26.

Updating the contents of the Tag Database
editor

You can create tags in the Tag Database editor, but you can also
create them “on the fly” in other editors, and you can import them
from an existing tag database. To see the result of changes to the
database you made in other editors while the Tag Database editor
was open, update the contents.

To update the contents of the editor:

� On the View menu, click Refresh, or click the Refresh tool.

When you click Refresh, the undo buffer is cleared and recent
changes can’t be automatically reversed.

Refresh is not available if you haven’t accepted the current tag.

For information about creating tags in other editors, see page 7-23.

Viewing tag statistics

The Tag Statistics dialog box provides a summary of how many tags
your project uses, as well as other tag information such as the date
the tag database was last modified. To view tag statistics, the Tag
Database editor must be open and have focus.

To view tag statistics:

� On the View menu, click Tag Statistics.

Refresh tool
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Searching for tags
Use the query box to select the tags you want to display in the
spreadsheet. This allows you to edit tags in different folders without
browsing the folder hierarchy. You can:

select a single tag by typing the tag name

select multiple tags by typing wildcards

These are the wildcards:

This character Does this

? Matches any single character.

* Matches any number of characters, including the
backslash (\) character.

Use this wildcard by itself to display all the tags in the
tag database.

For example, to search for all the OPC tags in the system folder,
open the folder and then type *opc in the Search For box. When you
press Enter, a list of tags ending with the letters “OPC” appears in
the spreadsheet.

When you do searches, remember that the backslash in a folder
name counts as a character in the tag name.

Using folders
The folder hierarchy and spreadsheet work together. The hierarchy
shows the tag folders and the spreadsheet shows the tags within the
folders.
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Use the folder hierarchy to:
create folders

open folders

add tags to folders

nest folders

duplicate folders

delete folders

A folder icon known as root is always present in the hierarchy
window, at the top of the folder hierarchy. This folder contains all
the tag folders you and RSView create. For example, the system
folder holds the system tags that come with RSView. For a complete
list of the system tags, display the contents of the folder or see
Appendix A.

You can nest folders. If a folder has a plus (+) sign, it contains one or
more folders. If a folder is blank, it does not contain any other
folders.

This folder contains one or more folders.

This folder does not contain another folder.

Resizing the hierarchy box

To view a series of nested folders, resize the hierarchy box.

To resize the hierarchy box:

1. Place the cursor over the right border of the box until it changes
to a double arrow.

2. Drag the border to the required size.

Creating folders

To create a folder:

1. On the Edit menu, click New Folder, or click the Create Folder
tool.

Create Folder tool
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2. Type the folder name.

3. Click OK.

The new folder appears in the hierarchy window.

Opening folders

When you open a folder, its contents are displayed in the
spreadsheet.

To open a folder:

� Double-click the folder.

To open multiple folders:

1. Select the folders by doing one of the following:

Click a folder and then drag the mouse up or down.

Click a folder and Shift-click other folders immediately above
or below the first selected folder.

Click a folder and Ctrl-click other folders anywhere in the
hierarchy.

2. Press Enter.

The tags in the selected folders are displayed in the spreadsheet.

Creating tags in a folder

Once you have created a folder, you can create tags in it.
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To create a tag in a folder:

1. Double-click a folder in the folder hierarchy.

The folder name is displayed in the Name box of the form.

2. After the backslash (\), type the new tag name.

For information about configuring tags once you’ve created them,
see page 7-14.

Nesting folders

Nesting folders means to create a folder inside another folder.

To create a folder inside another folder:

1. Select a folder in the folder hierarchy.

2. On the Edit menu, click New Folder, or click the Create Folder
tool.

3. After the backslash (\), type the new folder name.

4. Click OK.

When you nest folders, remember that the backslash in a folder
name counts as one character in the tag name.

Duplicating folders

When you duplicate a folder, all the tags in the folder are duplicated
and automatically given the new folder name. If the folder contains
folders, those folders are also duplicated.

Create Folder tool



Preface

7-12 � RSView Machine Edition User’s Guide

IMPORTANT Be sure to choose Duplicate Folder rather than
Duplicate. Duplicate only duplicates individual tags.

To duplicate a folder and its tags:

1. Select the folder in the hierarchy.

2. On the Edit menu, click Duplicate Folder, or click the Duplicate
Tag Folder tool.

3. In the To box, type the new folder name.

4. Click OK.

Deleting folders

To delete folders:

1. Select one or more folders in the hierarchy.

2. On the Edit menu, click Delete Folder, or click the Delete Folder
tool.

Working with tags
Use the spreadsheet to:

view tags

create tags

edit tags

duplicate tags

delete tags

Use the query box or folder hierarchy to select the tags you want to
view.

Moving through the spreadsheet

To scroll through the spreadsheet rows:

Use the Prev or Next buttons in the form area.

Duplicate Tag Folder

tool

Delete Folder tool
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Use the Up Arrow and Down Arrow keys.

Use the scroll bars on the spreadsheet.

To select a row, click anywhere in the row or click the row number.

Resizing columns and rows

To resize a column or row:

1. Place the cursor over the division between the column or row, in
the top or side border, until it changes to a double arrow.

2. Drag the column or row to the required size.

Creating tags

To create a tag inside a folder, first open the folder. For details, see
page 7-10.

To create a tag, use any of these methods:

Click New in the forms area.

Click the Insert Row tool.

On the Edit menu, click Insert Row.

Each method inserts a new row above the highlighted row, with the
boxes in the form area ready to receive information about the new
tag.

For information about configuring tags once you’ve created them,
see page 7-14.

Duplicating tags

To duplicate a tag:

1. Select the tag to duplicate.

2. On the Edit menu, click Duplicate, or click the Duplicate Tag
tool.

A new row is inserted below the highlighted row. The new row
contains all the same information except the tag name.

3. In the form area, in the Name box, type the name for the new
tag.

Insert Row tool

Duplicate Tag tool
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4. Click Accept.

Editing tags

You can edit all parts of a tag except the tag name and tag type.

To edit a tag:

1. Select the tag to edit.

The details of the tag appear in the form area.

2. Edit any details except the tag name or tag type.

Deleting tags

Delete tags carefully. Once you click the Delete button, the tag is
deleted. There is no confirmation message and you cannot undo the
deletion.

To delete a tag:

1. Select the tag you want to delete.

2. On the Edit menu, click Delete, or click the Delete tool, or press
the Delete key on your keyboard.

Configuring tag types

The topics below describe how to complete the boxes in the Tag
section of the form. There are separate instructions for analog,
digital, string, and block tag types.

For information on filling in the boxes in the Data Source section of
the form, see page 7-20.

Configuring analog tags

To configure an analog tag:

1. Create the tag, as described on page 7-13.

2. In the Name box, type a tag name. If the tag is part of a folder,
type the name after the backslash (\).

3. In the Type box, select Analog.

Delete tool
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4. Fill in the boxes as outlined below.

Numeric values that require a decimal must use the decimal point
(.) as the decimal symbol, regardless of which decimal symbol is
specified in Regional Options in the Windows Control Panel.

Description

Type a description of the tag, up to 128 characters long.

Minimum and Maximum

Type the minimum and maximum values that can be written to
the programmable controller or server. These values do not affect
what is read from the programmable controller or server. For
example, if you specify a minimum of 0 and a maximum of 100,
RSView would be able to read a value of 200 from a PLC and
store it in the value table, but would not be able to write this
value to the PLC.

The range between the minimum and maximum values cannot
exceed the maximum floating point value (3.402823E38).

Scale and Offset

Type a number. For the scale, do not use 0. To disable the scale,
type 1. To disable the offset, type 0.

The scale and offset modify the “raw data” that comes from the
programmable controller before it is saved in the value table. The
scale and offset also modify the value specified in RSView before
it is written to the programmable controller. The scale is a
multiplication factor—the value from the PLC is multiplied by
the scale. The offset is a fixed value—after the value from the
PLC is multiplied by the scale, the offset amount is added. The
following formula shows the relationship between the PLC value
and the amount stored in the RSView value table.
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RSView value = (PLC value × scale) + offset

IMPORTANT Values from the programmable controller are first
scaled and then added to the offset. When a value is
written to the programmable controller, the process
is reversed: the offset is subtracted and the scale is
used for division. This ensures that the correct,
unchanged value is sent to the programmable
controller.

Data Type

For tags with Device as the data source, select the data type that
matches the format of the data stored in the programmable
controller or Windows application. If you are using direct driver
nodes, use the Default data type to automatically match the data
format specified by the address.

For analog tags connecting to a ControlLogix processor, specify
a data type that corresponds to the data type in the ControlLogix
processor: Byte, Unsigned Integer, Integer, Long Integer, or
Floating Point.

For tags with Memory as the data source, select the data type that
matches the format of the data you will store in the tag.
Choosing Default is the same as choosing Floating Point.

The data types are:

Data type Description Range

Default* Depends on the data
source and node type.

See below.

Unsigned Integer Unsigned 16-bit integer 0 to 65,535

* Do not use this data type with an OPC server, as doing so will produce
unexpected results.
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Data type RangeDescription

Integer Signed 16-bit integer -32,768 to 32,767

Long Integer Signed 32-bit integer -2,147,483,648 to
-2,147,483,647

Floating Point Single-precision (32-bit)
floating point

-3.402823E+38 to
-1.175494E-38,
0,
1.175494E-38 to
3.402823E+38

Byte Unsigned 8-bit integer 0 to 255

3-Digit BCD* 3-digit binary-coded
decimal

0 to 999

4-Digit BCD* 4-digit binary-coded
decimal

0 to 9,999

* Do not use this data type with an OPC server, as doing so will produce
unexpected results.

IMPORTANT For a tag with a Long Integer data type, if the
minimum, maximum, scale, offset, or initial value is
used with a decimal point, the value is stored
internally in floating point format. This means that
the maximum value for the tag is 16,777,216, which
is the maximum integer value for single-precision
floating point numbers.

For information on filling in the boxes in the Data Source section of
the form, see page 7-20.5.

Configuring digital tags

To configure a digital tag:

1. Create the tag, as described on page 7-13.

2. In the Name box, type a tag name. If the tag is part of a folder,
type the name after the backslash (\).

3. In the Type box, select Digital.
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4. In the Description box, type a description of the tag, up to 128
characters long.

For information on filling in the boxes in the Data Source section of
the form, see page 7-20.5.

Configuring string tags

To configure a string tag:

1. Create the tag, as described on page 7-13.

2. In the Name box, type a tag name. If the tag is part of a folder,
type the name after the backslash (\).

3. In the Type box, select String.

4. Fill in the boxes as outlined below:

Description

Type a description of the tag, up to 128 characters long.

Length

Type a number between 1 and 82 to specify the length of the
string tag in characters. The length must be a multiple of the size
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of the programmable controller data element you are addressing.
For example, to reference two-byte data elements in an integer
section, the length must be a multiple of two.

For information on filling in the boxes in the Data Source section of
the form, see page 7-20.5.

Configuring block tags

Block tags are not supported for OPC nodes.

To configure a block tag:

1. Create the tag, as described on page 7-13.

2. In the Name box, type a tag name. If the tag is part of a folder,
type the name after the backslash (\).

3. In the Type box, select Block.

4. Fill in the boxes as outlined below:

Description

Type a description of the tag, up to 128 characters long.

Number of Bits

Type a number between 1 and 1024 to define the length of the
block tag in bits.

The number of bits must correspond to the element in the
address. For example, if the address is located at an integer data
file element, the length must be a multiple of 16, the bit length of
an integer. To create a block tag starting at N7:0 and reaching to
N7:2, you would type 48 (3 x 16).

For information on filling in the boxes in the Data Source section of
the form, see the next section.5.
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Specifying a data source

The following topics describe how to fill in the boxes in the Data
Source section of the form. For details about filling in the boxes in
the Tag section of the form, see page 7-14.

Specifying device as the data source

A tag with device as its data source receives its data from a source
external to RSView. The data can come from:

programmable controllers through direct drivers

programmable controllers through an OPC server

another Windows program through an OPC server

To specify device as the data source:

1. Click Device.

2. In the Node Name box, do one of the following:

Type a node name.

Click the Browse button to open the Node Browser and
select a node name.

Click the Browse button to open the Node Browser and add
a new node.

For information about adding a node for a direct driver, see
page 5-15. For information about adding a node for an OPC
server, see page 6-10.

3. If you are communicating through direct drivers, in the Scan
Class box select a scan class.

For more information about scan classes, see page 5-17.

4. In the Address box, do one of the following:

To communicate through direct drivers to a programmable
controller, specify the physical memory location in the
programmable controller. The address syntax depends on the
controller.

Browse button
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For information about addressing syntax, see the
documentation that comes with your controller. For
information about addressing syntax for Allen-Bradley
controllers, see Appendix B.

To connect to an OPC server, specify the address of the OPC
item in the OPC server. The item syntax depends on the OPC
server.

To open the OPC Address Browser and select the OPC item,
click the Browse button beside the Address box. The browser
is not available if you specify an access path for the OPC
node in the Nodes editor.

If the OPC node is for an OPC server on a remote computer,
the OPC Address Browser displays the items of the OPC
server on the remote computer.

For more information about OPC see Chapter 6.

To specify memory as the data source:

1. Click Memory.

2. In the Initial Value box, type the tag’s starting value.

Each time you start the project, the value defined in the Initial
Value box is assigned to the memory tag.

Browse button
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You can also use macros to assign initial values to tags when the
project starts or when a graphic display opens. For information
about creating macros, see page 7-32.

Example: ControlLogix addressing

We recommend that you use the OPC Address Browser to select
OPC items. When you use the address browser the correct syntax
and data types are selected automatically.

However, if you want to define tags before setting up
communications, you can type the address manually, as shown in
this example. If you type the address manually, be sure to select the
data type for the tag that matches the data type used by the
ControlLogix processor. Do not use the Default data type.

This example shows you how to specify the OPC topic, item name,
and bit level of an item that uses the integer data type in a
ControlLogix processor.

OPC topic and item addressing

ControlLogix uses this addressing syntax:

[OPC topic name]item name

In this example, the RSLinx OPC topic name for the ControlLogix
processor is CLGX. To connect to an OPC item called Motor, type
this address:

[CLGX]Motor

Bit level addressing

You can access the bit level of an item that uses the integer data type
by appending .# to the end of the tag address, where # is the number
of the bit to access.

For example, to access the first bit of the integer item Motor, type
this address:

[CLGX]Motor.0
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Other methods for creating tags

In addition to creating tags in the Tag Database editor as described
earlier in this chapter, you can:

create tags in a third-party application and import them into
RSView

create tags as needed in other editors

import tags from a PLC or SLC database

Creating tags in a third-party application

You can use a third-party spreadsheet editor such as Microsoft Excel
to create your tags, and then import the tags into RSView using the
Tag Import and Export Wizard. When you import tags, they can be
merged with tags already in the tag database and any tags with the
same name can be updated with the new information.

For more information about the wizard, see page 7-28.

Creating tags as needed in other RSView
editors

You can create tags as needed in any editor or dialog box that uses
tags. You can add a tag to the database by doing one of the
following:

Click the Browse button in the Tag column to open the Tags
dialog box and create the tag. For more information, see
page 7-25.

Type a new tag name in the “Tag or expression” column. Keep
track of the tag name, and add the tag in the Tag Database editor
when convenient.

In some editors, when you save or close, a message appears
prompting you to create the tag. For example, if you typed
“Tag1” and it did not exist in the tag database, the following
message would appear:

Browse button in

the Tag column
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Click Yes to create it now, or click No to create it later.

Creating tags as needed in the Data Log
Models editor

In the Data Log Models editor, in the Tags in Model tab, you can
add a tag to the database by doing one of the following:

Click the Browse button beside the “Tags to add” box to open
the Tags dialog box and create the tag, as described in the next
section.

Type a new tag name in the “Tags to add” box, and then click
Add. You are warned that the tag does not exist. Click Yes to add
the tag to the list of tags in the datalog model. Keep track of the
tag name, and add the tag in the Tag Database editor when
convenient.

For more information about the Data Log Models editor, see
Chapter 16.

Browse button in the

Data Log Models editor
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Using the Tags dialog box

When you click a Browse button in a dialog box or editor’s Tag
column, or in the Tags in Model tab of the Data Log Models editor,
the Tags dialog box opens.

In the Tags dialog box, you can:

select a tag by double-clicking it, or by highlighting it and then
clicking OK

edit a tag by highlighting it and then clicking Edit Tag. The Tag
Editor dialog box opens so you can edit the tag’s definition

create a new tag by opening the desired folder and clicking New
Tag. The Tag Editor dialog box opens so you can define the tag.

create a new folder by clicking New Folder. The New Folder
dialog box opens so you can create the folder.

import tags from a PLC or SLC database by clicking Other DB.
The PLC Database Browser opens so you can specify the tags to
import.
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Importing tags from a PLC database

To open the PLC Database Browser, do one of the following:

In the Tags dialog box, click the Other DB button.

In the Tag Database editor, on the Edit menu click Other
Databases, or click the DB Browser tool.

Use the PLC Database Browser to selectively import tags from a
PLC or other database into your project’s tag database. Tags
imported in this way are copied into the database—they are not
shared with the source database. This means changes to tags in your
project do not affect the database from which they have been
imported and vice versa.

You can import tags from any of these databases:

legacy PLC databases, created using WINtelligent LOGIC 5�
or A.I.� 5, with file extension .dsc

RSLogix 5� or RSLogix 500�, saved as an external database,
with file extension .ctd (before importing, explicitly export to the
.ctd format to be sure of including the latest changes)

RSFrameworks databases, with file extension .fm?

For PLC and SLC addresses, the PLC Database Browser shows
only addresses that are used in the symbol or address list of the PLC
programming software.

DB Browser tool

in the Tag

Database editor
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To import tags from a PLC database:

1. In the Node Name box, select a node.

2. If the node uses direct driver communications, in the Scan Class
box select a scan class.

3. In the PLC Database box, type the path to the database to
import tags from, or click Browse to locate and select the
database to import tags from.

The addresses and symbols from the selected database are
displayed in the box below the Filter box.

4. To filter the tag list so that only certain addresses or symbols are
displayed, in the Filter box type a character string, and then click
Search.

To search on names only, click the Symbols button so that only
symbol names are displayed. If an address does not have a
symbol name it is not displayed.

Use filtering if the address or symbol list is too big to display
entirely. You cannot filter beyond a slash. For example, a filter of
B3/1 will not show B3/10, B3/11, and so on.

5. In the list box, click the symbols to import.
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6. In the Put Tags into Folder box, type a folder name if you want
the tags to be in a folder. If the folder does not already exist in
the project’s tag database, it is created.

7. Click OK.

The selected symbols are added to the tag database for the
current project and displayed in the tag list. If you have already
imported a particular symbol, you are prompted to change its
name if you want to import it again.

Using the Tag Import and Export Wizard

You can also import PLC or SLC databases into RSView using the
Tag Import and Export Wizard.

You can use the wizard to:

import tags from legacy PLC databases, created using
WINtelligent LOGIC 5� or A.I.� 5, with file extension .dsc

import tags from RSLogix 5� or RSLogix 500�, saved as an
external database, with file extension .ctd (before importing,
explicitly export to the .ctd format to be sure of including the
latest changes)

export your project’s tags to a .csv file

import tags from another RSView project’s tag .csv file

merge tags from another RSView project (that is, import them
directly from the project, without first creating a tag .csv file)

To start the wizard, do one of the following:

In RSView Studio, on the Tools menu click Tag Import and
Export Wizard.

On the Windows Start menu, select Programs, Rockwell
Software, RSView Enterprise, Tools, and then click Tag Import
and Export Wizard.

For details about using the wizard, see the wizard’s Help.

Using tags and expressions in your project

Once you’ve created tags, assign them to controls in your project to
allow the project to interact with the data source and perform
actions based on the tag values.
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You can assign tags in these editors:

Global Connections

Graphics Display

Parameters

Alarm Setup

Information Setup

Data Log Model

Macros

This example shows the Trigger dialog box that opens when you
click the Add button in the Triggers tab of the Alarm Setup editor:

Type the tag name here... ... or click the Browse button

to open the Tags dialog box.

To specify a tag, do one of the following:

In the “Tag or expression” column, type the tag name.

In the Tag column, click the Browse button and then select a tag
from the Tags dialog box.

Assigning tags to graphic objects

In the Graphics Display editor, you can assign tags to many of the
graphic objects you create.

Use one of these methods to assign tags to a graphic object:

Double-click the object to open the object’s Properties dialog
box, and then click the Connections tab.

Type the tag name here... ... or click the Browse button

to open the Tags dialog box.

Browse button in

the Tag column
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Select the object, and then assign tags in the Connections tab of
the Property Panel.

Type the tag name here... ... or click the Browse button

to open the Tags dialog box.

Using expressions to manipulate tag values

Many of the controls to which you can assign a tag also permit the
use of expressions to perform logical or mathematical calculations on
tag values. If you assign an expression, RSView monitors the
expression value rather than the original tag value. For example,
your machine might send values to the data source in the form of
temperature in degrees Celsius. You could use an expression to
convert the value to degrees Fahrenheit, and then monitor the
expression result rather than the original tag value.

If you can assign an expression, a Browse button is present in the
Exprn column in the editor or Connections tab.
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Type the expression here... ... or click the Browse button to

open the Expression editor.

To specify an expression, do one of the following:

In the Exprn column, click the Browse button, and then create an
expression in the Expression editor. Use this method if you want
to check the expression syntax.

In the “Tag or expression” column, type the expression. The
expression syntax is not checked if you use this method.

For more information about expressions, see Chapter 12.

Substituting tag names used in graphic
objects

You can use tag substitution to replace tag names assigned to the
controls for graphic objects. For example, if you assign a tag to
multiple objects in a graphic display, and then decide to use a
different name for the tag, you can create a new tag and then use tag
substitution to search for all tag references with the old name, and
replace them with the new tag name.

For more information about tag substitution, see page 9-34.

Logging tag values

Any analog or digital tag value can be logged. To set up data logging,
use the Data Log Models editor. For details, see Chapter 16.
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Using macros to assign values to tags

A macro is a list of tag assignments stored in a text file, in the format
<tag>=<value>. Each assignment assigns a value to a tag. The value
can be in the form of another tag, an expression, a numeric constant,
or a string.

Examples: Using macros to set tag values

Tag1 = 8
Sets the value of Tag1 to 8.

Tank1\Message = “Tank1 Overflow”
Sets the string tag Tank1\Message to Tank1 Overflow.

Tag1 = Tag2
Sets the value of Tag1 to be the same as Tag2.

Tag1 = Tag1 + 1
Increases the value of Tag1 by 1.

Tag1 = If (Tag2 < Tag1) Then 4 Else 3
Performs the if-then-else calculation and stores the result in Tag1.
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1Pump = {Industry-2} + {2Pump}
Adds the values of Industry-2 and 2Pump and stores the result in
1Pump.

Braces surround Industry-2 because of the dash in the name. Braces
surround 2Pump because the name starts with a number. No braces
are used for 1Pump because this name is on the left side of the equal
sign.

For more information about expression syntax, see Chapter 12.

When to use macros

You can assign macros to run when:

the project starts or stops

a graphic display opens or closes

a user logs in or out

a specified tag or expression changes to a new non-zero value

At runtime, when the macro runs, the values are sent to the tags at
the data source.

IMPORTANT At runtime, the tag assignments are executed
asynchronously. That is, the system does not wait for
the completion of one tag assignment before executing
the next. Therefore, do not rely on the order of
assignments to control your process.

Example: Using a Goto Display button to run a macro

This example shows you how to run a macro when the operator
presses a Goto Display button. The macro resets a group of
production tags to 0.

1. Create a macro called Reset, with these tag assignments:

TotalProductionUnits=0
LineDownTime=0
TotalRejects=0

2. Create an On Top display containing the text “Production values
have been reset.” Create a Close Display button in the display,
with the caption “OK.” Call the display Reset Message.
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3. Create a Goto Display button with the caption “Reset
Production Data.” Assign the Reset Message display and the
Reset macro to the button.

At runtime when the operator presses the Reset Production Data
button, the display opens and the macro runs. When the operator
presses OK the display closes.

Running macros when tags or expressions
change value

You can use global connections to run macros when tags or
expressions change value. This means you can use the data source to
trigger the macro to run.

RSView allows you to create up to five macros for use with global
connections. The macros must be named Macro1, Macro2, Macro3,
Macro4, and Macro5 in order to work with global connections.

For more information about global connections, see Chapter 19.

Example: Using macros to reset tag values

This example shows you how to run a macro whenever the operator
needs to reset production information tags to known values.

The macro writes the desired values to the tags whenever the
operator presses a Momentary Push button.

1. Create a memory tag called ResetProdData.

2. Create a Momentary Push button with the caption “Reset
Production Data.” Assign the ResetProdData tag to the Value
control.

3. Create a macro called Macro1, with these tag assignments:

TotalProductionUnits=0
LineDownTime=0
TotalRejects=0

4. In the Global Connections editor, assign the ResetProdData tag
to the Remote Macro1 control.
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When the operator presses the Reset Production Data button, the
value of the ResetProdData tag changes from 0 to 1. This tells
RSView to run Macro1, which writes the specified values to the tags
in the macro.

Creating macros

To create a macro:

1. Open the Macros editor.

2. In the Tag column, type the name of the tag to assign a value to,
or click the Browse button to open the Tags dialog box and select
a tag.

3. In the Expression column, type a tag name, expression, or
numeric value, or click the Browse button to open the
Expression editor and create an expression.

Create the expression in the Expression editor if you want to
check the expression syntax.

4. Repeat steps 2 and 3 to assign values to other tags.

5. On the File menu click Save, or click the Save tool.

6. In the Component name box, type a name for the macro, and
then click OK.

7. Click Close.

Browse button in

the Tag column

Save tool
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What to do next

Once you’ve created the macros you want to use, assign the macros
in these editors:

In this editor Do this

Startup Assign project startup and shutdown macros. See
Chapter 20.

Graphics
Display

Assign macros to run when displays open or close,
using the Display Settings dialog box. See Chapter 8.

User Accounts Assign macros to run when users log in and log out.
See Chapter 18.

Global
Connections

Specify the tags or expressions that will start the
macros named Macro1 to Macro5. See Chapter 19.
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Creating graphic
displays

This chapter describes the editors in the Graphics folder and outlines
how to:

create and open graphic displays

use the Graphics Display editor

test your displays as you work

specify display settings

create a background for your displays

use graphic libraries

import graphic images

create parameters to use the same display with different tags

create local messages in your displays

print graphic displays at runtime

IMPORTANT Before creating graphic displays, specify project
settings. Project settings determine important aspects of
your graphic displays such as display size and position.
For more information, see page 4-7.

About graphic displays and graphic objects

A graphic display represents the operator’s view of plant activity.
The display can show system or process data and provide operators
with a way to write values to an external data source. The data
source can be memory or a device such as a programmable controller
or an OPC server.

Operators can print the display at runtime to create a visual record
of tag values, object states, or current messages.

8
Chapter
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The elements that make up a graphic display are called graphic
objects. You can create objects in the Graphics Display editor, or
copy them from a graphic library or from another project.

For information about creating and copying graphic objects, see
Chapter 9.

Before you begin

Before you begin, plan your displays. Think about what information
the operator needs to see, and the best way to provide the
information. For example:

Does the operator need to know the exact speed of a conveyor
belt, or just whether the belt is moving, jammed, or stopped?

Do different users need to have access to different types of
information?

Do you want to limit access to certain types of information?

Also consider the runtime environment and how the operator will
use the project:

Does the runtime computer have a touch screen, mouse,
keyboard, or some combination of these?

How will the operator navigate through the displays of the
project?

Review the chapters on planning, security, and navigation before
you begin creating displays. Browse through the sample projects for
design ideas. Map out a display hierarchy. Then create a graphic
display to use as a template.

The time you spend planning your displays will make your project
easy to use and will save you time in the long run.

For information about See

Planning your displays and creating a template Chapter 3

Setting up project security to control access to displays Chapter 18

Setting up display navigation and creating a display
hierarchy

Chapter 19

Setting up how objects are used at runtime Chapter 10



� 8-3Creating graphic displays

Using the Graphics Display editor

The Graphics Display editor opens when you create or open a
graphic display. Each display is stored in the Displays folder. You
can open and work on multiple graphic displays at the same time.

Creating and opening graphic displays

To create a graphic display:

1. In the Graphics folder, do one of the following:

right-click Displays and then click New

click the New Display tool

drag and drop the Displays icon into the work area

2. On the Edit menu, click Display Settings to open the Display
Settings dialog box and specify settings for the display.

For more information, see page 8-10.

3. Create the objects you want to put in the display.

For information about creating graphic objects, see Chapter 9.

4. On the File menu click Save, or click the Save tool.

5. In the Component name box, type a name for the display, and
then click OK.

The display is added to the list in the Displays folder.

The display is created as a Replace display by default, but you
can change it to an On Top display in the Display Settings dialog
box. For more information, see page 8-12.

To open a graphic display:

� In the Graphics folder, open the Displays folder and then
double-click the display name, or right-click the display name
and then click Open.

You can also drag and drop the display from the Project Explorer
to an empty area in the RSView Studio main window.

New Display tool

Save tool
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This example shows a graphic display from the Malthouse sample
project, with the Project Explorer closed.

Graphics toolbar

Standard toolbar

Display area

Status bar

Objects toolbar

Property Panel

Object Explorer

Activity bar

The parts of the editor

This section provides an overview of the main parts of the Graphics
Display editor that you use to create your graphic displays.

Toolbars

The Graphics Display editor provides an array of toolbars in
addition to the Standard toolbar available in other editors. The
toolbars contain tools for creating and configuring graphic objects.

The illustration shows the Graphics and Objects toolbars, which
you’ll probably want to keep open at all times. There are other
toolbars that you can use when performing specific tasks such as
assigning colors to objects. For more information, see page 8-6.

Display area

This area is your graphic display. The appearance of the display in
the Graphics Display editor is similar to what you see at runtime,
except for the title bar and the display position. If you change the
zoom settings, or resize a Replace display by dragging the borders,
these changes do not affect the appearance of the runtime display.
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If you want to use a title bar at runtime, set up the title bar in the
Project Settings editor. Also use the Project Settings editor to specify
the display size (for Replace displays), position, and whether to use a
border at runtime. For more information, see page 4-7.

You can change the display type, color, and other settings in the
Display Settings dialog box. For more information, see page 8-12.

Property Panel

The Property Panel displays the properties of the selected objects,
and shows what values are assigned to the properties. For example, it
shows whether an object’s background style (BackStyle) is solid or
transparent. It also lists the object’s controls, and shows which tags
or expressions have been assigned to them.

In addition to displaying information, you can use the Property
Panel to modify the properties of graphic objects and assign tags and
expressions to the objects.

You can keep the Property Panel open as you work on different
objects and in different displays. For more information, see
page 9-24.

Object Explorer

The Object Explorer lists all the objects and groups of objects in
your display (except objects that are converted to wallpaper). You
can click an object in the list to select it in your display. You can also
right-click the object to open the context menu for the object.

You can keep the Object Explorer open as you work on different
objects and in different displays. For more information, see
page 9-20.

Status bar

The status bar describes the action to be performed by the selected
menu item or tool. The status bar also displays the X and Y
coordinates, width, height, and name of the selected object.

Tools and tips for working in the Graphics Display
editor

This section describes features of the Graphics Display editor that
help you create your displays. It describes how to:

use context menus and toolbars to perform actions quickly
set up a grid that you can use to position and size objects
precisely
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zoom in when you need to look at details closely

correct mistakes

test your displays as you work

Using context menus

No matter where you are in the Graphics Display editor, you can
open a menu by clicking the right mouse button. This is often
quicker than moving the mouse up to the menus at the top of the
screen.

The items on the menu depend on the cursor’s location. For
example, when you right-click an object, the menu contains the most
common actions you can perform on that object.

... a menu opens. It

contains menu items

for working with the

selected object.

When you

right-click an

object...

Using the toolbars

The toolbars provide another convenient way to perform an action
quickly. You can customize your work area by dragging the toolbars
to any location on the screen. You can also dock them to the inside
edges of the RSView Studio main window.
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Click the grab bars

and drag to undock a

docked toolbar.

Click the title bar and

drag to move a floating

(undocked) toolbar.

Click the Close button to

close the toolbar.

To display a toolbar:

� On the View menu, select Toolbars, and then click the toolbar to
display.

The menu displays a check mark beside the toolbars that are
already open.

To undock a toolbar:

� Click the double “grab bars” at the left or top of the toolbar, and
then drag. Press the Ctrl key to prevent accidental redocking.

To move an undocked toolbar:

� Click the toolbar’s title bar, and then drag. Press the Ctrl key to
prevent accidental redocking.

To dock a toolbar:

� Click the toolbar’s title bar, and then drag to any edge of the
work area.

To close a toolbar:

� On the View menu, select Toolbars, and then click the toolbar to
close, or click the toolbar’s Close button.
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Using the grid

To size and position objects precisely, use the grid. You can change
the grid settings at any time during the drawing process.

The grid can be active or passive. When the grid is active, all the
objects you draw or position are pulled to the closest grid point.
This makes it easy to align and size objects. When the grid is passive,
it is visible but does not affect the position of your objects.

Make the grid passive to position an element between the grid lines.
Make the grid active, and the next object you draw or place is
automatically aligned with the grid. Making the grid active does not
affect the placement of existing objects.

The grid is visible during project development only. It is not visible
at runtime.

To set up the grid:

1. On the View menu, click Grid Settings, or right-click an empty
area of the display and then click Grid Settings.

Check this box to make

the grid visible.

Set the spacing of the grid

points in pixels.

Select a color for the

grid points.

Check this box to make

the grid active.

2. Specify the color and spacing of the grid points.

3. To turn on the grid, click Show Grid.

When the Grid Settings dialog box is not open you can turn the
grid on by clicking Show Grid on the View menu.

4. To make the grid active, click Snap To Grid.

When the Grid Settings dialog box is not open you can make the
grid active by clicking Snap On on the View menu.

5. Click OK.

To make the grid passive:

� In the Grid Settings dialog box, clear the Snap To Grid check
box, or on the View menu deselect Snap On.
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There is no check mark beside the menu item when it is
deselected.

To turn off the grid:

� In the Grid Setting dialog box, clear the Show Grid check box, or
on the View menu, deselect Show Grid.

Zooming in and out

To magnify or reduce your view of a graphic display, use Zoom In
and Zoom Out. Zoom In magnifies objects; Zoom Out reduces
magnification.

To zoom in on objects:

1. Select the objects you want to zoom in on.

2. On the View menu, click Zoom In, or click the Zoom In tool.

To zoom out:

� On the View menu, click Zoom Out, or click the Zoom Out
tool.

Correcting mistakes

If you change your mind about something you did, you can undo
the action. If you change your mind again, you can redo the action.

You can undo and redo all the operations you performed since you
last saved the display, one operation at a time.

The operations you perform between opening and closing a dialog
box are treated as a single operation. Operations you perform in the
Property Panel are treated as separate operations.

To undo an operation:

� On the Edit menu, click Undo, or click the Undo tool.

To redo an operation:

� On the Edit menu, click Redo, or click the Redo tool.

Testing your displays as you work

To test the objects in your displays as you work, use the Test
Display tool to switch to test display mode. When you are finished
testing, switch back to edit display mode to continue editing.

Zoom In tool

Zoom Out tool

Redo tool

Undo tool
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IMPORTANT Test display mode is not the same as running the
display. It does not change the appearance or position
of the display as set up in the Display Settings dialog
box. Alarm and information messages are not
displayed, although if communications are set up, tag
values are read and written. Display navigation, data
logging, parameters, and macros do not work in this
mode. If you want to test these features, test the project
as described on page 20-3.

Using the activity bar when in test display mode

The activity bar shows messages about system activities when you
test your graphic displays. You can specify the types of messages to
display in the activity bar, move the bar, resize it, and clear the
messages in it.

For information about using the activity bar, see page 2-4. For
information about specifying the types of activities to show in the
activity bar, see page 15-2.

To use test display mode:

� On the View menu, click Test Display, or click the Test Display
tool.

To return to edit display mode:

� On the View menu, click Edit Display, or click the Edit Display
tool.

Setting up graphic displays

To set up a graphic display, specify its type, background color, and
runtime behavior in the Display Settings dialog box. You can specify
and edit the display settings at any time while you work on your
display.

About display types

Replace

Replace is the default display type. Replace displays are full-sized
displays. They use the project window size specified in the Project
Settings editor.

Edit Display tool

Test Display tool
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For more information about the project window size, see page 4-8.

At runtime, you can have only one Replace display open at a time.
When the operator opens a Replace display, this is what happens:

The Replace display that was open closes.

On Top displays that do not use the Cannot Be Replaced option
are closed.

The new Replace display opens.

On Top displays that use the Cannot Be Replaced option remain
open, on top of the new Replace display.

If the operator attempts to open a Replace display that is already
open (for example, using a Goto Display button to which the same
display is assigned), the display does not close and RSView sends an
error message to the activity log.

On Top

Use this option to create “pop-up” displays that open on top of the
current Replace display. Usually, On Top displays are smaller than
Replace displays, so the operator doesn’t lose track of display
navigation.

You can open multiple On Top displays. If more than one On Top
display is open, the display that has focus, or had the most recent
focus, appears on top.

Use the Cannot Be Replaced option if you want the On Top display
to remain open when a new Replace display is opened.

On Top displays do not have a Close button in the title bar. Be sure
to create a Close button graphic object in On Top displays so the
operator can close them.

The operator cannot move an On Top display by dragging its title
bar. The runtime position of the display is fixed (according to the
position settings defined for the display).

Resizing displays

The project window size is used for all Replace displays. If you
change the project window size after you have designed any graphic
displays, Replace displays are resized, but any objects in the displays
remain in the same position as before. On Top displays are not
resized.
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For information about specifying the project window size, see
page 4-8.

Changing the display area while working

You can change the display area of a display while you’re working
on it by dragging the border of the display area. For example, you
might want to make the display area smaller so you can see parts of
two displays in order to drag and drop objects between them.

Changing the display area in this manner does not change the
display size for Replace displays. For On Top displays that are sized
with the “Use Current Size” option, dragging the border does resize
the display.

Another way to arrange multiple displays while working on them is
to use the options on the Windows menu. For example, Tile
Horizontal arranges all the open displays with as much of the top
part of each display showing as possible.

Specifying display settings

To specify display settings:

1. On the Edit menu, click Display Settings, or right-click an empty
area of the display and then click Display Settings.

Set up how the display looks.

Set up how the display works

at runtime.
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2. In the General tab, specify these settings:

Display Type

Select the display type.

If you select On Top and you want the display to remain open
when a new Replace display opens, select Cannot Be Replaced.

Display Number

For Replace displays, if you want the data source to open the
display remotely at runtime, specify a unique display number.
Otherwise, accept the default number.

For information about remote display changes, see page 19-7.

Security Code

To restrict access to the display, select a security code. At
runtime, only users with access to the security code can open the
display.

For information about setting up security and user accounts, see
Chapter 18.

Title Bar

This option is available only for On Top displays. To use a title
bar, check this box and then type the title in the box below.

Disable Initial Input Focus

Check this box if you don’t want the display to have input focus
when it opens.

This option is useful for On Top displays, if you want the
Replace display to retain the focus after the On Top display
opens.

The operator can still touch or click the On Top display to give it
input focus.

Size

For On Top displays, specify the display size. The operator
cannot resize the display at runtime.

Use Current Size—Select this option to size the display using
the mouse.

Specify Size in Pixels—Select this option to specify the width
and height manually. Type the width and height (in pixels) in
the boxes.
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Position

For On Top displays, specify the display position relative to the
upper left inside corner of the project window. (That is, inside
the window’s border and below the title bar, if these are selected
in the Project Settings editor.)

X—Type the number of pixels from the left of the project
window’s edge.

Y—Type the number of pixels from the top of the project
window’s edge.

IMPORTANT If the operator opens the display using a Goto
Display button that uses the “Display position
enabled” option, the position specified by the button
overrides the position specified in the Display
Settings dialog box.

Background Color

Click this box to select a different background color for the
display.

3. Click the Behavior tab, and then specify these settings:

Startup Macro

Click the Browse button to select a macro to run while the
display opens.

A macro assigns values to tags. For more information, see
page 7-32.

Browse button
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Shutdown Macro

Click the Browse button to select a macro to run after the display
closes.

Disable Highlight When Object has Focus

Check this box if you don’t want a highlight box to appear
around objects when they have the input focus. (When an object
has input focus it is ready to accept keyboard input.)

The operator can still select and use input objects, but there is no
visual indicator that the object is selected.

For more information about input focus, see page 10-8.

Highlight Color

Click this box to select a different highlight color for input
objects.

Select a color that stands out from the display’s background
color or wallpaper objects. For information about wallpaper
objects, see the next section.

4. Click OK to save your changes and close the dialog box.

Creating a background for your display
You can create a background for your graphic display by converting
graphic objects to wallpaper. When objects are converted to
wallpaper, they are locked into position and become an unchanging
background for the other objects in the display.

Converting objects that do not need to be animated or updated with
tag values can significantly improve the runtime performance of a
graphic display.

Objects that have been converted to wallpaper cannot be selected or
edited until you unlock the wallpaper. Also, animations attached to
the wallpaper objects are not in effect. However, animations are
restored when you unlock the wallpaper.

Similarly, any tags or expressions assigned to an object become
inactive when the object is converted to wallpaper. Connections are
restored if you unlock the wallpaper.

To manage a number of objects easily, group the objects, and then
convert the group to wallpaper.

To convert objects to wallpaper:

1. Select the objects to convert.
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For information about selecting objects, see page 9-19.

2. On the Edit menu, select Wallpaper, and then click Convert to
Wallpaper.

For a single object, you can right-click it and then click Convert
to Wallpaper.

To unlock the wallpaper:

� On the Edit menu, select Wallpaper, and then click Unlock All
Wallpaper.

All objects in the graphic display are converted back to their
original state.

Using graphic libraries

RSView Studio comes with a set of libraries, contained in the
Libraries folder. As with a public library, the graphics libraries can
provide you with source materials and reference information.

Each graphic library consists of a graphic display, with the file
extension .gfx. The library displays contain graphic objects that you
might find useful in your own project. Many of the objects are
preconfigured with animation. For example, see the Conveyor parts
library.

You can:

look at the objects and displays to get ideas for your own project

drag and drop (or copy and paste) objects from the libraries into
your own displays

For information about copying objects from a library into your
graphic display, see page 9-38.

use the objects as they are or change them to suit your needs

create your own libraries of objects

use libraries as displays in your project
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To open a graphic library:

1. In the Project Explorer, open the Graphics folder, and then open
the Libraries folder.

2. Double-click the library name, or right-click it and then click
Open.

Creating graphic libraries

You can create a graphic library in the Libraries folder, or create a
graphic display in the Displays folder and then add the display to the
Libraries folder.

To create a graphic library:

1. In the Graphics folder, right-click Libraries and then click New.
2. Create the objects you want to put in the library.

For information about creating graphic objects, see Chapter 9.
3. On the File menu click Save, or click the Save tool.
4. In the Component name box, type a name for the library, and

then click OK.
The library is added to the list in the Libraries folder.

You can also create a graphic display and then use Add Component
Into Project to add the display to the Libraries folder.

To add a graphic display to the library:

1. Create the graphic display.
2. In the Project Explorer, in the Graphics folder, right-click the

Libraries icon.
3. Click Add Component Into Project.
4. In the dialog box, navigate to the Gfx folder, and then click the

.gfx file for the display to use.
The Gfx folder is located in \Documents and Settings\All
Users\Documents\RSView Enterprise\ME\HMI projects\Project
Name
where Project Name is the name of your project.

5. Click Open. The display is copied into the Libraries folder.

Using libraries as displays in your project

The graphic libraries are available on the development computer, but
do not appear at runtime. To use a library as a graphic display at
runtime, you must add the library into your project’s folder of
graphic displays.

Save tool
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To use a library as a display in your project:

1. In the Project Explorer, in the Graphics folder, right-click the
Displays icon.

2. Click Add Component Into Project.

3. In the dialog box, navigate to the Libraries folder, and then click
the .gfx file for the library to use.

The Libraries folder is located in \Documents and Settings\All
Users\Documents\RSView Enterprise\ME.

4. Click Open. The library is copied into the Displays folder.

Location of library components

The Libraries folder is located in \Documents and Settings\All
Users\Documents\RSView Enterprise\ME.

If desired, you can specify a different directory in which to store
library components. If you specify a different directory, RSView
saves graphic libraries that you add or create in the new directory.
Similarly, when you open a library component RSView looks for the
component in the specified directory.

If you specify a different directory but want to use the libraries that
come with RSView, use My Computer or Windows Explorer to
copy the library component files into the directory you’ve specified,
or else change the path back to the default path when you want to
open an RSView library component.
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To specify a new path for graphic libraries:

1. On the Tools menu, click Options.

2. Click the Browse button.

3. In the dialog box, navigate to the directory where you want to
store library component files.

To create a new folder, click New Folder and then specify the
name for the folder. Click the new folder to select it.

4. With the desired folder selected, click OK.

5. Click OK to close the Options dialog box.

Browse button
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Importing images into your project

You can use these types of external graphic files in your graphic
displays:

.bmp—bitmap images

.dxf—AutoCAD� files

.wmf—Windows meta files

You import and place .dxf and .wmf files in your displays in one
step. Once imported, they are converted to drawing objects. For
more information about using these types of files in your displays,
see page 9-17.

Bitmap images that come with RSView
Studio

RSView Studio comes with sets of bitmaps that are useful for
illustrating graphic objects and displays:

arrows

DIN symbols

ISA symbols

keyboard button symbols such as Enter and Page Up

parts such as buttons, conveyors, pipes, tanks, and valves

The symbols and most of the arrows are monochrome (that is, use
only two colors, one for the foreground and one for the
background).

You can configure the foreground and background colors for the
monochrome images that you use for your objects.

For color images, you can specify whether to use a transparent or
solid background. If you select the transparent background style, the
black portions of the image become transparent.

For detailed information about configuring objects, see Chapter 10.

Location of bitmap files

The bitmap files that come with RSView Studio are stored in this
directory:

\Documents and Settings\All Users\Documents\RSView
Enterprise\Images



� 8-21Creating graphic displays

The images are in folders called Arrows, DIN, ISA, ListKey, and
Parts.

Importing bitmap images

To use bitmap images, you can:

import the images first, and then place them in your displays as
needed. This method is useful for bitmaps that you use to
illustrate your displays.

For information about placing images in your display once
you’ve imported them, see page 9-11.

use the Image Browser to import images as needed while
configuring your graphic objects. This method is useful for
bitmaps that you use for labels on your graphic objects.

For information about using the Image Browser, see page 8-22.

copy and paste images from the graphic libraries

For information about copying and pasting objects, see
page 9-39.

copy and paste images from one project to another

For information about opening two projects at once, see
page 4-6.

If you will be using bitmaps that have more than 256 colors, before
importing the bitmaps configure your video adapter to display more
than 256 colors. This will ensure that the colors of imported images
appear the same as in the original. For more tips about using bitmap
images, see page 8-24.
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To import bitmap images:

1. In the Graphics folder, right-click Images and then click Add
Component Into Project.

To view the bitmap images,

click this button and then

click Thumbnails.

2. Navigate to the directory where the bitmap file is stored, and
then click the file name.

Shift-click or Ctrl-click to select additional files.

3. Click Open to add the selected files to the list in the Images
folder.

To view a bitmap image that you’ve already imported:

� In the Images folder, double-click the image name, or right-click
it and then click Open.

Using the Image Browser to import bitmaps

Use the Image Browser to import bitmap images as needed while
you configure graphic objects.

In the Image Browser you can:

import images into the project
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select the image to use on a graphic object

remove images from the project

To open the Image Browser, use one of these methods:

In an object’s Properties dialog box, click the Browse button next
to the Image box.

Depending on the type of object, the Image box could be located
on the General tab, Label tab, or States tab.

For information about opening the Properties dialog box, see
page 9-23.

With one or more objects selected, in the Property Panel click the
Image property, and then click the Browse button.

For information about opening the Property Panel, see
page 9-24.

Click an object to

select it.

To use the Image Browser to import and select an image:

1. Click Add.

2. Navigate to the directory where the bitmap file is stored, and
then click the file name.

Shift-click or Ctrl-click to select additional files.

3. Click Open to add the images to the Select image list. The first
image you added is displayed in the Preview box.

The images are also added to the Images folder in the Project
Explorer.

Browse button
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4. To view another image, click it in the list.

To scroll quickly through all the images in the list, select the first
image and then press the Down Arrow key.

5. When you’re finished viewing images, click the image to use on
the object’s label.

6. Click OK to close the Image Browser and use the selected image
on the object’s label. To close the browser without using the
selected image, click Cancel.

Clicking Cancel does not remove the imported images from the
Images folder.

To use the Image Browser to remove images from the

project:

1. In the Select image list, click the file to remove.

Shift-click or Ctrl-click to select additional files.

2. Click Remove to delete the images from the project.

3. To close the browser, click OK or Cancel.

Clicking Cancel does not restore the images you removed.

You can also remove an image by clicking it in the Images folder and
then right-clicking Remove or Delete. For more information, see
page 2-13.

Tips for using bitmaps

Bitmaps consume Windows resources, so when using bitmaps
follow these guidelines:

Avoid unnecessary color depth.

The more colors you use, the more memory is consumed:

This bitmap type Consumes this many bits per pixel

Monochrome 1

16-color 4

256-color 8 (1 byte)

64-K color 16 (2 bytes)

16 million color 24 (3 bytes)
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For example, a 24-bit image that measures 800x600 pixels
consumes 1440 KB of memory. If the bitmap color depth is
decreased to 256 colors, the image might have minor color loss,
but the new image uses only 480 KB of memory.

Avoid using unnecessary bitmaps.

For simple illustrations, create graphic objects using the drawing
tools. You can change a bitmap to a collection of drawing objects
by converting the bitmap to wallpaper, tracing over the bitmap
with the drawing tools, and then deleting the bitmap.

Use your judgement here; if the illustration is complex, a bitmap
might display more quickly at runtime than a huge number of
drawing objects would.

Using parameter files

To use the same graphic display with different sets of tags, use
parameter files and tag placeholders. Using tag placeholders can be
quicker than duplicating a display and reconfiguring the objects in it
to use a different set of tags, especially when the display uses a lot of
tags. Using parameter files also reduces the size of the runtime
project file.

The parameter file specifies which tags to substitute for the
placeholders in the display, by assigning one tag to each unique
placeholder in the display. Create a parameter file for each set of tags
that you want to use with the same graphic display.4.

At runtime, the tag values that are displayed depend on which
parameter file is used when the display opens. When you open the
display, the tags specified in the parameter file replace the tag
placeholders.

About tag placeholders

A tag placeholder consists of the # symbol and a number between 1
and 500, for example, #1. You can use a placeholder anywhere that
you would normally assign a tag.

For more information about using tag placeholders, see page 9-36.
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Assigning parameter files to graphic
displays

You can use parameter files with:
the graphic display that opens when the project is first run.
Specify the graphic display to open, and the parameter file to use
with it, in the Startup editor.
graphic displays that are opened using Goto Display buttons.
Specify the graphic display to open, and the parameter file to use
with it, when you set up the button.

Example: Using a parameter file to replace tag placeholders

This example shows how to use a graphic display called Canning
Overview with two sets of tags, one for canning corn, and one for
canning peas.

The Canning Overview display is opened from a graphic display
called Main Menu.
1. Create these sets of tags:

Tag type Tag name Tag name

String Corn_Name Pea_Name

Analog Corn_Temp Pea_Temp

Analog Corn_Weight Pea_Weight

Analog Corn_Level Pea_Level

2. Create two parameter files, called Corn and Peas, containing
these parameters:

Corn Peas

#1=Corn_Name #1=Pea_Name

#2=Corn_Temp #2=Pea_Temp

#3=Corn_Weight #3=Pea_Weight

#4=Corn_Level #4=Pea_Level

3. In the Canning Overview display, assign tag placeholders to the
Value controls for these graphic objects:

This graphic object Uses this tag placeholder

String display #1

Numeric display 1 #2
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This graphic object Uses this tag placeholder

Numeric display 2 #3

Bar Graph #4

4. Use descriptive text to illustrate the objects in the display.

5. In the Main Menu display, create two Goto Display buttons for
opening the Canning display. Assign the Corn parameter file to
one button, and the Peas parameter file to the other.

At runtime, when the operator presses the Peas button in the Main
Menu, the Canning Overview display opens and shows the values of
the Pea_ tags. When the operator presses the Corn button, the values
of the Corn_ tags are displayed.

The Canning Overview display looks like this when the operator
presses the Peas button:
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Summary of steps

Follow these steps to use parameter files and tag placeholders:

1. In the Parameters editor, create parameter files for each set of tags
that the display will use. In the parameter files, specify which tags
to substitute for which placeholders.

2. In the Graphics Display editor, create graphic objects and assign
tag placeholders to the objects.

For information about creating graphic objects and assigning tag
placeholders, see Chapter 9.

3. In the Graphics Display editor, create Goto Display buttons for
opening the display containing tag placeholders. Specify the
appropriate parameter files in the Goto Display Button
Properties dialog box.

4. If the startup display uses tag placeholders, in the Startup editor
specify the parameter file to use with the startup display.

For information about the Startup editor, see Chapter 20.

Using the Parameters editor

Use the Parameters editor to create one or more files of tag
placeholder replacements. Each file is stored in the editor’s folder.
You can open and work on multiple parameter files at the same time.
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Creating parameter files

To create a parameter file:

1. Open the Parameters editor.

2. Type one entry for each unique placeholder in the display, in the
format <placeholder>=<tag name>.

The placeholder consists of the # symbol and a number between
1 and 500. For example:

#1=pea_weight
#2=pea_level
#3=pea_temp

To open the Tags dialog box and select a tag, double-click the
editor where you want to insert the tag name. The selected tag
name is inserted in front of the cursor.

3. On the File menu click Save, or click the Save tool.

4. In the Component name box, type a name for the file, and then
click OK.

Using local messages

Use local messages to give the operator ongoing information about
the status of devices and processes. For example, you might use local
messages to describe the status of a device whose condition cannot
be shown graphically with complete accuracy.

The messages you create in the Local Messages editor are displayed
in Local Message display objects in graphic displays. You can use
multiple Local Message display objects in your project, and link each
object to a different file of messages. Or, you can use the same file of
messages for multiple Local Message display objects.

When to use local messages

Use local messages to give the operator information in a specific
graphic display while the display is open. To give the operator
information no matter which display is open, use information
messages.

For details about information messages, see Chapter 14.

Save tool
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Preparing to set up local messages

As your project is running, information is continually sent to the
data source about the state of various processes. For example, your
project might be monitoring whether a valve is open or closed, or
the temperature in a boiler. Values representing the status of these
processes are sent to the data source.

The data source

The data source can be memory or a device such as a programmable
logic controller or OPC server. RSView writes values to and reads
values from the data source. The data source is configured to
exchange information (in the form of numeric or string values)
between RSView and the physical machine that your project is
controlling.

Identifying the tags and values to monitor

To set up local messages, determine which tags associated with
machine processes to monitor, and identify the values for those tags
that will trigger local messages.

For information about creating tags, see Chapter 7.

How local messages work

These are the key parts of the local message system:

Local message files—text files containing lists of messages, with a
numeric trigger value for each message

Local Message display object—a graphic object that displays
local messages when the Value control assigned to the object
matches a message’s trigger value

Value control—a tag or expression. When the value of this
control matches a message’s trigger value, the local message
display object displays the associated message.

The Local Message display object always appears in the graphic
display it’s placed in, whether or not there is a message to display.
However, the operator does not see the message unless the object is
located in the display the operator is currently viewing.

The following example shows how the key parts of the local message
system work together.
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Example: Displaying local messages

This example shows how to notify the operator of the status of a
hoist.

1. Create an analog tag called Hoist_Status. This tag points to an
address in a programmable controller that is linked to sensors on
the hoist. The tag has five possible values:

The tag has this

value

When the hoist has this status

1 At bottom

2 Raising

3 Stopped between the top and bottom

4 Lowering

5 At top

2. In the Local Messages editor, create these messages with trigger
values matching the values that will be sent to the Hoist_Status
tag:

Trigger value Message

1 The hoist is ready to rise.

2 The hoist is raising the pallet.

3 The hoist has stopped.

4 The hoist is lowering the pallet.

5 The hoist is finished rising.

Save the message file with the name “Hoist status.”

3. In the Graphics Display editor, create a Local Message display
object. In the object’s Properties dialog box, assign the
Hoist_Status tag to the Value control, and select the Hoist status
message file.

At runtime, when the operator views the graphic display containing
the Local Message display object, the status of the hoist is displayed.
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Local messages and trigger values

Create messages associated with each tag value that you want to
inform the operator about. Assign each message a trigger value, and
configure the data source to send the trigger value to the Value
control.

The trigger value can be any non-zero integer value (positive or
negative). Trigger values do not need to be contiguous, but they
must be unique for each message. For example, you could use trigger
values of 1, 2, and 3, or values of 10, 20, and 30.

If you use an analog tag or an expression, you can use any non-zero
integer or floating point value to trigger an alarm. Floating point
values are rounded to the nearest integer. For information about
how values are rounded, see page 7-3.

Trigger values cannot be 0. Digital tags have two possible values, 0
and 1. Therefore, if you use a digital tag you can only use the value 1
to trigger a message. If you want to use a digital tag to trigger two
different messages, create an expression that adds 1 to the digital
tag’s value. That way, you can use the trigger values 1 and 2.

When the Value control’s value is 0, the Local Message display
object is cleared.

Summary of steps

Follow these steps to configure local messages:

1. In the Local Messages editor, set up the messages and their
trigger values.

2. In the Graphics Display editor, create Local Message display
objects in the graphic displays in which you want the messages to
appear at runtime. For each Local Message object, assign a tag or
expression to the Value control and specify the file of messages to
display.

For information about creating graphic objects, see Chapter 9.
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Using the Local Messages editor

Use the Local Messages editor to create one or more files of local
messages. Each file is stored in the editor’s folder. You can open and
work on multiple message files at the same time.

You can define up to 10,000 messages in each message file.

Creating local messages

To create local messages:

1. Open the Local Messages editor.

2. Specify these properties for the message:

Trigger value

Type a non-zero integer value. When the Value control changes
to this value, the associated message is generated. This column
cannot be blank.

For more information about trigger values, see page 8-32.

Message

Type the message, up to 256 characters. You can use the new line
characters, \n, to specify that the message continues at the
beginning of the next line.

If you want the character sequence “\n” to appear in the message,
type “\\n”. This way the sequence won’t be interpreted as the
new line characters. For example, to create the message “Logging
to \norm’s bakery\logs has been interrupted.” you would type
this: Logging to \\norm’s bakery\logs has been interrupted.



Preface

8-34 � RSView Machine Edition User’s Guide

3. Repeat steps 1 and 2 to create additional messages.

4. To sort the messages by trigger value, highlight the rows to sort,
right-click in any of the selected rows, and then click Sort.

5. On the File menu click Save, or click the Save tool.

6. In the Component name box, type a name for the file, and then
click OK.

7. Click Close.

To delete a message:

� Select any cell in the message’s row, and then press Delete.
Shift-click in a column to select cells for multiple messages.

To copy a message:

1. In the Message column, select one or more messages and then
press Ctrl-C (or right-click the selected cells and then click
Copy).

2. In the Message column, click the cell to paste the first message in,
and then press Ctrl-V (or right-click the cell and then click
Paste).

Creating messages in a spreadsheet
application

You can also create local messages in a spreadsheet application such
as Microsoft Excel, and then copy the messages into the Local
Messages editor.

Save tool
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To create messages in a spreadsheet application:

� Create one message per row, as follows:

In column 1, type the trigger value.

In column 2, type the message.

Type the messages in the order you want them to appear in the
Local Messages editor.

To copy the messages into the Local Messages editor:

1. In the application where you created the messages, select the cells
for the trigger values and messages to copy, and then press
Ctrl-C (or right-click the selected cells and then click Copy).

2. In the Local Messages editor, click in the Trigger value column
for the first message and then press Ctrl-V (or right-click in the
column and then click Paste).

The cell contents from the spreadsheet application are pasted into
the current and succeeding rows.

How the Local Message display graphic
object works

When you open a graphic display at runtime, RSView reads the
value of the Value control and updates the Local Message display
object based on the value.

What is displayed

If the Value control is unassigned, the display is filled with
question marks (?).

The Value control is rounded to the nearest integer. If the value
does not match any of the trigger values in the specified message
file, the display is filled with questions marks (?).

For information about how values are rounded, see page 7-3.

If the message is too long to fit in the object, the last displayed
character is replaced with an asterisk (*).

When the Value control’s value is 0, the display is cleared.

Printing displays
You can print your graphic displays on the development computer.
This might be useful if you want other people to review the displays
before implementing the project, or if you want to keep a visual
record of the displays.
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You can also print graphic displays at runtime, to provide a printed
record of process values such as trend data.

For information about printing on the development computer, see
page 2-14.

Printing displays at runtime

When you print a display at runtime, everything on the screen is
printed, including the current display, pop-up windows, and any
visible background applications.

For information on specifying the printer to use at runtime, see page
22-6.

To print graphic displays at runtime, use one or both of

these methods:

Create Display Print buttons in the graphic displays you want to
print. At runtime, the operator presses the buttons to print the
displays.

For information about creating graphic objects, see Chapter 9.

Assign a tag or expression to the Remote Display Print control
(in the Global Connections editor). When the value of the tag or
expression changes from 0 to a non-zero value, the current
displays are automatically printed.

Program the data source to trigger the change as often as you
want the data printed.

For more information about setting up remote display printing,
see page 19-10.
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Creating and working
with graphic objects

This chapter describes the types of graphic objects and outlines how
to:

create interactive, drawing, and ActiveX objects

select and deselect objects and use the Object Explorer

use the Properties dialog box and Property Panel to configure
objects

color objects

name objects

test how objects look in different states

assign tags and expressions to objects

replace tags using tag substitution

use tag placeholders

move, copy, duplicate, resize, reshape, and delete objects

group and ungroup objects, and edit group objects

arrange objects and lock objects into position

For information about configuring graphic objects, see Chapter 10.

For examples of how to configure objects, see the sample projects
that come with RSView Studio. The Help also provides examples of
how to use objects.

Types of graphic objects

The components that make up a graphic display are called graphic
objects. Use objects to control your process and project.

9
Chapter



Preface

9-2 � RSView Machine Edition User’s Guide

RSView comes with a complete range of configurable objects such as
push buttons, list selectors, bar graphs, and trends. Some objects
interact with the data source, allowing the operator to change or
view tag values. For example, the operator can push a button to set a
tag value to 1, causing a programmable controller to start a conveyor
belt. Other objects are used to control your project. For example,
there are button objects that you can use to change displays and
scroll through lists.

RSView also comes with drawing objects that you can use to
illustrate your graphic displays. The drawing objects include text,
bitmap images, and geometric and freehand shapes.

RSView also supports the use of ActiveX objects—third-party
software components that you can use to control processes and
display information. The ActiveX objects available depend on which
third-party applications are installed on your development
computer. For example, products such as Microsoft Visual Basic�,
Rockwell Software RSTools�, and Microsoft Office provide
ActiveX objects that are configurable in RSView Studio.

Using the tables

The tables beginning on the next page will help you choose which
objects to use to control your project and process. The tables group
the objects according to function, provide an overview of what each
object does, and list cross-references to more detailed information
about using the objects.

About controls

Many of the objects use controls to interact with the data source. A
control is the link between the object and the data source.
Depending on an object’s function, the object may have more than
one control. For example, a Momentary Push button has a Value
control and an Indicator control. The Value control is used to set a
value at the data source, and the Indicator control is used to display
the data source value in your graphic display.

By assigning tags or expressions to an object’s controls, you control
the flow of data between the project and the data source, which in
turn controls your process or equipment. Assign tags or expressions
to an object’s controls in the Connections tab of the object’s
Properties dialog box (see page 9-22) or in the Connections tab of
the Property Panel (see page 9-24).
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Illustrating your displays

Use this graphic

object

To do this

Text Create text for labels or instructions in the display. See page 9-10.

Image Place bitmap images in your display. For information about bitmaps, see
page 8-20. For details about creating image graphic objects, see page 9-11.

Panel Draw rectangles that have borders. See page 9-12.

Arc Draw an arc (a segment of an ellipse or circle’s perimeter). See page 9-12.

Ellipse Draw ellipses and circles. See page 9-13.

Freehand Draw freehand shapes as you would with a pen on paper. See page 9-14.

Line Draw straight diagonal, horizontal, and vertical lines. See page 9-14.

Polygon Draw a series of connected straight lines forming a closed shape. See
page 9-14.

Polyline Draw a series of connected straight lines. See page 9-14.

Rectangle Draw rectangles and squares. See page 9-15.

Rounded Rectangle Draw rectangles or squares with rounded corners. See page 9-16.

Wedge Draw a filled segment of an ellipse or circle. See page 9-12.

Controlling the project

Use this graphic

object

To do this

Goto Display button Open a graphic display. For details, see page 19-4.

Return to Display button Close a display and return to the previous display. For details, see
page 19-5.

Close Display button Close a display. For details, see page 19-6.

Display List selector Select a display to open from a list of displays. For details, see page 19-6.

Login button Open the Login dialog box and then log in. For details, see page 18-9.

Logout button Log out of the project. For details, see page 18-9.

Display Print button Print the current display. For details, see page 8-35.

Shutdown button Stop the project and close RSView ME Station. For details, see page 19-7.
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Starting and controlling processes
Use this graphic object To do this

Momentary Push button Start a process or action by sending one value to the tag when pressed,
and another value when released. For details, see page 10-30.

Maintained Push button Toggle between two values, by sending one value to the tag when
pressed, and a second value the next time the button is pressed and
released. This button is useful for changing a setting within a machine or
process, but not for starting the machine or process. For details, see
page 10-37.

Latched Push button Start a machine or process. The button remains set (latched) until the
process is complete. For example, use this button to start a bag filling
machine. When the process is complete (the bag is full), the button is
reset (unlatched) by the Handshake control. For details, see page 10-43.

Multistate Push button Cycle through a series of values. Each time the operator presses the
button, the value for the next state is sent to the tag. When the button is
in its last state, pressing it changes the button to its first state and writes
out the first state value.

This button is useful when you want the operator to see and select
multiple options in sequence, using a single button. The button displays
the current state of a process or operation by showing a different color,
caption, or image to reflect the different states. For details, see
page 10-49.

Interlocked Push button Use a group of buttons to send values to the same tag. When the
operator presses one button in the group, the button’s value is sent to
the tag, and the button remains highlighted as long as the tag value is the
same as the button’s value. Pressing another button in the group releases
the first button, and sends a new value to the tag. For details, see
page 10-57.

Ramp button Increase or decrease the value of a tag by a specified integer or floating
point value. For example, use two ramp buttons together to create a
raise/lower control. For details, see page 10-62.

Control List selector Select from a list of states for a process or operation. The list is
highlighted to show the current state, and the operator can scroll
through the list to select a different state. The value assigned to the
selected state is written to the tag. For details, see page 10-126.

Drawing object with
horizontal or vertical slider
animation

Set the value of a tag by dragging the slider object. The pixel position of
the slider is translated into a value that is written to the tag. If the value
of the tag is changed at the data source, the position of the slider changes
to reflect this. For information about animation, see Chapter 11.

ActiveX object Change tag values using a third-party object connected to an analog,
digital, or string tag. When the object’s property value changes, the new
value is written to the associated tag. For details, see page 9-17.
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Displaying processes and values graphically

Use this graphic object To display this

Bar Graph Numeric values in bar graph format. The bar graph increases or
decreases in size to show the changing value. For details, see
page 10-115.

Gauge Numeric values in dial format. The gauge’s needle moves around the
dial to show the changing value. For details, see page 10-115.

Scale A static indication of the range of values for a bar graph. For details, see
page 10-115.

Multistate indicator The state of a process, on a panel that changes its color, image, or
caption to indicate the current state. Each state is configured to
correspond to a numeric tag value. For details, see page 10-100.

Symbol The state of a process, using a monochrome image that changes color to
indicate the current state. Each state corresponds to a numeric tag value.

This object is useful for showing the state of a process or operation at a
glance. For details, see page 10-100.

List indicator The state of a process, using a list of possible states with the current
state highlighted. Each state is represented by a caption in the list, and
corresponds to a numeric tag value.

This indicator is useful if you want to view the current state, but also
want to see the other possible states. For sequential processes, the list
can alert the operator about what happens next in the process. For
details, see page 10-100.

Trend Historical or real-time numeric tag values, plotted against time or
displayed in an XY plot, where one or more tags’ values are plotted
against another tag’s values to show the relationship between them. For
details, see Chapter 17.

Time and Date display Display the current time and date. For details, see page 10-136.

ActiveX object Data using a third-party object connected to an analog, digital, or string
tag. The format of the data displayed depends on the object. For details,
see page 9-17.

Drawing object with
rotation, width, height, fill,
color, or horizontal or
vertical position animation

The value of a tag using a pictorial representation of the current value in
relation to a range of possible values. For example, use rotation
animation to show the tag value as a needle’s position on a dial.

For color animation, assign different colors to represent different values.
For information about animation, see Chapter 11.
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Working with lists and trends

Use this button With this graphic

object

To do this

Pause button Trend Toggle a trend between pausing and automatic
scrolling.

Next Pen button Trend Change the vertical axis labels for a trend to the
scale for the next pen.

Backspace button Control List selector Move the cursor back to the highlighted item in
the list.

End button Lists and trends List—move to the bottom item visible in the list.

Trend—resume trend scrolling and move to the
current (latest) data in the trend.

Enter button Lists Select the item the cursor is pointing to.

Home button Lists and trends List—move to the top item visible in the list.

Trend—pause the trend and move to the earliest
data in the trend.

Move Left / Right buttons Trend Pause the trend and scroll to the left or right.

Move Up / Down buttons Lists and trends List—move up or down one item in the list.

Trend—scroll up or down to display lower values
on the vertical scale.

Page Up / Down buttons Lists Move up or down one page in the list.

Acknowledge Alarm
button

Alarm list Acknowledge and silence the selected alarm.

Acknowledge All Alarms
button

Alarm list Acknowledge and silence all currently
unacknowledged alarms.

Clear Alarm History
button

Alarm list Remove all alarms from the alarm log file and all
Alarm lists.

Silence Alarms button Alarm list Silence the audio indicator for all current alarms
(Windows 2000 projects only).

Activity Clear button Activity list Remove the selected message from all Activity
lists.

Activity Clear All button Activity list Remove all activity messages from all Activity
lists.

Information
Acknowledge button

Information Message
display

Acknowledge the current message in the display.
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For more information about using the buttons with lists and trends,
see the topics on these pages:

For information about See

Linking a button to a specific list or trend object Page 10-9

Using buttons with Alarm lists Page 13-28

Using buttons with Information Message displays Page 14-10

Using buttons with Activity lists Page 15-9

Using buttons with trends Page 17-24

Entering and displaying numeric and string values

Use this graphic object To do this

Numeric Input Enable
button

Enter a numeric value and then write the value to a tag or an expression.
For details, see page 24-3.

String Input Enable button Enter a string value and then write the value to a tag. For details, see
page 24-7.

Numeric display Display numeric tag values. For example, display the current
temperature of an oven. For details, see page 10-68.

String display Display string tag values. For example, set up the data source to generate
strings that report on the state of a process or operation, or that provide
the operator with instructions about what to do next. For details, see
page 10-80.

ActiveX object Enter or display data using a third-party object connected to an analog,
digital, or string tag. The format of the data entered or displayed
depends on the object. For details, see page 9-17.

Displaying alarms and messages

Use this graphic object To display this

Alarm list Alarm messages that notify the operator when a situation requiring
immediate attention occurs. For details, see page 13-27.

Activity list Messages about system activity such as tag reads, tag writes, and
communication errors. For details, see page 15-8.

Information Message
display

Messages about the process, prompts or instructions, and information
about current states. For details, see page 14-12.

Local Message display Ongoing information about the status of devices or processes. For
details, see page 8-29.
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Selecting tools for creating graphic objects

The Objects menu in the Graphics Display editor contains items for
creating objects, as well as items for selecting and rotating objects.
You can also create most objects using the tools on the Objects
toolbar.

Objects toolbarObjects menu

Before you can create an object, you must select the object’s tool,
either by clicking a menu item or by clicking the tool on the toolbar.
When you position a cursor over a tool on the toolbar, the name of
the tool is displayed in a tooltip and in the status bar.

To select a tool:

� Click the tool on the toolbar or on the Objects menu. When you
click a tool, the pointer changes to show which tool is active.

Freehand tool Text tool

To deselect a tool, do one of the following:

Double-click an empty area in the display.
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Click the Select tool.

Click another tool.

For some drawing objects, double-clicking an empty area of the
display creates another instance of the object. For these objects, to
finish drawing, click the Select tool. For more information, see the
instructions for creating drawing objects, beginning on page 9-10.

Before you begin creating objects

To size and position objects precisely as you create them, use the
grid.

To use the grid:

� On the View menu, click Show Grid, and then click Snap On.

For information about setting up the grid, see page 8-8.

The next sections describe how to create graphic objects. For
information about attaching animation to the objects you create, see
Chapter 11.

Creating graphic objects

This section applies to graphic objects in general.

ActiveX objects and some drawing objects require extra steps to
create them. For details about creating drawing objects, see the next
section. For information about ActiveX objects, see page 9-17.

To create a graphic object:

1. Select the tool for the object to create.

2. Click the mouse where you want to position the object, and then
drag to draw a rectangle the general size you want the object to
be.

3. Double-click the object to open its Properties dialog box.

4. In the dialog box, specify how the object looks, its behavior, and
controls. For more information about the dialog box, see
page 9-22.

You can also use the Property Panel to configure objects. For
information about using the Property Panel, see page 9-24.

Select tool
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For information about configuring a specific object, see
Chapter 10.

Creating drawing objects

The following instructions for creating drawing objects describe
how to create the objects and then open the objects’ Properties
dialog boxes to configure how the objects look. For information
about using the Properties dialog box, see page 9-22.

You can also use the Property Panel to configure objects. For
information about using the Property Panel, see page 9-24.

For detailed information about configuring a specific object, see
Chapter 10.

Creating text

Choosing fonts

You can select any font you have installed, but TrueType� and
OpenType� fonts are recommended. These fonts can be resized
easily, without losing text quality.

If you run a project on a computer that does not have the fonts you
used when configuring the project, Windows substitutes with the
fonts that most closely match the fonts you specified.

To create a text object:

1. Select the Text tool.

The pointer becomes an I-beam ( ).

2. Click the I-beam where you want the text to start.

3. Type the text.

To move the cursor to the next line of text, press Enter.

4. To create another text object, move to a new area in the display,
click, and then type the text.

5. To finish entering text, right-click or double-click the text.

6. To change how the text looks, right-click the text and then click
Properties on the context menu, or double-click the text to open
the Text Properties dialog box.
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7. In the dialog box, specify how the text looks and the font to use.

For example, if the text has a solid background and you don’t
want the background to show, select the transparent background
style.

8. To close the dialog box, click OK.

After you’ve configured one text object to look the way you want,
copy and paste it to create additional text objects with the same
formatting. Then edit the text of the new objects.

To edit a text object:

1. Right-click the text, and then click Edit.

The pointer becomes an I-beam ( ).

2. Click where you want to make the change. To delete text
characters, use the Backspace and Delete keys.

You can also edit the text in the Text Properties dialog box.

Creating images

Use the image graphic object to place bitmap images in your graphic
displays.

Images support visibility animation only.

Using bitmaps

Before you can place a bitmap image in a display, you must import
the image into your project. For more information, see page 8-20.

To place a bitmap image in a display:

1. Select the Image tool.

2. Click the mouse where you want to position the image, and then
drag to draw a rectangle.

3. Double-click the rectangle to open the Image Properties dialog
box.

4. In the dialog box, specify the bitmap image to use.

The image is placed where you drew the rectangle, but the actual
size of the image is used, rather than the size of the rectangle you
drew.
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5. For monochrome bitmaps, specify the image color, background
style, and whether the image blinks.

For color bitmaps, specify the background style.

6. Click OK to close the dialog box.

Creating panels

Panels support visibility animation only.

To create a panel:

1. Select the Panel tool.

2. Click the mouse where you want to position the panel, and then
drag to draw a rectangle the general size you want the panel to
be.

3. To change how the panel looks, double-click the panel to open
the Panel Properties dialog box.

4. In the dialog box, specify how the panel looks.

5. To close the dialog box, click OK.

Creating arcs and wedges

Arcs and wedges are drawn in two steps: first you create an ellipse or
circle, and then you reshape it into the segment you want.

Arc Solid wedgeTransparent wedge

To create an arc or wedge:

1. Select the Arc or Wedge tool.

2. Click the mouse where you want to position the object, and then
drag to draw an ellipse or circle.

To base the arc or wedge on a circle rather than an ellipse, hold
down Ctrl while you drag.

When you release the mouse button, a set of handles appears so
you can decrease the angle of the wedge or arc from 360 degrees
to the desired angle.
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3. Click a handle, and drag the mouse to ‘cut out’ part of the circle.

4. To finish drawing, right-click the object.

5. To change how the object looks, click Properties on the context
menu, or double-click the object to open its Properties dialog
box.

6. In the dialog box, specify how the object looks.

For example, if the shape you created has a solid background and
you don’t want the shape to be filled, select the transparent
background style.

7. To close the dialog box, click OK.

You can also use the Arc and Wedge tools to reshape arcs and
wedges. For more information, see page 9-42.

Creating ellipses and circles

Use the Ellipse tool to draw an ellipse or circle.

To create an ellipse or circle:

1. Select the Ellipse tool.

2. Click the mouse where you want to position the object, and then
drag to draw an ellipse or circle of the desired size.

To draw a circle, hold down Ctrl while you drag.

3. To change how the object looks, double-click it to open the
object’s Properties dialog box.

4. In the dialog box, specify how the object looks.
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5. To close the dialog box, click OK.

Creating freehand shapes

Using the Freehand tool is similar to drawing with a pen on paper.

To create a freehand shape:

1. Select the Freehand tool.

2. Click and drag to create the shape you want.

3. To change how the object looks, double-click it to open the
Freehand Properties dialog box.

4. In the dialog box, specify how the object looks.

For example, if the shape you created has a solid background and
you don’t want the shape to be filled, select the transparent
background style.

5. To close the dialog box, click OK.

Creating lines

To create a line:

1. Select the Line tool.

2. Click where you want the line to start, and then drag from the
beginning point to the end point.

To draw horizontal or vertical lines, hold down Ctrl while you
drag the mouse.

3. To change how the line looks, right-click the line and then click
Properties on the context menu. The Line Properties dialog box
opens.

4. In the dialog box, specify how the line looks.

5. To close the dialog box, click OK.

You can use the Polyline tool to convert the line into a polyline. For
more information, see page 9-42.

Creating polygons and polylines

A polyline is a series of connected line segments. A polygon is a
multi-sided object (with three or more sides). For example, use the
polygon shape if you want to create triangles.
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Polyline Transparent polygon Solid polygon

To create a polygon or polyline:

1. Select the Polygon or Polyline tool.

2. Click and drag to create the first segment of the object. Release
the mouse button.

To draw horizontal or vertical lines, hold down Ctrl while you
drag.

3. Move the mouse to where you want the next segment to end, and
then click.

Repeat this step until you have completed the object.

4. To finish drawing, double-click an empty area of the display, or
click the Select tool.

5. To change how the object looks, double-click it to open the
object’s Properties dialog box.

6. In the dialog box, specify how the object looks.

For example, if the shape you created has a solid background and
you don’t want the shape to be filled, select the transparent
background style.

7. To close the dialog box, click OK.

You can use the Polygon tool to reshape lines, polygons, polylines,
and rectangles. For more information, see page 9-42.

Creating rectangles and squares

To create a rectangle or square:

1. Select the Rectangle tool.

2. Click the mouse where you want to position the object, and then
drag until the rectangle or square is the size you want.
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To draw a square, hold down Ctrl while you drag.

3. To change how the object looks, double-click it to open the
object’s Properties dialog box.

4. In the dialog box, specify how the object looks.

5. To close the dialog box, click OK.

You can use the Polygon tool to reshape the rectangle into a
polygon. For more information, see page 9-42.

Creating rounded rectangles and squares

Due to a Windows limitation, you cannot rotate rounded rectangles
and rounded squares.

To create a rounded rectangle or square:

1. Select the Rounded Rectangle tool.

2. Click the mouse where you want to position the object, and then
drag until the rectangle or square is the size you want.

To draw a square, hold down Ctrl while you drag.

You can change how rounded the corners are by using the handle
that appears inside the rounded rectangle. Click the handle and
drag inward to increase roundedness, or outward to decrease
roundedness.

3. To finish drawing, right-click the object.

4. To change how the object looks, click Properties on the context
menu, or double-click the object to open its Properties dialog
box.

5. In the dialog box, specify how the object looks.

6. To close the dialog box, click OK.

For information about using the Rounded Rectangle tool to reshape
the rounded rectangle, see page 9-43.
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Using .wmf and .dxf files

Windows metafiles (.wmf) and AutoCAD (.dxf) files are converted
to drawing objects (such as lines, ellipses, and polygons) when you
import them. You can edit the drawing objects the same way you
edit drawing objects that you create in RSView.

To place a .wmf or .dxf file in a display:

1. On the Objects menu, click Import.

2. Click the mouse where you want to position the file, and then
drag to draw a rectangle the general size you want the final object
to be.

3. In the “Files of type” box, select the type of file to import.

4. Navigate to the directory where the file is stored, and then click
the file to import.

5. Click Open.

The file is converted to drawing objects and grouped, and then
the grouped object is placed in the graphic display.

Using ActiveX objects

ActiveX objects use tags or expressions to exchange information
with the data source.

The properties and controls available for a particular ActiveX object
depend on the third-party vendor’s implementation.
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IMPORTANT If your project will run on a RAC6182, the ActiveX
object must be available for both Windows 2000 and
RAC6182 platforms. Make sure you install and
register the RAC6182 version of the ActiveX object
on the runtime computer.

ActiveX objects support visibility animation only.

To create an ActiveX object:

1. Select the ActiveX Control tool.

2. Click the mouse where you want to position the object, and then
drag until the object is the size you want.

3. In the dialog box, click the object you want to add to your
graphic display. The list of objects depends on the software you
have installed.

If an object you have installed does not appear in the list, the
object might not be registered. To register an object, click
Register, select the object to add to the list, and then click Open.

To remove an object from the list, select the object, and then click
Unregister.

4. Click OK.

The object is placed in the display. Depending on how the third
party implemented the object, it may be a different size than the
rectangle you drew.

5. To specify the object’s properties and assign tags or expressions
to its controls, do one of the following:

Right-click the object, and then click Properties to open the
object’s Properties dialog box.
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Depending on how the third party implemented the object, it
may not have a Properties dialog box. If the Properties menu
item is not available, use the next method.

Right-click the object, and then click Property Panel.

6. In the Properties dialog box or Properties tab of the Property
Panel, specify the object’s properties.

7. In the Connections tab, assign tags or expressions to the object’s
controls.

8. To close the Properties dialog box, click OK. To close the
Property Panel, click the Close button.

For information about using the Properties dialog box, see
page 9-22. For information about using the Property Panel, see
page 9-24.

Tools and tips for working with objects
This section describes features of the Graphics Display editor that
help you work with the objects you create. It describes how to:

select and deselect objects

use the Object Explorer to view and select objects

use an object’s Properties dialog box to configure the object’s
properties and assign tags and expressions to its controls

use the Property Panel to configure individual and group object
properties, and to assign tags and expressions to individual
objects’ controls

color objects

name objects

test how objects look in different states

Selecting and deselecting objects

To work with an object, you must first select it. You can use the
Select tool or the Object Explorer to select objects.

For information about using the Object Explorer, see page 9-20.

To select the Select tool:

� On the Objects menu, click Select, or on the Objects toolbar
click the Select tool.

The mouse pointer changes to a single arrow.
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To select objects, follow the procedures in this table:

To select Do this

An object or group of objects � Click the object or group.

� In the Object Explorer, click the
object or group.

An object within a group of
objects

� Double-click the group, and then
click the object.

� In the Object Explorer, open the
group, and then click the object.

Several objects Click the first object, and then Ctrl-click
additional objects.

All objects in an area Click and drag diagonally to draw a
selection border around the objects.

Ctrl-click objects outside the border to
add them to the selection.

All objects in the drawing area
or in a group you are editing

On the Edit menu, click Select All, or
press Ctrl-A.

To deselect objects, follow the procedures in this table:

To deselect Do this

An object Ctrl-click the object.

Several objects Hold down Ctrl and drag a selection
border around the objects.

All selected objects Click in the drawing area, away from
any objects.

Using the Object Explorer

Use the Object Explorer to view and select objects from a tree-list of
all the objects in a display. Groups are listed as expandable items in
the tree, with a + icon.

Use the Object Explorer to select an object that is hidden behind
other objects in the display, without bringing it to the front. Objects
are listed in front-to-back order.

The Object Explorer does not show wallpaper objects, nor objects
within ActiveX composite objects.
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To open the Object Explorer, use one of these methods:

On the Graphics toolbar, click the Object Explorer tool.

On the View menu, click Object Explorer.

Right-click an object, and then click Object Explorer.

You can keep the Object Explorer open as you work in the Graphics
Display editor.

To view the objects in a group:

� Click the + icon next to the group name, or double-click the
group name.

The list expands to show the objects and groups within the
group.

If the list is already expanded, double-clicking the group name
collapses the group.

Click the + icon to

view the objects and

groups within a group.

Right-click an object

to open its context

menu.

Object Explorer tool
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To select an object in the Object Explorer:

� Click the object.
The object is selected in the Object Explorer and selection
handles appear around the object in the graphic display.

Double-clicking objects in the Object Explorer

Double-clicking an object in the Object Explorer is the same as
double-clicking it in the display:

For most graphic objects, including drawing objects,
double-clicking the object in the Object Explorer opens the
object’s Properties dialog box.

For ActiveX objects, the behavior of the object when
double-clicked depends on the vendor’s implementation.

Using the Properties dialog box

Every graphic object has a Properties dialog box that you can use to
configure the object. Depending on how the vendor implemented
the object, third-party ActiveX objects might have a Properties
dialog box as well.

The Properties dialog box contains tabs that you can use to
configure the object’s properties and controls:

In this tab Do this

General Configure the object’s appearance, audio indicator and
touch margins (for buttons), and settings that are unique
to the object, such as the button action for a push
button, whether to use key navigation to select the
object, or whether to link a button to a specific object.

For information about touch margins, see page 10-4.

For information about key navigation, see page 10-8.

For information about linking buttons to objects, see
page 10-9.

States Configure the states for the object, including the value
for each state and whether to display a caption or image
for the state.

For information about checking that the states are
configured the way you intended, see page 9-31.

Label For objects that don’t have multiple states, specify
whether to use a caption or image on the object.

For information about using the Image Browser to
select an image to use in the label, see page 8-22.
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In this tab Do this

Timing Configure the object’s auto repeat (see page 10-11) or
Enter key handshaking (see page 10-12) settings.

Connections Assign tags and expressions to the object’s controls.

For information about assigning tags and expressions,
see page 9-32.

The tabs that are available depend on the object:

Some objects have only a General tab.

If an object can have more than one state, the object’s dialog box
contains a States tab.

The trend and gauge objects have unique tabs that are not listed
in the table above.

The tabs that an ActiveX object has depends on the vendor’s
implementation, though if you can assign tags or expressions to
the object it has a Connections tab.

To open an object’s Properties dialog box, use one of these

methods:

Double-click the object.

Right-click the object and then click Properties.

Select the object, and then on the Edit menu, click Properties.

In the Property Panel, with the object selected, click the
(Custom) property and then click the Browse button.

In the Property Panel, with the object selected, double-click the
(Custom) property.

In the Object Explorer, double-click the object.

Browse button
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Click a tab to

select it.

Click Apply to apply your changes

without closing the dialog box. Also,

when you change to a different tab

the changes in the current tab are

applied.

You can also use the Property Panel to configure an object’s
properties, as described next.

For more information about assigning tags and expressions to
objects, see page 9-32. For details about configuring a particular
object, see Chapter 10.

Using the Property Panel

Use the Property Panel to modify the properties of graphic objects
and assign tags and expressions to the objects.

The Property Panel is especially useful for making changes to the
properties of multiple objects at the same time.

To open the Property Panel, use one of these methods:

On the Graphics toolbar, click the Property Panel tool.

On the View menu, click Property Panel.
Property Panel tool
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Right-click an object, and then click Property Panel.

Right-click an empty area of the display, and then click Property
Panel.

You can keep the Property Panel open as you work in the Graphics
Display editor. You can drag the panel’s borders to make the
Property Panel larger or smaller.

Configuring properties

Use the Property Panel’s Properties tab to configure the properties
of the selected object or objects.

Viewing properties for multiple objects

If multiple objects are selected, you can specify which properties to
display in the Property Panel:

To view all the properties of all the selected objects, click All
Properties.

To view only the properties that are common to the selected
objects, click Shared Properties.

Viewing properties for group objects

When you first select a group object, the Property Panel displays the
group properties only, such as the group’s name and height. To view
and edit the properties of the individual objects within the group,
click Include Grouped Objects.

When you click Include Grouped Objects, if Shared Properties is
selected, only the properties that are common to the selected objects
are displayed. To view all the properties of all the objects in the
group, click All Properties.

If different objects in the group have different values assigned to a
property, the cell next to the property name is blank.
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Click for help on the

selected property.

.. or drag the splitter

bar to see more

properties.

Click for help on the

Property Panel.

Scroll to see more

properties...

If a group object is

selected, click this button

to edit the properties of

the objects within the

group.

Click to Close.

This box describes the

selected property and

indicates the type of data

the property value uses.

If only one object is

selected, this box shows

the object’s name and

type.

To configure an object’s properties:

1. Select one or more objects.

2. Click the Properties tab if it is not already selected.

3. Double-click a property’s row to select the property.

If the property has a list of values associated with it, pressing
Enter or double-clicking in the property’s row changes the
property’s value to the next available value. A down-arrow
appears in the right column. Click it to see the options for the
property.

If the property has a dialog box (such as the Font dialog box)
associated with it, double-clicking the row opens the dialog box.

Browse button
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Or, a Browse button appears in the right column—click it to
open the dialog box.

If the selected object has a dialog box for setting up properties, a
(Custom) property appears in the first or second row of the grid.
To open the object’s dialog box, double-click the row, or click
the Browse button.

4. Type the new value for the property, select one from the list, or
make selections from the dialog box.

5. Press Enter or click another cell in the grid to save the change.
The selected object is updated with the new property value and
its appearance in the display changes, if appropriate.

Assigning tags and expressions to an
object’s controls

Use the Property Panel’s Connections tab to assign tags or
expressions to the selected object’s controls. If multiple objects are
selected the tab is blank, because you can assign tags or expressions
to only one object at a time.

How values are updated

The arrows indicate the direction in which the data flows between
the control and the data source:

A right arrow indicates that the control sends values to the data
source. The control is a write control.

A left arrow indicates that the data source sends values to the
control. The control is a read control.

A double arrow indicates that the data flows in both directions.
The control is a read-write control.
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Click for help on the

selected control.

The arrows show the direction in which data flows between the control and

the data source.

This box describes the

selected control and

indicates the type of data

the control uses.

To assign tags and expressions to an object’s controls:

1. Select an object.

2. Click the Connections tab if it is not already selected.

3. Click a control’s row to select it.

4. In the “Tag or expression” column, type a tag name or
expression. You can assign an expression only if the Browse
button is available in the Exprn column.

To open the Tags dialog box and select a tag, click the Browse
button in the Tag column. For information about using the Tags
dialog box, see page 7-25.

To open the Expression editor and use it to create an expression,
click the Browse button in the Exprn column. For information
about creating expressions, see Chapter 12.

For the Numeric Input Enable button’s Optional Expression
control, you can assign write expressions only. For information
about write expressions, see page 12-20.

5. Press Enter or click another row to save the tag or expression
assignment.

For more information about assigning tags and expressions to
objects, see page 9-32.

Browse button in

the Exprn column
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To delete a tag or expression assignment:

� Click the row and press Delete.

Coloring objects using the color toolbars

The Foreground Color and Background Color toolbars contain a
selection of colors you can assign to objects’ color properties.

About color properties

The number of color properties an object has depends on the type of
object and how you configure it. For example, a button with states
can use up to seven different colors for each state. When you select
colors using the color toolbars, some properties are assigned the
foreground color and some are assigned the background color.
Other color properties, such as Fill color, cannot be assigned using
the color toolbars (instead, use the object’s Properties dialog box or
the Property Panel).

This table lists the color properties you can assign using the color
toolbars:

Property Foreground color Background color

Back color �

Background color �

Border color �

Caption color �

Caption back color �

Fore color �

Foreground color �

Image color �

Image back color �

Legend color �

Needle color �

Pattern color �

For objects with states, the selected color is applied to the current
state’s color properties only. In the Property Panel, properties that
apply to states have “St_” at the beginning of the property name.
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When to select colors using the toolbars

For all the drawing objects except Image and Panel, you can select
colors from the color toolbars before you draw an object (either
before or after you click the object’s tool).

The other objects are always drawn using their default colors, but
you can select the objects and then click the toolbars to change their
colors. The toolbars are especially useful for quickly assigning the
same colors to multiple objects.

To display a color toolbar:

� On the View menu, select Toolbars, and then click Foreground
Colors or Background Colors.

To close a color toolbar:

� On the View menu, select Toolbars, and then click Foreground
Colors or Background Colors, or click the toolbar’s Close
button.

Other methods for assigning colors

You can also assign colors using an object’s Properties dialog box or
the Property Panel. Use one of these methods if you want to assign
separate colors to different foreground or background color
properties, or to choose colors that don’t appear in the toolbars.

For example, if you want to use a dark blue background color for a
button, with a light blue background color for its image label, you
must assign the colors separately. Using the toolbar would assign the
same color to both properties.

Also use the Properties dialog box or Property Panel to change the
default colors for properties that cannot be assigned using the color
toolbars.

Naming objects

Objects (and groups of objects) are automatically given a name and
number when you create them, for example NumericInputEnable4.
If desired, you can assign a more meaningful name to the object, for
example Conveyor_Speed_Input.

The object name appears in the status bar, activity bar, Property
Panel, and Object Explorer in RSView Studio, and in activity log
messages at runtime.
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To name an object:

1. Select the object.

2. In the Property Panel, click the Properties tab.

3. Double-click the (Name) row, and then type the name.

The name must start with a letter, and cannot contain spaces. You
can use the underscore character (_).

To name a group object:

1. Select the group object.

2. In the Property Panel, click the Properties tab.

3. Double-click the (GroupName) row, and then type the name.

The name must start with a letter, and cannot contain spaces. You
can use the underscore character (_).

Testing how objects look in different states

To make sure the different states for an object are configured
correctly, you can view them using the States toolbar or the Property
Panel.

To open the States toolbar:

� On the View menu, select Toolbars, and then click States.

To view an object’s states using the States toolbar:

1. Select one or more objects.

2. In the States toolbar, select the state to view.

If you selected multiple objects, the toolbar shows the states that
are common to all the objects.

3. To view the next state, select it in the toolbar or press the Down
Arrow key on your keyboard.

You can also use these keys to select the next state to view:

To view the previous state, press the Up Arrow key.
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To view the first state, press the Home key.

To see the last state, press the End key.

To view an object’s states using the Property Panel:

1. Select one or more objects.

2. In the Property Panel, click the State property and then select the
state to view.

3. To view the next state quickly, double-click the row, or press the
Enter key on your keyboard.

Assigning tags and expressions to graphic objects

You can assign tags and expressions to many of the graphic objects,
including ActiveX objects (depending, of course, on how the vendor
implemented the object). This section describes how to:

assign tags to graphic objects

use expressions to manipulate tag values

replace tags using tag substitution

use tag placeholders so the same display can be used with
different sets of tags

Assigning tags

To assign tags to a graphic object, use one of these

methods:

Double-click the object to open the object’s Properties dialog
box, and then assign tags in the Connections tab.

Type the tag name here... ... or click the button to open

the Tags dialog box.

Select the object and then assign tags in the Connections tab of
the Property Panel.
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Type the tag name here... ... or click the button to open

the Tags dialog box.

Select the object, and then on the Edit menu click Connections.
Assign tags in the Connections tab of the Properties dialog box.

Right-click the object, and then click Connections. Assign tags in
the Connections tab of the Properties dialog box.

For information about:

using the Tags dialog box, see page 7-25

using the Properties dialog box, see page 9-22

using the Property Panel, see page 9-24

Using expressions to manipulate tag values

Many of the controls to which you can assign a tag also permit the
use of expressions to perform logical or mathematical calculations on
tag values. If you assign an expression, RSView monitors the
expression value rather than the original tag value. For example,
your machine might send values to the data source in the form of
temperature in degrees Celsius. You could use an expression to
convert the value to degrees Fahrenheit, and then monitor the
expression result rather than the original tag value.

If you can assign an expression, a Browse button is present in the
Exprn column in the Connections tab.



Preface

9-34 � RSView Machine Edition User’s Guide

Type the expression here... ... or click the Browse button to

open the Expression editor.

To specify an expression, do one of the following:

In the “Tag or expression” column, type the expression.

In the Exprn column click the Browse button and then create an
expression in the Expression editor. Use this method if you want
to check the expression syntax, or to use multiple lines for the
expression.

For more information about expressions, see Chapter 12.

Replacing tags using tag substitution

You can replace tags assigned to the graphic objects in your display
by using tag substitution. You can also replace the tags used in
expressions assigned to graphic objects.

For example, if you assign a tag called HoistHeight to multiple
objects in the display, and then decide to use the tag Hoist_Height
instead, you can use tag substitution to quickly replace the old tag
with the new tag.

You can replace:

a tag name (with or without folder names)

a folder name

the text in an expression

To replace tags:

1. Select one or more objects.

To select all the objects in the display, on the Edit menu, click
Select All.

2. On the Edit menu, click Tag Substitution.

To replace the tags for a single object, right-click it and then click
Tag Substitution.
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3. In the Search for box, type the name of the tag, folder, or
expression to replace, or click the down arrow to display a list of
the possible items you can search for and replace.

To open the Tags dialog box and select a tag, click Tags.

4. In the Replace with box, type the name of the new tag, folder, or
expression.

To open the Tags dialog box and select a tag, click Tags.

5. To confirm each replacement before it is made, check Confirm
Replacements.

To automatically replace all occurrences of the tag, folder, or
expression for the selected object or objects, leave the box
unchecked.

6. Click Replace.

If the Confirm Replacements check box is not selected, all
occurrences of the text in the Search for box are automatically
replaced with the text in the Replace with box (for the selected
object or objects).

If the Confirm Replacements check box is selected, the Confirm
Replacement dialog box opens, showing the objects in which the
text is used. The first object is selected.

7. To replace the text in the selected object, click Replace.

To move to the next object that uses the text string, click Next.

To replace the text for all the objects in the dialog box, click
Replace All.
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8. When all replacements are done, click Cancel to close the
Confirm Replacements dialog box. (It closes automatically if you
click Replace All.)

9. To close the Tag Substitution dialog box, click Close.

Using tag placeholders

Tag placeholders provide a way to use one graphic display to
represent a number of similar operations.

For example, suppose you are creating displays for a plant that cans
corn and peas. The machinery used in both processes is identical.
Instead of creating two displays and specifying corn-related tags in
one display and pea-related tags in another, you can create one
display and not specify any tag names. Where a tag name is required,
type a tag placeholder.

You can use tag placeholders wherever you would normally assign a
tag to an object, including in expressions. You can also use tag
placeholders in the expressions you create to animate objects.

You can use tag placeholders in:

the graphic display that opens when the project is first run

graphic displays that are opened using a Goto Display button

Use parameter files to specify which tags to substitute for which
placeholders. For information about creating parameter files, see
page 8-25.

Creating tag placeholders

A tag placeholder is the cross-hatch character (#) followed by a
number from 1 to 500, as shown in this example:

You can use tag placeholders in:

the Connections tab of an object’s Properties dialog box

the Connections tab of the Property Panel
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the Expression box in the Animation dialog box

To create a tag placeholder:

� Type the cross-hatch character followed by a number (no space
in between). For example, #1.

Performing basic operations on objects

Once you have drawn an object, you can select the object and work
with it. You can:

move objects

copy objects

duplicate objects

resize objects

reshape drawing objects

delete objects

Moving objects

You can move objects using the mouse or the keyboard. The keys
give you fine positioning, allowing you to move objects in small
increments. You can also use the grid to position objects precisely.

Another option is to position an object using the object’s Top and
Left properties in the Property Panel. For information about using
the Property Panel, see page 9-24.

Once you’ve moved objects into position, you might want to align
other objects with them, or lock them into place. For information
about aligning objects, see page 9-47. For information about locking
objects into position, see page 9-52.

To automatically align objects to the grid as you move

them:

� On the View menu, select Snap On. A check mark appears beside
the menu item when the option is selected.

For information about setting up the grid, see page 8-8.

To move objects by dragging with the mouse:

1. Select one or more objects.
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2. Place the pointer on an object (not on the edge or on the
handles).

3. Drag the objects to the desired position.

Select the object. Drag the object to the

desired position.

If you selected several objects, dragging one of the objects moves
all the selected objects. The objects maintain their position
relative to each other.

To move objects in small increments using the keyboard:

1. Select one or more objects.

2. Place the pointer on the object, not on its edge or handle.

3. Hold down Shift while you press an arrow key.

To adjust the amount of the increment, first hold down the Shift
key and press the + or - keys on the keyboard’s numeric keypad.

4. Release the Shift key when the object is in place.

Copying objects

To copy objects, you can:

drag and drop objects in the same display

drag and drop objects between displays, or from a graphic library
to a display

copy and paste objects

When an object is copied, any animation attached to the object is
also copied. If a group is copied, the new copy of the group can be
ungrouped to individual objects, just like the original.

To drag objects in the same display:

1. Select one or more objects.

2. Drag the object, and then press Ctrl.
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When you press Ctrl, a plus sign is added to the cursor.

3. When the object is where you want it, release the mouse button
and then the Ctrl key.

A new copy of the object is created.

If you selected several objects, dragging one of the objects copies
all the selected objects. The objects maintain their position
relative to each other.

To drag objects between displays:

1. Open both displays (or a graphic library and a display).

2. Position or resize the displays so both are visible.

For more information, see page 8-12.

3. Select one or more objects.

4. Click the selected object and drag it to the new display.

If you selected several objects, dragging one of the objects copies
all the selected objects. The objects maintain their position
relative to each other.

Copying and pasting objects

You can cut, copy, or paste objects using the menu items on the Edit
menu or the buttons on the toolbar.

Once you cut or copy an object, you can paste it anywhere in the
drawing area of:

the same graphic display

a graphic display in the same or a different project

a graphic library in the same or a different project

To cut or copy objects:

1. Select one or more objects.

2. On the Edit menu, click Cut or Copy, or click the Cut or Copy
tool on the Graphics toolbar.

To remove the original object, click Cut.

To retain the original object, click Copy.

To paste objects:

1. Click in the display or library to paste to.
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2. On the Edit menu, click Paste, or click the Paste tool on the
Graphics toolbar.

Duplicating objects

When an object is duplicated, any animation attached to the object is
also duplicated. If a group is duplicated, the new copy of the group
can be ungrouped to individual objects, just like the original.

To duplicate objects:

1. Select one or more objects.

2. On the Edit menu, click Duplicate, or click the Duplicate tool on
the Graphics toolbar.

The duplicated object is placed slightly offset from the original.

Duplicate also duplicates actions. For example, if you duplicate an
object, move it, and then duplicate it again, the second Duplicate
will, in one step, duplicate and move the object. This is useful for
creating a series of objects with an equal distance between them.

Select object. Duplicate object. Move object. Duplicate again.

Duplicate works until you deselect the object.

Resizing objects

You can resize objects using the mouse or using the keyboard. The
keys let you resize objects in small increments. You can also use the
grid to resize objects precisely.

Another option is to size an object using the object’s Height and
Width properties in the Property Panel. This method is especially
useful for quickly resizing multiple objects to the same size. For
information about using the Property Panel, see page 9-24.
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When you resize text objects, the font size is adjusted to fit the new
object size as closely as possible.

To automatically align objects to the grid as you resize

them:

� On the View menu, select Snap On. A check mark appears beside
the menu item when the option is selected.

For information about setting up the grid, see page 8-8.

To resize an object using the mouse:

1. Select the object.

2. Place the pointer on one of the handles.

A double arrow appears.

3. Drag the handle until the object is the desired size or shape.

Drag a side handle to change width or height, or a corner handle
to change both.

For perfect circles and squares, press Ctrl and hold the key down
while you drag a corner handle.

To maintain the object’s original proportions (width to height),
press Shift and hold the key down while you drag a corner
handle.

To resize an object in small increments using the

keyboard:

1. Select the object.

2. Place the pointer on one of the handles.

A double arrow appears.

3. Hold down Shift and press an arrow key until the object is the
desired size.
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To adjust the amount of the increment, first hold down the Shift
key and press the + or - keys on the keyboard’s numeric keypad.

Reshaping drawing objects

You can reshape arcs, lines, polygons, polylines, rectangles, rounded
rectangles, and wedges.

To reshape lines, rectangles, polylines, and polygons:

1. Select the object you want to reshape.

2. Click the Polygon tool, or right-click the object and then click
Edit.

The cursor changes to the Polygon tool, and handles appear on
the object.

3. Move the cursor over any line or corner of the object.

A handle with a cross-hair appears.

4. Drag the handle until the object is the desired shape.

Dragging from a point along the line (between corners) creates a
new angle between the two corners.

5. To delete an angle, position the pointer at the tip of the angle, and
then press Delete.

To reshape arcs and wedges:

1. Select the object you want to reshape.

2. Click the Arc or Wedge tool, or right-click the object and then
click Edit.

The cursor changes to the Arc or Wedge tool, and handles appear
on the object.

3. Place the pointer on one of the handles.

A cross-hair appears.
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4. Drag the handle until the object is the desired shape.

To reshape rounded rectangles:

1. Select the rounded rectangle.

2. Click the Rounded Rectangle tool, or right-click the object and
then click Edit.

A handle appears inside the rounded rectangle.

3. Click the handle and drag inward to increase roundedness, or
outward to decrease roundedness.

Deleting objects

If you accidentally delete an object, use the Undo tool to restore it.

To delete objects:

1. Select one or more objects.

2. On the Edit menu, click Delete, or press Delete on the keyboard.

To delete all the objects in the display:

� On the Edit menu, click Clear All.

Working with groups of objects

Grouping and ungrouping objects

Grouping combines several objects into a single object so you can
manipulate them as a single object. Grouping is useful for keeping
objects in the same position relative to each other. You can cut, copy,
and paste groups, arrange the group as a single object relative to
other objects, and apply the same properties to all the members of
the group at once.

You can attach animation to a group, and any animation attached to
individual objects in the group remains active. The group animation
generally takes precedence over the animation of individual objects
within the group. For more information, see page 11-27.

Deleting a group deletes all individual objects in the group.

To group objects:

1. Select all the objects you want grouped.
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2. On the Arrange menu, click Group, or on the Graphics toolbar
click the Group tool.

The handles around each object are replaced by a set of handles
around the group.

Select the objects. Group them.

... ... ... ... ...
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To ungroup objects:

1. Select the group of objects to ungroup.

2. On the Arrange menu, click Ungroup, or on the Graphics
toolbar click the Ungroup tool.

The handles around the group are replaced with handles around
each object.

Select the group. Ungroup it.

Ungrouping deletes any animation attached to the group, because
the group no longer exists. However, animation attached to the
individual objects that were in the group remains active.
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Editing groups of objects

Edit a group the same way you would edit an individual object. You
can:

use the Property Panel to apply the same properties to all the
members of the group at once. For example, change the line
width of all objects in the group to 2 pixels.

For information about using the Property Panel to edit groups of
objects, see page 9-24.

use the toolbars to apply the same pattern style, background
style, foreground colors, and background colors to all the
members of the group

for objects with states, use the States toolbar to cycle through the
states and apply the same properties to the states for each object
in the group at once. When you select a group containing objects
with states, only the states that are common to all objects in the
group appear in the toolbar.

For information about using the States toolbar, see page 9-31.

Editing objects within a group

You can also edit individual objects within the group without
breaking the group, which is particularly useful when you have
animation attached to the group.

To edit objects within a group:

1. Double-click the grouped object, or right-click it and then click
Edit. A hatched border appears around the group.

When the hatched border is around the group, you are in group
edit mode. In this mode, you can select individual objects in the
group and modify them.

You can also add new objects to the group.
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Double-click to edit the group. A hatched

border appears around the group.

Click again to select an object in the

group. Handles appear to indicate the

object is selected.

2. To select an individual object (or a group) in the group, click it.
You can also use the Object Explorer to select objects within the
group. For details, see page 9-20.

The status bar and Object Explorer indicate which object or
group is selected.

3. Make your changes to the object.

You can change the selected object’s shape, size, or position, or
use the object’s Properties dialog box or the Property Panel to
edit the object’s properties.

4. If desired, create new objects inside the hatched border.

5. To stop editing, click outside the group.

Arranging objects
You can arrange objects (or groups of objects) in a number of ways.
You can:

layer objects by moving them in front of or behind other objects

align objects with each other and with the grid

space objects horizontally or vertically

flip drawing objects horizontally or vertically

rotate drawing objects

lock objects into position

Layering objects

You can layer objects (or groups of objects) on top of each other.
Objects are layered in the order they are created, with the most
recently created object on top. Change the layer order with Send to
Back and Bring to Front.
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Send to Back moves the selected object to the bottom layer.

Bring to Front moves the selected object to the top layer.

To bring an object to the front:

1. Select the object.

To select an object that’s behind another object, place your
pointer on the front object, click once, pause, and then click
again. Do not double-click and do not move the mouse.

You can also select a concealed object easily by clicking the
object in the Object Explorer.

2. On the Arrange menu, click Bring to Front, or click the Bring to
Front tool.

Select the object in

back.

Bring the

object to front.

To send an object to the back:

1. Select an object.

2. On the Arrange menu, click Send to Back, or click the Send to
Back tool.

Select the

object.

Send the

object to the

back.

Aligning objects

You can align objects (or groups of objects) with each other and
with the grid.

To align objects:

1. Select the objects you want to align.
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2. On the Arrange menu, click the appropriate menu item, or click a
tool on the Alignment toolbar:

This tool or menu item Aligns selected objects with

Align Left Left-most selected object

Align Center Horizontal center of all selected objects

Align Right Right-most selected object

Align Top Top-most selected object

Align Middle Vertical center of all selected objects

Align Bottom Bottom-most selected object

Align Center
Points

Center of all selected objects

Align to Grid Grid

To automatically align objects to the grid as you create or

move them:

� On the View menu, select Snap On. A check mark appears beside
the menu item when the option is selected.

For information about setting up the grid, see page 8-8.
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Examples: Aligning objects left, right, and center

Select objects. Align left.

Select objects. Align right.

Select objects. Align center.

Examples: Aligning objects top, middle, and bottom

Align

top.

Align

middle.

Align

bottom.
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Spacing objects

With Space Vertical and Space Horizontal, objects (or groups of
objects) are moved vertically or horizontally to have the same
amount of space from the center point of each object.

To space objects:

1. Select the objects you want to space.

2. On the Arrange menu, click the appropriate menu item, or click a
tool on the Graphics toolbar:

This tool or menu item Does this

Space Horizontal Places the centers of the selected objects
an equal distance apart horizontally.

Space Vertical Places the centers of the selected objects
an equal distance apart vertically.

Examples: Spacing objects vertically and horizontally

Select objects. Space vertically.

Centers are

separated by

an equal vertical

distance.

Select objects. Space horizontally.

Centers are separated

by an equal horizontal

distance.

Flipping drawing objects

Flipping an object creates a mirror image of the object. You can flip
all the drawing objects (or groups of drawing objects) except text,
images, and panels.
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To flip a drawing object:

1. Click the object.

2. On the Arrange menu, click the appropriate menu item, or click a
tool on the Graphics toolbar:

This tool or menu

item

Flips selected objects

Flip Vertical Top to bottom (upside-down)

Flip
Horizontal

Left to right

Examples: Flipping drawing objects vertically and horizontally

Select object. Flip vertical.

Select object. Flip horizontal.

Rotating drawing objects

You can rotate all the drawing objects (or groups of drawing objects)
except images, panels, and rounded rectangles.

You can attach rotation animation to the same drawing objects. With
rotation animation, the object rotates around an anchor point to
indicate a tag’s value at runtime. For details about rotation
animation, see page 11-22.

When you rotate text, it rotates around the anchor point but the text
itself remains upright.
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To rotate a drawing object:

1. On the Objects menu, click Rotate, or on the Objects toolbar
click the Rotate tool.

2. Click the object you want to rotate. A small crosshair circle
appears in the middle of the object. This is the anchor point that
is used as the center of rotation.

3. To move the center of rotation, click the cross-hair and drag it to
a new anchor position. The anchor can be inside or outside the
object.

You can place the crosshair inside an object...

... or you can place it outside an object.

4. Click on an edge of the object and drag in the direction you want
to rotate it.

To rotate the object in five-degree increments, press Ctrl while
you drag.

5. When the object is in the desired position, release the mouse
button.

Locking objects into position

You can lock graphic objects (or groups of objects) into position by
converting them to wallpaper. Once you convert objects to
wallpaper, you cannot select or edit them unless you unlock the
wallpaper. Wallpaper objects cannot be animated at runtime.
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If the grid is on, wallpaper objects are positioned behind the grid.

If you just want to lock the objects into place while you’re working
in the display, unlock the wallpaper when you’re finished. If you
want to use the wallpaper objects as a background for your display,
leave the wallpaper locked.

For more information about creating a background for your display,
see page 8-15.

To convert objects to wallpaper:

1. Select the objects to convert.

2. On the Edit menu, select Wallpaper, and then click Convert to
Wallpaper.

For a single object, you can right-click it and then click Convert
to Wallpaper.

To unlock the wallpaper:

� On the Edit menu, select Wallpaper, and then click Unlock All
Wallpaper.

All objects in the graphic display are converted back to their
original state.
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Configuring
graphic objects

This chapter describes how to set up graphic objects. It describes
how to:

work with objects that have states

position objects for touch screens

assign function keys to buttons

use the keyboard to navigate to and select objects

link buttons to lists and trends

repeat a button’s action by holding down the button

ensure values are read by the data source before sending new
values

use objects’ Properties dialog boxes to set up options for the
individual graphic objects

For objects that are not described in other chapters of the manual,
this chapter provides information about how to use the objects.

For information about creating graphic objects, see Chapter 9.

For information about creating and configuring the trend graphic
object, see Chapter 17.

Tips for configuring objects with states

The graphic objects that have configurable states have a States tab
in their Properties dialog box.

10
Chapter
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To set up the properties for a state:

1. Click the States tab.

2. In the Select state list, click the state.

3. Specify options for the state.

4. Repeat steps 2 and 3 for each additional state, including the
error state if the object has one.

Copying and pasting properties from one
state to another

Often, you’ll want most of the properties to be the same from state
to state, with only one or two settings changing to distinguish the
different states.

To simplify setting up states when many of the properties are the
same, you can copy and paste settings from one state to another.

To copy settings from one state to another:

1. In the Select state box, click the state whose settings you want to
copy.
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2. Click the Copy button.

3. In the Copy State Settings dialog box, select the settings to copy.
Clear the check boxes for settings you don’t want to copy, or
click Clear All to clear all the check boxes and then specify the
settings to copy.

4. Click OK.

5. In the Select state box, click the state to which to paste the
settings.

6. Click the Paste button.

7. In the Paste State Settings dialog box, specify whether to paste
the settings to the selected (current) state only, or to all the
object’s states.

8. Click OK.

Adding and removing states

Some graphic objects have a configurable number of states. For
these objects, you can use the Insert State and Delete State buttons
in the States tab, to add and remove states without returning to the
General tab. The “Number of States” setting on the General tab is
automatically updated.
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Insert State Click a state, and then click Insert State. The new
state is inserted above the selected state.

Delete State Click the state to delete, and then click Delete State.

Setting up how objects are used at runtime

Just as you must provide operators with a way to navigate between
displays at runtime, you must also make sure that operators can use
the objects within the displays. The next sections in this chapter
describe how to set up your objects so the operator can:

access objects using a touch screen

use function keys to press buttons when a mouse or touch
screen is not available on the runtime computer

use the keyboard or keypad to navigate to and select lists,
trends, and ActiveX input objects

use buttons to work with lists and trends

repeat a button’s action by pressing and holding it

ensure that tag values are read by the data source before sending
new values

Positioning objects for touch screens

If the operator will be using a touch screen at runtime, keep these
tips in mind when positioning graphic objects in your displays:

Don’t place important buttons where they’ll be blocked by an
On Top display. The user can’t press a covered button.

Ensure buttons are large enough for users to touch easily.

Use touch margins for buttons that are positioned close
together, to ensure that the adjacent button is not pressed by
mistake.

Using touch margins

Touch margins are touch-insensitive borders inside the button’s
margin. If the operator presses on the touch margin, the button
press is not registered. Touch margins are useful when buttons are
positioned close to each other and you want to make sure the
operator doesn’t press the wrong button by mistake.
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You can create touch margins at the top and bottom of the button,
at the sides, or on all four sides.

In the illustration below, the button’s border and touch margins are
the same size, 12 pixels. A button press would be registered only
when the darker rectangle in the middle of the button is pressed.

The margins at

the top and

bottom edges

are called

vertical touch

margins.

The margins at

the left and right

edges are called

horizontal touch

margins.

The bounding box

If the button shape is a circle or ellipse, the touch margin applies to
the button’s bounding box, not the object’s border. The bounding
box is an invisible square or rectangle that surrounds the button.
When you select the button, the selection handles show the location
of the bounding box.

The invisible

bounding box is

just inside the

selection handles.

To create touch margins, use one of these methods:

In the General tab of the button’s Properties dialog box, type
the number of pixels for the touch margins in the Horizontal
margin and Vertical margin boxes.

In the Properties tab of the Property Panel, type the number of
pixels for the HorizontalMargin and VerticalMargin properties.

Assigning function keys to buttons

You can assign function keys to the buttons in your displays to
allow the operator to press the buttons using the function keys on
the runtime terminal (or the function keys on a keyboard, if one is
available).

You can assign up to 34 function keys to each graphic display.
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Here are some tips for assigning function keys:

Where possible, use the same function keys for the same
operations in all your graphic displays. For example, if every
display contains a Goto Display button that returns the operator
to a graphic display called Main Menu, assign the same function
key to this button in each display.

Include the name of the function key assigned to a button in a
caption on the button.

For buttons with multiple states, include the function key name
in the caption for each state, or create a text object to use as a
label for the button (so that you don’t have to configure the
caption for each state), and then group the text and button
together.

Function key equivalents

If your project will run on the RAC6182, the function keys
correspond to the keys F1 to F14 and K1 to K20 on the computer’s
keypad.

If your project will run in Windows 2000, the keyboard contains
the function keys F1 to F12 only. The remaining function keys are
associated with these key combinations:

For this function key Use this key combination

F13 Left Shift-F1

F14 Left Shift-F2

K1 - K12 Right Alt-F1 to Right Alt-F12

K13 Right Shift-F1

K14 Right Shift-F2

K15 Right Shift-F3

K16 Right Shift-F4

K17 Right Shift-F5

K18 Right Shift-F6

K19 Right Shift-F7

K20 Right Shift-F8

At runtime, the operator presses the key combination to activate
the object to which the function key is assigned.
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To assign function keys to buttons:

1. On the Edit menu, click Key Assignments, or right-click a
button and then click Key Assignments.

The list shows all the buttons in the graphic display to which a
function key can be assigned, and indicates which keys have
already been assigned.

2. In the “Select an object” list, click the button to which to assign
a function key.

3. In the “Select a key assignment” box, select the key to assign.

The assigned key appears after the button name in the list.

4. Repeat steps 2 and 3 to assign keys to the other buttons in the
display.

5. Click OK to close the dialog box.

To change the function key assigned to a button:

� In the Key Assignment Properties dialog box, select the button
and then select a new function key.
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Using the keyboard to navigate to and select
objects

If a mouse or touch screen is not available on the runtime computer,
the operator can use the keys on a keyboard or keypad to select
(give the input focus to) these objects:

lists: Control List selector, Display List selector, Activity list,
and Alarm list

trends

third-party ActiveX input objects

What input focus looks like

The object with focus is surrounded by a highlight box, unless the
“Disable Highlight When Object has Focus” box is selected (in the
Display Settings dialog box). You can specify the color of the
highlight in this dialog box as well. For more information, see
page 8-15.

Highlight box

Using the keys on the keyboard or keypad

When a graphic display opens, the list, trend, or ActiveX input
object that is closest to the top left corner of the display is selected.
The operator can use these keys to move to and select a different
object:

Use this key To do this

Tab Move from the upper left to the
lower right.

Shift-Tab Move from the lower right to the
upper left.

Ctrl-arrow key Move left, right, up, or down

Removing objects from the tab sequence

By default, you can use the keys to navigate to all lists, trends, and
ActiveX input objects in a display. However, you can disable the
key navigation for objects if desired.
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When an object’s key navigation is disabled, the operator can still
select the object using a mouse or touch screen, if available.

To disable key navigation, use one of these methods:

In the Properties tab of the Property Panel, set the
KeyNavigation property to False.

In the General tab of the object’s Properties dialog box, clear
the Key navigation box. (This method is not available for trends
and ActiveX objects.)

Linking buttons to lists and trends

The table on page 10-22 lists buttons that work with the trend and
list objects. For the buttons in the list, you can specify whether the
button works with a specific object only, or whether it works with
whichever trend or list is selected in the display.

If you are creating small graphic displays that don’t have much
room, you might prefer to use one set of buttons to work with all
the lists and trends in the display.

By default, the buttons are configured to work with whichever
object has input focus (is selected) in the display.

However, if space isn’t a concern, you can create multiple copies of
the buttons you want to use and link them to specific lists or trends.
One benefit of linking a button to a specific object is that the
operator doesn’t have to select the list or trend before pressing the
button. Another benefit is that you can position the buttons close
to the specified object, making it easier for the operator to
understand which buttons work with which objects.
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This object has

input focus.

These Move Up

and Move Down

buttons work with

all the objects in

the display.

Each object has

its own set of

buttons.

To link a button to a specific object using the button’s

Properties dialog box:

1. Double-click the button to open its Properties dialog box.

2. In the General tab, in the “Send press to” box, select Linked
Object.
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3. To select from a list of all the objects in the display that you can
link the button to, click the Browse button next to the Linked
object box.

4. Click the name of the object to link the button to, and then click
OK.

5. Click OK to close the button’s Properties dialog box.

To link a button to a specific object using the Property

Panel:

� In the Properties tab, specify the SendPressTo and
LinkedObject properties.

Once you have linked buttons to an object, you might want to
disable the object’s key navigation, since this option is no longer
needed. For details, see page 10-8.

Repeating a button’s action by holding down the
button

To repeat a button’s action by pressing and holding it, set up auto
repeat for the button. If you set up auto repeat, when the operator
presses and holds down the button, repeated button presses are
registered until the operator releases the button.

A button press occurs when the operator clicks an object with the
mouse, presses it on a touch screen, or presses the function key
associated with the object. Auto repeat works with all these
methods of pressing buttons.

Browse button
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You can use auto repeat with these buttons:

For this button Each button press does this

Multistate Push Sends the value for the next state to the data source.
External changes to the Value control are not
recognized when the button is in auto repeat mode.

Ramp Sends the new ramped value to the data source.
External changes to the Value control are not
recognized when the button is in auto repeat mode.

Move Up Moves the highlight up an item in the list, or scrolls
up in the trend.

Move Down Moves the highlight down an item in the list, or
scrolls down in the trend.

Page Up Moves the highlight up a page in the list.

Page Down Moves the highlight down a page in the list.

Move Left Scrolls the trend to the left.

Move Right Scrolls the trend to the right.

For each button that uses auto repeat, you can specify:

Auto repeat rate—the number of times per second a button
press is registered when the button goes into auto repeat mode.
The default rate is 0, which means that auto repeat is disabled.

Auto repeat delay—the length of time the button has to be
pressed and held down before auto repeat starts.

To set up auto repeat for a button, use one of these

methods:

In the Timing tab of the button’s Properties dialog box, specify
the Auto repeat rate and Auto repeat delay properties.

In the Properties tab of the Property Panel, specify the
AutoRepeatRate and AutoRepeatDelay properties.

Ensuring values are read by the data source before
sending new values

To ensure a value is read by the data source before the operator
sends a new value, use Enter key handshaking. While Enter key
handshaking is in effect for an object, the operator cannot send a
new value to the object’s Value control.
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You can use Enter key handshaking with these graphic objects:

Control List selector

Numeric Input Enable button

String Input Enable button

If Enter key handshaking is in effect for one of these objects, the
operator can still provide input to other objects in the graphic
display.

If the graphic display is closed while Enter key handshaking is in
effect, the handshaking is cancelled.

Methods of Enter key handshaking

Enter key handshaking works by setting the object’s Enter control
to 1. As long as the Enter control is set to 1, new values cannot be
sent to the Value control. How the Enter control is reset to 0
depends on how you set up Enter key handshaking.

There are two ways you can use Enter key handshaking:

To hold the value at the data source for a specific period of time.

To hold the value at the data source until the data source notifies
RSView that the value has been read.

Choose the method that best suits your project needs and
communication system.

Holding the value for a specific period of
time

To configure an object’s Enter key handshaking so that the value at
the Value control is held for a specific period of time, assign a tag to
the Enter control and specify the Enter key hold time. You can also
specify an Enter key control delay, if desired.

How handshaking works

This method of Enter key handshaking works as follows:

1. When the operator presses the Enter button, the value is sent to
the Value control and the “Enter key control delay” timer
begins timing. (The use of a delay is optional.)

2. If you specify an Enter key control delay, when the time is up,
the Enter control is set to 1. If you don’t use the delay, the Enter
control is set to 1 as soon as the operator presses Enter.



Preface

10-14 � RSView Machine Edition User’s Guide

As long as the Enter control is set to 1, the operator cannot send
new values to the data source.

3. When the Enter control is set to 1, the “Enter key hold time”
timer begins timing.

4. When the Enter key hold time has expired, the Enter control is
reset to 0 and the operator can send a new value to the Value
control.

To set up Enter Key Handshaking to hold the value for a

specific period of time:

1. In Timing tab of the object’s Properties dialog box, specify the
Enter key control delay (optional) and Enter key hold time
properties.

2. In the Connections tab, assign a tag to the Enter control. A
digital tag is recommended.

You can also use the Property Panel to specify the properties and
assign a tag to the Enter control.

Holding the value until the data source
acknowledges that it has read the value

To configure an object’s Enter key handshaking so that the value at
the Value control is held until the data source notifies RSView that
it has read the value, use two controls: the Enter control and the
Enter handshake control.

Instead of using an Enter key hold time, specify an Enter key
handshake time. You must also specify the Handshake reset type.
You can use an Enter key control delay, if desired.
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How the Handshake reset type works

How the Enter handshake control resets the Enter control depends
on which Handshake reset type you select:

With this Handshake

reset type

The Enter control is set to 0 when

Non-zero value The Enter handshake control has a
non-zero value.

If the Enter handshake control already has
a non-zero value when the value is sent to
the Value control (or when the Enter key
control delay has expired, if the delay is
used), then the Enter control is not set to 1,
and Enter key handshaking does not take
place.

Zero to non-zero transition The Enter handshake control changes from
0 to a non-zero value.

Configure the data source to send a non-zero value to the Enter
handshake control when it has read the new value at the Value
control, and then to reset the Enter handshake control to 0.

If the Enter key handshake time expires before the Enter handshake
control resets the Enter control, an error message is sent to the
activity log.

How handshaking works

If you use the Enter handshake control, handshaking works like
this:

1. When the operator presses the Enter button, the value is sent to
the Value control and the “Enter key control delay” timer
begins timing. (The use of a delay is optional.)

2. If you specify an Enter key control delay, when the time is up,
the Enter control is set to 1. If you don’t use the delay, the Enter
control is set to 1 as soon as the operator presses Enter.

As long as the Enter control is set to 1, the operator cannot send
new values to the data source.

If the Handshake reset type is Non-zero value, the Enter
handshake control must be 0 when the delay expires in order to
set the Enter control to 1.
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If the data source has already read the value at the Value control
and set the Enter handshake control to a non-zero value, it’s not
necessary to set the Enter control to 1. The operator can send a
new value to the Value control.

3. When the Enter control is set to 1, the “Enter key handshake
time” timer begins timing.

4. The Enter control remains set until the Enter key handshake
time expires or until reset by the Enter handshake control,
whichever happens first.

5. The Enter control is reset to 0 and the operator can send a new
value to the Value control.

To set up Enter Key Handshaking to hold the value until the

data source has read it:

1. In the Timing tab of the object’s Properties dialog box, specify
these properties:

Enter key control delay (optional)

Enter key handshake time

Handshake reset type

2. In the Connections tab, assign these controls:

Enter—assign a tag. A digital tag is recommended.

Enter handshake—assign a tag or expression.

3. Configure the data source to send a non-zero value to the Enter
handshake control when it has read the new value at the Value
control, and then to reset the Enter handshake control to 0.

You can also use the Property Panel to specify the properties and
assign tags to the controls.
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Using buttons to operate the project

Use these button graphic objects to operate the project:

Use this button To do this

Return to Display
button

Close a display and return to the previous display.
For details, see page 19-5.

Close Display
button

Close a display. For details, see page 19-6.

Login button Open the Login dialog box and then log in. For
details, see page 18-9.

Logout button Log out of the project. For details, see page 18-9.

Display Print
button

Print the current display. For details, see page 8-35.

Shutdown button Stop the project and close RSView ME Station. For
details, see page 19-7.

Acknowledge All
Alarms button

Acknowledge and silence all currently
unacknowledged alarms. For details, see page 13-30.

Clear Alarm
History button

Remove all alarms from the alarm log file and all
Alarm lists. For details, see page 13-30.

Silence Alarms
button

Silence the audio indicator for all current alarms
(Windows 2000 projects only). For details, see
page 13-30.

Activity Clear All
button

Remove all activity messages from all Activity lists.
For details, see page 15-9.

Information
Acknowledge
button

Acknowledge the current message in the Information
Message display. For details, see page 14-10.

You can set up any combination of these buttons in a graphic
display. For example, you might want to put a Login, Logout, and
Shutdown button in the same graphic display.

Create and then set up each button separately.

Setting up buttons to operate the project

All of the buttons listed in the previous table are configured the
same way. This section shows how to set up the Login button, but
you can use these instructions to set up any of the buttons in the
table.
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To set up a button:

1. Double-click the button.

2. In the button’s Properties dialog box, fill in the options on each
tab, as described in the sections that follow. When you are
finished, click OK.

Setting up the appearance of the button

In the General tab, specify what the button looks like at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color.
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Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Shape Click a shape for the button.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.
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Setting up a caption or image for the button

In the Label tab, specify what text or image to display on the
button.

Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the font list.
Type or click a size for the font in the size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.
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Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

Browse button
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If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Using buttons with lists and trends

These button graphic objects are useful for scrolling through and
selecting items in lists and trends:

Use this

button

With this

graphic object

To do this

Pause button Trend Toggle a trend between pausing and
automatic scrolling.

Next Pen button Trend Change the vertical axis labels for a
trend to the scale for the next pen.

Backspace
button

Control List
selector

Move the cursor back to the
highlighted item in the list.

End button Lists and trends List—move to the bottom item
visible in the list.

Trend—resume trend scrolling and
move to the current (latest) data in
the trend.

Enter button Lists Select the item the cursor is pointing
to.

Home button Lists and trends List—move to the top item visible in
the list.

Trend—pause the trend and move to
the earliest data in the trend.

Move Left
button

Trend Pause the trend and scroll to the left.

Move Right
button

Trend Pause the trend and scroll to the
right.

Move Down
button

Lists and trends List—move down one item in the
list.

Trend—scroll down to display
lower values on the vertical scale.
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Use this

button

To do thisWith this

graphic object

Move Up button Lists and trends List—move up one item in the list.

Trend—scroll up to display higher
values on the vertical scale.

Page Down
button

Lists Move down one page in the list.

Page Up button Lists Move up one page in the list.

Acknowledge
Alarm button

Alarm list Acknowledge and silence the
selected alarm.

Activity Clear
button

Activity list Remove the selected message from
all Activity lists.

Working with lists and trends

The buttons in the table work with these graphic objects:

Control List selectors

Display List selectors

Activity lists

Alarm lists

trends

You can set up any combination of these buttons in a graphic
display that contains a list object or trend. Create and then set up
each button separately.

For information about See

Using buttons with Alarm lists Page 13-28

Using buttons with Activity lists Page 15-9

Using buttons with trends Page 17-24

Linking buttons to objects

You can link the buttons to specific objects in a display, or use the
same buttons with multiple objects. If you use the same buttons
with multiple objects in a display, the button press goes to
whichever object has input focus.

For more information about linking buttons to graphic objects, see
page 10-9.
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Setting up buttons to use with lists and trends

All of the buttons listed in the previous table are configured the
same way, except that the Move Up, Move Down, Move Left,
Move Right, Page Up, and Page Down buttons can be set up to
auto repeat. The other buttons have no auto repeat function.

This section shows how to set up the Move Up button, but you can
use these instructions to set up any of the buttons in the table.

To set up a button:

1. Double-click the button.

2. In the button’s Properties dialog box, fill in the options on each
tab, as described in the sections that follow. When you are
finished, click OK.
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Setting up the appearance of the button

In the General tab, specify what the button looks like at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color.

Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Shape Click a shape for the button.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.
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Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.

Send press to Click Object With Focus to send the button’s press
action to the object that is selected on the display.

Click Linked Object to send the button’s press action to the object
to which the button is linked.

For more information about linking buttons to graphic objects, see
page 10-9.

Linked object Click the Browse button, and then click the object
you want to link the button to.

Setting up a caption or image for the button

In the Label tab, specify what text or image to display on the
button.

Browse button
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Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the font list.
Type or click a size for the font in the size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.
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Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Browse button
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Setting up whether the button press repeats
when held down

The Timing tab is available only for the Move Up, Move Down,
Move Left, Move Right, Page Up, and Page Down buttons.

In the Timing tab, set up whether or not the button press repeats
automatically when the operator presses and holds the button
down. You can also set up the rate at which the button press
repeats.

For more information about auto repeat, see page 10-11.

Auto repeat rate Select the number of times per second a button
press is registered when the button goes into auto repeat mode.
If you don’t want the button press to repeat automatically, click 0.

Auto repeat delay Click the number of milliseconds or seconds
the button must remain pressed before auto repeat starts.

How to use push buttons
Push buttons start or stop processes or actions by changing tag
values.

IMPORTANT Never use push buttons for emergency stops.
Emergency stop buttons must always be hard-wired.

You can use different kinds of push buttons, depending on what
kind of machinery you are running or process you are controlling:

Momentary Push buttons change a tag to one value when the
button is pressed, and another value when the button is released.
Momentary push buttons work like the Pulse button on a food
processor. The machine is on only while the button is held down.
When the button is released, the machine turns off. Momentary
push buttons are useful for jogging a motor, and they can be set up
to start and stop a machine or process.
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Maintained Push buttons toggle between two values. This type of
button is useful for changing a setting within a machine or process,
but not for starting the machine or process. For example, use the
Maintained Push button for changing modes, such as Auto to
Manual, or Metric to Imperial.

Latched Push buttons latch in the on position, and must be
unlatched by another button or process to return to the off
position. This type of button is useful for starting a machine or
process.

Multistate Push buttons allow an operator to cycle through
multiple options consecutively, using a single button. The current
state of a process or operation is displayed on the button by a
different color, caption, or image for each state.

Interlocked Push buttons work in groups, and share the same tag.
The buttons work together like the preset station selector buttons
on a car radio: pressing one button cancels another. Although
Interlocked Push buttons work as a group, you add them to the
display one at a time.

Ramp buttons increase or decrease the value of a tag by either an
integer or floating point value. You can use two ramp buttons
together to create an increase/decrease control, for example for the
speed of a motor.

Setting up Momentary Push buttons
Use the Momentary Push button to start a process or action. When
pressed, the button changes a tag to one value, and when released,
the button changes the tag to another value.

The Momentary Push button’s states can perform one of three
kinds of actions:

Change the Value control to 1 when the button is pressed, and
to zero when the button is released. This kind of button is called
normally open, because its released state is off. Pressing the
button completes the circuit.

Change the Value control to zero when the button is pressed,
and to 1 when the button is released. This kind of button is
called normally closed, because its released state is on. Pressing
the button breaks the circuit.

Change the Value control to a value you specify. You assign the
desired values to the button’s press and release actions. For
example, 50 when pressed, and 100 when released.
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To set up a Momentary Push button:

1. Double-click the Momentary Push button.

2. In the Momentary Push Button Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance and action of the
Momentary Push button

In the General tab, specify what the Momentary Push button looks
like at runtime, and what type of action the button performs.
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Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color on the States tab.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Shape Click a shape for the button.

Button action Click Normally open to change the button’s tag to
1 when the button is pressed, and zero when the button is released.

Click Normally closed to change the button’s tag to zero when the
button is pressed, and 1 when the button is released.

Click Value to specify values for each of the button’s states. Type
values on the States tab, described on page 10-33.

Hold time Select the amount of time the button remains pressed
before the Release action takes effect, even if the operator releases
the button sooner.

The hold time should reflect network traffic. Increasing the hold
time prevents a very quick object press from being missed by the
programmable controller. If you are using a memory tag, click the
shortest hold time.
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The operator cannot press the object again until the hold time has
expired. If a display change occurs before the hold time has expired,
the value for the released state is sent immediately to the tag.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.

Setting up what the Momentary Push button
does when it is pressed and released

In the States tab, specify what the button does when it is pressed
and released.

For tips about configuring states, see page 10-1.

The error state

The button’s error state is displayed at runtime when:

the Value control is unassigned

the Indicator control’s value does not match one of the state
values you set up
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Value The value to which the button changes the Value control
when the selected state is in effect. When the Indicator control
changes to this value, the button’s appearance changes to the
settings you specify for the state.

If you clicked Value for the button action on the General tab, you
can type a value for the state in this box. You cannot type a value
for the button’s error state.

If you clicked Normally open for the button action on the General
tab, state 0 has a value of 0, and state 1 has a value of 1. You cannot
change these values.

If you clicked Normally closed for the button action on the
General tab, state 0 has a value of 1, and state 1 has a value of 0.
You cannot change these values.

Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.
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Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.
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Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Browse button
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Connecting the Momentary Push button
to data

In the Connections tab, specify the tags or expression with which
button exchanges data. For information about assigning tags and
expressions, see page 9-32.

Type the tag name,

or expression if

applicable, here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The Value control triggers the button’s action. For example,
when the tag assigned to the control is set to 1, the data source
starts a motor.

Indicator The Indicator control provides visual feedback to the
button of its state. For example, the control can show whether a
motor is running. If you assign this control, the button does not
display the pressed state until it receives a response from the
Indicator control. Configure the data source to change the Indicator
control’s value when it has read the Value control’s value.

Setting up Maintained Push buttons

Use the Maintained Push button to change a setting in a machine or
process. Maintained push buttons are not useful for starting or
stopping a machine or process.

When pressed the first time, the Maintained Push button changes a
tag to one value. When pressed and released a second time, the
button changes the tag to another value.

To set up a Maintained Push button:

1. Double-click the Maintained Push button.
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2. In the Maintained Push Button Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance of the Maintained
Push button and how it changes state

In the General tab, specify what the button looks like at runtime,
and how the button changes state.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color on the States tab.
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Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Shape Click a shape for the button.

Next state based on Click Current state to toggle the button’s
state relative to its current state. For example, if the button’s
current state is zero, its next state is 1. If the button’s current state
is 1, its next state is zero.

Click Value control to toggle the button’s state relative to the Value
control. If the operator presses the button, changing its state to 1,
and then the data source changes the button’s state to zero, the next
time the operator presses the button, the button’s state will be 1.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button. If the computer running the
display does not have an internal speaker, pressing the button does
not trigger a beep.
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Setting up what the Maintained Push button
does when it is pressed and released

In the States tab, specify what the button does when it is pressed
and released.

For tips about configuring states, see page 10-1.

The error state

The button’s error state is displayed at runtime when:

the Value control is unassigned

the Indicator control’s value does not match one of the state
values you set up

The error state is also displayed when the display containing the
Maintained Push button first opens, if the Value control’s value
does not match one of the state values you set up.

Value The value to which the button changes the Value control
when the selected state is in effect. When the Indicator control
changes to this value, the button’s appearance changes to the
settings you specify for the state.
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Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.
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Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Browse button
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Connecting the Maintained Push button
to data

In the Connections tab, specify the tags or expression with which
the button exchanges data. For information about assigning tags
and expressions, see page 9-32.

Type the tag name,

or expression if

applicable, here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The Value control triggers the button’s action. For example,
when the tag assigned to the control is set to 1, the data source
changes the machine to Auto mode.

Indicator The Indicator control provides visual feedback to the
button of its state. For example, the control can show which mode
a machine is using. If you assign this control, the button does not
display the pressed state until it receives a response from the
Indicator control. Configure the data source to change the Indicator
control’s value when it has read the Value control’s value.

Setting up Latched Push buttons
The Latched Push button latches in the on position, and must be
unlatched by another button or process to return to the off
position.

Latched Push buttons work like Momentary Push buttons, except
that the tag doesn’t change to the button’s release value until the
button is unlatched by another button or process. This type of
button is useful for starting a machine or process.

When the operator presses a Latched Push button, it changes a tag
to one value, and remains at that value until the operator presses
another button to change the Handshake control to a different
value.

To set up a Latched Push button:

1. Double-click the Latched Push button.
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2. In the Latched Push Button Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance of the Latched
Push button and how to unlatch it

In the General tab, specify what the button looks like at runtime,
and how to unlatch it.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color on the States tab.
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Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Shape Click a shape for the button.

Latch reset type To unlatch the push button when the Handshake
control has a non-zero value, click Non-zero Value.

To unlatch the push button when the Handshake control changes
from a zero to a non-zero value, click Zero to Non-zero transition.

Be sure to assign values to states 0 (unlatched) and 1 (latched) on
the States tab, and assign a tag or expression to the Handshake
control in the Connections tab.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.
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Setting up what the Latched Push button
does when it is latched and unlatched

In the States tab, specify what the button does when it is latched
and unlatched.

For tips about configuring states, see page 10-1.

The error state

The button’s error state is displayed at runtime when:

the Value control is unassigned

the Indicator control’s value does not match one of the state
values you set up

The error state is also displayed when the display containing the
Latched Push button first opens, if the Value control’s value does
not match one of the state values you set up.

Value The value to which the button changes the Value control
when the selected state is in effect. When the Indicator control
changes to this value, the button’s appearance changes to the
settings you specify for the state.
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Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.
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Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Browse button
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Connecting the Latched Push button to data

In the Connections tab, specify the tags or expressions with which
the button exchanges data. For information about assigning tags
and expressions, see page 9-32.

Type the tag name,

or expression if

applicable, here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The Value control triggers the button’s action. For example,
when the tag assigned to the control is set to 1, the data source
starts a motor.

Indicator The Indicator control provides visual feedback to the
button of its state. For example, the control can show whether a
motor is running. If you assign this control, the button does not
display the pressed state until it receives a response from the
Indicator control. Configure the data source to change the Indicator
control’s value when it has read the Value control’s value.

Handshake To unlatch the button, the Handshake control works
with the “Latch reset type” setting (on the General tab, see
page 10-45).

Depending on which latch reset method you select, the Handshake
control unlatches the button either when the Handshake control
has a non-zero value, or when the Handshake control changes from
a zero to a non-zero value.

Setting up Multistate Push buttons
The Multistate Push button displays—and allows an operator to
cycle through—multiple options consecutively. The Multistate Push
button displays the current state of a process or operation by
showing a different color, caption, or image to reflect different
states.

Each time the operator presses the button, the tag changes to the
value for the next state. When the button is in its last state and the
operator presses the button, the button returns to its first state.
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To set up a Multistate Push button:

1. Double-click the Multistate Push button.

2. In the Multistate Push Button Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance of the Multistate
Push button and how it changes state

In the General tab, specify what the button looks like, and how the
button changes state.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.
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Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color on the States tab. For details, see page 10-53.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Shape Click a shape for the button.

Number of states Click the number of states you want the button
to have.

Select only as many states as you want to use. If you don’t assign
values to all the states the button has, the operator must press the
button repeatedly through all the empty states before the first state
becomes available again.

Next state based on When the operator presses the button, the
next state that is displayed can be based on the current state, or on
the value of the Value control.

Click Current state to use the current state as the basis for deciding
what the next state will be. With this method, the button itself
determines what its next state will be.

Click Value control to use the Value control as the basis for
deciding what the next state will be. With this method, other
devices can change the Value control’s value, and determine what
the button’s next state will be.

If the Value control does not match one of the button’s state values,
the button changes to State 0, and changes the Value control to the
value of State 0.
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Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.

Setting up what the Multistate Push button
does when it is pressed and released

In the States tab, specify what the button does when it is pressed
and released.

For tips about configuring states, see page 10-1.

The error state

The button’s error state is displayed at runtime when:

the Value control is unassigned

the Indicator control’s value does not match one of the state
values you set up

The error state is also displayed when the display containing the
Multistate Push button first opens, if the Value control’s value does
not match one of the state values you set up.
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Value The value to which the button changes the Value control
when the selected state is in effect. When the Indicator control
changes to this value, the button’s appearance changes to the
settings you specify for the state.

Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.
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Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.
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Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Setting up whether the Multistate Push
button press repeats when held down

In the Timing tab, set up whether or not the button press repeats
automatically when the operator presses and holds the button
down. You can also set up the rate at which the button press
repeats.

Browse button
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For more information about auto repeat, see page 10-11.

Auto repeat rate Select the number of times per second a button
press is registered when the button goes into auto repeat mode. If
you don’t want the button press to repeat automatically, click 0.

Auto repeat delay Click the number of milliseconds or seconds
the button must remain pressed before auto repeat starts.

Connecting the Multistate Push button
to data

In the Connections tab, specify the tags or expression with which
the button exchanges data. For information about assigning tags
and expressions, see page 9-32.

Type the tag name,

or expression if

applicable, here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The Value control triggers the button’s action. For example,
when the tag assigned to the control changes to the next state, the
data source changes the speed of a conveyor belt.

Indicator The Indicator control provides visual feedback to the
button of its state. For example, the control can show the speed of a
conveyor belt. If you assign this control, the button does not
display the pressed state until it receives a response from the
Indicator control. Configure the data source to change the Indicator
control’s value when it has read the Value control’s value.
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Setting up Interlocked Push buttons

Multiple Interlocked Push buttons work together and share the
same tag.

The buttons work together like the preset station selector buttons
on a car radio: pressing one button cancels another. Although
Interlocked Push buttons work as a group, you add them to the
display one at a time.

When the operator presses one of the Interlocked Push buttons, the
tag assigned to its Value control changes to one value. When the
operator presses a different Interlocked Push button, the tag
changes to another value. Assign the same tag to each button’s
Value control.

To set up an Interlocked Push button:

1. Double-click the Interlocked Push button.

2. In the Interlocked Push Button Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.
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Setting up the Interlocked Push button’s
appearance and value

In the General tab, specify the button’s appearance, and the value it
sends to the Value control.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color on the States tab.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Shape Click a shape for the button.

Button value Type an integer value for the button. When the
operator presses the button, the button changes to State 1, and
changes the Value control to this value.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.
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Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.

Setting up the appearance of the
Interlocked Push button when it is pressed
and released

In the States tab, specify what the button looks like when it is
pressed and released at runtime.

For tips about configuring states, see page 10-1.
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Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.
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Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Browse button
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Connecting the Interlocked Push button
to data

In the Connections tab, specify the tag with which the button
exchanges data. Interlocked push buttons have no Indicator control.
For information about assigning tags, see page 9-32.

Type the tag name

here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The Value control triggers the button’s action. For example,
when the tag assigned to the control is set to 1, the data source
changes the machine to Auto mode.

Setting up Ramp buttons

Use the Ramp button to increase or decrease the value of a tag.

Ramp buttons can change a tag by either an integer or floating
point value. You can use two ramp buttons together to create an
increase/decrease control.

Each time the operator presses the button, the tag changes to the
next highest or next lowest value, depending on how you set up the
button.

To set up a Ramp button:

1. Double-click the Ramp button.
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2. In the Ramp Push Button Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance of the Ramp
button and how it works

In the General tab, specify what the button looks like, and whether
the button ramps a value up or down.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color.
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Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Shape Click a shape for the button.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Ramp up Click Ramp up to increase the value of the tag.

Ramp down Click Ramp down to decrease the value of the tag.

Upper limit This box appears only if you click Ramp up. Type the
upper limit for the tag’s value.

Lower limit This box appears only if you click Ramp down. Type
the lower limit for the tag’s value.

Ramp value Type the positive value by which the button increases
or decreases the tag’s value.
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Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.

Setting up a caption and image for the Ramp
button

In the Label tab, specify what text or image appears on the button.
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Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.
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Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Browse button



Preface

10-68 � RSView Machine Edition User’s Guide

Setting up whether the Ramp button press
repeats when held down

In the Timing tab, set up whether or not the button press repeats
automatically when the operator presses and holds the button
down. You can also set up the rate at which the button press
repeats.

For more information about auto repeat, see page 10-11.

Auto repeat rate Select the number of times per second a button
press is registered when the button goes into auto repeat mode. If
you don’t want the button press to repeat automatically, click 0.

Auto repeat delay Click the number of milliseconds or seconds
the button must remain pressed before auto repeat starts.

Connecting the Ramp button to data

In the Connections tab, specify the tag with which the button
exchanges data. Ramp buttons have no Indicator control. For
information about assigning tags, see page 9-32.

Value The Value control triggers the button’s action. For example,
when the tag assigned to the control is increased, the data source
increases a motor’s speed.

How to use Numeric displays
Use the Numeric display object to show the operator numeric
information from the data source. For example, you might use a
Numeric display to show the current temperature of an oven.



� 10-69Configuring graphic objects

How values are displayed

The Numeric display shows the value of the Value control at the
data source. The value shown depends on whether the Value
control value is a floating point or integer. Integer values are
displayed as is. Floating point values are rounded to fit the display.

For example, if the Numeric display is configured to show 6 digits,
1234.56 is rounded to 1234.6. 1234.44 is rounded to 1234.4. The
decimal counts as one of the digits.

For more information about how values are rounded, see page 7-3.

Number formats

The Numeric display uses the number format you set up on the
runtime computer. For example, if the runtime computer is set up
to use a comma for the decimal symbol, the Numeric display uses a
comma for the decimal symbol.

For information about specifying time, date, and number formats
on the RAC6182, see page 21-3. For information about specifying
time, date, and number formats in Windows 2000, see page 22-3.

Problems with displaying values

If the Value control is unassigned, the Numeric display is filled
with asterisks (*).

If the value, including the decimal point and minus sign,
contains more digits than specified for the display, the Numeric
display is filled with asterisks.

If the Numeric display is sized so that the value cannot be fully
displayed, the value is truncated and the last displayable digit is
replaced with an asterisk.

If the value doesn’t fit on the first line of the display, and there is
room for a second line, the value continues onto the second line.

Setting up Numeric displays

The Numeric display shows the operator numeric values from the
data source.

Specify the appearance of the display, the number of digits to
display, and the tag or expression to display.
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To set up a Numeric display:

1. Double-click the Numeric display.

2. In the Numeric Display Properties dialog box, fill in the options
on each tab, as described in the sections that follow. When you
are finished, click OK.

Setting up the appearance of the Numeric
display

In the General tab, specify what the Numeric display looks like at
runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
Numeric display’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
Numeric display’s border to have the same color as the display’s
background.



� 10-71Configuring graphic objects

Clear the check box if you want the Numeric display’s border to
have a different color than the display’s background, and then
choose a Border color.

Back color Click the color box, and then click a color for the
Numeric display’s background.

Border color Click the color box, and then click a color for the
Numeric display’s border.

Back style Click Solid to cover objects or the display background
behind the Numeric display. Click Transparent to allow objects or
the display background behind the Numeric display to show
through.

Pattern style Click a pattern style for the display.

Pattern color Click the color box, and then click a color for the
pattern.

Fore color Click the color box, and then click a color for the text
in the display.

Blink Select the check box to make the display blink at runtime.
Clear the check box to prevent the display from blinking at
runtime.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Alignment Click a position in the grid, relative to the Numeric
display. In the default alignment position, the text is centered
vertically and horizontally on the display.
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Number of digits Click the maximum number of digits to display,
up to 17 digits. The decimal point and minus sign each count as a
digit.

Fill left with Select a character to fill the left of the display with if
the value at the data source contains fewer than the maximum
number of digits. If you don’t want to use a fill character, select
None.

Connecting the Numeric display to data

In the Connections tab, specify the tags or expressions whose data
is displayed. For information about assigning tags and expressions,
see page 9-32.

Type the tag name

or expression here.

The arrow shows

that the control is a

read control. You

cannot write a

value to the

control.

Value The Value control’s value is shown in the display. For
example, the display can show the temperature of an oven.

Polarity The Polarity control determines whether or not a minus
sign is displayed. A minus sign is displayed when this control has a
positive non-zero value.

If the Polarity control is assigned, it overrides the polarity of the
Value control’s value.

If the Polarity control uses a tag with a floating point value, values
of less than .5 are rounded down (to zero) and values of .5 or
greater are rounded up (to 1).
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Setting up Numeric Input Enable buttons

The operator can press the Numeric Input Enable button to open a
numeric pop-up keypad or scratchpad. The operator can enter a
number in the keypad or scratchpad, and then send the number to
the data source.

For more information about using the Numeric Input Enable
button and the numeric pop-ups, see page 24-3.

Specify the appearance of the button, whether the button opens a
keypad or scratchpad, and how the button interacts with the data
source.

To set up a Numeric Input Enable button:

1. Double-click the Numeric Input Enable button.

2. In the Numeric Input Enable Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.
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Setting up the appearance and action of the
Numeric Input Enable button

In the General tab, specify what the button looks like at runtime,
whether the button opens the keypad or scratchpad, and the type of
data the operator can enter.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color.

Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Shape Click a shape for the button.
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Numeric pop--up Select whether to use the keypad or scratchpad.

To use the scratchpad, the runtime computer must have an external
keyboard or keypad.

Decimal point Click Implicit if the operator manually enters the
decimal point and you want the decimal point to be used when the
value is sent to the Value control.

Click Fixed Position if the values to enter in the pop-up always
have the same number of digits after the decimal point. If you select
this type of decimal point, specify a ”Digits after decimal” value.
The decimal point is stripped when the value is sent to the Value
control.

Minimum value Type the minimum value to send to the Value
control. For the Fixed Position decimal point, the minimum applies
to the stripped value, not the displayed value.

If you use the Optional Expression control, the minimum also
applies to the value sent to the expression.

Maximum value Type the maximum value to send to the Value
control. For the Fixed Position decimal point, the maximum applies
to the stripped value, not the displayed value.

If you use the Optional Expression control, the maximum also
applies to the value sent to the expression.

Digits after decimal If you select the Fixed Position decimal
point, select the number of digits to appear after the decimal point.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.
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Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.

Setting up a caption or image for the
Numeric Input Enable button

In the Label tab, specify what text or image to display on the
button.
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Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the font list.
Type or click a size for the font in the size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Browse button
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Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Setting up the how the Numeric Input
Enable button’s pop-up works with an Enter
key

In the Timing tab, set up the timing and handshake settings for the
Enter key.

For information about using Enter key handshaking, see page
10-12.
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Enter key control delay Click the number of milliseconds or
seconds to delay between pressing the Enter key and setting the
Enter control to 1. Specify the tag to use for the Enter control in
the Connections tab.

Enter key hold time Click the number of milliseconds or seconds
the Enter control remains at a value of 1. This setting applies only if
the Enter control is assigned and the Enter handshake control is not
assigned (in the Connections tab).

Enter key handshake time Click the maximum number of
seconds the Enter control remains at a value of 1. This setting
applies only if the Enter control and Enter handshake control are
both assigned (in the Connections tab).

Handshake reset type Click Non-zero Value to reset the Enter
control when the Enter handshake control is a non-zero value.
Click Zero to Non-zero transition to reset the Enter control when
the Enter handshake control changes from zero to a non-zero value.

Connecting the Numeric Input Enable button
to data

In the Connections tab, specify the tags or expression with which
the Numeric Input Enable button exchanges data. For information
about assigning tags and expressions, see page 9-32.

Type the tag name,

or expression if

applicable, here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The numeric value the operator enters is sent to the Value
control. For example, the operator could enter a value to change the
fill level for a tank.

If you do not assign a tag to this control, at runtime when the
operator presses the button the pop-up keypad or scratchpad does
not open.
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Optional Expression The Optional Expression control is an
optional write control. Assign a write expression to this control.
When the operator enters a value, the expression’s logic is
performed on the value, and the result is sent to the Value control.

The write expression must contain a question mark (?) as a
placeholder for the value the operator enters at runtime.

For more information about write expressions, see page 12-20.

Enter The Enter control accepts values of 0 or 1 only. The control
determines how long the Enter key press is registered. No further
values can be entered by the button when the Enter control is set
to 1.

Enter handshake The Enter handshake control resets the Enter
control, using the ”Handshake reset type” option specified on the
Timing tab.

Use this control for Enter key handshaking if you want to reset the
Enter control when a value in the programmable controller
changes.

How to use String displays
Use the String display object to show the operator messages from
the data source. For example, you might configure the data source
to generate strings that report on the state of a process or operation,
or that provide instructions about what the operator should do
next. At runtime the display shows the operator the string value of
the Value control at the data source.

You can use hex control codes to format and position the text
strings. For more information, see the Help.

How values are displayed
If the Value control is unassigned, the String display is blank.

RSView displays the number of characters (bytes) specified for
the tag assigned to the Value control. If a longer string is sent to
the control, only the specified number of characters is displayed.

Setting up String displays
The String display shows the operator string values from the data
source.

Specify the appearance of the display and the tag or expression to
display.
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To set up a String display:

1. Double-click the String display.

2. In the String Display Properties dialog box, fill in the options on
each tab, as described in the sections that follow. When you are
finished, click OK.

Setting up the appearance of the String
display

In the General tab, specify what the String display looks like at
runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the String
display’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
String display’s border to have the same color as the display’s
background.
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Clear the check box if you want the String display’s border to have
a different color than the display’s background, and then choose a
Border color.

Back color Click the color box, and then click a color for the
String display’s background.

Border color Click the color box, and then click a color for the
String display’s border.

Back style Click Solid to cover objects or the display background
behind the String display. Click Transparent to allow objects or the
display background behind the String display to show through.

Pattern style Click a pattern style for the display.

Pattern color Click the color box, and then click a color for the
pattern.

Fore color Click the color box, and then click a color for the text
in the display.

Blink Select the check box to make the display blink at runtime.
Clear the check box to prevent the display from blinking at
runtime.

Font, size, and style Click a font for the text in the Font list. Type
or click a size for the font in the Size box. Click B to make the font
bold, click I to make the font italic, click U to underline the text.

Alignment Click a position in the grid, relative to the String
display. In the default alignment position, the text is centered
vertically and horizontally on the display.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the display.

Clear this check box to wrap on characters instead. If there is room
for another line, the rest of the truncated word is displayed on the
next line.
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Connecting the String display to data

In the Connections tab, specify the tag or expression whose data is
displayed. For information about assigning tags and expressions, see
page 9-32.

Type the tag name

or expression here.

The arrow shows

that the control is a

read control. You

cannot write a

value to the

control.

Value The Value control’s value is shown in the display. For
example, the display can show a message about the status of a
conveyor belt.

Assign a tag or expression that can support up to 82 characters
(bytes).

Setting up String Input Enable buttons

The operator can press the String Input Enable button to open a
string pop-up scratchpad or keyboard. The operator can enter text
in the scratchpad or keyboard, and then send the string to the data
source.

For more information about using the String Input Enable button
and the string pop-ups, see page 24-7.

Specify the appearance of the button, whether the button opens a
scratchpad or keyboard, and how the button interacts with the data
source.

To set up a String Input Enable button:

1. Double-click the String Input Enable button.
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2. In the String Input Enable Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance and action of the
String Input Enable button

In the General tab, specify what the button looks like at runtime,
whether the button opens the scratchpad or keyboard, and the
number of characters the operator can enter.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color.
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Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Shape Click a shape for the button.

String pop--up Select whether to use the scratchpad or keyboard.

To use the scratchpad, the runtime computer must have an external
keyboard or keypad.

Number of input characters Specify the maximum number of
input characters for the pop-up to accept, up to 82 characters.

Fill character Select a character to pad the string with if the
operator enters fewer than the maximum number of input
characters.

When the value is sent to the Value control, the fill characters are
placed after the string the operator enters. The characters do not
appear in the pop-up.

Mask scratchpad Check this box to hide the text the operator
enters by using the # character instead of the actual text.
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If you don’t want to hide the text the operator types, clear the
check box.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.

Setting up a caption or image for the String
Input Enable button

In the Label tab, specify what text or image to display on the
button.
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Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the font list.
Type or click a size for the font in the size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.
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Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Browse button
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Setting up the how the String Input Enable
button’s pop-up works with an Enter key

In the Timing tab, set up the timing and handshake settings for the
Enter key.

For information about using Enter key handshaking, see page
10-12.

Enter key control delay Click the number of milliseconds or
seconds to delay between pressing the Enter key and setting the
Enter control to 1. Specify the tag to use for the Enter control in
the Connections tab.

Enter key hold time Click the number of milliseconds or seconds
the Enter control remains at a value of 1. This setting applies only if
the Enter control is assigned and the Enter handshake control is not
assigned (in the Connections tab).

Enter key handshake time Click the maximum number of
seconds the Enter control remains at a value of 1. This setting
applies only if the Enter control and Enter handshake control are
both assigned (in the Connections tab).

Handshake reset type Click Non-zero Value to reset the Enter
control when the Enter handshake control is a non-zero value.
Click Zero to Non-zero transition to reset the Enter control when
the Enter handshake control changes from zero to a non-zero value.
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Connecting the String Input Enable button
to data

In the Connections tab, specify the tags or expression with which
the String Input Enable button exchanges data. For information
about assigning tags and expressions, see page 9-32.

Type the tag name,

or expression if

applicable, here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The string value the operator enters is sent to the Value
control. Assign a tag that can support up to 82 characters (bytes).

When the operator presses the Enter key, the alphanumeric string is
sent to the data source.

If you do not assign a tag to this control, at runtime when the
operator presses the button the pop-up does not open.

Enter The Enter control accepts values of 0 or 1 only. The control
determines how long the Enter key press is registered. No further
values can be entered by the button when the Enter control is set
to 1.

Enter handshake The Enter handshake control resets the Enter
control, using the ”Handshake reset type” option specified on the
Timing tab.

Use this control for Enter key handshaking if you want to reset the
Enter control when a value in the programmable controller
changes.

Setting up Goto Display buttons

Use the Goto Display button to open a graphic display. You can
create as many Goto Display buttons as you need, but each button
opens a single display only.

For more information about using Goto Display buttons, see
page 19-4.
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Specify the graphic display to open, and a parameter file to use with
tag placeholders in the display (if any).

To set up a Goto Display button:

1. Double-click the Goto Display button.

2. In the Goto Display Button Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.
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Setting up the appearance of the Goto
Display button

In the General tab, specify what the button looks like at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
button’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
button’s border to have the same color as the button’s background.

Clear the check box if you want the button’s border to have a
different color than the button’s background, and then choose a
Border color.

Back color Click the color box, and then click a color for the
button’s background.

Border color Click the color box, and then click a color for the
button’s border.

Back style Click Solid to cover objects or the display background
behind the button. Click Transparent to allow objects or the display
background behind the button to show through.

Pattern style Click a pattern style for the button.

Pattern color Click the color box, and then click a color for the
pattern.

Highlight color Click the color box, and then click a color for the
selection border that appears around the button when it is pressed.
If the button does not use a border, the highlight color is not visible
when the button is pressed.

Blink Select the check box to make the button blink at runtime.
Clear the check box to prevent the button from blinking at runtime.

Shape Click a shape for the button.

Display Type the name of the graphic display to open when the
button is pressed. To browse for a graphic display, click the Browse
button.

Browse button
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Parameter file Type the name of the parameter file to run when
the button is pressed. To browse for a parameter file, click the
Browse button.

A parameter file assigns tags to tag placeholders in the display when
the display opens.

Top position Type the number of pixels from the top edge of the
project window to position the display. This option applies only if
the graphic display the button opens is an On Top display.

Left position Type the number of pixels from the left edge of the
project window to position the display. This option applies only if
the graphic display the button opens is an On Top display.

Display position enabled Check this box if you want to use the
Top position and Left position options to position the display the
button opens.

Horizontal margin Type the number of pixels for the
touch-insensitive margin inside the object’s left and right edges.

For information about using touch margins, see page 10-4.

Vertical margin Type the number of pixels for the
touch-insensitive margin inside the object’s top and bottom edges.

Audio Select this check box to beep the computer’s internal speaker
when the operator presses the button.

If the computer running the display does not have an internal
speaker, pressing the button does not trigger a beep.
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Setting up a caption or image for the Goto
Display button

In the Label tab, specify what text or image to display on the
button.

Caption Type the text you want to appear on the button. If you
don’t want any text on the button, leave the Caption box blank.

Caption back style Click Solid to cover the button’s background
(such as a graphic image) with the text. Click Transparent to allow
the button’s background to show through between the letters.

Font, size, and style Click a font for the caption in the font list.
Type or click a size for the font in the size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.
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The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the text is centered vertically and
horizontally on the button.

Image Type the name of the image file to display on the button, or
click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the button’s background
behind the image. Click Transparent to allow the button’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the button. Clear this check box to crop the image to the area of
the button if it is too large to fit on the button.

Browse button
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If the button’s shape is a Circle or Ellipse, the image is shaped to fit
inside the circle or ellipse.

Alignment Click a position in the grid, relative to the button. In
the default alignment position, the image is centered vertically and
horizontally on the button.

Setting up Display List selectors

The Display List selector is a list of displays in the project. Each
graphic display is represented by a different state in the Display
List selector. An operator can scroll through the list of displays, and
then select the display to open.

For more information about using Display List selectors, see
page 19-6.

Specify the graphic displays associated with each state. At runtime,
the operator selects a graphic display by highlighting the state in the
list, and then pressing an Enter button or key to select the state.

To set up a Display List selector:

1. Double-click the Display List selector.
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2. In the Display List Selector Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance of the
Display List selector

In the General tab, specify what the Display List selector looks like
at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
Display List selector’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
Display List selector’s border to have the same color as the
selector’s background.

Clear the check box if you want the Display List selector’s border
to have a different color than the selector’s background, and then
choose a Border color.
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Back color Click the color box, and then click a color for the
Display List selector’s background.

Border color Click the color box, and then click a color for the
Display List selector’s border.

Pattern style Click a pattern style for the Display List selector.

Pattern color Click the color box, and then click a color for the
pattern.

Selection back color Click the color box, and then click a color
for the background of a selected item in the list.

Selection fore color Click the color box, and then click a color for
the text of a selected item in the list.

Blink Select the check box to make the Display List selector blink
at runtime. Clear the check box to prevent the selector from
blinking at runtime.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption truncate Click Word to cut off captions that exceed the
maximum length at the beginning of a word. Click Character to cut
off captions that exceed the maximum length in the middle of a
word.

The maximum caption length depends on the width of the Display
List selector and the font size.

When a caption has been truncated, an asterisk ( * ) appears at the
right end of the caption to indicate that text is missing.
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Number of states Click the number of states you want the
Display List selector to have.

Key navigation Select this check box to allow the operator to
navigate to the Display List selector and give it focus using the
keyboard.

For more information about key navigation, see page 10-8.

Setting up which displays appear in the
Display List selector

In the States tab, specify which graphic display to use for each of
the Display List selector’s states, and how each graphic display is
named in the list.

For tips about configuring states, see page 10-1.

Display Type the name of the graphic display for the selected state.
To browse for a graphic display, click the Browse button.

Browse button
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Use display name Select this check box to use the name of the
graphic display as the caption for the state. Clear this check box to
type a different caption for the state.

Caption Type the text you want to appear as the name of the
graphic display in the Display List selector.

Caption back style Click Solid to cover the Display List selector’s
background with the text. Click Transparent to allow the Display
List selector’s background to show through between the letters.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Alignment Click a position in the grid for the text, relative to the
Display List selector. In the default alignment position, the text is
aligned at the left edge of the Display List selector.

How to use indicators

Indicators display the status of processes or operations by showing
different colors, captions, images, or options to reflect different
states.

You can create different kinds of indicators, depending on your
needs:

Multistate indicators display the current state of a process or
operation by showing a different color, caption, or image to reflect
different states.
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Symbols display a symbol that changes to match the state of a
process or operation. This allows the operator to see the status of a
process or operation at a glance.

List indicators display a list of states for a process or operation, and
highlight the current state. Each state is represented by a caption in
the list. This type of indicator is useful if you want operators to
view the current state, but also see the other possible states. For
sequential processes, the list can inform the operator about what
happens next.

Setting up Multistate indicators

The Multistate indicator displays the current state of a process or
operation by showing a different color, caption, or image for each
state.

Specify the state values of the Multistate indicator. At runtime, the
indicator displays the state whose value matches the Indicator
control’s value.

To set up a Multistate indicator:

1. Double-click the Multistate indicator.

2. In the Multistate Indicator Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.
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Setting up the appearance of the Multistate
indicator and its number of states

In the General tab, specify what the indicator looks like, and the
number of states for the indicator.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
indicator’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
indicator’s border to have the same color as the indicator’s
background.

Clear the check box if you want the indicator’s border to have a
different color than the indicator’s background, and then choose a
Border color on the States tab.

Back style Click Solid to cover objects or the display background
behind the indicator. Click Transparent to allow objects or the
display background behind the indicator to show through.

Shape Click a shape for the indicator.

Number of states Click the number of states you want the
indicator to have.

Setting up how the Multistate indicator’s
appearance changes to match its value

In the States tab, specify how the indicator’s appearance changes
when its tag or expression’s value changes.

For tips about configuring states, see page 10-1.

The error state

The Multistate indicator’s error state is displayed at runtime when:

the Indicator control is unassigned

the Indicator control’s value does not match one of the state
values you set up.
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Value Type the integer value for the selected state. When the
Indicator control changes to this value, the indicator’s appearance
changes to use the settings you specify for the state.

Back color Click the color box, and then click a color for the
indicator’s background.

Border color Click the color box, and then click a color for the
indicator’s border.

Blink Select the check box to make the indicator blink at runtime.
Clear the check box to prevent the indicator from blinking at
runtime.

Pattern style Click a pattern style for the indicator.

Pattern color Click the color box, and then click a color for the
pattern.
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Caption Type the text you want to appear on the indicator. If you
don’t want any text on the indicator, leave the Caption box blank.

Caption back style Click Solid to cover the indicator’s
background (such as a graphic image) with the text. Click
Transparent to allow the indicator’s background to show through
between the letters.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the caption. Clear this check box
to wrap on characters instead.

Alignment Click a position in the grid for the text, relative to the
indicator. In the default alignment position, the text is centered
vertically and horizontally on the indicator.



� 10-105Configuring graphic objects

Image Type the name of the image file to display on the indicator,
or click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Image back style Click Solid to cover the indicator’s background
behind the image. Click Transparent to allow the indicator’s
background to show through spaces in the image.

Image color Click the color box, and then click a color for a
monochrome image. You cannot change the color of grayscale or
color images.

Image back color Click the color box, and then click a color for
the background of a monochrome image. You cannot change the
background color of grayscale or color images.

Image blink Select the check box to make a monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime. You cannot make grayscale or color images
blink.

Image scaled Select the check box to scale the image to fit the area
of the indicator. Clear the check box to crop the image to the area
of the indicator if it is too large to fit on the indicator.

If the indicator shape is a Circle or Ellipse, the image is shaped to
fit inside the circle or ellipse.

Alignment Click a position in the grid for the image, relative to the
indicator. In the default alignment position, the image is centered
vertically and horizontally on the indicator.

Browse button
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Connecting the Multistate indicator to data

In the Connections tab, specify the tag or expression from which
the indicator receives data. For information about assigning tags
and expressions, see page 9-32.

Indicator The Indicator control provides visual feedback to the
indicator object of its state. For example, the control can show the
status of a hoist.

Setting up Symbols

The Symbol is an indicator that displays a single monochrome
image that changes color to match the state of a process or
operation. This allows the operator to see the status of a process or
operation at a glance.

Specify the state values, and the color of the image for each state.
At runtime, the indicator displays the state that matches the
Indicator control’s value.

To set up a Symbol:

1. Double-click the Symbol.
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2. In the Symbol Properties dialog box, fill in the options on each
tab, as described in the sections that follow. When you are
finished, click OK.

Setting up the appearance of the Symbol
and its number of states

In the General tab, specify what the indicator looks like at runtime,
and the number of states for the indicator.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
indicator’s border. Border width is measured in pixels.

Shape Click a shape for the indicator.
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Number of states Click the number of states you want the
indicator to have.

Image Type the name of the monochrome image file to display on
the indicator, or click the Browse button to browse for the image.

If you click the Browse button, the Image Browser opens. Click an
image in the Select image box, and then click OK.

Setting up how the Symbol changes
appearance when its value changes

In the States tab, specify how the indicator’s appearance changes
when its tag or expression’s value changes.

For tips about configuring states, see page 10-1.

The error state

The Symbol’s error state is displayed at runtime when:

the Indicator control is unassigned

the Indicator control’s value does not match one of the state
values you set up.

Browse button
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Value Type the integer value for the selected state. When the
Indicator control changes to this value, the indicator’s appearance
changes to the settings you specify for the state.

Border color Click the color box, and then click a color for the
indicator’s border.

Image color Click the color box, and then click a color for the
monochrome image.

Image back color Click the color box, and then click a color for
the background of the monochrome image.
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Image back style Click Solid to cover the indicator’s background
behind the image. Click Transparent to allow the indicator’s
background to show through spaces in the image.

Image blink Select the check box to make the monochrome image
blink at runtime. Clear the check box to prevent the image from
blinking at runtime.

Connecting the Symbol to data

In the Connections tab, specify the tag or expression from which
the indicator receives data. For information about assigning tags
and expressions, see page 9-32.

Type the tag name

or expression here.

The arrow shows

that the control is a

read control. You

cannot write a

value to an

Indicator control.

Indicator The Indicator control provides visual feedback to the
indicator object of its state. For example, the control can show the
state of a pump.

Setting up List indicators

The List indicator displays a list of states for a process or operation,
and highlights the current state.

Each state is represented by a caption in the list. This type of
indicator is useful if you want operators to view the current state,
but also see the other possible states.

For sequential processes, the list can inform the operator about
what happens next.

Specify the state values of the List indicator. At runtime, the
indicator highlights the state whose value matches the Indicator
control’s value.

The List indicator has no error state. If the value of the Indicator
control does not match any of the available states, none of the states
is highlighted.
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To set up a List indicator:

1. Double-click the List indicator.

2. In the List Indicator Properties dialog box, fill in the options on
each tab, as described in the sections that follow. When you are
finished, click OK.

Setting up the appearance of the List
indicator and its number of states

In the General tab, specify what the indicator looks like at runtime,
and the number of states for the indicator.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
indicator’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
indicator’s border to have the same color as the indicator’s
background.
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Clear the check box if you want the indicator’s border to have a
different color than the indicator’s background, and then choose a
Border color.

Back color Click the color box, and then click a color for the
indicator’s background.

Border color Click the color box, and then click a color for the
indicator’s border.

Pattern style Click a pattern style for the indicator.

Pattern color Click the color box, and then click a color for the
pattern.

Selection fore color Click the color box, and then click a color for
the text of a selected item in the list.

Selection back color Click the color box, and then click a color
for the background of a selected item in the list.

Blink Select the check box to make the indicator blink at runtime.
Clear the check box to prevent the indicator from blinking at
runtime.

Font, size, and style Click a font for the indicator’s text in the
Font list. Type or click a size for the font in the Size box. Click B to
make the font bold, click I to make the font italic, click U to
underline the text.

Caption truncate Click Word to cut off captions that exceed the
maximum length at the beginning of the word. Click Character to
cut off captions that exceed the maximum length in the middle of a
word.

The maximum caption length depends on the width of the indicator
and the font size.

When a caption has been truncated, an asterisk ( * ) appears on the
right of the caption to indicate that text is missing.
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Number of states Click the number of states you want the
indicator to have.

Setting up how the List indicator’s
appearance changes when its value
changes

In the States tab, specify how the indicator’s appearance changes
when its tag or expression’s value changes.

For tips about configuring states, see page 10-1.

Value Type the integer value for the selected state. When the
Indicator control changes to this value, this state becomes the
selected state.
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Caption Type the text to display on the indicator for this state.

Caption back style Click Solid to use the Caption back color
behind the text. Click Transparent to allow the indicator’s
background to show through between the letters.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only if the Caption back
style is Solid.

Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Alignment Click a position in the grid for the text, relative to the
indicator. In the default alignment position, the text is positioned at
the left of the indicator, inside the border (if a border is used).

Connecting the List indicator to data

In the Connections tab, specify the tag or expression from which
the indicator receives data. For information about assigning tags
and expressions, see page 9-32.

Type the tag name

or expression here.

The arrow shows

that the control is a

read control. You

cannot write a

value to an

Indicator control.

Indicator The Indicator control provides visual feedback to the
indicator object of its state. For example, the control can show the
mode of operation of a blower.
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How to use bar graphs, gauges, and scales

Bar graphs and gauges display graphical representations of numeric
values.

Bar graphs make it easy to compare values

Bar graphs display numeric values in bar graph format. They are
useful for allowing comparisons between multiple values, or for
representing the fill levels of tanks for which a reading on a vertical
scale is appropriate.

For example, one bar graph can show the required level of a tank,
and a second bar graph can show the actual level of the tank. The
first graph changes to represent the required level for a particular
application, and the second graph changes as the actual level in the
tank rises or drops.

Bar graphs are more useful than Numeric displays when it’s
important for the operator to analyze the relationships between
numeric values. It’s easier for the operator to see that one graph is
at a lower level than the other, or that one’s fill is blue and the
other’s is yellow, than it is to subtract one numeric value from
another.

Thresholds change a bar graph’s fill color

As it fills, a bar graph can change its fill color to help an operator
recognize abnormal conditions. The change in color happens when
the tag (or expression) value crosses a threshold you set up for the
graph. For example:

if the level of the tank of ingredients is lower than the recipe
requires, the graph can show the tank’s level in red

if the recipe will empty the tank, the graph can show the level in
yellow

if the level is higher than the level the recipe requires, the graph
can show the level in green

If you want to use a different fill color on a bar graph to show
abnormal conditions, make sure enough of the new fill color is
visible when the abnormal condition occurs that the operator can
see the condition.
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Use bar graphs with scales to show limits

Unlike gauges, bar graphs do not have integrated scales. You can
show values on a bar graph using a scale graphic object and text.

Scales consist of major ticks, represented by long lines, and minor
ticks, represented by short lines. To indicate the values of major or
minor ticks, use text objects.

Gauges make it easy to see limits

Gauges display numeric values in dial format. They are useful for
displaying a value in relation to its lower and upper limits.

For example, a temperature gauge shows the current temperature in
relation to its minimum and maximum extremes. By looking at the
position of the needle on the gauge (pointing left, up, or right), the
operator can tell at a glance whether the temperature is nearer its
lower limit, nearer the middle, or nearer its upper limit.

Gauges are used instead of Numeric displays when it’s important
for the operator to recognize an abnormal condition instantly,
either from far away when the scale on the gauge isn’t visible, or
before the operator has had the opportunity to determine the exact
reading on the gauge. This characteristic of gauges is one of the
reasons why they are used in automobile instrumentation.

Thresholds change a gauge’s fill color

As the needle sweeps higher on a gauge, the gauge can fill the area
behind the needle with a color. The gauge can change its fill color
to help an operator recognize abnormal conditions. The change in
color happens when the tag (or expression) value crosses a
threshold you set up for the gauge. For example:

if the temperature of an oven is lower than required for a recipe,
the gauge can show the temperature in blue

if the temperature is in the correct range for the recipe, the
gauge can show the temperature in green

if the temperature is higher than the recipe allows, the gauge can
show the temperature in red

If you plan to use colored fills on a gauge to show abnormal
conditions, make sure enough of the fill is visible when the
abnormal condition occurs that the operator can see the condition.
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IMPORTANT Some people are color blind to red and green so don’t
rely on color alone to establish meaning.

Setting up bar graphs

Use bar graphs to represent numeric values by filling and emptying
as the values rise and fall.

Specify the minimum and maximum values of the bar graph, and
the tag or expression to which the graph is connected. At runtime,
the graph shows the value of the tag or expression in relation to the
graph’s minimum and maximum values.

To set up a bar graph:

1. Double-click the bar graph.

2. In the Bar Graph Properties dialog box, fill in the options on
each tab, as described in the sections that follow. When you are
finished, click OK.
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Setting up the appearance of the bar graph

In the General tab, specify what the bar graph looks like at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the bar
graph’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the bar
graph’s border to have the same color as the bar graph’s
background.

Clear the check box if you want the bar graph’s border to have a
different color than the bar graph’s background.

Back style Click Solid to cover objects or the display background
behind the bar graph. Click Transparent to allow objects or the
display background behind the bar graph to show through.

Back color Click the color box, and then click a color for the bar
graph’s background.

Border color Click the color box, and then click a color for the bar
graph’s border.

Fill color Click the color box, and then click a color for the filled
part of the graph. The filled part represents a numeric value, and is
displayed against the graph’s background. If you use thresholds,
this color is used until the graph’s value reaches the first threshold.

Minimum value Type the minimum value to display on the graph.
If the Value control is at or below this value, the graph is empty.

Maximum value Type the maximum value to display on the graph.
If the Value control is at or above this value, the graph is filled.

Fill direction Click the direction in which to fill the graph.
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Number of thresholds Click the number of thresholds you want
the graph to have, or click 0 if you don’t want to use thresholds.

Threshold type Click Value to set up thresholds using constant
values. Click Percentage to set up thresholds using percentages of
the graph’s total range.

Threshold 1 value, Threshold 2 value Type a constant value, or a
percentage, depending on the threshold type. When the tag or
expression crosses this value, the fill color changes. The section of
the graph above the threshold can also begin to blink.

Fill color Click the color box, and then click a color for the filled
part of the graph above the threshold.

Blink Select the check box to make the filled section above the
threshold blink at runtime. Clear the check box to prevent the filled
section from blinking at runtime.

Connecting the bar graph to data

In the Connections tab, specify the tag or expression from which
the bar graph receives data. For information about assigning tags
and expressions, see page 9-32.

Type the tag name

or expression here.

The arrow shows

that the control is a

read control. You

cannot write a

value to a bar

graph’s tag.
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Value The Value control changes the fill level on the bar graph. For
example, the Value control can show the temperature in an oven
going up.

Setting up gauges

The gauge graphic object represents numeric values using a needle
on a dial.

Specify the minimum and maximum values of the gauge, and the
tag or expression to which the gauge is connected. At runtime, the
gauge indicates the value of the tag or expression in relation to the
gauge’s minimum and maximum values.

To set up a gauge:

1. Double-click the gauge.

2. In the Gauge Properties dialog box, fill in the options on each
tab, as described in the sections that follow. When you are
finished, click OK.

Setting up the appearance of the gauge

In the General tab, specify what the gauge looks like at runtime.
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Back style Click Solid to cover objects or the display background
behind the gauge. Click Transparent to allow objects or the display
background behind the gauge to show through.

Back color Click the color box, and then click a color for the
gauge’s background.

Fill color Click the color box, and then click a color for the filled
part of the gauge. The filled part represents a numeric value, and is
displayed against the gauge’s background. If you use thresholds,
this color is used until the gauge’s value reaches the first threshold.

Line style Click a line style for the gauge’s scale. If you want a line
style other than solid, the line width must be 1 pixel.

Line width Type a number to change the line thickness of the
gauge’s scale. Line width is measured in pixels.

Needle color Click the color box, and then click a color for the
gauge’s needle.

Fore color Click the color box, and then click a color for the
gauge’s scale. The scale is the curved line and ticks that form the
dial shape.

Sweep style Click Point to point the needle at the scale as the
needle sweeps over the gauge. Click Fill to fill the area behind the
needle with color as the needle sweeps over the gauge.

Needle width Type a number to change the thickness of the
gauge’s needle. Needle width is measured in pixels.

Major ticks Click the number of major ticks you want on the
gauge’s scale.

Minor ticks Click the number of minor ticks you want on the
gauge’s scale. Minor ticks are spaced evenly between the major
ticks.

Font, size, and style Click a font for the gauge’s legends in the
Font list. Type or click a size for the font in the Size box. Click B to
make the font bold, click I to make the font italic, click U to
underline the text.

Setting up how the gauge works

In the Display tab, specify how the gauge displays values at
runtime.
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Minimum value Type the minimum value to display on the gauge.
If the Value control is at or below this value, the needle is at the left
end of the dial.

Maximum value Type the maximum value to display on the gauge.
If the Value control is at or above this value, needle is at the right
end of the dial.

Show legend Select this check box to show numeric labels on the
gauge. The labels show the numeric value for each major tick on the
gauge. Clear this check box to remove labels from the gauge.

Digits after decimal Click the number of digits to display after
the decimal point for the numeric labels on the gauge’s scale.

Legend color Click the color box, and then click a color for the
numeric labels on the gauge’s scale.
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Number of thresholds Click the number of thresholds you want
the gauge to have, or click 0 if you don’t want to use thresholds.

Threshold type Click Value to set up thresholds using constant
values. Click Percentage to set up thresholds using percentages of
the gauge’s total range.

Threshold 1 value, and Threshold 2 value Type a constant value,
or a percentage, depending on the threshold type. When the tag or
expression crosses this value, the fill color changes. The section of
the gauge above the threshold can also begin to blink.

Threshold fill and blink indicators do not appear if the Sweep style
is Point. The Sweep style is specified in the General tab.

Fill color Click the color box, and then click a color for the filled
part of the gauge above the threshold.

Blink Select the check box to make the filled section above the
threshold blink at runtime. Clear the check box to prevent the filled
section from blinking at runtime.

Connecting the gauge to data

In the Connections tab, specify the tag or expression from which
the gauge receives data. For information about assigning tags and
expressions, see page 9-32.

Type the tag name

or expression here.

The arrow shows

that the control is a

read control. You

cannot write a

value to a

gauge’s tag.
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Value The Value control changes the position of the needle on the
gauge. For example, the Value control can show that a machine is
overheating, or that a tank is empty.

Setting up scales
Use the scale graphic object to show the possible range of values for
a bar graph.

Specify how the scale looks. Because the scale doesn’t change at
runtime, you don’t need to assign tags or expressions to it.

To place value labels on the scale (to create a legend), use text
objects. Create the text objects and then position them next to the
tick marks on the scale.

To set up a scale:

1. Double-click the scale.

2. In the Scale Properties dialog box, fill in the options on the
General tab, as described in the next section. When you are
finished, click OK.
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Setting up the appearance of the scale

In the General tab, specify what the scale looks like at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the scale’s
border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
scale’s border to have the same color as the scale’s background.

Clear the check box if you want the scale’s border to have a
different color than the scale’s background, and then choose a
Border color.

Back color Click the color box, and then click a color for the
scale’s background.

Border color Click the color box, and then click a color for the
scale’s border.

Line style Click a line style for the scale. If you want a line style
other than solid, the line width must be 1 pixel.

Line width Type a number to change the line thickness of the scale.
Line width is measured in pixels.

Fore color Click the color box, and then click a color for the lines
of the scale.

Blink Select the check box to make the scale blink at runtime.
Clear the check box to prevent the scale from blinking at runtime.

Back style Click Solid to cover objects or the display background
behind the scale. Click Transparent to allow objects or the display
background behind the scale to show through.
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Tick direction Click the direction for the ticks to face. For
example, if you are positioning the scale to the right of a vertical
bar graph, click right.

The tick direction graphic illustrates the selected tick direction.

Major ticks Click the number of major ticks to use on the scale.

Minor ticks Click the number of minor ticks to use on the scale.
Minor ticks are spaced evenly between the major ticks.

How to use Control List selectors

Control list selectors allow an operator to scroll through a list of
states for a process and select one of the states. A highlight in the
list shows the current state.

A Control List selector can show several states at the same time,
but only one state can be selected at a time. As the operator scrolls
through the list, each successive state is selected automatically. If
you want the operator to confirm the selection of a particular state
before the state’s value is written to the programmable controller,
create an Enter button on the same display as the Control List
selector, and select the “Write on enter” option.

The operator can scroll through the Control List selector using:

button objects. These are graphic objects that duplicate the
functions of keyboard keys. Use them with touch-screen
terminals. For details, see page 10-24.

the arrow keys and Enter key on a terminal’s keypad

the arrow keys and Enter key on a keyboard
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The operator presses the buttons to scroll up or down the list, or to
make selections from the list. The buttons can be set up to work
with the Control List selector that has input focus, or you can link
the buttons to a specific Control List selector. For information
about how particular buttons work with the Control List selector,
see page 10-24.

How Enter key handshaking works

When the operator selects a state in the Control List selector and
presses an Enter button or Enter key, the highlighted state’s value is
written to the programmable controller or device.

You can use Enter key handshaking to hold the value of the tag at
the programmable controller or device for a specific period of time,
to ensure the value is read before the Control List selector
overwrites the value with a new value.

For more information about using Enter key handshaking, see
page 10-12.

Setting up Control List selectors

The Control List selector is a list that allows an operator to cycle
through and select from multiple options. The Control List selector
displays the current state of a process or operation by highlighting
the state.

To set up a Control List selector:

1. Double-click the Control List selector.
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2. In the Control List Selector Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance of the
Control List selector

In the General tab, specify what the Control List selector looks like
at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
Control List selector’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
Control List selector’s border to have the same color as the
selector’s background.

Clear the check box if you want the Control List selector’s border
to have a different color than the selector’s background, and then
choose a Border color.
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Back color Click the color box, and then click a color for the
Control List selector’s background.

Border color Click the color box, and then click a color for the
Control List selector’s border.

Pattern style Click a pattern style for the selector.

Pattern color Click the color box, and then click a color for the
pattern.

Selection back color Click the color box, and then click a color
for the background of a selected item in the list.

Selection fore color Click the color box, and then click a color for
the text of a selected item in the list.

Blink Select the check box to make the selector blink at runtime.
Clear the check box to prevent the selector from blinking at
runtime.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Caption truncate Click Word to cut off captions that exceed the
maximum length at the beginning of a word. Click Character to cut
off captions that exceed the maximum length in the middle of a
word.

The maximum caption length depends on the width of the selector
and the font size.

When a caption has been truncated, an asterisk ( * ) appears on the
right of the caption to indicate that text is missing.

Number of states Click the number of states you want the
selector to have.
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Write on enter Select this check box to send the Control List
selector’s state value to the programmable controller when the
operator presses Enter.

Clear this check box to send the state value as soon as the operator
selects a new state.

Key navigation Select this check box to allow the operator to
navigate to the Control List selector and give it focus using the
keyboard.

For more information about key navigation, see page 10-8.

Setting up the Control List selector’s state
values and captions

In the States tab, set up the value and caption for each state. The
value defines the Control List selector’s action, by changing the
Value control to the value you specify when the selected state is in
effect.

For tips about configuring states, see page 10-1.
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Value Type the integer value for each state. The Value control
changes to this value when the selected state is in effect.

Caption Type the text to display in the list for this state.

Caption back style Click Solid to cover the Control List selector’s
background color with the caption’s background color. Click
Transparent to hide the caption’s background color.

Caption color Click the color box, and then click a color for the
caption’s text.

Caption back color Click the color box, and then click a color for
the caption’s background.

The caption’s background color is visible only on items in the list
that are not highlighted, and if the Caption back style is Solid.
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Caption blink Select the check box to make the caption blink at
runtime. Clear the check box to prevent the caption from blinking
at runtime.

Alignment Click a position in the grid, relative to the Control List
selector. In the default alignment position, the text is aligned on the
left side of the Control List selector.

Setting up the Control List selector to work
with an Enter key

In the Timing tab, set up the timing and handshake settings for the
Enter key.

For information about using Enter key handshaking, see page
10-12.

Enter key control delay Click the number of milliseconds or
seconds to delay between pressing the Enter key and setting the
Enter control to 1. Specify the tag to use for the Enter control in
the Connections tab.

Enter key hold time Click the number of milliseconds or seconds
the Enter control remains at a value of 1. This setting applies only if
the Enter control is assigned and the Enter handshake control is not
assigned (in the Connections tab).

Enter key handshake time Click the maximum number of
seconds the Enter control remains at a value of 1. This setting
applies only if the Enter control and Enter handshake control are
both assigned (in the Connections tab).

Handshake reset type Click Non-zero Value to reset the Enter
control when the Enter handshake control is a non-zero value.
Click Zero to Non-zero transition to reset the Enter control when
the Enter handshake control changes from zero to a non-zero value.
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Connecting the Control List selector to data

In the Connections tab, specify the tags or expression with which
the Control List selector exchanges data. For information about
assigning tags and expressions, see page 9-32.

Type the tag name,

or expression if

applicable, here.

The arrow shows

whether the control

is a read control

(arrow points left),

a write control

(arrow points right),

or a read and write

control

(double-headed

arrow).

Value The Value control triggers the state’s action. For example,
when the tag assigned to the control changes to a new state, the data
source changes a motor’s speed to a new setting.

Enter The Enter control accepts values of 0 or 1 only. The control
determines how long the Enter key press is registered. No further
values can be entered by the selector when the Enter control is set
to 1.

Enter handshake The Enter handshake control resets the Enter
control, using the ”Handshake reset type” option specified on the
Timing tab.

Use this control for Enter key handshaking if you want to reset the
Enter control when a value in the programmable controller
changes.

Setting up Local Message displays

Use Local Message displays to provide the operator with
information about what to do next, or with information about a
process. At runtime, the Local Message display shows one message
at a time.

To use local messages, create a Local Message display object in a
graphic display, and then assign a local message file to the Local
Message display.
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For more information about local messages, see page 8-29. For
information about creating local message files, see page 8-33.

Specify the Local Message display’s appearance, the file of messages
to use with the display, and the tag or expression to monitor for
message trigger values.

To set up a Local Message display:

1. Double-click the Local Message display.

2. In the Local Message Display Properties dialog box, fill in the
options on each tab, as described in the sections that follow.
When you are finished, click OK.

Setting up the appearance of the
Local Message display

In the General tab, specify what the Local Message display looks
like at runtime.

Border style Click a border style in the list, or click None to
remove the border.
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Border width Type a number to change the thickness of the Local
Message display’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
Local Message display’s border to have the same color as the
display’s background.

Clear the check box if you want the Local Message display’s border
to have a different color than the display’s background, and then
choose a Border color.

Back color Click the color box, and then click a color for the
Local Message display’s background.

Border color Click the color box, and then click a color for the
Local Message display’s border.

Back style Click Solid to cover objects or the display background
behind the Local Message display. Click Transparent to allow
objects or the display background behind the Local Message
display to show through.

Pattern style Click a pattern style for the Local Message display.

Pattern color Click the color box, and then click a color for the
pattern.

Fore color Click the color box, and then click a color for the text
of the message in the Local Message display.

Blink Select the check box to make the Local Message display
blink at runtime. Clear the check box to prevent the display from
blinking at runtime.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the Local Message display. Clear
this check box to wrap on characters instead.
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The maximum number of characters displayed in the Local Message
display depends on the size of the display and the font.

Alignment Click a position in the grid, relative to the Local
Message display. In the default alignment position, the text is
centered vertically and horizontally on the Local Message display.

Message file Type the name of the message file to use for this
Local Message display. Click the Browse button to browse for the
file instead of typing its name.

Connecting the Local Message display to
data

In the Connections tab, specify the tag or expression the Local
Message display is connected to. For information about assigning
tags and expressions, see page 9-32.

Type the tag name

or expression here.

The arrow shows

that the tag or

expression is read

only. You cannot

write a value to the

tag or expression.

Value The Value control determines which message in the message
file is displayed in the Local Message display. For example, if the
Value control is 1, the Local Message display shows the message
whose trigger value is 1.

If no message exists for the trigger value, the display is filled with
question marks (?).

Setting up Time and Date displays

A Time and Date display shows the current time and date in a
graphic display.

Specify the appearance of the Time and Date display, and the
format in which the time and date appear.

Browse button
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Time and date formats

The Time and Date display uses the time and date formats you set
up on the runtime computer. For example, if you set up the display
to use the short date format, at runtime the display uses the short
date format for the runtime computer.

For information about specifying time, date, and number formats
on the RAC6182, see page 21-3. For information about specifying
time, date, and number formats in Windows 2000, see page 22-3.

To set up a Time and Date display:

1. Double-click the Time and Date display.

2. In the Time Date Display Properties dialog box, fill in the
options on the General tab, as described in the next section.
When you are finished, click OK.
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Setting up the appearance of the
Time and Date display

In the General tab, specify what the Time and Date display looks
like at runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the Time
and Date display’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the Time
and Date display’s border to have the same color as the display’s
background.

Clear the check box if you want the Time and Date display’s border
to have a different color than the display’s background, and then
choose a Border color.

Back color Click the color box, and then click a color for the Time
and Date display’s background.

Border color Click the color box, and then click a color for the
Time and Date display’s border.

Back style Click Solid to cover objects or the display background
behind the Time and Date display. Click Transparent to allow
objects or the display background behind the Time and Date
display to show through.

Pattern style Click a pattern style for the Time and Date display.

Pattern color Click the color box, and then click a color for the
pattern.

Fore color Click the color box, and then click a color for the text
of the Time and Date display.

Blink Select the check box to make the Time and Date display
blink at runtime. Clear the check box to prevent the display from
blinking at runtime.
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Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the Time and Date display. Clear
this check box to wrap on characters instead.

The maximum number of characters displayed in the Time and
Date display depends on the size of the display and the font.

Alignment Click a position in the grid, relative to the Time and
Date display. In the default alignment position, the text is centered
vertically and horizontally on the display.

Time and date format Click the format in which to display the
time and date.

Setting up Alarm lists

The Alarm list graphic object notifies the operator when a situation
requiring immediate attention occurs. For example, the list could
display a message that warns the operator that the pressure in a
boiler is too high.

RSView comes with a default graphic display called [ALARM] that
contains an Alarm list object. You can use the display and object as
is, customize them, or create your own.

For more information about using Alarm lists, see page 13-27.

Specify the appearance of the Alarm list, and whether it displays all
alarms or only unacknowledged alarms.

To set up an Alarm list:

1. Double-click the Alarm list.
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2. In the Alarm List Properties dialog box, fill in the options on
the General tab, as described in the next section. When you are
finished, click OK.

Setting up the appearance and content of
the Alarm list

In the General tab, specify what the Alarm list looks like at
runtime, and which alarms and alarm information it contains.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the Alarm
list’s border. Border width is measured in pixels.

Border uses back color Select the check box if you want the
Alarm list’s border to have the same color as the list’s background.

Clear the check box if you want the Alarm list’s border to have a
different color than the list’s background, and then choose a Border
color.
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Back color Click the color box, and then click a color for the
Alarm list’s background.

Border color Click the color box, and then click a color for the
Alarm list’s border.

Header back color Click the color box, and then click a color for
the heading bar at the top of the list.

Header fore color Click the color box, and then click a color for
the text in the heading bar at the top of the list.

Selection back color Click the color box, and then click a color
for the background of a selected item in the list.

Selection fore color Click the color box, and then click a color for
the text of a selected item in the list.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

List type Select whether to show all alarms or only alarms that
haven’t been acknowledged.

Header Select the check box to display a heading bar at the top of
the alarm list. The heading bar provides titles for the columns of
information in the list.

Clear the check box if you don’t want to use a heading bar.
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Alarm time Select the check box to display the Alarm time
column. This column shows the time the alarm was triggered.

Clear the check box if you don’t want to use the Alarm time
column.

Acknowledge time Select the check box to display the
Acknowledge time column. This column shows the time the alarm
was acknowledged. Don’t use this column if the List type is
”Unacknowledged alarms only.”

Clear the check box if you don’t want to use the Acknowledge time
column.

Time and date format Click the format in which to display the
time and date.

Key navigation Select this check box to allow the operator to
navigate to the Alarm list and give it focus using the keyboard.

For more information about key navigation, see page 10-8.

Setting up Activity lists

The Activity list graphic object displays runtime information about
system activity:

Information messages, such as messages about tag assignments,
tag read and write activity, and macro usage.

Warning messages.

Error messages, such as messages about communication errors,
invalid values, and unassigned controls.

RSView comes with a default graphic display called [ACTIVITY]
that contains an Activity list object. You can use the display and
object as is, customize them, or create your own.
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For more information about using Activity lists, see page 15-8.

Specify the appearance of the Activity list, and whether the
operator can navigate to the list using a keyboard.

To set up an Activity list:

1. Double-click the Activity list.

2. In the Activity List Properties dialog box, fill in the options on
the General tab, as described in the next section. When you are
finished, click OK.

Setting up the appearance of the Activity
list

In the General tab, specify what the Activity list looks like at
runtime.

Border style Click a border style in the list, or click None to
remove the border.

Border width Type a number to change the thickness of the
Activity list’s border. Border width is measured in pixels.
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Border uses back color Select the check box if you want the
Activity list’s border to have the same color as the list’s
background.

Clear the check box if you want the Activity list’s border to have a
different color than the list’s background, and then choose a Border
color.

Back color Click the color box, and then click a color for the
Activity list’s background.

Border color Click the color box, and then click a color for the
Activity list’s border.

Fore color Click the color box, and then click a color for the text
in the Activity list.

Selection back color Click the color box, and then click a color
for the background of a selected item in the list.

Selection fore color Click the color box, and then click a color for
the text of a selected item in the list.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Key navigation Select this check box to allow the operator to
navigate to the Activity list and give it focus using the keyboard.

For more information about key navigation, see page 10-8.

Setting up Information Message displays

The Information Message display graphic object gives the operator
runtime messages about information that requires immediate
attention.
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RSView comes with a default graphic display called
[INFORMATION] that contains an Information Message display
object. You can use the display and object as is, customize them, or
create your own.

For more information about using Information Message displays,
see page 14-12.

Specify the appearance of the Information Message display.

To set up an Information Message display:

1. Double-click the Information Message display.

2. In the Information Message Display Properties dialog box, fill
in the options on the General tab, as described in the next
section. When you are finished, click OK.

Setting up the appearance of the
Information Message display

In the General tab, specify what the Information Message display
looks like at runtime.

Border style Click a border style in the list, or click None to
remove the border.
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Border width Type a number to change the thickness of the
Information Message display’s border. Border width is measured in
pixels.

Border uses back color Select the check box if you want the
Information Message display’s border to have the same color as the
display’s background.

Clear the check box if you want the Information Message display’s
border to have a different color than the display’s background, and
then choose a Border color.

Back color Click the color box, and then click a color for the
Information Message display’s background.

Border color Click the color box, and then click a color for the
Information Message display’s border.

Back style Click Solid to cover objects or the display background
behind the Information Message display. Click Transparent to allow
objects or the display background behind the Information Message
display to show through.

Pattern style Click a pattern style for the Information Message
display.

Pattern color Click the color box, and then click a color for the
pattern.

Fore color Click the color box, and then click a color for the text
of the Information Message display.

Blink Select the check box to make the Information Message
display blink at runtime. Clear the check box to prevent the display
from blinking at runtime.

Font, size, and style Click a font for the caption in the Font list.
Type or click a size for the font in the Size box. Click B to make the
font bold, click I to make the font italic, click U to underline the
text.

Word wrap Select this check box to wrap words to the next line if
they are too long for the width of the Information Message display.
Clear this check box to wrap on characters instead.
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The maximum number of characters displayed in the Information
Message display depends on the size of the display and the font.

Alignment Click a position in the grid, relative to the Information
Message display. In the default alignment position, the text is
centered vertically and horizontally on the display.
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Animating graphic
objects
This chapter describes:

the types of animation and which objects support which types of
animation

using the Animation dialog box
testing animation

using tag names, tag placeholders, and expressions when
attaching animation

setting the minimum and maximum values for animation that
uses a range of motion

using Object Smart Path� to define an object’s range of motion

configuring each type of animation
applying animation to groups

checking what kind of animation is attached to an object
changing animation settings

copying and pasting animation

Types of animation
Animation associates graphic objects with tags so the appearance or
position of an object changes to reflect changes to the tag’s value.
For example, the object’s color could change from yellow to orange
to red as the tag’s value increases. Or a slider could move from left to
right as a tag’s value increases.

You can use these types of animation:

color

fill
height

horizontal position
horizontal slider

rotation

11
Chapter
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vertical position

vertical slider

visibility

width

The Objects sample project contains many examples of animation.
In particular, see the graphic displays called “Animation I” and
“Animation II.”

Which objects can have which types of
animation?

This table summarizes which types of objects support which types
of animation. For information about the different types of graphic
objects, see page 9-1.

These objects Support these types of

animation

Drawing objects, except images,
panels, and rounded rectangles

All types

Rounded rectangles All types except rotation

All other objects Visibility

You can also attach all types of animation to groups of drawing
objects. For more information, see page 11-27.

You can attach as many types of animation to a drawing object as
you like. For example, apply width, height, horizontal position, and
vertical position animation to an object to give it the appearance of
moving into or out of the display as it shrinks and grows.

Using the Animation dialog box

To attach animation, use the Animation dialog box.

To open the Animation dialog box, do one of the following:

Select an object, and then on the View menu click Animation.

Select an object, and then on the Animation menu click an
animation type. Animation types that are not supported for the
selected object are disabled.
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Right-click an object, select Animation, and then click an
animation type. Animation types that are not supported for the
selected object are disabled.

View menu Animation menu

About the Animation dialog box

The Animation dialog box is a floating dialog box, which means you
can keep it open all the time and can move it around the screen,
select other objects, and open other dialog boxes.



Preface

11-4 � RSView Machine Edition User’s Guide

Animation tabs Expression box

Expression range Animation result

Animation tabs

Click the tab for the type of animation to configure. If the animation
type is not supported for the selected object, the boxes in the tab are
dimmed.

Touch and OLE Verb animation are not supported in machine-level
projects.

Expression box

Create an expression either by typing it or by clicking the
Expression button.

To supply a tag name for an expression, click the Tags button and
then select a name, or type the name in the Expression box. If you
use multiple tags in an expression, the first tag’s minimum and
maximum values are used if you select the “Use tag’s min and max
property values” expression range.

Enclose tag names that contain dashes or start with a number in
braces { } when you use them in an expression. This distinguishes the
characters in the tag name from the characters in the expression.

For more information about creating expressions, see Chapter 12.
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For horizontal and vertical sliders, you assign a single tag to define
animation. In the Animation tabs for slider animation, there is a Tags
box rather than an Expression box.

Expression range

Specify how to calculate the minimum and maximum values for the
tag or expression. If a value falls outside the specified range, it will be
evaluated as either the minimum or maximum value. For details, see
page 11-7.

Animation Result

Specify how the object’s appearance changes based on the result of
the expression. The boxes in this area change for each type of
animation.

For some types of animation, you specify a change of state. For
example, an object with visibility animation switches between visible
and invisible.

For other types of animation, you specify a range of motion. For
example, an object can move from a fixed starting point to a fixed
end point. The range of motion is related to the minimum and
maximum values for the expression. The object moves from the At
Minimum position to the At Maximum position as the expression
value changes to the maximum value.

Apply, Delete, and Close Buttons

These buttons do the following:

This button Does this

Apply Applies the animation configured
for the selected object or group of
objects. Choosing another tab is the
same as choosing Apply—the
animation you configured is applied
to the object.

Delete Deletes the animation for the
selected object.

Close Prompts to apply changes and
closes the dialog box.
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Using Object Smart Path to visually set
animation

Because the Animation dialog box stays open, you can go back and
forth between the dialog box and the graphic display. This makes it
easy to set the range of motion for an object because you do not
have to know how many pixels you want an object to move. Instead,
use the Object Smart Path feature. For details, see page 11-8.

Testing animation
To test the animation you have set up in a graphic display, use the
Test Display tool to switch to test display mode. When you are
finished testing, switch back to edit display mode to continue
editing.

To switch between test display and edit display modes:

� On the View menu, click Test Display or Edit Display, or click
the Test Display and Edit Display tools.

IMPORTANT Test display mode is not the same as running the
display. Test display mode does not change the
appearance or position of the display as set up in
the Display Settings dialog box.

Using tag names and tag placeholders
When configuring animation for objects, you are linking objects to
tags, so you have to specify a tag name or tag placeholder. Following
is a brief description of how to use tag names and placeholders.

Tag names

You can use tag names that you have already added to the tag
database or you can use a new tag name.

Tag placeholders

Tag placeholders allow you to create displays that can be used with
different tags.

You can use tag placeholders in:

the graphic display that opens when the project is first run

graphic displays that are opened using a Goto Display button

Edit Display tool

Test Display tool
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Use parameter files to specify which tags to substitute for which
placeholders. For information about creating parameter files, see
page 8-25.

To create a tag placeholder:

� In the Expression box, type the cross-hatch character followed
by a number (no space in between). For example, #1.

Using expressions

Many types of animation require an expression. You can use
expressions containing tag values, constants, mathematical equations,
and if-then-else logic. A tag name or tag placeholder can be included
as part of an expression, or it can stand alone as the entire
expression.

For more information about expressions, see Chapter 12.

Setting minimum and maximum values

Many types of animation require a minimum and maximum range
for the tag or expression. These values determine the start and end
points for a range of motion.

For example, if you specify a minimum of 0 and a maximum of 100,
the object will not react to values outside of this range. So, even if
the expression has a value of 200, the object does not change from its
At Maximum position.

When configuring animation, select one of these methods for
calculating the minimum and maximum values:

Use tag’s min and max property values—select this method to
use the minimum and maximum values of the first tag in the
expression. That is, if multiple tags are used in the expression, the
first tag’s minimum and maximum values are used.

For analog tags, the values are taken from the Minimum and
Maximum boxes in the Tag Database editor. For digital tags, the
minimum is 0 and the maximum is 1.

Use constant—select this method to use numeric constants. Type
the minimum and maximum values in the boxes.
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Read from tags—select this method to read two tags’ values to
determine the minimum and maximum values. Type the tag
names in the boxes, or click the Browse buttons to open the Tags
dialog box and select the tags.

If you use this method, the tags are read when the graphic display
opens. Their values at that time are used for the minimum and
maximum values. The tags are not read again after this.

Defining a range of motion

To define a range of motion for an object, do one of the following:

Use the mouse to move the object in the display. This uses the
Object Smart Path feature to visually define the range of motion.

Type values in the At Minimum and At Maximum boxes.

All motion is defined in pixels.

Animation that does not use a range of
motion

Visibility and color animation do not use a range of motion, because
these types of animation represent a change of state, not a range.

Using Object Smart Path

With Object Smart Path, you can easily set the range of motion for
an object. The following example shows how Object Smart Path
works.

Example: Using Object Smart Path to define the range of
motion for horizontal slider animation

To define a range of motion for a slider object:

1. In the Graphics Display editor, create a slider object using a line
and a rectangle, or copy a slider object from the Sliders graphic
library.

2. Open the Animation dialog box and click the Horizontal Slider
tab.

3. In the display, select the rectangle in the slider object.

Browse button
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4. In the Tag box of the Animation dialog box, specify a tag name.

5. In the display, drag the rectangle to the position that will indicate
the lowest number in the range.

In the Animation dialog box, set this position by clicking the At
Minimum check box.

6. In the display, drag the rectangle to the position that will indicate
the highest number in the range.

In the Animation dialog box, set this position by clicking the At
Maximum check box.
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7. To save the settings, click Apply.

When you finish configuring the animation, the rectangle returns
to its original position.

Configuring visibility animation

With visibility animation, an object becomes visible or invisible
based on a tag value or the result of an expression.

If an object is invisible, it is disabled.

Visibility animation is available for all objects. Visibility animation
overrides an object’s Visible property.

To configure visibility animation:

1. Select the object.

2. In the Animation dialog box, click the Visibility tab.

3. In the Expression box, create an expression.
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4. Specify the Expression True State:

Invisible—Click this if you want the object to be invisible
when the tag or expression value is true—that is, when it does
not equal 0.

Visible—Click this if you want the object to be visible when
the tag or expression value is true—that is, when it does not
equal 0.

5. Click Apply.

Example: Using visibility animation to set up security for a
graphic display

This example shows how to use visibility animation to control what
operators can see. In a graphic display that all users can access, only
the Admin user can see the graphic object to which this animation is
attached.

This example uses the security function CurrentUserName( ). The
function returns the string value of the Account ID (user name) for
the user who is currently logged in.

The CurrentUserName( ) function is case sensitive. All user names
use upper case letters, so make sure that you use upper case letters in
your expression.

To specify which user can view an object in a display:

1. Select the object to which to limit visibility.

2. Open the Animation dialog box and click the Visibility tab.

3. In the Expression box, type this:

CurrentUserName( ) == “ADMIN”

4. For the Expression True State, click Visible.
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5. Click Apply, and then click Close.

At runtime, the object will only be visible if the Admin user is
logged in.

Configuring color animation

With color animation, an object changes color based on a tag value
or the result of an expression. You can specify up to 16 color changes
(A to P) for any object. Colors can be solid or blinking. For each
color change, specify the value or threshold at which the color is to
change and specify the colors to change to. At runtime, when the
value reaches or crosses the threshold, the color changes.

Color animation is available for all drawing objects except images
and panels.
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To return to the default

colors and thresholds,

click this button.

The list box displays

the values and colors

for each threshold.

The parts of the list box

Foreground color

Background color

Threshold value

Threshold

If you select white, the color box is

not visible against the white

background of the dialog box.

A box with two colors shows the

colors the object will alternate

between when blinking.

To configure color animation:

1. Select the object.

2. In the Animation dialog box, click the Color tab.

3. In the Expression box, create an expression.

4. In the list box, select a threshold (A through P) for which to
configure a value and colors. You can change the default values
and colors for thresholds A and B. The other thresholds have no
defaults.
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5. In the Value box, type the threshold value. When the expression
value reaches this threshold, the object’s color changes.

Enter threshold values in ascending order. That is, A must be
lower than B, B must be lower than C, and so on.

To delete a value for a threshold (A - P), select the threshold and
delete the value in the Value box. In the list box, the value is
replaced with “No value.”

6. Click Solid or Blink for the foreground and background colors,
and then select the foreground and background colors to use.

Foreground colors apply to the object’s Fore color and Pattern
color properties. Background colors apply to the object’s Back
color properties.

To select a color, click the color box, and then click the desired
color.

Specify the solid color here. Specify the blinking colors here.

If you select blink, the two colors must be different.

7. Repeat steps 4 through 6 to configure additional thresholds.

8. In the Blink Rate box, specify how many seconds each blink
cycle will be. For example, if you specify four seconds, the object
will be one color for two seconds and the other color for two
seconds.

9. Click Apply.

Example 1: Creating a Text object that blinks

This example describes how to create a text object that constantly
blinks between two colors. Since the blinking is not based on
changes in tag values, the expression is simply a constant value that
matches the value for the selected threshold.

For details about creating text, see page 9-10.

1. Select the text object.

2. Open the Animation dialog box, and then click the Color tab.
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3. In the Expression box, type 0.

Zero is the default value for threshold A.

4. In the list box, click threshold A. (Leave the value in the Value
box as 0.)

5. For the foreground color, click Blink. (If desired, click Blink for
the background color too.)

6. For each color, click the color box, and then click the color to
use.

7. Click Apply.

Example 2: Creating an object that changes color as the fill
level changes

This example describes how to create a rectangle object that changes
color as the object’s fill level increases. This example uses a tag called
Hopper1\FlourLevel. The tag has a range of 1 to 100. When the
flour level reaches 80, the rectangle blinks between gray and yellow
to warn the operator that the hopper is nearly full. When the flour
level reaches 95, the rectangle blinks between gray and red.

You could use a Bar Graph object (without animation) to achieve a
similar result.

1. Double-click the rectangle to open its Properties dialog box.
Assign these properties to the rectangle:

In the Back style box, select Solid.

For the Fore color and Back color, select gray.

2. Click OK to close the properties dialog box.

3. With the rectangle selected, open the Animation dialog box, and
then click the Fill tab. Attach fill animation as follows:

In the Expression box, type Hopper1\FlourLevel (this is the
tag that controls the fill level).

For Fill Direction, click Up.

4. Click the Color tab and then attach color animation as follows:

In the Expression box, type Hopper1\FlourLevel (the same
tag that was used in the Fill tab).
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Configure the color for the normal state

In the list box, click A. (In the Value box, leave the value as 0.)

For foreground and background colors, click Solid.

For each, click the color box, and then click gray (the same
gray used for the rectangle).

Configure the color for the first warning

In the list box, click B.

In the Value box, type 80.

For foreground and background colors, click Blink.

Gray
Yellow

For the foreground colors, select gray for the first color and
yellow for the second color. Repeat for the background
colors.

Configure the color for the second warning

In the list box, click C.

In the Value box, type 95.

For the foreground and background colors, click Blink.

Gray
Red

For the foreground colors, select gray for the first color and
red for the second color. Repeat for the background colors.

5. Click Apply.

Configuring fill animation
With fill animation, the level of fill in an object is based on a tag
value (or the result of an expression) in relation to the specified
minimum and maximum values. For example, if the value of the
expression is halfway between the minimum and maximum values,
the object will be half full.
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Fill animation is available for all drawing objects (including group
objects) except images and panels.

If you select the Inside Only check box, fill animation does not
affect line objects or objects with transparent backgrounds.

If you clear the Inside Only check box, fill animation does not affect
horizontal lines.

To configure fill animation:

1. Select the object.

2. In the Animation dialog box, click the Fill tab.

3. In the Expression box, create an expression.

4. Specify At Minimum and At Maximum values for the fill
percentage levels.

5. Click a fill direction.

6. If you want the object’s outline to remain constant so only the
inside fill level varies, select the Inside Only check box.

7. Select the method to use to calculate the expression’s minimum
and maximum values.

8. Click Apply.
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Configuring horizontal position animation

With horizontal position animation, an object moves horizontally
based on a tag value (or the result of an expression) in relation to the
specified minimum and maximum values. For example, if the value
of the expression is halfway between the minimum and maximum
values, the object will be halfway between its minimum and
maximum pixel offset.

Horizontal position animation is available for all drawing objects
except images and panels.

To configure horizontal position animation:

1. Select the object.

2. In the Animation dialog box, click the Horizontal Position tab.

3. In the Expression box, create an expression.

4. Set the starting point for the object by dragging the object or by
typing a value in pixels (in relation to its current position on the
display). Click the At Minimum check box.

5. Set the ending point for the object by dragging the object or by
typing a value in pixels (in relation to its current position on the
display). Click the At Maximum check box.

6. Select the method to use to calculate the expression’s minimum
and maximum values.

7. Click Apply.
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Configuring vertical position animation

With vertical position animation, an object moves vertically based on
a tag value (or the result of an expression) in relation to the specified
minimum and maximum values. For example, if the value of the
expression is halfway between the minimum and maximum values,
the object will be halfway between its minimum and maximum
offset.

Vertical position animation is available for all drawing objects except
images and panels.

To configure vertical position animation:

1. Select the object.

2. In the Animation dialog box, click the Vertical Position tab.

3. In the Expression box, create an expression.

4. Set the starting point for the object by dragging the object or by
typing a value in pixels (in relation to its current position on the
display). Click the At Minimum check box.

5. Set the ending point for the object by dragging the object or by
typing a value in pixels (in relation to its current position on the
display). Click the At Maximum check box.

6. Select the method to use to calculate the expression’s minimum
and maximum values.

7. Click Apply.
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Configuring width animation

With width animation, an object’s width changes based on a tag
value (or the result of an expression) in relation to the specified
minimum and maximum values. For example, if the value of the
expression is halfway between the minimum and maximum values,
the object will be half the full width.

Width animation is available for all drawing objects except images
and panels.

To configure width animation:

1. Select the object.

When the object is first selected, its width is 100 percent.

2. In the Animation dialog box, click the Width tab.

3. In the Expression box, create an expression.

4. Set the minimum width for the object by doing one of the
following:

Click a handle on the left or right side of the object and drag
it to resize the object.

Type the width (as a percentage of the full width) you want
the object to be when the expression evaluates to its minimum
value.

Select the At Minimum check box.
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5. Set the maximum width for the object by doing one of the
following:

Click a handle on the left or right side of the object and drag
it to resize the object.

Type the width (as a percentage of the full width) you want
the object to be when the expression evaluates to its
maximum value.

Select the At Maximum check box.

6. Click an anchor point.

This is the part of the object that does not move. For example,
click Left if you do not want the left side of the object to move.
As the value of the expression changes, the object will grow to or
shrink from the right.

7. Select the method to use to calculate the expression’s minimum
and maximum values.

8. Click Apply.

Configuring height animation
With height animation, an object’s height changes based on a tag
value (or the result of an expression) in relation to the specified
minimum and maximum values. For example, if the value of the
expression is halfway between the minimum and maximum values,
the object will be half the full height.

Height animation is available for all drawing objects except images
and panels.
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To configure height animation:

1. Select the object.

When the object is first selected, its height is 100 percent.

2. In the Animation dialog box, click the Height tab.

3. In the Expression box, create an expression.

4. Set the minimum height for the object by doing one of the
following:

Click a handle on the top or bottom of the object and drag it
to resize the object.

Type the height (as a percentage of the full height) you want
the object to be when the expression evaluates to its minimum
value.

Select the At Minimum check box.

5. Set the maximum height for the object by doing one of the
following:

Click a handle on the top or bottom of the object and drag it
to resize the object.

Type the height (as a percentage of the full height) you want
the object to be when the expression evaluates to its
maximum value.

Click the At Maximum check box.

6. Click an anchor point.

This is the part of the object that does not move. For example,
click Top if you do not want the top of the object to move. As
the value of the expression changes, the object will grow to or
shrink from the bottom.

7. Select the method to use to calculate the expression’s minimum
and maximum values.

8. Click Apply.

Configuring rotation animation

With rotation animation, an object rotates around an anchor point
based on a tag value (or the result of an expression) in relation to the
specified minimum and maximum values. For example, if the value
of the expression is halfway between the minimum and maximum
values, the object will rotate half the specified amount.
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Rotation animation is available for all drawing objects except images,
panels, and rounded rectangles. If you apply rotation animation to
text, the text rotates around the anchor point but remains in the
upright position.

To configure rotation animation:

1. Select the object.

2. In the Animation dialog box, click the Rotation tab.

3. In the Expression box, create an expression.

4. Set the center of rotation using one of the methods described
below. The center of rotation is the point around which the
object will rotate. This point can be inside or outside of the
object. If it is outside, the object will appear as if it is moving in
an arc.

Using the Default Center Points

To use the default center points, click a Center of Rotation
button.

Why use the default center points? If you set the center of
rotation with the default center points, the object will rotate
around the same point even if the object is resized. For example,
the top-middle point will always be the center of rotation no
matter what size the object is.
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Specifying Coordinates

The default coordinates 0,0 are the center of the object; all
coordinate values are relative to the center. To specify
coordinates, do one of the following:

Select the button beside the coordinates box. Place the mouse
pointer over the object’s cross-hair until the cursor changes to
a cross-hair, and then click and drag the cross-hair to the
desired center of rotation.

Type values in the coordinates box, and then select the button
beside the box.

5. Set the range of motion for the object.

To set the minimum, do one of the following and then select the
At Minimum check box:

With the cursor indicating the Rotate tool (not the
cross-hair), visually set the degree of rotation by clicking the
mouse and dragging until the object is in the desired
minimum (beginning) position.

Type the desired minimum degree of rotation (this value is
relative to the object’s current position). For clockwise
rotation, use a positive number. For counterclockwise
rotation, use a negative number.

To set the maximum, do one of the following and then select the
At Maximum check box:

With the cursor indicating the Rotate tool (not the
cross-hair), visually set the degree of rotation by clicking the
mouse and dragging until the object is in the desired
maximum (ending) position.

Type the desired maximum degree of rotation (this value is
relative to the object’s current position). For clockwise
rotation, use a positive number. For counterclockwise
rotation, use a negative number.

6. Select the method to use to calculate the expression’s minimum
and maximum values.

7. Click Apply.

Object’s

cross-hair

Rotate tool
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Configuring horizontal slider animation
With horizontal slider animation, you can use a drawing object to set
the value of a tag. To do this, define a path for the object. At
runtime, when the operator moves the object horizontally (using a
mouse), the pixel position of the object is translated into values that
are written to the tag. If the tag value is changed externally, the
position of the slider changes as well.

An object can have both vertical and horizontal slider animation.

Horizontal slider animation is available for all drawing objects
except images and panels.

Here are some tips for creating slider objects:

The Sliders graphic library contains several slider objects you can
drag and drop into your graphic displays. Attach slider
animation to the button portion of the slider object.

If you create your own slider object, it’s useful to draw an object
(for example, a line) to represent the path the slider will move
along.

To configure horizontal slider animation:

1. Select the object.

2. In the Animation dialog box, click the Horizontal Slider tab.

3. In the Tag box, type the name of the tag whose value will be set
by the slider.

4. Set the starting point for the slider object by dragging the object
or by typing a value (in relation to its current position on the
display). Select the At Minimum check box.
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5. Set the ending point for the slider object by dragging the object
or by typing a value (in relation to its current position on the
display). Select the At Maximum check box.

6. Select the method to use to calculate the minimum and maximum
values that are written to the tag.

7. Click Apply.

Configuring vertical slider animation

With vertical slider animation, you can use a drawing object to set
the value of a tag. To do this, define a path for the object. At
runtime, when the operator moves the object vertically (using a
mouse), the pixel position of the object is translated into values that
are written to the tag. If the tag value is changed externally, the
position of the slider changes as well.

An object can have both vertical and horizontal slider animation.

Vertical slider animation is available for all drawing objects except
images and panels.

For tips for creating slider objects, see page 11-25.

To configure vertical slider animation:

1. Select the object.

2. In the Animation dialog box, click the Vertical Slider tab.

3. In the Tag box, type the name of the tag whose value will be set
by the slider.
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4. Set the starting point for the slider object by dragging the object
or by typing a value (in relation to its current position on the
display). Select the At Minimum check box.

5. Set the ending point for the slider object by dragging the object
or by typing a value (in relation to its current position on the
display). Select the At Maximum check box.

6. Select the method to use to calculate the minimum and maximum
values that are written to the tag.

7. Click Apply.

Applying animation to groups
You can apply animation to objects and then group those objects
and apply animation to the group. When the display is running,
animation is applied as follows:

These types of animation Are applied like this

Color, fill Animation attached to individual objects
within the group overrides group
animation.

Horizontal slider, vertical
slider

Group animation overrides animation
attached to individual objects within the
group.

Height, width, horizontal
position, vertical position,
and rotation

Animation results for individual objects
and the group are combined. For example,
if an individual’s horizontal position
animation result is to offset the object by
100 pixels, and the group’s result is to
offset the group by 200 pixels, the
individual object is offset by 300 pixels.

Visibility When the group’s animation visibility is
False (the group is not visible), then no
objects in the group are visible, regardless
of the animation status of the individual
objects.

When the group’s animation visibility is
True (the group is visible), the visibility of
an object within the group is determined
by the individual object animation.

Test your animation to ensure you achieve the intended results.

To apply animation to objects within groups, use the group edit
feature. For details, see page 9-45.
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Checking the animation on objects

To see what type of animation has been set up for an object or group
of objects, use the Animation menu or the Animation dialog box. To
see what type of animation has been set up for objects within a
group, use the group edit feature. For details, see page 9-45.

To view the animation on an object using the menu:

1. Select an object.

2. View the animation by doing one of the following:

Click the Animation menu and see which items have a check
mark.

Right-click the object and then select Animation to see which
items have a check mark.

This strangely-

designed object

has visibility,

color, fill, and

horizontal slider

animation.

To view the animation on an object using the Animation

dialog box:

1. Select an object.

2. On the View menu, click Animation.

When the Animation dialog box opens, look at which tabs have
check marks on them to see which types of animation have been
set up.
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Changing the animation on objects
You can change the animation attached to an object, a group of
objects, or to individual objects within the group. To access objects
within a group, use the group edit feature. For details, see page 9-45.

To change the animation on objects:

1. Select the object or group.

2. Open the Animation dialog box.
3. Make the required changes.

4. Click Apply.

Copying or duplicating objects with animation
You can copy or duplicate objects that have animation attached to
them. When you do, the animation attached to the objects is also
copied or duplicated. If you copy or duplicate a group, the copy of
the group can be ungrouped to individual objects, just like the
original.

For information about copying and duplicating objects, see
pages 9-38 and 9-40.

Copying animation without copying objects
If you have attached animation to an object, you can copy the
animation and paste it onto another object. If the object has more
than one type of animation, all animation is copied and pasted. Note
that you can only copy animation to an object that supports the
same type of animation.
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To copy and paste animation:

1. Select the object that has the animation you want to copy.

2. On the Edit menu, click Copy Animation, or right-click the
object and then click Copy Animation.

3. Select the objects to copy the animation to.

4. On the Edit menu, click Paste Animation.

To paste to a single object, you can right-click the object and
then click Paste Animation.
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Creating expressions
This chapter describes:

the types of expression components

which editors use expressions

using the Expression editor

creating and formatting expressions

using tag names and tag placeholders with expressions

using constants

using operators, math and security functions, and if-then-else
logic in expressions

the evaluation order of operators

using write expressions

About expressions
Sometimes the data you gather from devices is meaningful only
when you:

compare it to other values

combine it with other values

create a cause-effect relationship with other values

Expressions allow you to create mathematical or logical
combinations of data that return more meaningful values.
Depending on the components used in the expression, the value
returned can be in the form of a numeric value, a true/false value, or
a text string.

Expressions that result in floating point
values

You can assign expressions to many of the controls in RSView. If the
expression results in a floating point value but an integer value is
required, the floating point value is rounded.

For information about how values are rounded, see page 7-3.

12
Chapter
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Expression components

Expressions can be built from:

tag values

constants

arithmetic, relational, logical, and bitwise operators

mathematical and security functions

if-then-else logic

Tags, arithmetic operators, bitwise operators, and mathematical
functions such as SQRT (square root) return numeric values.

Relational and logical operators return true/false values. The security
function CurrentUserHasCode(x) also returns a true/false value.

The security function CurrentUserName( ) returns a string value.

Expressions that use if-then-else logic can return numeric values,
true/false values, or text strings, depending on how they are
structured. These are called conditional expressions because the
result of the expression depends on whether the If statement is true
or false. When the If statement evaluates to true, the result is defined
by the Then statement. When the If statement is false, the result is
defined by the Else statement.

The Objects sample project contains many examples of expressions.
For example, see the alarm triggers in the Alarm Setup editor.

Where you can use expressions

You can use expressions in these editors:

Graphics Display—You can define an expression to control
various aspects of a graphic object’s appearance. For more
information, see Chapter 9.

You can also use expressions to attach animation to graphic
objects. For more information, see Chapter 11.

Global Connections—You can use expressions to remotely
control the opening and printing of displays, as well as the date
and time to display. For more information, see Chapter 19.

Alarm Setup—When configuring alarms, you can use expressions
for alarm triggers, and with some of the controls that silence and
acknowledge alarms. For more information, see Chapter 13.
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Information Setup—You can use expressions to determine when
to display information messages. For more information, see
Chapter 14.

Macros—You can use expressions in macros to assign values to
tags. For more information, see page 7-32.

Using the Expression editor

To create an expression, you can:

type it directly in the “Tag or expression” column, for any
control that accepts expressions, or in the Expression box (for
animation)

open the Expression editor, and then create the expression in the
editor, as described on page 12-5

Using the Expression editor versus typing
expressions directly

Once you are familiar with expression syntax, you might find it
quicker to create short expressions by typing them directly in the
“Tag or expression” column.

The Expression editor allows you to see more text at once, which is
useful for longer, more complicated expressions. Also, you can click
buttons to enter tag names, operators, and functions, thus avoiding
typing mistakes. Also, in the Expression editor, you can check that
the syntax of the expression you’ve created is valid.

To create an expression by typing it directly:

� Type an expression up to 999 characters long.

Expressions that you type directly are not checked for syntax.

To open the Expression editor, do one of the following:

Click the Browse button in the Exprn column for a control that
accepts expressions.

The Browse button is not available for controls to which you can
assign only tags.

In the Animation dialog box only, click the Expression button.

Browse button in

the Exprn column
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About the Expression editor

The Expression editor has these parts:

Expression box

Expression buttons

Validation area

Cursor position

Expression box

The Expression box is a text edit area where you can build
expressions. Enter text directly and use the expression buttons to
build the expression.

Expression buttons

These are the expression buttons:

This button Displays a list of

If If-then-else operators

Logical Logical operators

Relational Relational operators

Arithmetic Arithmetic operators

Bitwise Bitwise operators

Functions Mathematical and security
functions (clicking the button
opens the Functions box)

Tags Tags in the tag database
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Validation area

To validate your expression, click the Check Syntax button. You can
check the syntax as often as you like. When you make changes, the
expression is no longer validated.

If an expression is without errors, “Valid” appears in the text
box.

If an expression has not been validated, the text box remains
empty.

If there are errors in the expression, a description of the error and
the location appears in the text box.

Cursor position

The Line and Column boxes show the cursor position in the
Expression box.

Creating expressions

Choose the type of

operation performed by

the expression.

Create an expression.

Validate the syntax.

Locate syntax errors.

To create an expression in the Expression editor:

1. Type the expression in the Expression box, up to 999 characters
long.

2. To use a tag in the expression, you can type the tag name directly
or click Tags and then select the tag to use.

You cannot use block tags in expressions.
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For more information about using tags in expressions, see
page 12-7.

3. To use an operator, you can type it directly or click an expression
button and then click the operator to use.

4. To use a function, click Functions.

To limit the functions in the

list to the type of function you

want to use, click a category.

5. In the Functions box, click the function to use, and then click
OK.

6. To validate your expression, click Check Syntax.

If your expression has a syntax error, the line and column
location appears beside the Check Syntax button.

For information about formatting expressions, see page 12-6.

Cutting, copying, and pasting expressions
You can cut, copy, or paste an expression or parts of an expression
between objects and editors.

To do this Do this And then press this

Cut Select the text Ctrl-X

Copy Select the text Ctrl-C

Paste Double-click in the column
or click in the Expression
box and then position the
cursor where you want the
text

Ctrl-V

Formatting expressions
You can format expressions so they are easier to read. However, do
not let tag names, function names, or function arguments span more
than one line.
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When formatting expressions, you can use line returns and multiple
spaces.

Enclose strings in quotes. The string can contain any character, and
can include spaces.

Example: Formatting an expression

To format this if-then-else statement, you can align the Else with the
appropriate If so the logic is easy to understand:

If (tag1 > tag2) Then 0
Else If (tag1 > tag3) Then 2
Else 4

Or you can condense it to the following:

If (tag1 > tag2) Then 0 Else If (tag1 > tag3) Then 2 Else 4

Using tag names and tag placeholders
A tag name can be included as part of an expression or can stand
alone as the entire expression.

To supply a tag name, do one of the following:

Type a tag name.

You can type a tag name that does not exist in the tag database.
When you click OK, you are prompted to create the tag. You can
create it now, or write down the name and create it later.

Click the Tags button and select a tag from the Tags dialog box.

Enclose tag names that contain dashes or start with a number in
braces { } when you use them in an expression. This distinguishes the
characters in the tag name from the characters in the expression.

You can use string tags as operands with the plus (+) arithmetic
operator and with the relational operators.

You cannot use block tags in expressions.

Using tag placeholders instead of tag
names

The Graphics Display editor accepts tag placeholders instead of tag
names. Placeholders allow you to use the same display with different
sets of tags.
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You can use tag placeholders in:

the graphic display that opens when the project is first run

graphic displays that are opened using a Goto Display button

Use parameter files to specify which tags to substitute for which
placeholders. For information about creating parameter files, see
page 8-25.

To create a tag placeholder in an expression:

� Type the cross-hatch character followed by a number (no space
in between). For example, #1.

Constants

A constant can have any of the following formats:

integer (123)

floating point (123.45)

string constant (“character string”)

Arithmetic operators

Arithmetic operators calculate values based on two or more numeric
values. The arithmetic operators are:

Symbol Operator Example

(For these examples, tag1 = 5 and

tag2 = 7)

+ addition tag1 + tag2
returns a value of 12

You can also use this operator with string
operands. See page 12-9.

- subtraction tag1 - tag2
returns a value of -2

* multiplication tag1 * tag2
returns a value of 35

/ division tag1 / tag2
returns a value of 0.7142857
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Symbol Example

(For these examples, tag1 = 5 and

tag2 = 7)

Operator

MOD,
%

modulus
(remainder)

tag2 MOD tag1
returns a value of 2

The modulus operator is the remainder of
one number divided by another. For
example, the remainder of 13 divided by 5
is 3; so 13 % 5 = 3.

Important: This operator is for integers
only, not floating point numbers.

** exponent tag1 ** tag2
returns a value of 78125

IMPORTANT Be sure that any tag value you use as a divisor cannot at
some point have a value of zero. Expressions that
attempt to divide a number by zero produce an error at
runtime.

String operands

The + operator can be used to join string operands. For example, the
expression “hello” + “world” returns: helloworld.

Relational operators

Relational operators compare two numeric or string values to
provide a true or false result. If the statement is true, a value of 1 is
returned. If false, 0 is returned.

The relational operators are:

Symbols Operator Numeric

Examples

String Examples

For the numeric examples, tag1 = 5 and tag2 = 7

For the string examples, serial_no = “ST009”

EQ, == equal tag1 == tag2
false

serial_no == “ST011”
false

NE, <> not equal tag1 <> tag2
true

serial_no <> “ST011”
true

LT, < less than tag1 < tag2
true

serial_no < “ST011”
true
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Symbols String ExamplesNumeric

Examples

Operator

GT, > greater than tag1 > tag2
false

serial_no > “ST011”
false

LE, <= less than or
equal to

tag1 <= tag2
true

serial_no <= “ST011”
true

GE, >= greater than or
equal to

tag1 >= tag2
false

serial_no >= “ST011”
false

How string operands are evaluated

String operands are evaluated by case and by alphabetical order.
Upper case letters are greater than lower case letters. For example, H
is greater than h. Letters later in the alphabet are greater than those
earlier in the alphabet. For example, B is greater than A.

Logical operators

Logical operators determine the validity of one or more statements.
There are three logical operators: AND, OR, and NOT. The
operators return a non-zero value if the expression is true, or a zero
if the expression is false.

Any statement that evaluates to a non-zero value is regarded as true.
For example, the statement tag1 will be false if the value of tag1 is 0,
and true if tag1 has any other value.
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The logical operators are:

Symbols Operator Action Example

(For these examples, tag1 =

5 and tag2 = 7)

AND, && and Returns a 1
if the
statements
to the right
and left of
the operator
are both
true.

(tag1 < tag2) AND (tag1 == 5)
both statements are true;
returns a 1

OR, || or Returns a 1
if either the
statement to
the left or
right of the
operator is
true.

(tag1 > tag2) OR (tag1 == 5)
tag1 == 5 is true;
returns a 1

NOT negation Reverses the
logical value
of the
statement it
operates on.

NOT (tag1 < tag2)
although tag1 < tag2 is true,
NOT reverses the logical value;
returns a 0

IMPORTANT The parentheses are essential in the above expressions.
See page 12-13.

Bitwise operators

Bitwise operators examine and manipulate individual bits within a
value.

IMPORTANT These operators are for integers only, not floating point
numbers. Do not use them with tags or expressions that
return floating point values.
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Symbol Operator Action

& AND Compares two integers or tags on a bit-by-bit
basis.

Returns an integer with a bit set to 1 if both the
corresponding bits in the original numbers are
1. Otherwise, the resulting bit is 0.

| inclusive
OR

Compares two integers or tags on a bit-by-bit
basis.

Returns an integer with a bit set to 1 if either or
both of the corresponding bits in the original
numbers are 1. If both bits are 0, the resulting
bit is 0.

^ exclusive
OR (XOR)

Compares two integers or tags on a bit-by-bit
basis.

Returns an integer with a bit set to 1 if the
corresponding bits in the original numbers
differ. If both bits are 1 or both are 0, the
resulting bit is 0.

>> right shift Shifts the bits within an integer or tag to the
right.

Shifts the bits within the left operand by the
amount specified in the right operand. The bit
on the right disappears.

Either a 0 or a 1 is shifted in on the left,
depending on whether the left-most bit is a 0 or
a 1. If the left-most bit is 0, a 0 is shifted in. If
the left-most bit is 1, a 1 is shifted in. In other
words, the sign of the number is preserved.

<< left shift Shifts the bits within an integer or tag to the left.

Shifts the bits within the left operand by the
amount specified in the right operand. The bit
on the left disappears and 0 always shifts in on
the right.

See “Using the left shift operator,” next.

~ complement Returns one’s complement; that is, it toggles the
bits within an integer or tag.

Reverses every bit within the number so every 1
bit becomes a 0 and vice versa.
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Using the left shift operator

If the left bit is a 1 an overflow will occur, and an error message is
created. To prevent this, use the bitwise And (&) operator with the
left shift operator in an expression. For example:

(dev << 1) & 65535

where dev is a tag whose value is being shifted left, and 65535 is 1111
1111 1111 1111 in binary form.

Examples: Bitwise operators

For these examples tag1 = 5 (binary 0000 0000 0000 0101),
tag2 = 2 (binary 0000 0000 0000 0010)

tag1 & tag2
Returns 0 (binary 0000 0000 0000 0000).

tag1 | tag2
Returns 7 (binary 0000 0000 0000 0111).

tag1 ^ tag2
Returns 7 (binary 0000 0000 0000 0111).

tag1 >> 1
Returns 2 (binary 0000 0000 0000 0010).

tag1 << 1
Returns 10 (binary 0000 0000 0000 1010).

~ tag1
Returns -6 (binary 1111 1111 1111 1010).

Evaluation order of operators

Expressions with more than one operator are evaluated in this order:

Operators in parentheses are evaluated first.

Therefore, to change the order of precedence, use parentheses.

The operator with the highest precedence is evaluated next.

When two operators have equal precedence, they are evaluated
from left to right.



Preface

12-14 � RSView Machine Edition User’s Guide

Operators are evaluated in this order:

Evaluation order Symbols

1 (highest) ( )

2 NOT
~

3 *
/
MOD, %
**
AND, &&
&
>>
<<

4 +
-
OR, ||
|
^

5 (lowest) EQ, ==
NE, <>
LT, <
GT, >
LE, <=
GE, >=

Examples: Evaluation order

For these examples, tag1 = 5, tag2 = 7, and tag3 =10.

_____________________________

(tag1 > tag2) AND (tag1 < tag3)

is evaluated in this sequence:

1. tag1 > tag2 = 0

2. tag1 < tag3 = 1

3. 0 AND 1 = 0

The expression evaluates to 0 (false).
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_____________________________

tag1 > tag2 AND tag3

is evaluated in this sequence:

1. tag2 AND tag3 = 1

2. tag1 > 1 = 1

The expression evaluates to 1 (true).

_____________________________

NOT tag1 AND tag2 > tag3 ** 2

is evaluated in this sequence:

1. NOT tag1 = 0

2. 0 AND tag2 = 0

3. tag3 ** 2 = 100

4. 0 > 100 = 0

The expression evaluates to 0 (false).
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Mathematical functions

Use math functions to calculate the square root, log (natural or
base 10), or trigonometry ratios (in radians or degrees) of a tag.

These functions perform math on an expression:

This function Returns this value

SQRT (expression) The square root of the expression

LOG (expression) The natural log of the expression

LOG10 (expression) The base ten log of the expression

SIN (expression) The sine of the expression in radians

COS (expression) The cosine of the expression in radians

TAN (expression) The tangent of the expression in radians

ARCSIN (expression) The arc sine of the expression in radians

ARCCOS (expression) The arc cosine of the expression in radians

ARCTAN (expression) The arc tangent of the expression in
radians

SIND (expression) The sine of the expression in degrees

COSD (expression) The cosine of the expression in degrees

TAND (expression) The tangent of the expression in degrees

ARCSIND (expression) The arc sine of the expression in degrees

ARCCOSD (expression) The arc cosine of the expression in degrees

ARCTAND (expression) The arc tangent of the expression in
degrees



� 12-17Creating expressions

Security functions
Use security functions to control access to your project.

These functions allow you to determine a user’s identity or security
rights in order to limit access to the project based on these criteria.

This function Returns this value

CurrentUserHasCode
(Security Code Letters)

True (1) if any of the specified security
codes have been assigned to the user; False
(0) if not.

If checking multiple security codes, do not
type a space between the security code
letters.

For example:
CurrentUserHasCode (ABP)
returns the value 1 if the user has been
assigned one or more of the specified
codes.

CurrentUserName( ) A string containing the name of the
current user. The name does not include
the name of the user’s domain.

This function is case sensitive. All user
names use upper case letters, so make sure
that you use upper case letters in your
expression.

For more information about setting up security for your project, see
Chapter 18.

For an example of using the CurrentUserHasCode( ) function, see
page 18-3. For examples of using the CurrentUserName( ) function,
see page 18-13.

If-then-else
If-then-else expressions carry out an action conditionally or branch
actions depending on the statements in the expression. The
if-then-else statements enable the expression to perform different
actions in different situations and to repeat activities until a
condition changes.

To build conditional expressions, use the relational operators and the
logical operators.

The if-then-else structure is:

if statement then value1 else value2
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If the statement is true then the expression returns value1; if the
statement is false then the expression returns value2. Keep in mind
that the statement is a mathematical equation and true means a
non-zero value, and false means zero.

The if-then-else structure is illustrated below.

enter

true

false

value1value2

statement

exit
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Nested if-then-else

You can also nest an if-then-else structure inside the ‘then’ or ‘else’
part of an if-then-else structure.

Example 1: Nested if-then-else

This expression:

if (statement1) then (value1)
else if (statement2) then (value2)
else (value3)

has this interpretation:

enter

false

true

value2

value1

true

false

statement1

statement2

value3

exit
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Example 2: Nested if-then-else

This expression:

if (statement1) then
if (statement2) then (value1)
else (value2)
else (value3)

has this interpretation:

enter

true

false

value2

statement2
true

value1

false

statement1

value3

exit

Using write expressions

Write expressions allow the operator to enter a value at runtime.
RSView substitutes the value the operator enters for the placeholder
in the expression, calculates the value of the expression, and writes
the result to the Value control. All write expressions must contain a
question mark (?) as a placeholder for the value the operator enters.

You can use write expressions with the Numeric Input Enable
button graphic object. When the operator presses the button, a
keypad or scratchpad opens. The operator enters a value in the
keypad or scratchpad, and this value is substituted for the ?
placeholder in the write expression.
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Example: Using write expressions

In this example, the operator regulates the speed of a conveyor belt
by entering a value in feet or meters per second. When the operator
enters the value in meters per second, the value is converted to feet
per second before being passed to the data source.

The operator first indicates whether the value is in feet or meters by
pushing a Maintained Push button. The push button has one state
corresponding to feet per second, and the other state to meters per
second.

Then the operator presses the Numeric Input Enable button and
enters the value for the conveyor speed in a numeric pop-up keypad.
The ? character in the write expression is the placeholder for the
value the operator enters.

To configure the Maintained Push button:

1. In the Maintained Push Button Properties dialog box, in the
States tab, configure these states:

State 0—Value: 0, Caption: Feet/S

State 1—Value: 1, Caption: Meters/S

2. In the Connections tab, assign a digital tag called Feet_or_meters
to the Value control.

To configure the Numeric Input Enable button:

1. In the Numeric Input Enable Properties dialog box, in the Label
tab, type the caption “Enter conveyor speed.”

2. In the Connections tab, assign an analog tag called
Conveyor_speed to the Value control.

3. Assign this expression to the Optional Exp control:

If Feet_or_meters == 0 Then

?

Else

? * 3.281

RSView writes the result of the expression to the Conveyor_speed
tag at the data source.
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Setting up alarms
This chapter describes:

preparing to set up alarms

how alarms work

alarm trigger data types

optional alarm controls

steps for configuring alarms

using the Alarm Setup editor

configuring alarms

the [ALARM] display and [HISTORY] library

creating your own alarm display

opening and closing the alarm display

how the Alarm list works

using alarm buttons to acknowledge, silence, and clear alarms

About alarms
An alarm occurs when something goes wrong or is about to go
wrong. Alarms can signal that a device or process has ceased
operating within acceptable, predefined limits, and can indicate
breakdown, wear, or process malfunctions. Alarms are also used to
indicate the approach of a dangerous condition.

Alarms are an important part of most plant control applications
because an operator must know the instant something goes wrong. It
is often equally important to have a record of the alarm and whether
the alarm was acknowledged.

Preparing to set up alarms
As your project is running, information is continually sent to the
data source about the state of the various processes. For example,
your project might be monitoring whether a valve is open or closed,
or the temperature in a boiler. Values representing the status of these
processes are sent to the data source.

13
Chapter
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The data source

The data source can be memory or a device such as a programmable
controller or an OPC server. RSView writes values to and reads
values from the data source. The data source is configured to
exchange information (in the form of numeric or string values)
between RSView and the physical machine that your project is
controlling.

Tags and expressions

Before setting up alarms, you must set up tags corresponding to the
addresses at the data source that will store the values you want to
monitor for alarm conditions. You can monitor analog, digital, and
block tags for alarm conditions. You cannot monitor string tags.

For information about creating tags, see Chapter 7.

You can also use expressions to perform logical or mathematical
calculations on tag values, and monitor the expression value rather
than the original tag value. For example, you could use an expression
to monitor whether a tag value has increased or decreased beyond a
threshold value: If Tag1 > 100 then 1 else 0.

For information about creating expressions, see Chapter 12.

Identifying alarm conditions

Once you have identified the processes you want to monitor for
alarms, and the tag addresses or expressions that will store the values
representing the status of the processes, you must determine the
acceptable range of values for each tag or expression. Then you can
set up alarms to notify the operator when a value is outside the
normal operating range.

How alarms work

This section provides an overview of the key components of your
project’s alarm system, and describes how the different parts work
together.

Alarm triggers and trigger values

You specify the tags and expressions (also known as controls) to
monitor for alarm conditions by creating an alarm trigger for each
control.
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Each alarm trigger can generate one or more alarm messages,
associated with different trigger control values. For each alarm
trigger, you specify the trigger values that will generate alarm
messages, and create the messages to display for the trigger values.

The trigger value can be a non-zero integer value or a bit position,
depending on which trigger data type you assign. For more
information about trigger data types, see page 13-6.

Alarm notification methods

You can use any combination of these methods to notify the
operator that an alarm condition has occurred:

Open an alarm graphic display containing an appropriate alarm
message.

Set off an audible signal (if the project is running in
Windows 2000).

Send a message to a printer.

To use these methods, select the Display, Audio, and Print options
when you create your messages, as described on page 13-18.

IMPORTANT Be sure to select the Print option if you need to keep a
permanent record of alarms.

Displaying alarm information

RSView comes with a preconfigured alarm graphic display called
[ALARM] and a graphic library called [HISTORY]. Both contain
Alarm list graphic objects for displaying alarm information. By
default, the [ALARM] graphic display opens automatically at
runtime when an alarm is generated.

You can accept the default, edit the [ALARM] display, or use your
own display. If you elect not to open a graphic display for alarm
notification, an alternative is to place the Alarm list object in a
graphic display that doesn’t open automatically when an alarm is
generated.

For information about See

The [ALARM] display Page 13-23

The [HISTORY] graphic library Page 13-24

Creating your own alarm display Page 13-26

The Alarm list graphic object Page 13-27
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Responding to alarms

Depending on how you configure alarms, the operator can:

acknowledge one or all alarms

clear all alarms

silence alarms (if the project is running in Windows 2000)

For information about the alarm button graphic objects the operator
can use to acknowledge, clear, and silence alarms, see page 13-28.

You can also set up remote acknowledgement or silencing of alarms,
to allow the data source to acknowledge or silence the alarms. For
more information, see pages 13-12 and 13-14.

Methods for acknowledging alarms

A single alarm is acknowledged when:

the operator selects an alarm in the Alarm list and presses the
Acknowledge Alarm button

the operator selects an alarm in the Alarm list and presses an
Enter button object, or the Enter key on an external keyboard or
keypad

All alarms for a single trigger’s trigger value (or bit position) are
acknowledged when:

the Remote Ack control’s value changes to an alarm’s trigger
value (or bit position, for bit triggers)

All alarms for a trigger are acknowledged when:

the Remote Ack control’s value changes to the “Acknowledge
all” value. The “Acknowledge all” value is specified in the “Use
ack all value” box in the Alarm Setup editor.

All alarms are acknowledged when:

the operator presses the Acknowledge All Alarms button

the Remote Ack All control’s value changes to a new non-zero
value

Methods for clearing alarms

All alarms are cleared from the alarm log file and from all Alarm lists
when the operator presses the Clear Alarm History button.
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Methods for silencing alarms

The audio alarm indicator is available for projects running in
Windows 2000 only.

All alarms are silenced when:

the operator presses the Silence Alarms button

an alarm is acknowledged

the Remote Silence control’s value changes to a new non-zero
value

the operator presses the Clear Alarm History button

The alarm log file

As soon as the project starts running, RSView begins monitoring
trigger controls for alarm conditions. When an alarm occurs,
RSView adds the associated message to the alarm log file. When the
file is full, the oldest messages are deleted to make room for new
messages. Specify the maximum number of messages to store in the
Alarm Setup editor, as described on page 13-22.

For each message, the log file records the time the alarm was
triggered and the time the alarm was acknowledged (if it was
acknowledged).

The log file is saved every 30 seconds, if there are new alarms. The
log file is also saved when the project is shut down.

If the operator presses the Clear Alarm History button, all alarms
are removed from the log file.

The alarm log file is retained when you restart a project after a
shutdown or power loss. You can delete the log file from the
runtime computer at project startup. For information about deleting
the log file, see Chapter 23.

If you download a newer version of a project to the runtime
computer, the alarm log file for the older version is deleted
automatically.

The Alarm list

The contents of the alarm log file are displayed in the Alarm list
graphic object.
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You can specify the information that is displayed in the list:

messages for unacknowledged alarms only

messages for all alarms

the time the alarm was triggered

the time the alarm was acknowledged (if you display messages
for all alarms)

The Alarm list in the [ALARM] display is configured to display all
alarms, and to display both the alarm time and the acknowledge
time.

For more information about the Alarm list, see page 13-27.

Alarm trigger data types

When you create alarm triggers, you must specify the type of data
the trigger’s tag or expression uses. The type of data affects how
alarms are triggered.

The Value trigger type

If the trigger’s control uses integer or floating point values, use the
Value trigger type. When the value of the trigger control equals the
trigger value of a message, an alarm is generated.

If you use an analog tag or an expression, you can use any non-zero
integer or floating point value to trigger an alarm. Floating point
values are rounded to the nearest integer. For information about
how values are rounded, see page 7-3.

Trigger values cannot be 0. Digital tags have two possible values, 0
and 1. Therefore, if you use a digital tag you can only use the value 1
to trigger a message. If you want to use a digital tag to trigger two
different messages, create an expression that adds 1 to the digital
tag’s value. That way, you can use the trigger values 1 and 2.

Example: Integer trigger values

This example shows how to set up alarms using integer trigger values
to monitor the level of acid in a 100-gallon tank. Alarms are
generated when the tank is 75% full and 90% full.
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1. Create an alarm trigger for the analog tag Acid_Tank_Level. This
tag points to an address in a programmable controller that is
linked to a sensor in the tank. The tag’s minimum value is 0 and
its maximum value is 100.

Use this expression for the alarm trigger:

If ((Acid_Tank_Level > 74) AND (Acid_Tank_Level < 90))

then 1

else if (Acid_Tank_Level > 89)

then 2

else 0

2. Use the Value trigger type for the alarm trigger.

3. Specify these trigger values and alarm messages for the alarm
trigger:

Trigger value Message

1 Warning! The acid tank has exceeded safe fill
levels.

2 Danger! The acid tank is overflowing.

At runtime, when the value of Acid_Tank_Level is 75 or greater,
RSView generates the first alarm message. The second message is
generated when the tag value is 90 or greater.

Using the expression illustrated above allows a range of values to
trigger each alarm. This is useful in case the tag is not being scanned
at the exact moment it reaches a threshold level.

The Bit trigger type

If the trigger’s control is a block tag (a bit array consisting of up to
1024 bit positions), use the Bit trigger type to generate multiple
simultaneous alarm messages. Each bit in the array whose value
changes from 0 to 1 triggers an alarm (if a message is configured for
the bit position).
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Example: Trigger values using bit positions

This example shows how to use the bit positions in a block tag to
generate multiple simultaneous alarms. The block tag uses 32 bits,
from N7:0/00 to N7:1/15.

This diagram shows the bit addresses and bit positions for the block
tag:

Bit position

Bit address

Bit position

Bit address

The tag is currently generating alarms at bit positions 2, 6, 12, 21, 22,
26, and 30.

To set up alarms for this block tag:

1. Create an alarm trigger for the block tag. Use the Bit trigger type.

2. Specify trigger values and alarm messages for the alarm trigger.
Each trigger value corresponds to a bit position (not a bit
address).

Bit position Trigger value Message

1 1 Line 1: Conveyor has stopped.

2 2 Line 1: Power failure.

3 3 Line 2: Conveyor has stopped.

4 4 Line 2: Power failure.

.. .. ..

32 32 Oven door open.
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The Least Significant Bit (LSBit) trigger
type

If the trigger’s control is a block tag (a bit array consisting of up to
1024 bit positions), use the Least Significant Bit trigger type to
generate alarm messages based on a priority sequence that is
determined by bit position. When multiple bits in the array change
from 0 to 1, only the alarm with the lowest bit position is generated.

Example: Trigger values using least significant bits

This example shows how to use the Least Significant Bit trigger type
to prioritize which alarm is generated when multiple alarm
conditions occur.

In this example, a programmable controller monitors a motor’s
power, manual stop, and overload status. The diagram indicates the
location of sensors that are linked to a block tag in the
programmable controller.

Power loss

Bit 00

Start

Overload

CR

Stop

L1 L2

CR

Manual stop

Bit 01

Overload

Bit 02

If power to the motor is lost, the manual stop and overload switch
also lose power, generating alarms for all three components. The
only alarm the operator needs to see is the alarm for the motor, since
the cause of the alarm is power loss to the motor, not a problem with
the other two components.
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If someone stops the motor manually, power to the overload switch
is lost. Alarms are generated for the manual stop and the overload
switch, but the only alarm the operator needs to see is the alarm for
the manual stop.

1. Create an alarm trigger for the block tag Motor_Starter. The tag
uses 16 bits, and points to the programmable controller address
N7:61, although only the first three bit positions are used in this
example. Use the LSBit (Least Significant Bit) trigger type.

2. Specify these trigger values and alarm messages for the alarm
trigger:

Bit in the

array

Bit

position

Trigger

value

Message

00 1 1 The motor has lost power.

01 2 2 The motor has stopped.

02 3 3 The overload switch has
lost power.

At runtime, if power to the motor is lost, the programmable
controller changes all three bit values from 0 to 1, but RSView
generates the first alarm message only (since bit 00 is the
lowest—that is, least significant—bit in alarm). If the operator
acknowledges the first alarm and power is not yet restored, the
second alarm is generated, and so on.

Optional alarm controls
When an operator acknowledges an alarm (by pressing the
Acknowledge Alarm button), the acknowledge time is recorded in
the alarm log file and the alarm is silenced. This might be all you
require of your alarm system.

However, you can use the optional alarm controls to set up more
sophisticated interactions with the data source when alarms are
triggered, acknowledged, and silenced, and to allow the data source
to acknowledge and silence alarms.

There are two sets of optional alarm controls:

controls that work with a specific alarm trigger. You can assign a
different set of controls to each alarm trigger.

controls that apply to all alarms
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Controls that work with a specific alarm
trigger

You can assign a different set of these controls to each alarm trigger,
or to only one or some alarm triggers:

Handshake—Assign a digital tag to this control to notify the data
source when the trigger’s value changes.

Ack—Assign an analog or digital tag to this control to notify the
data source when the operator acknowledges an alarm (or all
alarms).

Remote Ack—Assign an analog tag or an expression to this
control to allow the data source to acknowledge alarms.

Remote Ack Handshake—Assign a digital tag to this control to
notify the data source when a remote acknowledgement occurs.

Assign tags or expressions to these controls when you create your
alarm triggers, as described on page 13-16. For more detailed
information about how these controls work, see the next sections.

How the Handshake control works

The Handshake control is useful for triggers that use the Value data
type. Program the data source to queue alarm notifications when
multiple alarms are generated for the same trigger. Use the
Handshake control to notify the data source that RSView has
detected the alarm notification. Then the data source can send the
next alarm to RSView.

When the project starts, the Handshake control has a value of 1.
When the trigger control’s value changes, the Handshake control’s
value toggles from 1 to 0. The next time the trigger value changes,
the Handshake control’s value toggles from 0 to 1.

When the trigger control’s value changes, this does not necessarily
indicate an alarm—the value might still be within acceptable limits.

How the Ack control works

When the project starts, this control has a value of 0.

When the operator acknowledges an alarm by pressing the
Acknowledge Alarm button, RSView sends the alarm’s trigger value
(or bit position, for bit triggers) to this control, and holds the value
as long as the operator presses the button, or for the duration of the
notification hold time, whichever is longer. Then the control’s value
is reset to 0.
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When the operator acknowledges all alarms by pressing the
Acknowledge All Alarms button, RSView sends the trigger’s
“Acknowledge all” value to this control, and holds the value as long
as the operator presses the button, or for the duration of the
notification hold time, whichever is longer. Then the control’s value
is reset to 0.

To avoid confusion about whether a specific trigger’s alarm has been
acknowledged or all alarms have been acknowledged, make sure the
“Acknowledge all” value is not the same as one of the trigger values.

How the Remote Ack control works

The Remote Ack control allows for the remote acknowledgement of
alarms. The data source writes the alarm’s trigger value (or bit
position, for bit triggers) to this control, and the unacknowledged
alarm with this trigger value is acknowledged.

If you assign this control and specify an “Acknowledge all” value for
the trigger, when the data source sends the “Acknowledge all” value
to this control, all unacknowledged alarms for the trigger are
acknowledged.

Make sure that the “Acknowledge all” value is not the same as one
of the trigger values.

Configure the data source to send the correct value to the Remote
Ack control when you want a remote acknowledgement to take
place.

Remote acknowledgement does not take place if the notification
hold time is in effect for the Ack control.

Example: Using the Remote Ack control

This example shows how to use the Remote Ack control to
acknowledge an alarm.

In this example, the same project is run at two different locations on
the plant floor, and both terminals are connected to the same
programmable controller. All the tags in the example refer to
addresses in the programmable controller.
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Project X

Location 1

Programmable

controller

Project X

Location 2

1. Create an alarm trigger for an analog tag called Alarm. Use the
Value trigger type.

2. Assign an analog tag called Ack to the Ack control.

3. Assign an analog tag called Remote_Ack to the Remote Ack
control.

4. Create four alarm messages for the alarm trigger, with the trigger
values 1 to 4.

5. Configure the data source to write the value at the Ack control to
the Remote Ack control whenever the value of the Ack control
changes from 0 to a non-zero value.

At runtime, when an alarm with the trigger value 1 is generated, the
first alarm message appears at both locations simultaneously. If the
operator acknowledges the alarm at Location 1, RSView writes the
value 1 to the Ack control.

Since the Ack control is write-only (not read), the acknowledgement
doesn’t appear at Location 2. However, the programmable controller
writes the value from the Ack control (1) to the Remote Ack
control, and the alarm at Location 2 is acknowledged.

How the Remote Ack Handshake control
works

This control is used to notify the data source that the remote
acknowledgement has been detected by RSView.

When the project starts, the Remote Ack Handshake control has a
value of 1. When the Remote Ack control value changes, the Remote
Ack Handshake control’s value toggles from 1 to 0. The next time
the Remote Ack value changes, the Remote Ack Handshake value
toggles from 0 to 1.
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The Remote Ack Handshake value toggles whether or not the new
Remote Ack value matches a trigger value.

Controls that apply to all alarms

These controls apply to all alarms:

Silence—Assign a digital tag to this control to notify the data
source that all alarms have been silenced (Windows 2000 projects
only).

Remote Silence—Assign an analog tag or an expresson to this
control to allow the data source to silence all alarms
(Windows 2000 projects only).

Remote Ack All—Assign an analog tag to this control to allow
the data source to acknowledge all alarms at once.

Assign tags or expressions to these controls in the Advanced tab of
the Alarm Setup editor, as described on page 13-21. For more
detailed information about how these controls work, see the next
sections.

How the Silence control works

When the project starts, this control has a value of 0. When alarms
are silenced, this control is set to 1 for the notification hold time and
the internal beeper is turned off. At the end of the notification hold
time, the control is reset to 0.

If subsequent alarms (that have been set up to sound the internal
beeper) are generated, the alarms sound the beeper regardless of the
Silence control value or notification hold time status.

While the notification hold time is in effect, new alarms cannot be
silenced.

How the Remote Silence control works

When this control changes to a new non-zero value, all alarms are
silenced. Alarms can be silenced using other methods regardless of
this control’s value.

Configure the data source to send a new non-zero value to the
Remote Silence control each time you want a remote silencing of
alarms to take place.

How the Remote Ack All control works

When this control changes to a new non-zero value, all alarms are
acknowledged.
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Configure the data source to send a new non-zero value to the
Remote Ack All control each time you want a remote
acknowledgement of all alarms to take place.

Summary of steps
Follow these steps to configure alarms:

1. In the Alarm Setup editor, set up alarm triggers (the tags or
expressions to monitor), define the alarm messages and their
trigger values, and specify the graphic display to open when
alarms occur (if any).

Also use this editor to specify trigger data types, “Acknowledge
all” values, the maximum alarm log file size, the notification hold
time, and optional controls.

2. In the Startup editor, ensure that the Alarms box is checked (it is
checked by default). See Chapter 20.

3. If desired, in the Graphics Display editor modify the default
[ALARM] display, or create your own graphic display to use for
alarms. For example, if you won’t be using audible alarm signals,
edit the default display to remove the Silence Alarms button.

For information about graphic displays, see Chapter 8.

4. Test alarms on the runtime system.

Using the Alarm Setup editor

Use the Alarm Setup editor to configure alarms.

Create alarm messages.

Define alarm triggers.

Specify the graphic

display to use to display

alarm messages at

runtime.
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To configure alarms:

1. Open the Alarm Setup editor

2. Configure alarms in the tabs of the editor, as described in the
sections that follow.

3. Click OK.

Creating alarm triggers

The “Select trigger” box

displays the tags and

expressions that have

been added so far.

To edit a trigger, click it

and then click Edit.

Make your changes in

the Trigger dialog box.

To remove a trigger,

click it and then click

Remove.

Each trigger is a control (a tag or an expression) you want to
monitor for alarm conditions. For detailed information about alarm
triggers, see page 13-2.

The Select trigger box lists the triggers you create.

To create alarm triggers:

1. In the Triggers tab, click Add.

The Trigger dialog box opens.

2. Specify the tag or expression to use.

You can use analog, digital, and block tags to generate alarms.
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For information about specifying tags and expressions, see
page 7-28.

3. Click OK. The trigger you created is selected in the “Select
trigger” box.

4. Specify these properties for the trigger:

Trigger type

Select the type of data the trigger’s tag or expression uses (for
details, see page 13-6):

Value—integer or floating point values. Floating point values
are rounded to the nearest integer. Use with analog or digital
tags.

Bit—a bit array consisting of one or more bit positions. Use
this trigger type with block tags, to generate multiple alarm
messages with a single tag or expression.

LSBit—a bit array consisting of one or more bit positions.
Use this trigger type with block tags, to trigger alarms based
on a priority sequence determined by bit position.

Use ack all value

Check this box to send a value to the data source when the
operator presses the Acknowledge All Alarms button. Type the
integer value to send.

The “Acknowledge all” value works with the Ack and Remote
Ack controls. For details see page 13-11.

Optional trigger connections

If desired, assign tags to use for handshaking and
acknowledgement for the selected trigger (for details, see
page 13-11):

Handshake—Assign a digital tag to this control to notify the
data source when the trigger’s value changes.

Ack—Assign an analog or digital tag to this control to notify
the data source when the operator acknowledges an alarm (or
all alarms).

Remote Ack—Assign an analog tag or an expression to this
control to allow the data source to acknowledge alarms.

Remote Ack Handshake—Assign a digital tag to this control
to notify the data source when a remote acknowledgement
has been detected by RSView.
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For information about assigning tags and expressions, see
page 7-28.

5. Repeat steps 1 through 4 to create and configure additional
triggers.

Creating alarm messages
To view only the messages for

a single trigger, select it in the

“Trigger filter” box.

To sort the list of messages by

trigger or by message, select

an option in the “Sort by” box.

Use the scroll bar to see more

columns.

To create alarm messages:

1. In the Messages tab, in the Trigger column, select the trigger for
which to create messages.

To assign the same message to all the triggers you set up in the
Triggers tab, select <AllTriggers>.

If you are creating messages before setting up triggers, select
<Unassigned>. Once you set up triggers, select the appropriate
trigger for each message.

2. Specify these properties for the message:

Trigger value

Type a non-zero integer value or bit position. When the trigger
control’s value changes to this value, or when the bit in this
position changes from 0 to 1, the associated message is generated.
This column cannot be blank.
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For more information about trigger values, see page 13-2.

Message

Type the message, up to 256 characters.

Display

Check this box to open the alarm graphic display (if it is not
already open) when this alarm is generated.

The message is added to the alarm log file, and to any Alarm list
objects in your graphic displays, even if you do not check this
box.

Audio

For Windows 2000 projects, check this box to sound the runtime
computer’s internal beeper when this alarm is generated. The
beeper beeps continuously, .5 seconds on and .5 seconds off, until
the alarm is silenced.

Print

Check this box to print the alarm message when this alarm is
generated.

To print alarm messages at runtime, set up a printer on the
runtime terminal. For more information, see Chapter 23.

Background

Click this button to select a different color for the background of
the message text.

Foreground

Click this button to select a different color for the message text.

3. Repeat steps 1 and 2 to create additional messages.

Deleting messages

To delete a message:

� Select any cell in the message’s row, and then press Delete.
Shift-click in a column to select cells for multiple messages.

Copying messages

To copy a message:

1. In the Message column, select one or more messages and then
press Ctrl-C (or right-click the selected cells and then click
Copy).
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2. In the Message column, click the cell to paste the first message in,
and then press Ctrl-V (or right-click the cell and then click
Paste).

Creating messages in a spreadsheet
application

You can also create alarm messages in a spreadsheet application such
as Microsoft Excel, and then copy the messages into the Alarm Setup
editor.

To create messages in a spreadsheet application:

1. Create one message per row, as follows:

In column 1, type the trigger value.

In column 2, type the message.

Type the messages in the order you want them to appear in the
Alarm Setup editor.

2. If desired, in columns 3 through 5 configure the display, audio,
and print options. To use a display, audio, or print option, type a
character in the column. If you don’t want to use the option,
leave the column blank.

To copy the messages into the Alarm Setup editor:

1. In the Alarm Setup editor, create a row for each message by
clicking in the Trigger column and selecting the trigger to use.

To select a trigger without opening the list, type the first
character in the trigger name.
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2. In the application where you created the messages, select the cells
to copy, and then press Ctrl-C (or right-click the selected cells
and then click Copy).

3. In the Alarm Setup editor, click in the Trigger value column for
the first message and then press Ctrl-V (or right-click in the
column and then click Paste).

The cell contents from the spreadsheet application are pasted into
the first and succeeding rows.

4. If desired, configure the background and foreground settings for
the messages.

Specifying how alarms are displayed, stored, and
silenced

The options in the Advanced tab apply to all alarms (as opposed to a
single alarm trigger or message).

To specify how alarms are displayed, stored, and silenced:

1. In the Advanced tab, in the Current alarms box, select the
graphic display to use to display alarm messages. Click the
Browse button to select from a list of all the graphic displays in
the project.

The specified display opens when an alarm occurs, if you select
the Display option for the alarm message (in the Messages tab).

If you don’t want to open a graphic display automatically when
alarms occur, clear the box.

Browse button
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For information about the different graphic displays you can use
to display alarm information, see page 13-3.

2. To edit the selected graphic display, click Edit. The Graphics
Display editor opens with the selected display open for editing.

For information about graphic displays, see Chapter 8.

3. Specify these settings:

History Size

Type the number of alarms to retain in the alarm log file, up
to 10,000. When the log file contains this number of alarms, the
oldest alarms are deleted when new alarms occur.

For more information about the alarm log file, see page 13-5.

Hold time

Select the hold time to use when acknowledging and silencing
alarms. RSView holds the values at the Ack and Silence controls
for the specified length of time, then resets the controls to 0.

Optional connections

If desired, assign tags to use for silencing and remotely
acknowledging all alarms (for details, see page 13-14).

The Silence and Remote Silence controls apply to projects that
will run in Windows 2000 only.

Silence—Assign a tag to this control to notify the data source
that alarms have been silenced.

Remote Silence—Assign a tag or an expression to this control
to allow the data source to silence alarms.

Remote Ack All—Assign a tag to this control to allow the
data source to acknowledge all alarms at once.

For information about assigning tags and expressions, see
page 7-28.
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What to do next

Now that you’ve configured alarms:

In the Startup editor, ensure that the Alarms box is checked (it is
checked by default). For more information, see Chapter 20.

If desired, in the Graphics Display editor, modify the default
[ALARM] display, or create your own graphic display to use for
alarms. For example, if you won’t be using audible alarm signals,
edit the default display to remove the Silence Alarms button.

See the topics in the remainder of this chapter.

Test alarms on the runtime system.

The [ALARM] display

When you create a project, it comes with a graphic display called
[ALARM]. The [ALARM] display is the default display for showing
alarm messages at runtime.

Alarm list graphic

object

Buttons

Header

You can use the [ALARM] display as is, or modify the display. For
example, you can change the color of the objects, or add and remove
buttons.

Another option is to create your own graphic display to use when an
alarm occurs. For example, you could create a display with a static
text object that notifies the operator that an alarm has occurred, and
a Goto Display button that the operator can press to open a display
that lists the actual alarm message.

In the Advanced tab of the Alarm Setup editor, specify the display to
use.
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The Alarm list graphic object

The [ALARM] display contains an Alarm list graphic object, which
lists the alarm messages. You can configure the Alarm list to show all
alarms, or to show unacknowledged alarms only. The Alarm list in
the [ALARM] display is configured to show all alarms (but you can
edit it, if desired).

For more information about the Alarm list, see page 13-27.

Buttons in the [ALARM] display

The [ALARM] display contains alarm buttons for acknowledging,
clearing, and silencing alarms, as well as buttons for scrolling the list
and closing the display. For information about how the buttons
work, see page 13-28.

The [HISTORY] library

The Graphics Library contains a [HISTORY] library. It is similar to
the [ALARM] display, but the Alarm list graphic object is larger (to
display more alarm messages at once), and the library contains
additional Key buttons.

Alarm list graphic

object

Buttons

Header
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To use objects in the [HISTORY] library in your project, copy the
objects to your own graphic displays. For information about
copying objects from a library into your graphic display, see page
9-38.

You can also add the [HISTORY] library component into your
project. The graphic libraries are available on the development
computer, but do not appear at runtime. To use a library as a graphic
display at runtime, you must add the library into your project’s
folder of graphic displays.

To add the [HISTORY] library into your project:

1. In the Project Explorer, in the Graphics folder, right-click the
Displays icon.

2. Click Add Component Into Project.

3. In the dialog box, navigate to the Libraries folder, and then click
[HISTORY].gfx.

The Libraries folder is located in \Documents and Settings\All
Users\Documents\RSView Enterprise\ME.

For information about changing the location of library
component files see page 8-18.

4. Click Open. The [HISTORY] library is copied into the Displays
folder.

Once you copy the library into your project, you can use the
[HISTORY] display as the display to open when alarms are
triggered, or use it in conjunction with the [ALARM] display or
with an alarm display that you create.

Example: Using the [ALARM] and [HISTORY] displays
together

To use the [ALARM] display to alert the operator about
unacknowledged alarms only, and the [HISTORY] display as a full
record of all alarms:

1. In the Alarm Setup editor, in the Advanced tab, select the
[ALARM] display as the display to open when alarms are
triggered.
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2. Edit the [ALARM] display as follows:

Configure the Alarm list to show unacknowledged alarms
only. The list will display both new alarms and past alarms
that have not been acknowledged.

Create a Goto Display button that opens the [HISTORY]
display when pressed.

Creating your own alarm display

You can create your own graphic display for displaying alarms,
containing an Alarm list graphic object and the buttons the operator
needs for responding to alarms.

If you create your own graphic display, use an On Top display and
select the Cannot Be Replaced option.

For more information about the Alarm list, see page 13-27. For
information about the buttons you can use with the list, see
page 13-28. For information about creating graphic displays and
graphic objects, see Chapters 8 and 9.

Opening and closing the alarm display

Opening the display

The alarm display you specify in the Advanced tab of the Alarm
Setup editor (either the default [ALARM] display, the [HISTORY]
display you create, or your own display) is automatically opened
whenever a trigger control’s value matches a trigger value.

You can also create a Goto Display button that the operator can
press to open the alarm display. For information about configuring a
Goto Display button and specifying the display to open, see
Chapter 10.

Closing the display

The operator can close the display by pressing a Close Display
button.
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How the Alarm list works

At runtime, when a trigger control at the data source matches a
message’s trigger value, an alarm appears in the Alarm list. The
Alarm list can be in the [ALARM] or [HISTORY] display, in an
alarm display you have created, or can be placed on any display in
your project.

You can use multiple Alarm lists, in the same display or in different
displays. Each Alarm list displays information from the same alarm
log file, although you can configure different lists to display
different information (all alarms or only unacknowledged alarms).

What is displayed

If you configure the list to display a header, a heading bar
containing column headings appears at the top of the list.

If you configure the list to display the alarm time or
acknowledge time, these columns appear in the list.

If the list is configured to show unacknowledged alarms only,
only alarms that haven’t been acknowledged appear in the list.
The acknowledge time column, if any, is always blank.

If the list is configured to show all alarms, when an alarm has
been acknowledged, an asterisk (*) appears at the left end of the
row, and the acknowledge time appears in the acknowledge time
column, if any.

If the message is too long to fit in the object, the last displayed
character is replaced with an asterisk.

The number of alarm messages that fits in the display depends on
the height of the Alarm list and the list’s font size.

Alarms are listed with the newest alarms on top.

How the list scrolls

When a display containing an Alarm list is opened, the highlight
bar is at the top of the list, on the most recent alarm. As new
alarms come in, the old alarms scroll down, but the highlight
remains at the top.

If the operator highlights an alarm other than the top one in the
list (by using the Move Down button), and new alarms come in,
they appear at the top of the list and all other alarms, including
the highlighted alarm, scroll down.
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The highlighted alarm never scrolls off the bottom of the list.
Therefore, once the list fills it stops scrolling, and the operator is
unable to see new alarms that come in above the top alarm in the
list.

If the operator scrolls up to the top of the list (using the Move
Up button), the top alarm is highlighted. As new alarms come in
the old alarms scroll down but the highlight remains at the top,
on the most recent alarm.

Using buttons with the Alarm list

Alarm buttons

You can use these alarm buttons to interact with the Alarm list:

This button Does this

Acknowledge Alarm Acknowledges and silences the selected alarm.

Acknowledge All
Alarms

Acknowledges and silences all currently
unacknowledged alarms.

Silence Alarms Silences the audio indicator for all alarms
(Windows 2000 projects only).

Clear Alarm History Removes all alarms from the alarm log file and all
Alarm lists. If the Ack control is assigned for any
of the alarm triggers, the operator is prompted to
acknowledge all alarms before clearing them.

You can assign any caption you choose to the labels on the alarm
buttons.

You can link the Acknowledge Alarm button to a specific Alarm list,
or configure the button to work with whichever Alarm list is
selected in the graphic display. This option is useful if you have
multiple Alarm lists in the same graphic display. For more
information, see page 10-9.

For information about configuring alarm buttons, see Chapter 10.
For information about how the alarm buttons work at runtime, see
page 13-29.

Key buttons

You can also use these Key button graphic objects to interact with
the Alarm list:

This button Does this

Move Up Scrolls up one row in the list.

Move Down Scrolls down one row in the list.
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This button Does this

Page Up Moves the highlight bar up one page in the list.

Page Down Moves the highlight bar down one page in the
list.

Home Moves the highlight bar to the top alarm in the
list.

End Moves the highlight bar to the bottom alarm in
the list.

Enter Acknowledges the currently highlighted alarm.

You can link Key buttons to a specific Alarm list, or configure the
buttons to work with whichever object is selected in the graphic
display. For more information, see page 10-9.

For information about creating graphic objects, see Chapter 9. For
information about configuring buttons, see Chapter 10.

Using alarm buttons to acknowledge, silence, and
delete alarms

Acknowledging messages does not remove them from the alarm log
file. You can still display acknowledged alarms in an Alarm list that
is configured to show all alarms.

Acknowledging the selected alarm

When the operator presses the Acknowledge Alarm button, an Enter
button object, or the Enter key on an external keyboard or keypad,
the selected alarm is acknowledged and the audio indicator for the
alarm, if any, is silenced.

This is what happens when the alarm is acknowledged:

If assigned, the alarm trigger’s Ack control is set to the alarm
trigger value at the data source. The value is held as long as the
operator presses the button, or for the notification hold time,
whichever is longer.

If the hold time is still in effect and the operator acknowledges a
new instance of the same alarm, the new acknowledgment is
ignored.

If the list is configured to display unacknowledged alarms only,
the alarm is removed from the list. The highlight bar moves up to
the next unacknowledged alarm, unless it is already on the top
unacknowledged alarm.
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If the highlight bar is on an acknowledged alarm when the
operator presses the Acknowledge Alarm button, the button
press is ignored.

Acknowledging all alarms

When the operator presses the Acknowledge All Alarms button, all
unacknowledged alarms in the system are acknowledged.

This is what happens when all alarms are acknowledged:

For each alarm trigger to which an “Acknowledge all” value is
assigned, the specified “Acknowledge all” value is sent to the
trigger’s Ack control. The value is held as long as the operator
presses the button, or for the notification hold time, whichever is
longer. Then the control’s value is reset to 0.

If the “Acknowledge all” value is not assigned for a trigger, no
value is sent to the trigger’s Ack control.

If the hold time for any alarm is still in effect and the operator
presses Acknowledge All Alarms, the button press is ignored.

If the list is configured to display unacknowledged alarms only,
all alarms are removed from the list.

Silencing alarms

When the operator presses the Silence Alarms button, any audible
signal triggered by an alarm is silenced and the Silence control is set
to 1 for the notification hold time. Then the control’s value is reset
to 0.

If the hold time for any alarm is still in effect and the operator
presses Silence Alarms, the button press is ignored.

The audio alarm indicator is available for projects running in
Windows 2000 only.

Deleting messages

When the operator presses the Clear Alarm History button, all
alarms in the system are deleted from the alarm log file and from all
Alarm lists. For information about the alarm log file, see page 13-5.
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If the Ack control is assigned for any of the alarm triggers, the
operator is prompted to acknowledge the unacknowledged messages
before deleting them. If the operator chooses to acknowledge the
alarms, the “Acknowledge all” value (if any) is sent to the Ack
control before deleting the messages. If the Ack control is not
assigned, or if the operator chooses not to acknowledge alarms, all
messages are deleted immediately.
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Creating information
messages
This chapter describes:

preparing to set up information messages
how information messages work
steps for setting up information messages

using the Information Messages and Information Setup editors
creating information messages
setting up how messages are displayed
the [INFORMATION] display
creating your own information message display

opening and closing the information message display
how the Information Message display graphic object works
changing the information message file used at runtime

About information messages
Use information messages to give the operator messages about the
process, prompts or instructions, and information about current
states.

When to use information messages

Use information messages to give the operator information no
matter which display is open. To give the operator information in a
specific graphic display while the display is open, use local messages.

For details about local messages, see page 8-29.

Preparing to set up information messages
As your project is running, information is continually sent to the
data source about the state of various processes. For example, your
project might be monitoring whether a valve is open or closed, or
the temperature in a boiler. Values representing the status of these
processes are sent to the data source.

14
Chapter
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The data source

The data source can be memory or a device such as a programmable
controller or an OPC server. RSView writes values to and reads
values from the data source. The data source is configured to
exchange information (in the form of numeric or string values)
between RSView and the physical machine that your project is
controlling.

Identifying the tags and values to monitor

To set up information messages, determine which tags associated
with machine processes to monitor, and identify the values for those
tags that will trigger information messages.

For information about creating tags, see Chapter 7.

How information messages work

These are the key parts of the information message system:

Information message file—a text file containing a list of messages,
with a numeric trigger value for each message.

Information message display—a graphic display that opens at
runtime and displays information messages.

Value control—a tag or expression. When the value of this
control matches a message’s trigger value, the information
message display opens with the associated message displayed.

The following example shows how the key parts of the information
message system work together.

Example: Configuring the data source to display information
messages

This example shows how to configure the data source to notify the
operator that a conveyor belt has stopped. In this example, there are
two conveyor belts whose statuses are monitored.

1. Create a digital tag called Conveyor_1_Status. This tag points to
an address in a programmable controller that is linked to a sensor
on the first conveyor belt. When the belt is running, the tag’s
value is 0. When the belt stops running, the value changes to 1.
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2. Create a second digital tag called Conveyor_2_Status, pointing to
an address in the programmable controller that is linked to a
sensor on the second conveyor belt. When the belt is running, the
tag’s value is 0. When the belt stops running, the value changes to
1.

3. Create an analog tag called Information_Messages, and configure
the data source to send a value of 1 to this tag when
Conveyor_1_Status has a value of 1. Configure the data source to
send a value of 2 to the Information_Messages tag when the
Conveyor_2_Status tag has a value of 1.

4. In the Information Messages editor, create these messages with
trigger values matching the values that will be sent to the
Information_Messages tag:

Trigger value Message

1 Conveyor belt 1 has stopped.

2 Conveyor belt 2 has stopped.

Save the message file with the name “Conveyor belts.”

5. In the Information Setup editor, assign the
Information_Messages tag to the Value control, and select the
Conveyor belts message file.

At runtime, when the value of Conveyor_1_Status changes to 1, the
first message is displayed (in the default information message
display). When the value of Conveyor_2_Status changes to 1, the
second message is displayed.

Information messages and trigger values

Create messages associated with each tag value change that you want
to inform the operator about. Assign each message a trigger value,
and configure the data source to send the trigger value to the Value
control.

The trigger value can be any non-zero integer value (positive or
negative). Trigger values do not need to be contiguous, but they
must be unique for each message. For example, you could use trigger
values of 1, 2, and 3, or values of 10, 20, and 30.
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Trigger values cannot be 0. Digital tags have two possible values, 0
and 1. Therefore, if you use a digital tag you can only use the value 1
to trigger a message. If you want to use a digital tag to trigger two
different messages, create an expression that adds 1 to the digital
tag’s value. That way, you can use the trigger values 1 and 2.

If you use an analog tag or an expression, you can use any non-zero
integer or floating point value to trigger an alarm. Floating point
values are rounded to the nearest integer. For information about
how values are rounded, see page 7-3.

You can create multiple information message files, but you can use
only one message file at runtime. For information about using a
different message file, see page 14-12.

The information message display

RSView comes with a preconfigured information message graphic
display called [INFORMATION]. It contains an Information
Message display graphic object and buttons for acknowledging the
displayed message and closing the display. By default, the
[INFORMATION] graphic display opens automatically at runtime
when an information message is generated.

You can accept the default, edit the [INFORMATION] display, or
create your own display. Another option is to place the Information
Message display object in a graphic display that doesn’t open
automatically when a message is generated.

For more information about the [INFORMATION] display, see
page 14-10. For information about creating your own information
message display, see page 14-11. For information about the
Information Message display graphic object, see page 14-12.

Summary of steps
Follow these steps to configure information messages:

1. In the Information Messages editor, set up the messages and their
trigger values.

2. In the Information Setup editor, specify the graphic display to
open when information messages occur, and the file of messages
to display.

Also use this editor to assign a tag or expression to the Value
control. If you want the operator to acknowledge messages,
assign the Ack control and specify the acknowledge hold time.
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3. In the Startup editor, ensure that the Information messages box is
checked (it is checked by default). See Chapter 20.

4. If desired, in the Graphics Display editor modify the default
[INFORMATION] display, or create your own graphic display
to use for information messages. For example, if you don’t want
the operator to acknowledge messages, edit the default display to
remove the Information Acknowledge button.

For information about graphic displays, see Chapter 8.

Using the Information Messages editor
Use the Information Messages editor to create one or more files of
information messages. Each file is stored in the editor’s folder. You
can open and work on multiple message files at the same time.

You can define up to 10,000 messages in each message file.

Creating information messages

To create information messages:

1. Open the Information Messages editor.

2. Specify these properties for the message:

Trigger value

Type a non-zero integer value. When the Value control changes
to this value, the associated message is generated. This column
cannot be blank.

For more information about trigger values, see page 14-3.
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Message

Type the message, up to 256 characters. You can use the new line
characters, \n, to specify that the message continues at the
beginning of the next line.

3. Repeat steps 1 and 2 to create additional messages.

4. To sort the messages by trigger value, highlight the rows to sort,
right-click in any of the selected rows, and then click Sort.

5. On the File menu click Save, or click the Save tool.

6. In the Component name box, type a name for the file, and then
click OK.

7. Click Close.

Deleting messages

To delete a message:

� Select any cell in the message’s row, and then press Delete.
Shift-click in a column to select cells for multiple messages.

Copying messages

To copy a message:

1. In the Message column, select one or more messages and then
press Ctrl-C (or right-click the selected cells and then click
Copy).

2. In the Message column, click the cell to paste the first message in,
and then press Ctrl-V (or right-click the cell and then click
Paste).

Creating messages in a spreadsheet
application

You can also create information messages in a spreadsheet
application such as Microsoft Excel, and then copy the messages into
the Information Messages editor.

Save tool
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To create messages in a spreadsheet application:

� Create one message per row, as follows:

In column 1, type the trigger value.

In column 2, type the message.

Type the messages in the order you want them to appear in the
Information Messages editor.

To copy the messages into the Information Messages

editor:

1. In the application where you created the messages, select the cells
for the trigger values and messages to copy, and then press
Ctrl-C (or right-click the selected cells and then click Copy).

2. In the Information Messages editor, click in the Trigger value
column for the first message and then press Ctrl-V (or right-click
in the column and then click Paste).

The cell contents from the spreadsheet application are pasted into
the current and succeeding rows.
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Setting up how information messages are displayed

Use the Information Setup editor to set up how information
messages are displayed.

To set up how information messages are displayed:

1. Open the Information Setup editor.

2. In the “Display file name” box, select the graphic display to use
to display information messages. Click the Browse button to
select from a list of all the graphic displays in the project.

If you clear the box, no display is opened when the Value control
changes to an assigned trigger value.

For information about the different graphic displays you can use
to display information messages, see page 14-4.

3. To edit the selected graphic display, click Edit. The Graphics
Display editor opens with the selected display open for editing.

For information about graphic displays, see Chapter 8.

4. In the “Message file name” box, select the file of information
messages to display. Click the Browse button to select from a list
of all the information message files in the project.

If you leave the box blank, no messages are ever displayed. If you
specify a message file, it is used for all Information Message
display objects you place in your graphic displays.

For information about creating information message files, see
page 14-5.

Browse button



� 14-9Creating information messages

5. To edit the selected message file, click Edit. The Information
Messages editor opens with the selected message file open for
editing.

6. Specify these settings:

Acknowledge hold time

Select the hold time to use when acknowledging information
messages. RSView sets the value at the Ack control to 1 for the
specified length of time (or as long as the operator presses the
Information Acknowledge button, whichever is longer), then
resets the control to 0.

Connection

Assign a tag or expression to these controls:

Value—Assign a tag or expression to this control. The
information message graphic display opens when the Value
control at the data source changes from 0 to a non-zero value.

If you assign an expression, RSView calculates the value of the
expression and opens the display when the expression value
changes from 0 to a non-zero value.

Ack—Assign a digital tag to this control to notify the data
source when the operator acknowledges an information
message.

For information about assigning tags and expressions, see
page 7-28.

7. Click OK.

What to do next

Now that you’ve configured information messages:

In the Startup editor, ensure that the Information messages box is
checked (it is checked by default). For more information, see
Chapter 20.

If desired, in the Graphics Display editor, modify the default
[INFORMATION] display, or create your own graphic display
to use for information messages. For example, if you don’t want
the operator to acknowledge information messages, edit the
default display to remove the Information Acknowledge button.

See the topics in the remainder of this chapter.
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The [INFORMATION] display
When you create a project, it comes with a graphic display called
[INFORMATION]. The [INFORMATION] display is the default
display for showing information messages at runtime.

Information

Message display

graphic object

Buttons

You can use the [INFORMATION] display as is, or modify the
display. For example, you can change the color of the objects, or add
and remove buttons. Or, you can create your own graphic display to
use for displaying information messages. In the Information Setup
editor, specify the display to use.

The Information Message display graphic object

The [INFORMATION] display contains an Information Message
display graphic object, which lists one information message at a
time.

For information about how the Information Message display object
works at runtime, see page 14-12.

Buttons in the [INFORMATION] display

The [INFORMATION] display contains these buttons:

This button Does this

Ack
(Information
Acknowledge)

Acknowledges the information message.

Close
(Close Display)

Closes the information message graphic display.

You can assign any caption you choose to the labels on the buttons.

Using the Information Acknowledge button

When the operator presses the Information Acknowledge button, if
the Ack control is assigned, the control value is set to 1 at the data
source. The value is held as long as the operator presses the button,
or for the acknowledge hold time, whichever is longer. Then the
control is reset to 0.



� 14-11Creating information messages

Creating your own information message display

You can create your own graphic display for displaying information
messages, containing an Information Message display graphic object
and the buttons you want to use in the display.

If you create your own graphic display, use an On Top display and
select the Cannot Be Replaced option.

For more information about the Information Message display
graphic object, see page 14-12. For information about creating
graphic displays and graphic objects, see Chapters 8 and 9.

Opening and closing the information message
display

Opening the display

The information message display you specify in the Information
Setup editor (either the default [INFORMATION] display or your
own display) is automatically opened whenever the Value control’s
value matches a trigger value.

You can also create a Goto Display button that the operator can
press to open the information message display. For information
about configuring a Goto Display button and specifying the display
to open, see Chapter 10.

Closing the display

The information message display closes when the Value control’s
value changes to 0.

To automatically close the display when the operator acknowledges
a message, configure the data source to set the Value control to 0
when the Ack control is set to 1.

The operator can also close the display by pressing a Close Display
button.
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How the Information Message display graphic
object works

At runtime, when the Value control at the data source changes from
0 to a non-zero value, the assigned information message display
opens. If the value matches a message’s trigger value, the associated
information message appears in the Information Message display
graphic object. The object can be in the default [INFORMATION]
display, in an information message display you have created, or can
be placed in any display in your project.

What is displayed

If the Value control is unassigned, the information message
graphic display never opens automatically. If the operator opens
a graphic display containing an Information Message display
object, the object is blank.

The Value control is rounded up to the nearest integer. If the
value does not match any of the trigger values in the specified
message file, the display is filled with questions marks (?).

For information about how values are rounded, see page 7-3.

If the message is too long to fit in the Information Message
display object, the last displayed character is replaced with an
asterisk (*).

When the Value control’s value is 0, the information message
graphic display is closed.

Changing the message file used at runtime

Your project can use only one message file at a time. Follow this
procedure to switch message files.

To use a different message file:

1. Shut down the project.

2. Open RSView Studio and open the project.

3. In the Information Setup editor, specify the new information
message file.

4. Create the runtime project. See Chapter 20.

5. Transfer the runtime project to the runtime platform.
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For information about transferring projects to a Windows CE
platform, see Chapter 21.

For information about transferring projects to a Windows 2000
platform, see Chapter 22.

6. Run the new project.
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Setting up activity
logging

This chapter describes:

what activity logging is

message severities and categories of system activities

displaying activity messages during project development

displaying activity messages at runtime

steps for changing the default settings for runtime activity
logging

using the Activity Log Setup editor

the [ACTIVITY] display

creating your own activity display

opening and closing the activity display

how the Activity list works

About activity logging

While you develop your project, use activity logging to track what
the system is doing and to ensure you’ve set things up the way you
intend. At runtime, use activity logging to show the operator
messages about system activity.

Message severity

There are three different severities of activity messages:

Information—messages about activities such as tag read and
write activity, users logging in and out, and server usage (RSView
uses servers to control different aspects of runtime operations,
such as data logging and alarm monitoring).

15
Chapter
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Warnings—messages about activities such as tag read and write
failures, server failures, or problems opening and closing graphic
displays.

Errors—messages about activities such as communication errors,
invalid values, connection failures, and unassigned controls.

Activity messages are preceded by a white, yellow, or red icon.
White indicates information, yellow indicates a warning, and red
indicates an error. The content of the messages is provided by the
system—you don’t need to do anything to set up message content.

You can choose which message severities to log.

Which activities can be logged?

While your project is running, various system activities occur. You
can log any or all of these categories of system activity:

application messages (about server status, server activity, and
problems running the project)

communication errors (from the communication network)

macro usage

tag write activity

tag read activity (normal scanning is not logged as a tag read)

For each category of system activity, you can specify whether to
display any or all severities of messages.

Displaying activity messages during project
development

During project development, activity messages are displayed when
you test your graphic displays. The messages are displayed in the
activity bar at the bottom of the RSView Studio window.

By default, all warning and error messages are displayed.

For information about testing graphic displays, see page 8-9.

To display the activity bar:

� On the View menu, click Activity Bar. A check mark beside the
menu item indicates the Activity Bar is displayed.

For information about moving, resizing, and clearing messages in the
activity bar, see page 2-4.
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If you don’t want to display activity messages:

� On the View menu, deselect Activity Bar. The menu item is
deselected when no check mark appears.

To change the categories and severities of messages that

are displayed:

1. On the Tools menu, click Options.

2. Click the Activity Bar Logging tab.

3. In the Categories list, click a category of system activities.

4. To display a severity of messages, check the box for the severity.
Clear the check box for the severity of message you don’t want
to display. To disable all messages for the category, clear all the
boxes.

5. Repeat steps 2 and 3 to set up additional categories and severities
of messages.

6. Click OK.

Displaying activity messages at runtime

At runtime, you can display activity messages in a graphic display.
You can also print the messages.

Printed messages list the date and time, the category of system
activity, and the message text.
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By default, your project is set up to display errors and warnings (but
not information messages) for all categories of system activity at
runtime. If you want to use the default settings, you don’t need to
do anything further to set up activity logging.

If you don’t want to display activity messages at runtime:

� In the Activity Log Setup editor, clear the Display name box, or
clear the three “Open display automatically when” boxes.

The activity message display

RSView comes with a preconfigured activity message graphic display
called [ACTIVITY]. It contains an Activity list graphic object,
which lists the activity messages, and buttons for scrolling through
the list of messages, clearing messages, and closing the display. By
default, the [ACTIVITY] graphic display opens automatically at
runtime when an activity warning or error message is generated.

You can use the [ACTIVITY] display as is, edit the display, or create
your own display. Another option is to place the Activity list object
in a graphic display that doesn’t open automatically when a message
is generated.

For more information about the [ACTIVITY] display, see
page 15-7. For information about creating your own activity
message display, see page 15-7. For more information about the
Activity list, see page 15-8.

Summary of steps

Follow these steps to change the default settings for runtime activity
logging:

1. In the Activity Log Setup editor, specify the categories of system
activity and severities of messages to log, how to display
information at runtime, the graphic display to use, and the
maximum number of messages to store in memory.

2. If desired, in the Graphics Display editor modify the default
[ACTIVITY] display, or create your own graphic display to use
for activity messages. For example, if you don’t want the
operator to clear all messages at once, edit the default display to
remove the Clear All button.

For information about graphic displays, see Chapter 8.



� 15-5Setting up activity logging

Using the Activity Log Setup editor

Use the Activity Log Setup editor to set up how activity logging
works at runtime.

To set up how activity logging works at runtime:

1. Open the Activity Log Setup editor.

2. In the Select category list, click a category of system activities.

3. Select one or both destinations for logging errors, warnings, and
information messages. If you don’t want to log to either
destination, clear the check boxes.

To print activity messages at runtime, check the appropriate
Printer boxes and set up a printer on the runtime terminal.

For information about specifying the printer to use at runtime,
see Chapter 23.

4. Repeat steps 2 and 3 to set up logging destinations for additional
categories of system messages.

5. In the Display name box, select the graphic display to use to
display activity messages. Click the Browse button to select from
a list of all the graphic displays in the project.

If you don’t want to display activity messages at runtime, clear
the box.

Browse button
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For information about the different graphic displays you can use
to display activity messages, see page 15-4.

6. To edit the selected graphic display, click Edit. The Graphics
Display editor opens with the selected display open for editing.

For information about graphic displays, see Chapter 8.

7. Specify these settings:

Open display automatically when

Specify when to open the activity display. Select any or all
options:

Error occurs—RSView opens the activity display when a new
error occurs.

Warning occurs—RSView opens the activity display when a
new warning occurs.

Information occurs—RSView opens the activity display when
a new information message occurs.

If you don’t want the activity display to open automatically, clear
all the check boxes.

The specified categories and severities of activity messages are
logged to the Activity list whether or not you set up the activity
display to open automatically.

If you elect not to open an activity display automatically, you can
still display activity messages in any Activity list graphic object,
in any graphic display. Create a Goto Display button that the
operator can use to open the graphic display containing the
Activity list.

Maximum number of messages

Type the maximum number of messages to store in memory, up
to 2000. When this number is reached, the oldest message is
deleted to make room for a new message. When you stop
running the project, the messages are removed from memory.

8. Click OK.

What to do next

Now that you’ve set up activity logging, you can, if you like, use the
Graphics Display editor to modify the default [ACTIVITY] display
or to create your own graphic display for activity messages. For
example, if you don’t want the operator to clear all messages at once,
edit the default display to remove the Clear All button.

See the topics in the remainder of this chapter.
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The [ACTIVITY] display

When you create a project, it comes with a graphic display called
[ACTIVITY]. The [ACTIVITY] display is the default display for
showing activity messages at runtime.

Activity list graphic

object

Buttons

You can use the [ACTIVITY] display as is, or modify the display.
For example, you can change the color of the objects, or add and
remove buttons. Or, you can create your own graphic display to use
for displaying activity messages. In the Activity Log Setup editor,
specify the display to use.

The Activity list graphic object

The [ACTIVITY] display contains an Activity list graphic object,
which lists the activity messages. For more information about the
Activity list, see page 15-8.

Buttons in the [ACTIVITY] display

The [ACTIVITY] display contains activity log buttons for clearing
the messages, as well as buttons for scrolling the list and closing the
display. For information about how the buttons work, see
page 15-9.

Creating your own activity display

You can create your own graphic display for displaying activity
messages, containing an Activity list graphic object and the buttons
the operator needs for using the display.

If you create your own graphic display, use an On Top display and
select the Cannot Be Replaced option.

For more information about the Activity list, see page 15-8. For
information about the buttons you can use with the list, see
page 15-9. For information about creating graphic displays and
graphic objects, see Chapters 8 and 9.
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Opening and closing the activity display

Opening the display

The activity display you specify in the Activity Log Setup editor
(either the default [ACTIVITY] display or a display you create) is
automatically opened whenever an activity message of the specified
severity occurs.

The display remains open until the operator closes the display.

If you decide not to open the activity display automatically, you can
create a Goto Display button that the operator can press to open the
activity display. For information about configuring a Goto Display
button and specifying the display to open, see Chapter 10.

Closing the display

The operator can close the display by pressing a Close Display
button.

How the Activity list works

At runtime, when a category and severity of system activity occurs
that you’ve configured to log, a message about the activity is added
to the Activity list. The Activity list can be in the [ACTIVITY]
display, in an activity display you have created, or can be placed on
any display in your project.

You can use multiple Activity lists, in the same display or in
different displays. Each Activity list displays the same information.

What is displayed

If the message is too long to fit in the list, the last displayed
character is replaced with an asterisk (*).

The number of activity messages that is visible at one time
depends on the height of the Activity list and the list’s font size.

Activity messages are listed with the newest activity message on
top.
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Using buttons with the Activity list

Activity buttons

You can use these activity buttons to interact with the Activity list:

This button Does this

Activity Clear Clears the selected message from all Activity lists
in the project.

Activity Clear All Clears all activity messages from all Activity lists
in the project.

You can assign any captions you choose to the labels on the activity
buttons.

You can link the Clear button to a specific Activity list. When the
operator presses the button, the selected message is deleted from the
linked activity list, and also from any other activity lists in the
project. For information about linking buttons to objects, see
page 10-9.

Key buttons

You can also use these Key button graphic objects to interact with
the Activity list:

This button Does this

Move Up Scrolls up one row in the list.

Move Down Scrolls down one row in the list.

Page Up Moves the cursor up one page in the list.

Page Down Moves the cursor down one page in the list.

Home Moves the cursor to the top message in the list.

End Moves the cursor to the bottom message in the
list.

You can configure the Key buttons to work only with the specified
Activity list, or to work with whichever object is selected in the
graphic display. For information about linking buttons to objects,
see page 10-9.

For information about creating graphic objects, see Chapter 9. For
information about configuring buttons, see Chapter 10.



 



� 16-1Setting up data logging

Setting up data logging
This chapter describes:

data logging and the trend graphic object

data log models

the different data logging methods

data storage locations

steps for configuring data logging

using the Data Log Models editor

creating and configuring data log models

changing the data log model used at runtime

problems with data logging

Data logging and the trend graphic object
Use data logging to keep a permanent record of tag data. You can
record tag data as tag values change, or on a periodic basis (for
example, every minute).

You can use the trend graphic object to display the data that you’ve
logged. At runtime, when the operator opens a graphic display
containing a trend, the trend displays values from the data log file
for the data log model that is running. The data log model specifies
which data to collect in the data log file.

In addition to displaying historical values from the data log file,
trends can display current tag values for the tags in the model.
Trends can also display current values for tags or expressions that are
not in a data log model. For more information about trends, see
Chapter 17.

What is a data log model?
A data log model defines which tags to log data for, as well as how
and where the data is logged. For information about creating a data
log model, see page 16-5.

16
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You can configure multiple data log models, but you can run only
one data log model at a time. For information about running a
different data log model, see page 16-10.

Tags in the data log model

The data log model can contain up to 100 analog or digital tags.

You cannot use string tags, block tags, tag placeholders, or
expressions in your data log model.

Deleting tags from the model

If you delete a tag from the data log model, previously logged data
for the tag is not accessible unless you add the tag back to the model.

Data log files

As soon as the project starts running, RSView begins logging tag
values to the data log files. When the maximum number of data
points have been logged, the oldest data is deleted to make room for
the new data. RSView supplies data from the log files to the trend
object for the requested tags and time span.

The data log files are retained when you restart a project after a
shutdown or power loss. You can delete the log files from the
runtime computer at project startup.

For information about deleting the log files, see Chapter 23.

File names

RSView creates two data log files:

Data Log Model Name.log

Data Log Model Name.tag

You’ll need this information if you log to a custom path and want to
delete the log files manually.

Data logging methods

There are two methods for triggering data logging. You can set up
logging so tag values are logged:

periodically (periodic logging)

only when a tag value changes (on-change logging)
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Logging periodically

Periodic logging is used to take a snapshot of all tag values at a
particular point in time. Tag values are logged even if there has been
no change.

Do not set the logging interval to be faster than the scan class rate or
OPC update rate, or you will log redundant data. For information
about scan classes, see page 5-17. For information about OPC
update rates, see page 6-13.

You cannot change the periodic log rate at runtime.

Logging on change

On-change logging is used to log only tags whose values have
changed. Before logging occurs, the change must equal a specified
percentage of change in the tag value.

The percentage is based on the tag’s minimum and maximum values
as configured in the Tag Database editor. Only the tags that change
by the specified percentage are logged. If you specify a percentage
of 0, all changes are logged.

You can also specify a heartbeat rate, to log values at specified times
even if no tag value changes have occurred. The heartbeat ensures
that the data in the log file is current. The heartbeat is also a good
way to ensure that data logging is working and acquiring valid data.
If you specify a heartbeat of 0, the heartbeat is not used.

Data storage locations

You can store data log files in any one of these locations:

on the runtime computer

on another computer on the network

on a PCMCIA card (for RAC6182 projects only)

Logging to a network location

To log data to a network location, the runtime computer must be
logged in to the same domain as the computer on the network. To
do this, the user must have access rights for the domain.

For information on logging in to a Windows domain, see page 24-1.
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Summary of steps

Follow these steps to set up data logging:

1. In the Data Log Models editor, set up a data log model that
specifies how many log values to store, the conditions that trigger
data logging, where to log data, and which tags to monitor.

2. In the Startup editor, turn on data logging by selecting the Data
logging check box. Also use this editor to specify the data log
model to use at runtime. See Chapter 20.

3. In the Graphics Display editor, create a graphic display
containing the trend graphic object, and set up how the object
looks, which tag values to display, the start time, and the time
span for the data. Also specify the name of the data log model to
use. See Chapters 8 and 17.

Using the Data Log Models editor

Use the Data Log Models editor to create one or more data log
models. Each data log model is a file stored in the editor’s
folder—you can open and work on multiple models at the same
time.
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Set up general aspects

of the model.

Specify how logging

should occur.

Specify which tags

to log data for.

Specify where to log

the data.

Creating data log models

To create a data log model:

1. Open the Data Log Models editor.

2. Configure the model in the tabs of the editor, as described in the
sections that follow.

3. On the File menu click Save, or click the Save tool.

4. In the Component name box, type a name for the model, and
then click OK.

5. Click Close.
Save tool
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Configuring data log models

Specifying how much data to store

You specify a name

for the model when

you save it.

To specify the maximum amount of data to store:

1. In the Setup tab, type a description of the model, up to 50
characters. This is for your information only.

2. Type the maximum number of data values to store, between 100
and 300,000.

When your data exceeds the limit, the oldest data is deleted from
the data log file. The higher the limit, the more space the data log
file requires on the runtime computer, or on the remote
computer (if logging to a custom path on a remote PC).
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Specifying where to store the data

To specify where to store the data:

� In the Paths tab, click System default or Custom.

System default

If you select this option, the location where log files are stored
depends on the runtime platform.

Log files for Windows 2000 projects are stored in this folder:

\Documents and Settings\All Users\Documents\
RSView Enterprise\ME\Logs\Runtime Project Name\
DLGLOG\Data Log Model Name

Log files for RAC6182 projects are stored in this folder:

\Storage Card\Rockwell Software\RSViewME\Logs\
Runtime Project Name\DLGLOG\Data Log Model Name

Custom

If you select this option, type the path to the folder where you
want the log files to be stored. The path syntax depends on the
runtime platform.
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For Windows 2000 projects, the path must contain a drive
letter (such as C:\) or use the Universal Naming Convention
(UNC) style.

Paths using UNC style begin with two backslashes. For
example, \\server\logs uses UNC style. In this example, logs
is a shared folder on a network server.

For RAC6182 projects, you can log to a location on the
RAC6182 or to a PCMCIA card. For example, \Storage
Card\Data\Logs specifies a location on the RAC6182.

To log from the RAC6182 to a network folder, use UNC
style.

You can specify a path to a folder that does not exist. If it doesn’t
exist, it is created at runtime, as long as the user logged in to the
runtime computer has folder creation rights at the specified
location.

Specifying when to log data

To specify when to log data:

1. In the Log Triggers tab, click Periodic or On Change to specify
whether logging takes place at regular intervals or when tag
values change.

2. Fill in the boxes as follows:

Log Periodically

In the Interval box, type a time and click a time unit to specify
how often tag values are logged. All tags in the model are logged
each time this interval expires.



� 16-9Setting up data logging

Log on tag change

In the Change Percentage box, type the percent the tag value has
to change in order to trigger logging. To log all changes, type 0.

To specify how often tag values are logged even if no change has
occurred, in the Heartbeat box type a time, and then click a time
unit. If you do not want to use the heartbeat, type 0. If you
type 0, tags values are logged only when a tag value changes.

Specifying the tags to log data for

The “Tags in model”

box displays the tags

that have been added

to the model so far.

To remove a tag from

the model, click it and

then click Remove.

To remove all the tags

from the model, click

Remove All.
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To specify the tags to log data for:

1. In the Tags in Model tab, in the “Tags to add” box, specify the
tags to log by doing one of the following:

Type the tag names, with a space between each tag name.

Click the Browse button to open the Tags dialog box, and
then select tags. Shift-click or click and drag to select groups
of tags. Ctrl-click to select multiple individual tags. Click OK
when you’re finished selecting tags.

2. Click Add. The tags listed in the “Tags to add” box move to the
“Tags in model” box.

What to do next

Now that you’ve created the data log model:

In the Startup editor, turn on data logging and specify the data
log model to use at runtime. For more information, see
Chapter 20.

In the Graphics Display editor, create a display containing a
trend graphic object, and configure the trend to display the
values from the data log model. For more information, see
Chapters 8 and 17.

Changing the data log model used at runtime

Your project can run only one data log model at a time. Follow this
procedure to switch data log models.

To run a different data log model:

1. Shut down the project.

2. Open RSView Studio and open the project.

3. In the Startup editor, specify the new data log model.

4. Create the runtime project. See Chapter 20.

5. Transfer the runtime project to the runtime platform.

For information about transferring projects to a Windows CE
platform, see Chapter 21.

For information about transferring projects to a Windows 2000
platform, see Chapter 22.

6. Run the new project.

Browse button
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Problems with data logging

Problems with data logging occur under these circumstances:

If logging to a folder on a networked computer, and the runtime
computer is not logged in to the Windows domain of the
network computer, the log folder cannot be created. An error
message is sent to the activity log.

If logging to an invalid path, the log folder cannot be created. An
error message is sent to the activity log.

If the storage device becomes full due to lack of disk space, data
logging stops and an error message is sent to the activity log.
When sufficient disk space becomes available, data logging
continues, but the data that would have been logged during the
intervening time cannot be retrieved.

If there is not enough disk space at project startup, the data log
model does not start when the project starts. An error message is
sent to the activity log.
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Configuring trends

This chapter describes:

what trends are

the parts of the trend graphic object

the different chart types

choosing colors, fonts, lines and markers for the trend

testing the trend

steps for creating trends

creating and configuring trend graphic objects

using objects from the Trends graphic library

using buttons to control the trend at runtime

printing trend data

runtime errors for trends

About trends

A trend is a visual representation of real-time or historical tag values.
The trend provides operators with a way of tracking plant activity as
it is happening.

You can:

plot data for as many as eight tags on one trend

create a trend that is part of a graphic display or acts as the entire
graphic display

plot data over time, or plot one variable against another in an XY
Plot chart to show the relationship between them

display isolated or non-isolated graphs. Isolated graphing places
each pen in a separate band of the chart. With non-isolated
graphing, pen values can overlap.

create buttons to allow the operator to pause, scroll, and print the
trend data

17
Chapter
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The illustration below shows a trend that has been added to a
graphic display. You can view the Kiln Status display by opening the
Malthouse sample project.

Trend

graphic

object

Current versus historical data

The data displayed in a trend can come from two sources. For
current values, data comes from the value table as it is collected. The
value table is a record of the most recent values collected from the
data source, and is stored in temporary memory while the project is
running.

For historical values, data comes from a data log model’s log file, if a
model is assigned to the trend. You can display both current and
historical data in the same trend.

For information about data log models, see Chapter 16.

Time, date, and number formats

The trend is displayed using the time, date, and number formats you
set up on the runtime computer.
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For information about specifying time, date, and number formats on
the RAC6182, see page 21-3. For information about specifying time,
date, and number formats in Windows 2000, see page 22-3.

The parts of a trend

The illustration below shows a standard trend chart, with three pens
and a two-minute time span. Two of the pens have markers. The
third uses digital plotting. For more information about plot types,
see page 17-22.

Chart

Y-axis

Vertical (Y) axis

label

Trend border

Horizontal (X) axis labelX-axis

Digital

plotting

Pen icon

Pen marker

Pen marker
Trend window

Trend border

The border appears around the trend object at runtime when the
trend is selected. The border uses the highlight color for the graphic
display, specified in the Behavior tab of the Display Settings dialog
box.



Preface

17-4 � RSView Machine Edition User’s Guide

Trend window

The area around the chart, between the border and the chart, is the
trend window. You can use the Property Panel to specify whether
the window is transparent or opaque. If it is opaque, you can specify
its color.

Chart

The chart is the area of the trend in which values are plotted. It is
bounded by the Y-axis on the left and the X-axis on the bottom. It
contains the plotted trend data (shown using pen lines and pen
markers), as well as grid lines (if you choose to display them).

Y-axis

The Y-axis is the left vertical edge of the chart. It is also known as
the vertical axis.

Vertical axis labels

The vertical axis labels show the scale (range) of values for the pens.
If desired, you can configure the trend to omit the vertical axis
labels.

The minimum and maximum values for the scale can be determined
automatically (using the best fit for the current data), derived from a
pen’s minimum and maximum values, use a constant value, or be
controlled by tags.

You can configure the trend so all pens use the same scale, or use
individual ranges for each pen. If you choose the latter method,
create a Next Pen button in the graphic display, to allow operators
to view the range for each pen. When the operator presses the
button, the vertical axis changes to the new pen’s range.

For example, if Pen 1 has a minimum value of 10 and a maximum
value of 100, the range on the vertical axis is 10 to 100 when the pen
is selected. If Pen 2 has a minimum of -10 and a maximum of 50, the
range on the vertical axis changes to -10 to 50 when the operator
presses the Next Pen button.

X-axis

The X-axis is the bottom horizontal edge of the chart. It is also
known as the horizontal axis.
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Horizontal axis labels

For standard charts, the horizontal axis labels indicate the time span
covered by the trend. For XY Plot charts, the horizontal axis labels
show the scale (range) of values for the pen selected to serve as the
X-axis pen.

If desired, you can configure the trend to omit the horizontal axis
labels. The number of labels depends on the size of the trend object
and the number of vertical grid lines.

Pens

Pens are the lines and/or symbols used to represent values. The
values can be tags you are monitoring, expressions that manipulate
tag values, or constants. For details, see page 17-20.

If there is no data for a pen, or if the data is outside the vertical axis
range, the pen does not appear in the chart.

Pen icons

Pen icons appear at the right edge of the chart at runtime, if you
choose to display them. The icon’s position indicates the pen’s most
recent recorded value (from the value table), even if the trend is
paused or if the most recent value has not been plotted yet.

Pen markers

Pen markers are symbols that indicate data points. If data is plotted
frequently, the markers might not appear as distinct, separate
symbols. For example, see the lowest pen in the illustration on
page 17-3.

Chart types

Standard vs. XY Plots

You can create a standard chart, which plots tag values against time,
or an XY Plot chart, which plots one (or more) tag’s values against
another’s.
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This illustration shows what an XY Plot chart might look like:

Time period

Notice that the horizontal axis labels display the range for the
specified X-axis pen. The time period covered by the chart is at the
upper left.

Isolated graphing

For charts with multiple pens, you can allow the pen values to
overlap, or you can isolate each pen in its own horizontal band on
the chart.
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This is an example of isolated graphing, with a 10% buffer between
each pen’s band:

Notice that in this illustration each pen uses its own scale. If desired,
you can use the same scale for all pens.

With isolated graphing, a grid line is automatically placed above each
pen’s band.

Plotting a value across the full width of the
chart

Use horizontal lines to provide a frame of reference for your tag
data. For example, if you define values that are the limits within
which a tag should operate, and display horizontal lines in your
trend to indicate the limits, when a tag crosses one of these limits the
tag’s alarm condition is obvious on the trend.

There are two ways to plot a value across the full width of the chart:

In the Connections tab, assign a constant value to a pen.

When values for the pen have been plotted across the full width
of the chart, the pen appears as a solid line.
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In the Connections tab, assign to a pen the tag, expression, or
constant whose value will be used to determine the position of
the line, and then in the Pens tab, choose the pen type Full
Width.

As soon as the trend is displayed, the pen appears as a horizontal
line across the full width of the chart. Its vertical position is
determined by the tag, expression, or constant’s value. If the
value changes, the position changes.

Choosing colors, fonts, lines, and markers

The following table summarizes where in the Trend Object
Properties dialog box to specify colors, fonts, lines, and markers for
a trend.

You can also specify these settings in the Properties tab of the
Property Panel.

To specify this Use this box or

column

In this tab

Chart background
color

Background color Display

Horizontal label color Text color Display

Text font, style, and
size

Font (button) Display

Pen line, pen marker,
pen icon, and vertical
label color

Color Pens

Pen line width Width Pens

Pen line style Style Pens

Pen marker Marker Pens

Vertical grid line color Grid color X-Axis

Horizontal grid line
color

Grid color Y-Axis

The trend border color

The trend border uses the highlight color for the graphic display,
specified in the Behavior tab of the Display Settings dialog box.
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The trend window color

By default, the trend window uses the background color of the
display, specified in the General tab of the Display Settings dialog
box.

To use a different window color:

� In the Property Panel, select the opaque WindowStyle, and then
specify the WindowColor property.

For information about using the Property Panel, see page 9-24.

Testing the trend

You can quickly test the trend by switching to test display mode. If
communications are active and there is data for the tags, the pens
plot values in the trend. When you are finished testing, switch back
to edit display mode to continue editing.

To switch between test display and edit display modes:

� On the View menu, click Test Display or Edit Display, or click
the Test Display and Edit Display tools.

IMPORTANT Test display mode is not the same as running the
display. Test display mode does not change the
appearance or position of the display as set up in
the Display Settings dialog box. Also, data logging
is not enabled in test display mode.

Summary of steps

These are the steps for creating a trend:

1. To plot historical data, create a data log model in the Data Log
Model editor. For information, see Chapter 16.

2. Create a trend graphic object in the Graphics Display editor.

3. Configure the trend in the Trend Object Properties dialog box.

4. If desired, create a Next Pen button, a Pause button, or Key
buttons in the same graphic display, to allow the operator to
switch between pens, pause the trend, or scroll the trend.

Edit Display tool

Test Display tool
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For information about the buttons you can use with trends, see
page 17-24.

5. To have a printed record of the trend data, provide a way for the
operator to print the graphic display. For information see
page 17-26.

Creating trend objects

To create a trend object:

1. In the Graphics Display editor, create or open a graphic display.

2. Select the Trend drawing tool by doing one of the following:

In the Objects toolbox, click the Trend tool.

On the Objects menu, select Trending, and then click Trend.

3. Drag the mouse to create a box approximately the size you want
for the trend.

4. Double-click the trend to open the Trend Object Properties
dialog box.

5. Configure the trend as described in the next section.

6. When you’re finished configuring the trend, click OK to save
your changes.

7. To name the trend, open the Property Panel and then type a
name in the (Name) row.

The name can contain letters, numbers, and the underscore
character (_), but the first character must be a letter. Do not use
spaces in the name.

The name is used in the status bar, activity bar, Property Panel,
Object Explorer, and activity log messages.

Once you have configured the trend, you can edit it as you would
any other graphic object. You can move it, resize it, attach animation
to it, and so on. You can also use this object in other graphic displays
by dragging it from one display and dropping it into another.

For more information about graphic objects, see Chapter 9.

Configuring trends
When you double-click a trend object, the Trend Object Properties
dialog box opens. Use the dialog box to configure the trend.
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Set up how the trend looks.

Set up the horizontal axis.

Set up how the trend works

at runtime.

Set up pens.

Set up the vertical axis.

Set up the tags and

expressions to plot data for.

Before you configure the pens in the Pens tab, use the Connections
tab to specify the tags and expressions for which to plot data.

Specifying chart style and update mode

To specify the chart style and update mode:

� In the General tab, specify these settings:

Chart style

Specify the plotting style of the trend:

Standard—plots each pen against time (with time on the
horizontal axis).

XY Plot—plots each pen against a pen that serves as the
X-axis. In the X-Axis pen box, select the pen to use for the
X-axis.

Chart update mode

Specify how often the trend updates with new data:

Automatic—updates data at regular time intervals. In the
Refresh Rate box, type a time and click a time unit to specify
how often the trend acquires data.
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The refresh rate range is 50 milliseconds to 596 hours.

On Change—updates the data as values change. This mode is
useful for data that changes rapidly.

To specify how often data is updated even if no change has
occurred, in the Heartbeat box type a time, and then click a
time unit. If you do not want to use the heartbeat, type 0.

To specify a percentage by which a value must change before
the trend displays the new value, in the Deadband box type a
number.

Setting up how the trend works at runtime

To set up how the trend works at runtime:

� In the Display tab, specify these settings:

Time format

Select how the trend displays time:

Use system time format—displays time using the format
specified in the Windows Control Panel, in the Regional
Options dialog box.
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24-hour format

AM/PM format

Chart radix

Specify the number base to use for displaying numeric values in
the trend labels. If you select the XY Plot chart style, this setting
affects the labels on the Y-axis and the X-axis.

However, if the number of decimal places specified in the Y-Axis
tab is set to anything other than 0, that setting overrides the radix
selection and all numbers are displayed as decimals.

Data point connection

Specify how data points on the trend are connected:

Connect points—data points are connected with a line.

Show discontinuity—plot lines are disconnected between the
start and end of a discontinuity in data. A discontinuity in
data indicates a communication error, or a break in a model’s
data logging (for example, when the operator stops and then
restarts the project).

Show only markers—a marker is displayed for each data
point. Lines do not connect the data points, so if a pen
doesn’t have a marker assigned to it (in the Pens tab), then the
pen does not appear in the trend.

Display milliseconds

If you select the standard chart style, select this box to display
milliseconds in the time labels on the X-axis. (To display time
labels, in the X-Axis tab select the Display Scale check box.)

Display pen icons

Select this box to display an icon for each pen at the right side of
the trend chart. The pen icon moves vertically to indicate the
current value of the pen, even if the chart is not scrolling, so some
pen icons might not be at the end of a line.

Background color

Click this box to select a background color for the chart.

The chart border is always black. For information about
specifying the background color for the other areas in the trend,
see page 17-9.

Text color

Click this box to select the text color for the labels above and
below the chart.
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The labels on the vertical axis use the color of the first pen, unless
you select the “Each pen on independent scale” option (in the
Y-Axis tab), in which case the label’s color matches the pen
whose range is currently displayed on the vertical axis.

If you use isolated graphing, each pen is shown in a separate
section of the chart, with its own color labels.

Font

Click this button to select the font to use for the text in the trend.

Allow scrolling

Check this box to continually update the trend with new data at
runtime. If you deselect this option, once the trend has filled
with data up to the buffer limit the chart does not update until
the operator manually toggles the scroll mode (using the Pause
button).

If you allow scrolling, select a scroll mode:

Continuous Scroll—chart scrolls from right to left for each
new data reading.

Half Screen Scroll—chart scrolls half a screen at a time. Pens
scroll from the middle of the chart to the right. When the
pens reach the right side of the screen, the screen scrolls left
and the pens continue at the middle of the chart.

Full Screen Scroll—chart scrolls a full screen at a time. Pens
scroll from the left to the right, starting at the left of the chart.
When the pens reach the right side of the screen, the entire
screen scrolls and the pens begin again at the left side.

Buffer for extra data

Specify the number of extra data points (outside of the display
area) to store for each pen. The operator can view these data
records by manually scrolling (using the Key buttons).

The maximum buffer size is 32,767 data points. Divide this
number by the number of pens in the trend to determine the
maximum data records per pen.

The more data points held in the buffer, the faster it is to scroll.
However, a larger buffer size also requires more system
resources.
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Setting up the horizontal axis

For a standard chart, the horizontal axis represents time; for an XY
Plot chart, the horizontal axis represents the selected pen’s values.
The settings in this tab apply to both types of chart.

To set up the horizontal axis:

� In the X-Axis tab, specify these settings:

Start date and Start time

These settings are not available if you select “Allow scrolling,”
on the Display tab.

If you want to specify a starting date and time for the trend, clear
the Allow scrolling check box, on the Display tab. To select a
date from the calendar, click the Down Arrow beside the Start
date box.

These settings determine when to begin displaying data for the
trend. As the operator manually scrolls, the chart updates with
the latest data for the specified time span.

If the trend is plotting current values only, and it is first displayed
after the specified time, the current time is used as the starting
point.
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If the trend is plotting historical data, and the data log model is
running at the specified start time, data is displayed from this
time onwards. Otherwise, the earliest available data (after the
start time) is displayed. Once the operator scrolls to the current
time, values are taken from the value table, not the data log file.

Time span

In this box type a time, and then click a time unit, to specify the
amount of data the trend displays at runtime.

For a standard chart, the time span controls the horizontal scale.
For an XY Plot chart, the Min and Max values (specified in the
Pens tab) of the selected pen control the horizontal scale, and the
time span controls the number of data points plotted.

Display scale

Check this box to display X-axis labels at the bottom of the
trend.

For a standard chart, the labels show the start and end times. If
there’s room, intermediate times are shown below each vertical
grid line.

For an XY Plot chart, the labels show the minimum and
maximum value range of the pen selected as the X-axis. If there’s
room, intermediate values are shown as well.

Display grid lines

Check this box to display vertical grid lines on the chart, and
then type the number of major and minor lines to display.

You can display up to 30 major lines, and up to 10 minor lines
between each major line. The major lines are solid, and the minor
lines are dashed.

Grid color

If you display grid lines, click this box to select the color for the
lines.
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Setting up the vertical axis

To set up the vertical axis:

� In the Y-Axis tab, specify these settings:

Minimum / maximum value options

Select the method for determining the minimum and maximum
values for the vertical axis:

Automatic—the lowest data reading serves as the minimum
value and the highest data reading serves as the maximum. As
the trend acquires new data, the Y-axis may rescale to fit the
new values.

Preset—the minimum and maximum pen values, configured
in the Pens tab, serve as the Y-axis scale. The scale does not
change. Which pen’s minimum and maximum values are used
depends on the scale options you select in this tab.

Custom—allows you to specify constant minimum and
maximum values, or to assign tags or expressions whose
values are used to determine the minimum and maximum
values.

To use constant minimum and maximum values, click “Actual
minimum value” and type the value in the box. Repeat for the
maximum value.
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To use tags or expressions to determine the values, you must
first assign the tags or expressions in the Connections tab.
Then return to this tab and click “Controlled by tag.”

Isolated graphing

Check this box to place each pen in a separate band of the chart,
and then, in the “% isolation” box, type the distance between
bands. The distance is a percentage of the chart height, between 0
and 10%.

To allow pens to overlap, clear the check box.

If you select isolated graphing, you cannot display horizontal
grid lines. Instead, a horizontal line appears above each band.

Display scale

Check this box to display Y-axis labels at the left of the trend.

To display decimals in the labels, type a number in the Decimal
places box. If you type a number other than 0, this setting
overrides the Chart Radix setting in the Display tab, and all
numbers are displayed as decimals.

Display grid lines

Check this box to display horizontal grid lines on the chart, and
then type the number of major and minor lines to display.

You can display up to 30 major lines, and up to 10 minor lines
between each major line. The major lines are solid, and the minor
lines are dashed.

Grid color

If you display grid lines, click this box to select the color for the
lines.

If you use isolated graphing, this color is used for the horizontal
lines between bands.

Scale options

Specify how multiple pens with different minimum and
maximum ranges scale together on the chart (this option is not
available if you use the Custom minimum/maximum value
option):

All pens on same scale—displays all pens relative to the same
scale, determined by the lowest minimum and highest
maximum values of all pens.
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Each pen on independent scale—scales each pen
independently using the pen’s minimum and maximum values
as the range. Only one pen’s range is used in the labels on the
vertical axis, which can be misleading if other pens use a
different range.

To allow the operator to view each pen’s vertical axis labels,
create a Next Pen button. When the operator presses the
button, the vertical axis changes to the new pen’s range. The
color for the labels changes to the color of the selected pen.

Scale using pen—uses the same scale for all pens, based on the
minimum and maximum values for the specified pen, or based
on the best fit for the pen’s actual data. Select the pen to use.

If you use the Preset minimum/maximum value option,
configure the minimum and maximum values in the Pens tab,
as described on page 17-21.

This option does not apply if you use the Custom
minimum/maximum value option.

Scale as percentage

Check this box to display the Y-axis values as a percentage of the
minimum and maximum range. The Y-axis labels display the
percentage range, from 0 to 100%.
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Specifying the tags and expressions to plot
data for

To specify the tags and expressions to plot data for:

1. In the Connections tab, specify up to 8 tags or expressions to
plot values for. Do not use string tags or block tags.

To plot historical values, specify tags from the data log model
you’ll be using at runtime. (Specify the data log model in the
Pens tab.)

If desired, you can specify both tags that are in a data log model
and tags that are not. You cannot use expressions to plot
historical values.

For information about specifying tags and expressions, see
page 7-28.

2. To control the vertical axis minimum and maximum values using
tags or expressions (using the Custom setting in the Y-axis tab),
assign tags or expressions to the Minimum and Maximum
controls.
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Configuring pens

Before you configure pens, assign tags or expressions to the pens in
the Connections tab.

To configure pens:

� In the Pens tab, configure each pen as follows:

Tag Name

This column is for display purposes only. Assign a tag or
expression to the pen in the Connections tab.

Color

Click this box to select the color for the pen’s lines, markers, and
icon.

At runtime, the selected pen’s color is also used for the labels on
the vertical axis.

If you use isolated graphing, each pen is shown in a separate
section of the chart, with its own color labels.

Visible

Click in this column to toggle between on and off. When
visibility is off, the pen is not displayed on the trend.
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Width

Type the number of pixels for the width of the pen’s line. If you
use a width other than 1, you cannot change the line style setting.

Type

Specify how to plot the pen lines:

Analog—plots pen lines using diagonals from one point to
the next.

Digital—plots pen lines using only horizontal and vertical
lines between points.

Full-Width—plots a tag’s value as a horizontal line that
extends across the full width of the chart. The line moves up
and down in the chart as the tag or expression value changes.

Style

Click in the column to select a line style. If you select a style
other than solid, the line width must be 1 pixel.

Marker

Click in the column to select a plot symbol for each data point. If
you use the “Show only markers” option (specified in the
Display tab), only pens that you select a plot symbol for are
displayed in the trend.

If a pen displays new data frequently, for example every few
seconds, the markers might appear to form a solid line.

Min and Max

If you specify the “Preset minimum/maximum value” option (in
the Y-Axis tab), type the minimum and maximum values for the
pens.

The minimum and maximum values, together with the scaling
options you select in the Y-Axis tab, determine the range of the
trend’s vertical axis. Tag values outside this range do not appear
on the chart.

Link Data

Check this box to use the assigned tag’s minimum and maximum
values. Checking this box disables the Min and Max columns. If
the tag’s minimum and maximum values are not available, ???
appears in the columns.

For digital tags, the minimum is 0 and the maximum is 1. For
analog tags, specify the minimum and maximum values in the Tag
Database editor.
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Data Log Model

For historical data, select the data log model to use to supply the
data when the trend is first displayed or you scroll back in time
(using the Key buttons). If buffered data is available, that data is
used instead of the data from the model.

If the trend plots current values only, accept the default of None.

Make sure you add the tags to the data log model.

To configure multiple pens at the same time:

1. Select the pens to configure by Shift-clicking or Ctrl-clicking in
the Tag Name column.

2. In the Multiple Pen Edits columns, specify the attributes to use.

To clear the Multiple Pen Edits columns, click Clear Selections.

3. To apply the attributes, click Apply to Selected Pens.

What to do next

Now that you’ve created the trend:

If desired, create a Next Pen button, a Pause button, or Key
buttons in the same graphic display, to allow the operator to
switch between pens, pause the trend, or scroll the trend.

For information about the buttons you can use with trends, see
page 17-24.

To have a printed record of the trend data, provide a way for the
operator to print the graphic display. For information see
page 17-26.

Using the Trends graphic library

The Trends graphic library contains a trend graphic object and
buttons for controlling the trend. It also contains Numeric display
objects that display the value of each tag used in the trend.

You can use the trend and objects as they are, or you can edit them
to suit your needs. To use the objects, drag and drop (or copy and
paste) them into your graphic display.

For information about copying and pasting objects from the graphic
libraries, see page 9-38.
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To use the Trends graphic library:

1. Open the Graphics folder, and then open the Libraries folder.

2. Double-click the Trends library.

3. Drag and drop or copy and paste objects into your display.

Using buttons to control the trend at runtime

You can place buttons in the same graphic display as the trend, to
allow the operator to pause the trend, switch between pens, or scroll
the trend.

You can link the buttons to a specific trend object, or configure the
button to work with whichever object is selected in the graphic
display. For information about linking buttons, see page 10-9.
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Use these buttons with trends:

This button Does this

Pause Toggles between pausing and
automatic scrolling.

When the trend is paused, the pen
icons continue to move vertically to
indicate the pens’ current values.

When the trend resumes scrolling,
values that occurred while the trend
was paused are filled in, bringing
the trend up to the current time
(unless you are scrolling historical
data).

Next Pen Changes the vertical axis labels to
the scale for the next pen. The color
of the labels matches the color of
the selected pen.

Move Up Scrolls up to display higher values
on the vertical scale. For example, if
the visible scale range is 0 to 100,
pressing Move Up changes the
visible range to 10 to 110.

The incremental amount the axis
scrolls depends on the pen’s range
and the number of horizontal grid
lines.

This button does not work if the
Y-Axis “Minimum / maximum
value option” is set to Automatic.

Move Down Scrolls down to display lower
values on the vertical scale.

This button does not work if the
Y-Axis “Minimum / maximum
value option” is set to Automatic.

Move Left Pauses the trend and scrolls to the
left.

Move Right Pauses the trend and scrolls to the
right.
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This button Does this

Home Pauses the trend and moves to the
earliest data in the trend.

End Resumes trend scrolling and moves
to the current (latest) data in the
trend.

To see how the buttons work with the trend, open the Trends
graphic library (see page 17-23), and start test mode (see page 17-9).

For information about creating buttons, see Chapter 9. For details
about configuring the buttons, see Chapter 10.

Printing trend data

To print trend data at runtime, provide the operator with a method
for printing the graphic display.

You can use these methods to print graphic displays at runtime:

Create a Display Print button.

Assign a tag or expression to the Remote Display Print control
(in the Global Connections editor). When the value of the tag or
expression changes from 0 to a non-zero value, the current
display is automatically printed.

Program the data source to trigger the change as often as you
want the data printed.

For more information about setting up remote display printing,
see Chapter 19.

Everything on the screen is printed, including the current display,
pop-up windows, and any visible background applications.

For information about specifying the printer to use at runtime, see
Chapter 23.

Improving clarity of the trend printout

Depending on what type of printer you use, pen lines with a width
of 1 pixel might not appear in the printout. Choose high-contrast
colors and wider line widths to ensure that the trend data prints
clearly.
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Runtime errors for the trend

If data for the trend is not available at runtime due to
communication errors, a message is sent to the activity log.

See the Help for information on solving common trend problems.
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Setting up security

This chapter describes:

what security is

how user accounts and security codes work

steps for setting up security

assigning security to graphic displays

using the User Accounts editor

setting up user accounts

changing passwords

providing a way for users to log in and log out

preventing unauthorized users from stopping the project

summary of security features in a sample startup display

About security

You can use security features to:

prevent users from opening graphic displays that you don’t want
them to have access to

prevent unauthorized users from running the project

prevent unauthorized users from stopping the project

prevent users from seeing and using certain parts of a graphic
display

prevent users from switching to other applications or accessing
the desktop on the runtime computer. This feature uses the
DeskLock tool, and is available for Windows 2000 runtime
projects only. For more information about the DeskLock tool,
see Chapter 22.

To limit the users who have access to the project or parts of the
project, you must set up user accounts and passwords.

18
Chapter
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If you don’t set up security, anyone can use the project without
logging on, and view all the graphic displays.

IMPORTANT If you configure the data source to open graphic
displays remotely (using global connections), remote
display changes occur whether or not the logged-in
user has security access to a given display.

For details about controlling display changes
remotely, see page 19-7.

How user accounts and security codes work
By default, all users have unrestricted access to all graphic displays.
When you assign a security code to a graphic display, only the users
who are assigned that security code have access to the display.

There are 16 security codes, A through P, and the asterisk
symbol (*). The * represents unlimited access. You can assign
combinations of security codes to users, to allow each user access to
a different set of displays.

Example: Assigning security codes to prevent access to
graphic displays

This example shows how to set up users with access to different
graphic displays.

1. Assign security codes to graphic displays as follows:

To this display Assign this security code

Alarm History A

Boiler B

Furnace C

Top Secret D

2. In the User Accounts editor, assign security codes to users:

To this user Assign these security codes

ALICE A, B, C

SIMON A, B

ADMIN All

DEFAULT None
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The users have access to these graphic displays:

ALICE has access to the first three graphic displays.

SIMON has access to the Alarm History and Boiler displays, but
not to the Furnace or Top Secret displays.

The ADMIN user has access to every graphic display.

The DEFAULT user has access only to graphic displays to which
no security has been assigned (that is, graphic displays with the
security code *). In this example, the DEFAULT user does not
have access to any of the graphic displays.

In this example, you could have assigned the same security code to
the Alarm History and Boiler displays, since all users except the
DEFAULT user have access to these displays.

Example: Using security codes to control the visibility of input
objects

This example shows how to set up users so that only authorized
users can use input objects to enter data.

This example uses the CurrentUserHasCode( ) expression security
function to determine whether a user is authorized to input data
using a Numeric Input Enable button.

The security code E is assigned to users who are authorized to enter
data.

1. In the User Accounts editor, assign security codes to users.



Preface

18-4 � RSView Machine Edition User’s Guide

To this user Assign these security codes

OPERATOR A, B, C

SUPERVISOR All

ADMIN All

DEFAULT None

2. Create a Numeric Input Enable button.

3. Assign visibility animation to the button using this expression:

CurrentUserHasCode( E )

For the Expression True State, click Visible.

When the graphic display containing the Numeric Input Enable
button is open, the SUPERVISOR and ADMIN user can see the
button. If the OPERATOR or DEFAULT user is logged in, the
button is not visible.

Summary of steps

Follow these steps to set up security:

1. In the Graphics Display editor, assign security codes to graphic
displays that will have limited access.

2. In the User Accounts editor, set up users and passwords, and
assign security codes to users.

3. Provide users with a method for logging in and out.

4. If desired, prevent unauthorized users from stopping the project.

5. If desired, assign visibility animation to graphic objects that only
certain users are authorized to use.

Assigning security to graphic displays

Assign security to graphic displays in the Graphic Display editor.
You can:

assign security when you create the graphic display, or at any
time after creating the display
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assign the same security code to more than one display

assign whichever codes you want, in any order. For example, you
can choose to use only the codes D and P and you can assign P
before you assign D.

For more information about graphic displays, see Chapter 8.

To assign security to a graphic display:

1. In the Graphic Display editor, right-click an empty area of the
display, and then click Display Settings.

Select a security code.

2. In the General tab, select a security code.

To allow unlimited access to the display, select the asterisk (*).

3. Click OK to close the dialog box.

Using the User Accounts editor

Use the User Accounts editor to set up accounts for each user or
group of users that will have access to the project at runtime.
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Form area

Spreadsheet area

Use the scroll bar or drag

the border of the editor to

see more columns.

Double-click in the security code

columns to toggle between Yes

and No.

You can use the form or spreadsheet section of the editor to enter all
user information except passwords. You must use the form area to
enter passwords.

Using the View menu

Use the items on the View menu to control the appearance of the
User Accounts editor.

To do this On the View menu, click this

Show or hide the spreadsheet area Spreadsheet

Show or hide the form area Form

Change the font used in the
spreadsheet area

Spreadsheet Font. In the Font
dialog box, specify the font, style,
and size to use.

Restore the default font Restore Default Settings

Using the Accept and Discard buttons

When you enter information, the Prev and Next buttons change to
Accept and Discard buttons. Click Accept to save user account
information. Click Discard to cancel changes to a user account.



� 18-7Setting up security

Using the tools

The User Accounts editor has these tools for working in the editor:

Use this tool To do this

Cut Cut the selected text and place it on
the clipboard.

Cutting a No security code setting
changes it to a Yes. You cannot cut
Yes security code settings.

Copy Copy the selected text.

Paste Paste the cut or copied text from
the clipboard.

Delete Delete the selected text.

Deleting a No security code setting
changes it to a Yes. You cannot
delete Yes security code settings.

Duplicate Create a duplicate of the selected
user, with all the same settings,
including name.

Insert Row Insert a blank row above the row in
which the cursor is located.

Fill Forward With multiple rows selected, copy
the settings from the first row into
the other selected rows.

Sort With multiple cells in a column
selected, sort the user accounts
alphanumerically by the selected
cells’ contents.

Undo Undo the previous operation or
sequence of operations.

Redo Redo the previously undone
operation or sequence of
operations.
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The DEFAULT user

The first account in the editor is the DEFAULT user account. The
DEFAULT account is used when no one is logged in. The
DEFAULT user initially has access to each security code. Unless
you want everyone to have access to all parts of the project without
logging on, disable the DEFAULT user’s access to the security codes
you plan to use.

You cannot delete the DEFAULT user account.

Setting up user accounts

To set up user accounts:

1. Open the User Accounts editor.

2. If the editor already contains user account definitions, click the
first blank row in the spreadsheet, or click Next to scroll to a
blank row.

3. Specify these settings:

Account ID

Type a user name or ID for the account, up to 20 characters
including spaces. The name is not case sensitive.

Login Macro

To run a macro when this user logs in, type the name of the
macro, or click the Browse button to select from a list of macros
in the project.

Logout Macro

To run a macro when this user logs out, type the name of the
macro, or click the Browse button to select from a list of macros
in the project.

Password

Type a password for the account, up to 14 characters including
spaces, and then press Enter. The password is not case sensitive.

The Password Confirmation dialog box opens. Retype the
password, and then click OK.

Security Codes

To prevent the user from having access to a security code, clear
the check box for the code, or double-click in the code’s column
in the spreadsheet to change the setting to N.

Browse button
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4. Click Accept.

5. Repeat steps 2 through 4 to set up additional user accounts.

6. Click Close. When prompted to save your changes, click Yes.

Deleting user accounts

To delete a user account:

� In the spreadsheet area, click the number at the left end of the
row for the user to delete, and then press Delete on your
keyboard.

Changing passwords

Users cannot change passwords at runtime. The only way to change
a password is by using the User Accounts editor.

To change a user’s password:

1. In the spreadsheet area, click the row for the user’s account.

2. In the form area, in the Password box, type the new password.

3. In the Password Confirmation box, type the new password
again, and then click OK.

Providing a way for users to log in and log out

Use Login and Logout buttons to provide a way for users to log in
and log out. Make sure you place these buttons in graphic displays
that all users have access to.

Logging in

When the project starts, the DEFAULT user is automatically logged
in until a new user logs in.

To provide a way for users to log in:

Create a Login button in the startup graphic display (the graphic
display that opens when your project starts running).

For information about creating graphic objects, see Chapter 9.
For information about configuring graphic objects, see
Chapter 10.
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Specify the startup display in the Startup editor, in the Initial
graphic box.

For information about using the Startup editor, see Chapter 20.

For more information about logging in, see Chapter 24.

Logging out

To best maintain your security system, users who log in should also
log out.

When a user logs out, the DEFAULT user is automatically logged in
until a new user logs in. Disable the DEFAULT user’s access to the
security codes you plan to use.

To provide a way for users to log out:

� Create a Logout button in a graphic display that all logged-in
users have access to.

For more information about logging out, see Chapter 24.

Preventing unauthorized users from stopping the
project

To prevent unauthorized users from stopping the project:

Do not use a title bar on the project window. To disable the title
bar for the project window, in the Project Settings editor, in the
Runtime tab, deselect the Title bar check box.

For more information about using the Project Settings editor, see
Chapter 4.

Assign visibility animation to the Shutdown button, so that the
button is only visible when a user who is authorized to stop the
project is logged in. For an example, see page 18-13.

Or, set up security for the graphic display in which the
Shutdown button is located, so only users who are authorized to
stop the project can open the display.

Additional step for Windows 2000 projects:

Use the DeskLock tool to prevent users from accessing the
desktop, to prevent access to operating system functions such as
restarting Windows or shutting down tasks. For more
information, see page 22-4.
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Additional steps for RAC6182 projects:

Use the Keypad Configuration Utility that ships on CD with the
RAC6182 to disable the Win key and the Alt-Tab key
combinations. Otherwise, the user can press the Win key or press
Alt-Tab to open the Windows Taskbar.

For information about using the Keypad Configuration Utility,
see the utility’s Help.

Hide the Windows Taskbar to make it inaccessible. To hide the
Taskbar, on the Windows Start menu select Settings, and then
select Taskbar. Clear the “Always on top” check box and select
Auto hide.

For more information about stopping the project, see Chapter 23.

Summary of security features in a sample startup
display

This section provides a summary of how to use all the security
features in a startup graphic display called Log In.

To create a startup display that uses all the security

features in RSView:

1. Set up user accounts and passwords.

2. In the Project Settings editor, clear the Title bar check box.

3. Create a graphic display called Main Menu that contains
navigation buttons that give the operator access to the different
displays in the project. Assign a security code to the display so
that only authorized users can open it.

4. Create a graphic display called Log In containing these button
objects:

This button Does this

Login Opens the Login dialog box.

Logout Logs the current user out and logs in the
DEFAULT user.

Goto Display Opens the Main Menu graphic display.

Shutdown Shuts down the project.

5. Configure the Goto Display button to open the Main Menu
display. If desired, attach visibility animation to the Goto
Display button, so that only authorized users can see the button.
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For more information, see Example 1 on page 18-13.

6. Attach visibility animation to the Shutdown button, so that only
authorized users can see (and therefore use) the button.

For more information, see Example 2 on page 18-13.

7. Specify captions for the buttons, and add explanatory text to the
graphic display. If desired, attach visibility animation to the text
as well.

8. In the Display Settings dialog box, assign the security code * to
the Log In display, so that all users have access to it.

9. In the Startup Settings editor, in the Initial graphic box, select the
Log In display.

Until an authorized user is logged in, further access to the project is
denied. In addition, only authorized users can stop the project.

Users who have access to the project can use the project and log out.
Make sure you provide a way for users to navigate back to this
display to log out.

IMPORTANT When a user logs out, the DEFAULT user is
automatically logged in. Do not give the DEFAULT
user access to the Goto Display button or Shutdown
button.

To see what the startup Log In display looks like when different
users are logged in, see Example 3 on page 18-14.

You can also use the Remote Display Number control to open the
startup Log In display when a user logs out. This might be useful if
users can log out from various locations (graphic displays) within
the project. For an example, see page 19-8.

For more information about See

Using the Project Settings editor Chapter 4

Attaching animation to graphic objects Chapter 11

Setting up display navigation Chapter 19

Using the Startup editor Chapter 20

Logging in, logging out, and stopping projects Chapter 24
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Example 1: Assigning visibility animation to the Goto Display
button

This example shows how to assign visibility animation to the Goto
Display button so that a user must log in before seeing the button.

This example uses the security function CurrentUserName( ). The
function returns the string value of the Account ID (user name) for
the user who is currently logged in.

The CurrentUserName( ) function is case sensitive. All user names
use upper case letters, so make sure that you use upper case letters in
your expression.

The DEFAULT user is the current user when the project starts, and
when a user logs out.

To assign visibility animation to the Goto Display button:

1. Right-click the Goto Display button, select Animation, and then
click Visibility.

2. In the Animation dialog box, in the Expression box, type this:

CurrentUserName( ) <> “DEFAULT”

3. For the Expression True State, click Visible.

4. Click Apply.

Example 2: Assigning visibility animation to the Shutdown
button

This example shows how to assign visibility animation to the
Shutdown button so that only the ADMIN user can stop the
project.

To assign visibility animation to the Shutdown button:

1. Right-click the Shutdown button, select Animation, and then
click Visibility.

2. In the Animation dialog box, in the Expression box, type this:

CurrentUserName( ) == “ADMIN”
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3. For the Expression True State, click Visible.

4. Click Apply.

Example 3: The sample Log In startup display

At runtime, this is what the display looks like when no one has
logged in:
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This is what the display looks like when a user who is authorized to
use the project but not to stop the project has logged in:

This is what the display looks like when the ADMIN user (who has
authority to stop the project) has logged in:
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Setting up display
navigation and
controlling projects at
runtime

This chapter describes:

what display navigation is

developing a hierarchy of displays

testing display navigation

using graphic objects to navigate

controlling display changes remotely

configuring remote display changes

what global connections are

setting up global connections

This chapter describes methods for navigating between graphic
displays. For information about navigating between objects in a
graphic display, see Chapter 9.

About display navigation

The way the operator moves between the graphic displays that make
up a project is referred to as display navigation.

Use these methods to set up display navigation for your project:

Develop a hierarchy of graphic displays, to chart how users will
navigate the project.

Determine which users will have access to which parts of the
project.

19
Chapter
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Create graphic objects that the operator can use to navigate the
project.

If desired, automatically control display changes using the
Remote Display Number control. The use of this control is
optional.

In the Startup editor, specify the graphic display to open when
the project starts.

For information about specifying the startup display, see
Chapter 20.

Set up security so that only authorized users have access to the
project or parts of the project.

For information about setting up security, see Chapter 18.

About global connections
Global connections are controls that apply to your entire runtime
project. Many of the global connections allow the data source to
control or interact with your project at runtime.

For example, the Remote Display Number control is a global
connection that you can use to control display changes from the data
source. You can also use global connections to print graphic displays
from the data source, to run macros from the data source, and to
control the date and time displayed on the runtime terminal. For
more information about global connections, see page 19-9.

The use of each global connection is optional.

Developing a hierarchy of displays
A display hierarchy is a series of graphic displays that provide
progressively more detail as users move through them. Design your
display hierarchy to meet the needs of the various users, including
managers, supervisors, and operators.

If you plan to use security, determine which groups of users need
access to which displays, and decide where in the hierarchy to locate
Login, Logout, and Shutdown buttons. For information about
setting up security, see Chapter 18.

A display hierarchy could include:

an initial graphic display for logging in

a graphic display that serves as a menu

an overview of the plant
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a comprehensive display of each process being monitored

process-specific displays that provide more detail

management summary displays

trend displays of historical and real-time data

The following illustration shows a sample display hierarchy.

Main Menu

Process

Overview

Management

Summary

System

Status

Alarm

Summary

Historical Data

Trend Display

Process

Monitoring 2

Process

Monitoring 1
Process

Monitoring 3

Area 1

Trend Display

Area 2

Trend Display

Area 3

Trend Display

Log In

Testing display navigation
Once you set up display navigation for your project, test the project
to make sure that navigation flows smoothly and that you have
avoided problems like these:

A graphic display contains no buttons for moving forward or
back.

When a graphic display closes, no other display is open and there
is no way to continue using the project.

For information on testing your project, see page 20-3.
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Using graphic objects to navigate

Use these graphic objects to navigate through the displays in the
project:

Use this object To

Goto Display button Open the specified graphic display.

Return to Display button Close the current display and open the
previous display.

Close Display button Close the current display.

Display List selector Provide a list of graphic displays so the
operator can select which display to
open.

Shutdown button Stop the project and close RSView ME
Station.

The behavior of these graphic objects depends on which types of
graphic displays are used. See the following sections for details.

For detailed information about configuring graphic objects, see
Chapter 10.

Display type

The display type you use gives you additional control over how the
operator navigates between displays. For example, use the On Top
type to keep a graphic display on top at all times, even when another
display has focus. Or use the Replace type if you want a display to
replace all other open displays when it opens.

For information about specifying the display type, see page 8-10.

Goto Display buttons

When you configure a Goto Display button, specify the graphic
display to open when the operator presses the button at runtime.

The specified display doesn’t open if the operator does not have
security access for the display.

You can also assign a parameter file that assigns tags to tag
placeholders in the display when the display opens. For more
information about parameter files, see page 8-25.
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How display types affect the button’s behavior

The Goto Display button’s behavior at runtime also depends on
which types of graphic displays are already open and which type of
display it is opening:

If the graphic display assigned to the button is a Replace display,
it closes any open On Top or Replace displays. It does not close
any On Top displays that use the Cannot Be Replaced option.

If the display assigned to the button is already open, but does not
have focus, pressing the button gives the display focus.

The operator cannot use the Goto Display button to open Replace
displays if display change is currently controlled remotely (using
global connections). But the operator can still open On Top displays.

Return to Display buttons

When the operator presses a Return to Display button at runtime,
the graphic display that the button is on closes and the display that
was previously open reopens.

The current display does not close if:

the display change is currently controlled remotely

there were no previously opened Replace displays

the operator does not have security access for the previous
display. This can only occur if a new user logs in using a Login
button in the current display.

The Return to Display button only goes back to the most recent
display. It doesn’t go back through a series of displays.

How display types affect the button’s behavior

Both the current display and the previous display must be Replace
displays. When the operator presses the Return to Display button:

If the graphic display that is closing is a Replace display, the
display closes and the previously opened Replace display opens.
Any On Top displays that were previously open with the
Replace display are not reopened.

If the graphic display that is closing is an On Top display, the
display closes but no display is reopened.

We therefore recommend that you use Return to Display buttons in
Replace displays only.
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Example: Navigating through displays

This example uses the display hierarchy illustrated on page 19-3,
and shows what happens as the operator navigates through the
hierarchy. The graphic displays are all Replace displays.

1. In the Main Menu display, the operator uses a Display List
selector to open the Process Overview display.

2. In the Process Overview display, the operator presses a Goto
Display button to open the Process Monitoring 1 display.

3. After viewing the state of the process, the operator presses a
Return to Display button to close the current display and reopen
the Process Overview display.

4. In the Process Overview display, the operator presses a Return to
Display button. Which display opens? The Process Monitoring 1
display (because this was the previously opened display).

To return to the Main Menu display from the Process Overview
display, the operator would have to press a Goto Display button
that is configured to open the Main Menu display.

Close Display buttons

When the operator presses a Close Display button at runtime, the
graphic display that the button is on closes.

If the graphic display that is closing is a Replace display, and the
display change is controlled remotely, the display does not close.

If the display change is controlled by the operator and the graphic
display that is closing is a Replace display, if there are no On Top
displays open, an empty window is displayed. The operator will not
be able to use the project again (unless a remote display change
occurs or an alarm, activity, or information message display opens).

We therefore recommend that you use Close Display buttons in On
Top displays only.

Display List selectors

Use the Display List selector to show a list of graphic displays that
the operator can choose from. The operator can scroll through the
list and select the graphic display to open.
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The specified display doesn’t open if the operator does not have
security access for the display.

How display types affect the selector’s behavior

The Display List selector’s behavior at runtime also depends on
which types of graphic displays are already open and which type of
display it is opening:

If the selected graphic display is a Replace display, it closes any
open On Top and Replace displays. It does not close On Top
displays that use the Cannot Be Replaced option.

If the selected display is an On Top display, it opens on top of the
current display. The current display does not close.

The operator cannot use the Display List selector to open
Replace displays if display change is currently controlled
remotely. But the operator can still open On Top displays (with
or without the Cannot Be Replaced option).

Selecting the display to open

The operator can scroll through the list and select displays using the
Key button graphic objects, or, if the list has the input focus, by
using the arrow keys and Enter key on a keypad or external
keyboard.

You can link Key buttons to a specific Display List selector, or
configure the buttons to work with whichever object is selected in
the graphic display.

For information about input focus, see page 10-8. For information
about linking buttons to the Display List selector, see page 10-9.

Shutdown button

When the operator presses the Shutdown button at runtime, the
project stops and RSView ME Station closes.

To prevent an unauthorized user from stopping the project, assign
visibility animation to the Shutdown button. For details, see
page 18-13.

Controlling display changes remotely

To control display changes remotely, you can configure the data
source to open graphic displays.
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The data source can control display changes for Replace displays
only. You can configure the data source to control all Replace
display changes, or to open displays under set conditions, allowing
the operator to change displays the rest of the time.

To use remote display changes, assign display numbers to the
Replace displays you want to open, and assign a tag or expression to
the Remote Display Number control. When the data source sends a
display’s number to the control, the specified display opens. When
the control’s value is 0, the operator has control of display changes.

Remote display changes and security

If you configure the data source to open graphic displays remotely,
remote display changes occur whether or not the logged-in user has
security access to a given display.

However, you can configure the Remote Display Number control to
prevent access to the project unless an authorized user is logged in.
To do this, assign an expression to the control to monitor the value
of the system\User tag, as described in the following example.

For more information about setting up security for your project, see
Chapter 18.

Example: Using the Remote Display Number control to
prevent unauthorized users from using the project

This example shows how to configure the data source to open a Log
In display when a user logs out. The Log In display remains open
until an authorized user logs in. Then control of display changes
reverts to the operator.

1. Create a graphic display called Log In, containing a Login
button. In the Display Settings dialog box, assign the display the
number 1.

2. In the Global Connections editor, assign this expression to the
Remote Display Number control:

if CurrentUserName( ) == “DEFAULT” then 1 else 0

If an authorized user is logged in, the value of the expression is 0,
and the operator has control of display changes. When the user logs
out, the DEFAULT user is logged in, and the Log In display remains
open until another authorized user logs in.
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This method is useful if you want to allow users to log out from
multiple locations (graphic displays) in the project. However, if you
use the Remote Display Number control for this purpose, you
cannot use it to control other display changes remotely.

If you only permit users to log out from a startup Log In display,
you can achieve the same result as in this example, but without using
the Remote Display Number control. For more information about
creating a startup display, see page 18-11.

Configuring remote display changes
This section outlines the steps for configuring remote display
changes. For detailed information about using the Global
Connections editor, see the next section.

To configure remote display changes:

1. In the Graphics Display editor, in the Display Settings dialog
box, assign a unique display number to each Replace display.

By default, every Replace display is assigned the number 1.
Therefore, to use remote display changes you must assign a
unique display number to every Replace display, even if you
don’t plan to open a particular Replace display remotely.

Another option is to avoid using the display number 1 for
remote display changes. Then you only need to assign display
numbers to the displays you want to change remotely.

For information about graphic displays, see Chapter 8.

2. In the Global Connections editor, assign an analog tag or
expression to the Remote Display Number control.

3. If you assign an analog tag to the Remote Display Number
control, configure the data source to send a display’s number to
the control when you want the display to open.

If you assign an expression to the Remote Display Number
control, RSView monitors the values of the tags used in the
expression, and uses the expression result to determine the
display to open.

About global connections
Global connections are controls that apply to your entire runtime
project. The use of each global connection is optional.
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You can use global connections to:

notify the data source of the current display number

notify the data source when a display is printed

update the date and time at the data source using the runtime
terminal’s date and time

change the display on the runtime terminal remotely (from the
data source)

print the current display from the data source

update the date and time on the runtime terminal using the data
source date and time

run up to five macros from the data source

Changing displays

Use these global connections to monitor and control display
changes:

Display Number—notifies the data source of the number of the
display that’s currently open.

Remote Display Number—allows the data source to change the
display on the runtime computer.

For detailed information about using the data source to control
display changes, see page 19-7.

Printing displays

Use these global connections to monitor and control display
printing:

Display Print Active—notifies the data source that a display
print is in progress.

Remote Display Print—allows the data source to trigger a
display print.

The operator can also print the current display by pressing the
Display Print button. For information about configuring this
button, see Chapter 10.

When the data source or the operator prints a display, everything on
the screen is printed, including the current display, pop-up windows,
and any visible background applications. The display is printed in
gray-scale, even if you use a color printer.
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IMPORTANT If you plan to print graphic displays remotely, disable
the screen saver. If the screen saver is on when a remote
display print is triggered, only the screen saver image is
printed.

For information about disabling the screen saver, see
your Windows documentation.

Updating the date and time

Use the date and time controls to update the date and time. You can
assign any or all of the date and time controls, or leave them
unassigned.

Normally you would assign only one set of date and time controls,
either to update the date and time at the data source from the
terminal, or to update the terminal’s internal clock from the data
source.

The values of assigned date and time controls are updated in the
order in which the controls are listed in the Global Connections
editor.

Updating the date and time at the data source from the

terminal

To update the date or time at the data source from the terminal’s
internal clock, assign an analog tag to one or more of these controls:

This control Contains this range of values

Year 00-99

Day of Week 1-7, with 1 being Sunday

Month 1-12

Day of Month 1-31

Hour 1-23

Minute 0-59

Second 0-59

Specify how frequently to update the values of the assigned controls
at the data source (from the terminal’s internal clock) by typing a
time in the “Date and time output interval” box.
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Updating the date and time at the terminal from the data

source

This option is especially useful if you have several terminals
connected to the same data source. Instead of the operator resetting
the date and time manually on each terminal, the data source can
reset all internal clocks at once.

To update the date or time in the terminal’s internal clock from the
data source, assign an analog or digital tag or an expression to the
Remote Date and Time control. Assign an analog tag or an
expression to one or more of these controls:

This control Contains this range of values

Remote Year 00-99 or 0000-9999

Remote Month 1-12

Remote Day of Month 1-31

Remote Hour 1-23

Remote Minute 0-59

Remote Second 0-59

When the Remote Date and Time control value changes from 0 to a
non-zero value, the terminal resets its internal time and date to the
time and date read from the individual remote date and time
controls.

Running macros

Use these global connections to run macros:

This control Runs this macro

Remote Macro1 Macro1

Remote Macro2 Macro2

Remote Macro3 Macro3

Remote Macro4 Macro4

Remote Macro5 Macro5

Create the macros in the Macros editor. Make sure you name them
exactly as shown in the table above (with no space in the name).

When the tag or expression assigned to one of these controls changes
to a new non-zero value, RSView runs the associated macro.

For information about creating macros, see page 7-32.
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Setting up global connections

To set up global connections:

1. Open the Global Connections editor.

2. In the “Date and time output interval” box, type the frequency
with which to update date and time values from the terminal to
the data source.

3. To send values from the project to the data source, assign tags to
the following controls.

For information about assigning tags, see page 7-28.

Display Number

RSView sends the number of the current graphic display to this
control. Assign an analog tag.

This option applies to Replace displays only. Make sure that each
display has its own unique number.

Display Print Active

Assign a digital tag to this control to notify the data source when
a display is printing. RSView writes a 1 to this control when
printing begins, and a 0 when RSView is finished printing. When
the value changes to 0 the printer could still be printing buffered
data.
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Year

RSView sends the value corresponding to the year in the
terminal’s internal clock to this control.

Day of Week

RSView sends the value corresponding to the day of the week to
this control.

Month

RSView sends the value corresponding to the month to this
control.

Day of Month

RSView sends the value corresponding to the day of the month
to this control.

Hour

RSView sends the value corresponding to the hour to this
control.

Minute

RSView sends the value corresponding to the minute to this
control.

Second

RSView sends the value corresponding to the second to this
control.

4. To allow the data source to control the project remotely, assign
analog tags or expressions to the following controls.

For information about assigning tags and expressions, see
page 7-28.

Remote Display Number

RSView reads the value of this control and opens the graphic
display whose display number matches the value. If the value is 0,
the operator has control of display changes. If the value does not
match any display’s number, the application logs an error to the
activity log.

If you assign this control, remote display changes occur whether
or not the logged-in user has security access to a given display.

This option applies to Replace displays only. Make sure that each
display has its own unique number.

Do not assign an expression consisting of a constant to this
control. If you do, the display whose number matches the
constant opens and can never be closed or changed.
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For more information about remote display changes, see
page 19-7.

Remote Display Print

Assign this control to allow the data source to trigger the
printing of graphic displays. When the value of the control
changes from 0 to a non-zero value, RSView prints the currently
visible display.

You can assign an analog or digital tag or an expression to this
control.

Disable the screen saver on the runtime terminal if you assign
this control.

If a display print is currently in progress, subsequent print
requests from the data source are ignored until the display print
is finished.

Remote Date and Time

RSView monitors this control and, when the value changes
from 0 to a non-zero value, updates the terminal’s internal clock
with the values in the remote date and time controls (listed next).

You can assign an analog or digital tag or an expression to this
control.

Remote Year

Assign this control to send the value corresponding to the year
from the data source to the runtime terminal.

Remote Month

Assign this control to send the value corresponding to the month
from the data source to the runtime terminal.

Remote Day of Month

Assign this control to send the value corresponding to the day of
the month from the data source to the runtime terminal.

Remote Hour

Assign this control to send the value corresponding to the hour
from the data source to the runtime terminal.

Remote Minute

Assign this control to send the value corresponding to the minute
from the data source to the runtime terminal.

Remote Second

Assign this control to send the value corresponding to the second
from the data source to the runtime terminal.
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Remote Macro1

Assign this control to allow the data source to control when
Macro1 is run.

Remote Macro2

Assign this control to allow the data source to control when
Macro2 is run.

Remote Macro3

Assign this control to allow the data source to control when
Macro3 is run.

Remote Macro4

Assign this control to allow the data source to control when
Macro4 is run.

Remote Macro5

Assign this control to allow the data source to control when
Macro5 is run.

5. Click OK to save your settings and close the editor.
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Specifying startup
settings, testing projects,
and creating runtime
projects

This chapter describes:

specifying startup settings

testing your project

creating runtime project files

Specifying startup settings

Use the Startup editor to specify which project components to start
when the project starts at runtime.

You can specify startup settings once you’ve set up all the
components of the project, or you can select components in the
Startup editor as you create them.

20
Chapter
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To specify startup settings:

1. Open the Startup editor.

2. Select the project components to use when the project starts:

Alarms

Check this box to monitor tag values for alarm conditions at
runtime.

For information about configuring alarms, see Chapter 13.

Communication status

Check this box to display information about communication
errors at runtime. When communication errors occur a
communication error banner opens to inform the operator.

If you check this box, communication information, warnings,
and errors are also sent to the activity log, if you set up activity
logging to record this information.

To disable the communication error banner, clear the box.
Clearing the box also means that runtime communication
information, warnings, and errors are not logged in the activity
log.

For information about setting up activity logging, see
Chapter 15. For more information about the communication
error banner, see page 24-15.

Information messages

Check this box to display information messages at runtime.

For information about setting up information messages, see
Chapter 14.
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Data logging

Check this box to start data logging when the project starts.
Select the data log model to use from the list of models in the
project.

For information about setting up data logging, see Chapter 16.

Startup macro

Check this box to use a startup macro. The startup macro assigns
values to tags when the project starts. Select the macro to use
from the list of macros in the project.

For information about creating macros, see page 7-32.

Shutdown macro

Check this box to use a shutdown macro. The shutdown macro
assigns values to tags when the project stops. Select the macro to
use from the list of macros in the project.

Initial graphic

Check this box to specify the graphic display to open when the
project starts. Select the display to open from the list of displays
in the project.

If you do not select a display, an empty window is displayed at
runtime.

For information about creating graphic displays, see Chapter 8.

Parameter file for the initial graphic

Check this box to use a parameter file to replace tag placeholders
in the graphic display that opens when the project starts. Select
the parameter file from the list of parameter files in the project.

For information about creating parameter files, see page 8-29.

3. Click OK.

Once you specify the startup settings, test your project.

Testing your project

You can test your project in RSView Studio at any time during the
development process, to make sure that everything works the way
you intend.

If the development computer is connected to the data source, you
can test all functions of the project, including communications and
alarm monitoring.
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An RSView ME Station emulator opens on the development
computer and runs the project. This runtime version of the project is
a temporary version for testing use only. You cannot run it on
another computer.

There is a two-hour time limit for test running the project in
RSView Studio.

The procedure in this section shows you how to test your entire
project. For information about testing a single graphic display, see
page 8-9.

To test your project in RSView Studio:

1. On the Project menu, click Test Project, or click the Test Project
tool.

2. Test your project.

3. To stop your project, press a Shutdown button, or type X.

Make sure you provide the operator with a method for stopping
the project at runtime. For more information about methods for
stopping projects, see page 23-6.

Once you’ve tested your project to make sure everything works the
way you intend, create the runtime project file and transfer the file
to the runtime computer.

Creating runtime project files

Before you can run your project, you must create a runtime version.
When you create the runtime version, RSView Studio compiles all of
the necessary project information into a single file with the
extension .mer.

To create a runtime project:

1. In RSView Studio, with the project open, on the Project menu
click Create Runtime Project.

Test Project tool
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2. If desired, specify a different directory in which to save the
runtime project file.

The default directory is \Documents and Settings\All
Users\Documents\RSView Enterprise\ME\Runtime.

3. If desired, in the File name box, type a different name for the
runtime project file.

The default is to use the same name as the development project.

4. Click Save.

RSView creates a runtime version of the project in the directory
you specify. If any editors are open, you are first prompted to
save any unsaved changes.

For information about transferring the runtime project to a
Windows CE platform, see Chapter 21. For information about
transferring the runtime project to a Windows 2000 platform, see
Chapter 22.
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Preparing to run
projects on a
RAC6182

This chapter describes:

steps for preparing to run your project on a RAC6182

specifying the time, date, and number formats to use at runtime

starting RSView ME Station

configuring the communication driver to use to transfer the
project to the RAC6182

transferring projects to the RAC6182

configuring the direct driver to use at runtime

specifying print options for graphic displays

opening and running projects on the RAC6182

other methods for starting RSView ME Station, including using
startup parameters and starting RSView ME Station
automatically when Windows starts

Summary of steps
Follow these steps to:

install the necessary hardware and software on the RAC6182

transfer your project to the RAC6182

prepare to run your project

For information about installing RSView ME Station, see the
RSView Machine Edition Installation Guide.

Installing hardware and software on the RAC6182

1. If you will be printing displays, alarms, or activity messages,
connect a printer to the RAC6182’s parallel port.

21
Chapter
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The RAC6182 supports printing using the Microsoft
Windows CE PCL3 printer driver, which is already installed on
the RAC6182. Printing is supported for most laser and ink-jet
printers. If you have problems printing, check that your printer
is compatible with the PCL3 printer driver.

2. If you will be transferring the project from the development
computer to the RAC6182 over a DH+ network, install a PKTX
card on the RAC6182, in the PCI slot.

For installation information, see the documentation that comes
with the card.

3. If your project uses OPC communications, set up the OPC
server on the RAC6182.

For installation information, see the documentation supplied by
your OPC server vendor. For information about OPC, see
Chapter 6.

4. If your project uses third-party ActiveX objects, install and
register the RAC6182 version of the objects on the runtime
computer.

For information about ActiveX objects, see page 9-17.

5. If the runtime computer uses different time, date, or number
formats than the development computer, specify the time, date,
and number formats to use at runtime.

For more information, see page 21-3.

6. If you want to store temporary files on an external PCMCIA
card to preserve internal storage space on the RAC6182, insert
the PCMCIA card.

For more information, see page 23-2.

Transferring the project

1. On the RAC6182, start RSView ME Station.

For more information, see page 21-4.

2. In RSView ME Station, specify the driver to use for the transfer.
If you are using Ethernet for the transfer, you can skip this step.

For more information, see page 21-5.

3. On the development computer, configure the RSLinx driver to
use for the transfer.
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For more information, see page 21-5.

4. Move the project to the RAC6182 using the Transfer Utility tool.

For more information, see page 21-6.

Preparing to run the project

1. In RSView ME Station, if you are using direct driver
communications, configure the driver to use at runtime.

For more information, see page 21-8.

2. If desired, in RSView ME Station, specify the print options to use
for printing graphic displays.

For more information, see page 21-12.

3. In RSView ME Station, open the project you just transferred.

For more information, see page 21-12.

4. If desired, in RSView ME Station, specify the PCMCIA card on
which to store temporary files.

For more information, see page 23-2.

Once you’ve completed these steps, you’re ready to run the project.
For information about running your project, see Chapter 24.

Specifying time, date, and number formats

Time, date, and number formats are used by these graphic objects:

Numeric display

Time and Date display

Trend

If the runtime computer uses different time, date, or number formats
than the development computer, specify the time, date, and number
formats to use at runtime.

You can also change these formats after the project is running, but
you must stop and restart the project for the changes to take effect.

To specify time, date, and number formats:

1. On the Windows Start menu, select Settings, and then click
Control Panel.
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2. Double-click Regional Settings.

3. Specify the region to use, and then select the number, time, and
date settings to use.

4. Click OK, and then close the Control Panel.

For more information, see your Windows CE documentation.

Starting RSView ME Station

Before running your project for the first time, use the RSView ME
Station dialog box to:

specify the driver to use for the transfer

select the project to run

configure the direct driver to use at runtime

configure the printer for printing graphic displays

specify the PCMCIA card on which to store temporary files

To start RSView ME Station:

� On the Windows Start menu, select Programs, Rockwell
Software, RSView Enterprise, and then click RSView ME Station.

The RSView ME Station dialog box opens.
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For information about other methods of starting RSView ME
Station, see page 21-13.

Specifying the driver to use for the transfer on the
RAC6182

On the RAC6182, if you will be using a serial transfer (via DF1) or
transferring over a DH+ or DH-485 network, you must specify the
driver to use for the transfer before you begin the transfer. If you
don’t, the transfer will not work!

If you are using an Ethernet connection for the transfer, you can
skip this step, since the Ethernet driver is already selected by default.

To specify the driver on the RAC6182:

1. In the RSView ME Station dialog box, click Configure Direct
Drivers.

2. In the Configure Direct Drivers dialog box, check the Enabled
box beside the driver to use:

AB_DF1-1—use for a serial transfer.

AB_KT-1—use to transfer over a DH+ network.

AB_ETH-1—use with an ethernet connection.

3. In the Download Using box, select the driver to use.

Configuring an RSLinx driver for the transfer on the
development computer

On the development computer, configure the RSLinx driver that
you will use to download your project to the RAC6182. You can
configure the driver directly in RSLinx, or when you set up the
download in the Transfer Utility.
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Use one of these drivers for the transfer:

AB_DF1-1—use for a serial transfer.

AB_ETH-1—use with an ethernet connection.

AB_KT-1—use to transfer over a DH+ network.

For information about configuring drivers in RSLinx, see the
documentation that comes with RSLinx.

For information about using the Transfer Utility, see the next
section.

Transferring projects to the RAC6182
Use the Transfer Utility to download your runtime project from the
development computer to the RAC6182. Runtime projects have the
extension .mer.

For information about creating the runtime project file, see
Chapter 20.

IMPORTANT
Install RSView ME Station on the RAC6182 before
you begin the transfer. If you don’t, the transfer will
not work!

About the download

You can use a serial or Ethernet connection between the
development computer and the RAC6182 destination. Or, you can
use a DH+ network for the transfer, if the runtime computer has a
PKTX card installed in the PCI slot. You must use one of the drivers
listed on page 21-6 for the download.

You can download while a project is running on the runtime
computer.

You can download:

multiple projects (one at a time) to the same runtime computer

a new copy of the project currently running on the runtime
computer, for use the next time the project is started

To transfer a project to the RAC6182:

1. On the development computer, do one of the following:

In RSView Studio, on the Tools menu click Transfer Utility.

On the Windows Start menu, select Programs, Rockwell
Software, RSView Enterprise, Tools, and then click ME
Transfer Utility.
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2. In the Source box, type the location of the runtime project file
(with the extension .mer) on the development computer.

To search for the file, click the Browse button, navigate to the
folder containing the project’s .mer file, click the file name, and
then click Open.

The default location for the runtime file is \Documents and
Settings\All Users\Documents\RSView Enterprise\ME\
Runtime.

3. To use a different name for the project file at runtime, check the
“Download as” box and then type the new name.

4. To configure the RSLinx driver to use for the transfer, click
Configure Drivers.

RSLinx opens. Configure the driver that’s appropriate for the
transfer method you’re using. If you’re using an Ethernet
connection, specify the IP address of the RAC6182.

When you’re finished configuring the driver, close RSLinx. You
are returned to the Transfer Utility dialog box.

For information about configuring RSLinx drivers, see the
RSLinx documentation.

Browse button
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5. In the left-hand pane, click the + beside the driver to use for the
download, and then click the RAC6182 computer to download
the project file to. Information about the selected computer is
displayed in the right-hand pane.

To update the list of destinations, click Refresh or check the
Autobrowse box.

To change the format of the list, click the icon and list buttons.

6. To begin the transfer, click Download.

If you selected a destination that is not a valid RAC6182
computer, you are prompted to select a new destination.

If the project file already exists at the destination, you are given
the opportunity to overwrite it.

If the terminal doesn’t respond within the timeout interval, a
message is displayed and the download is cancelled. Check that
the drivers on the RAC6182 are enabled and configured properly,
and then repeat step 6.

Configuring direct drivers on the RAC6182

If you are going to use direct driver communications, you must
configure a RAC6182-compatible communication driver before you
run the project for the first time.

You also need to configure the communication driver if you change
the type of communication network.

For more information about direct driver communications, see
Chapter 5.

If you’re connecting to a ControlLogix processor via Ethernet, set
up an OPC node. For more information, see page 6-4.

To configure the RAC6182 driver to use at runtime:

1. In the RSView ME Station dialog box, click Configure Direct
Drivers.
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2. In the Configure Direct Drivers dialog box, select the driver to
use:

AB_DF1-1

Click this driver if you are using a serial data link to a DH+
network, or to connect directly to a controller’s serial port.
Specify the driver’s settings in the dialog box that opens. For
details, see the next section.

AB_KT-1

Click this driver if you are using a DH+ or DH-485 network.
Specify the driver’s settings in the dialog box that opens. For
details, see page 21-11.

AB_ETH-1

Click this driver if you are using TCP/IP (with an Ethernet
connection).

If you specified the IP address to use when you set up the node
to communicate with, no further configuration is required.

To specify or change the IP address, use the runtime Nodes
editor. For information about using the Nodes editor, see
page 23-4.

3. Check the Enabled box beside the driver to use.

4. Click OK to confirm your changes and return to the RSView
ME Station dialog box.

The enabled driver is started the next time you restart the
runtime computer. When you click OK, you are given the option
of restarting the computer now.

Configuring the AB_DF1-1 driver

Use the AB_DF1-1 communication driver for serial network
connections to DH+, or to connect directly to a controller’s serial
port.
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To configure the AB_DF1-1 driver:

1. In the Configure Direct Drivers dialog box, click AB_DF1-1.

2. Specify these settings in the dialog box that opens:

Communication Port

Select the COM port to which the serial cable is attached on the
runtime computer.

Baud Rate

Select the baud rate (speed) to use for serial communications.

Parity

Select the type of error checking to perform for serial
communications.

Stop Bits

Select the amount of time between data transmissions.

Station Number (Octal)

Select the station number setting for the source DF1 device, from
0 to 77 (octal).

Error Checking

Select the type of error checking the controller uses to verify that
the data it sends is complete and correct. RSView will use the
same type of error checking when it receives the data.

Newer controllers generally use the CRC (Cyclical Redundancy
Check) method. Older controllers could use CRC or BCC
(Block Character Check).

If you’re not sure which type to select, consult the controller’s
documentation.
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3. To save your changes and return to the Configure Direct Drivers
dialog box, click OK.

Configuring the AB_KT-1 driver

Use the AB_KT-1 communication driver for DH+ and DH-485
network connections. These network connections also require the
Allen-Bradley 1784-PKTX communication device.

To configure the AB_KT-1 driver:

1. In the Configure Direct Drivers dialog box, click AB_KT-1.

2. Specify these settings in the dialog box that opens:

Network Type

Select the communication network type to use.

Station Number

Select the station number of the node the 1784-PKTX card
occupies on the network.

For DH+, select a number in the range 0 to 77 (octal). For
DH-485, select a number in the range 0 to 31 (decimal).

Network Speed

Select the network baud rate.

Max Station

For DH-485 networks, select a Max Station number (1-31). This
setting may speed up communications. Refer to your network
documentation for more information.

3. To save your changes and return to the Configure Direct Drivers
dialog box, click OK.
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Specifying print options on the RAC6182
If you set up your project to print activity or alarm messages, or to
print graphic displays, RSView automatically uses the printer
connected to the runtime computer’s parallel port. You don’t need
to do anything in RSView ME Station to set up the printer.

However, if desired, you can specify print options for printing
graphic displays.

To set print options for graphic displays:

1. In the RSView ME Station dialog box, click Print Setup.

2. Click Display Print Setup.

3. Modify the print options as required.

For example, if you will be printing on legal size paper, change
the Paper Size option to Legal.

For detailed information about printer options, refer to your
Windows documentation.

4. Click OK to confirm the printer settings.

5. Click OK to return to the RSView ME Station dialog box.

Opening and running projects on the RAC6182
You can run any runtime project that is on the runtime computer.
Runtime projects have the extension .mer.
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Before opening your project, you can specify an external PCMCIA
card to store temporary files on. For more information, see
page 23-2.

To open the project:

1. In the RSView ME Station dialog box, click Open.

2. Navigate to the folder containing the project’s .mer file, and then
click the file name.

If you used the Transfer Utility to transfer the project to the
RAC6182, the path is \Storage Card\Rockwell Software\
RSViewME\Runtime.

3. Click Open.

The project name is displayed in the Project name box in the
RSView ME Station dialog box.

4. To run the project, click Run.

Other methods for starting RSView ME Station
This section describes the various methods you can use to start
RSView ME Station.

When you start RSView ME Station, you can use startup parameters
to:

start running a project

automatically delete a project’s log files before running the
project

You can also configure RSView ME Station to start automatically
when Windows starts.
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To start RSView ME Station, do one of the following:

On the Windows Start menu, select Programs, Rockwell
Software, RSView Enterprise, and then click RSView ME Station.

On the desktop, double-click the shortcut icon RSView ME
Station.

In the Windows Explorer, double-click MERuntime.exe.

This file is located in \Storage Card\Rockwell Software\
RSViewME.

On the Windows Start menu, click Run. In the Open box, type
this:

“\Storage Card\Rockwell Software\RSViewME\
MERuntime.exe”

To search for the file, click Browse. When you’ve specified the
file to open, click OK.

A keyboard is required to use this method.

The RSView ME Station dialog box opens.

Use the dialog box to specify the project to run, configure direct
drivers, configure the printer for graphic displays, edit channels and
nodes, and delete log files. For information about editing channels,
editing nodes, and deleting log files, see Chapter 23.

To start RSView ME Station and start a project at the

same time:

� In Windows Explorer, double-click the project’s .mer file.

The file is located in \Storage Card\Rockwell Software\
RSViewME\Runtime.

The RSView ME Station dialog box opens, with the project selected.

Using startup parameters

When you start RSView ME Station, you can use startup parameters
to start running a project at the same time, and to automatically
delete a project’s log files before running the project.

If you use startup parameters, the RSView ME Station dialog box is
bypassed.

To set up startup parameters, a keyboard must be attached to the
runtime computer.
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You can use these startup parameters:

/r—runs the project

/d—deletes the project’s alarm and data log files before running
the project.

For more information about deleting data log files, see page 23-5.

You can use the /r parameter alone, or with the /d parameter. You
cannot use the /d parameter alone.

To use the startup parameters, you must specify both the path to the
MERuntime.exe file and the path to the project’s .mer file.

To use startup parameters:

1. On the Windows Start menu, click Run.

2. In the Open box, type this:

“\Storage Card\Rockwell Software\RSViewME\
MERuntime.exe” “\Storage Card\Rockwell Software\
RSViewME\Runtime\ProjectName.mer” /r /d

If you don’t want to delete the project’s log files, omit the /d
parameter.

3. Click OK.

The project starts running.

Starting RSView ME Station when Windows
starts

If desired, you can set up RSView ME Station to start automatically
when Windows starts. You can also run a project automatically
when Windows starts.

The Storage Card directory

Storage Card is the only permanent directory on the runtime
computer. All other directories are stored in volatile memory, and
are wiped out when Windows shuts down. When you restart
Windows, the terminal recreates the other directories using
information stored in the Storage Card directory.

This means that changes you make to the Windows desktop are not
permanent unless you store the changes in the Storage Card
directory.
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The instructions below show you how to create a permanent
shortcut in the \Storage Card\Windows\Startup directory, so that
RSView ME Station starts automatically each time Windows starts.

To create the shortcut, a keyboard must be attached to the runtime
computer.

To start RSView ME Station automatically:

1. In the Windows Explorer, open the folder \Storage
Card\Windows\Desktop.

2. Right-click RSView ME Station, and then click Copy.

3. Open the folder \Storage Card\Windows\Startup.

4. Right-click Startup, and then click Paste.

From now on, RSView ME Station starts automatically when
you start Windows.

To start RSView ME Station and run a project

automatically:

1. Follow steps 1 through 4 in the previous procedure.

2. In the Startup folder, right-click RSView ME Station, and then
click Properties.

3. In the Target box, type a space at the end of the existing text, and
then type this:

“\Storage Card\Rockwell Software\RSViewME\
Runtime\ProjectName.mer” /r /d

If you don’t want to delete the project’s log files, omit the /d
parameter.

4. Click OK.

From now on, RSView ME Station starts automatically when
you start Windows, and the specified project starts running.

For more information about configuring settings in Windows CE,
see your Windows documentation.
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Preparing to run
projects in Windows
2000

This chapter describes:

steps for preparing to run your project on the runtime computer

specifying the time, date, and number formats to use at runtime

using the DeskLock tool to prevent users from switching to
another application or accessing the desktop at runtime

moving the project to another Windows 2000 computer

starting RSView ME Station

configuring direct drivers in Windows 2000

specifying the printers to use at runtime

opening and running projects in Windows 2000

other methods for starting RSView ME Station, including using
startup parameters and starting RSView ME Station
automatically when Windows starts

Summary of steps

Follow these steps to:

install the necessary hardware and software on the runtime
computer

transfer your Windows 2000 project to the runtime computer

prepare to run your project

For information about installing RSView ME Station, see the
RSView Machine Edition Installation Guide.

22
Chapter
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Installing hardware and software on the runtime computer

1. If you will be printing displays, alarms, or activity messages, set
up printer connections on the runtime computer.

For more information, see page 22-6.

2. If your project uses direct driver communications, install RSLinx
on the runtime computer.

For installation information, see the documentation supplied
with RSLinx.

3. If your project uses OPC communications, set up the OPC
server on the runtime computer or on another computer on the
network.

For installation information, see the documentation supplied by
your OPC server vendor. For information about OPC, see
Chapter 6.

4. If your project uses third-party ActiveX objects, install and
register the Windows 2000 version of the objects on the runtime
computer.

For information about ActiveX objects, see page 9-17.

5. If the runtime computer uses different time, date, or number
formats than the development computer, specify the time, date,
and number formats to use at runtime.

For more information, see page 22-3.

6. If desired, use the DeskLock tool to prevent users from
switching to another software application or the desktop at
runtime.

For more information, see page 22-4.

Transferring the project

� Move the project to the Windows 2000 runtime computer.

For more information, see page 22-4.

Preparing to run the project

1. On the runtime computer, start RSView ME Station.

For more information, see page 22-5.

2. In RSView ME Station, if you are using direct driver
communications, configure the driver (if you have not already
done so).
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For more information, see page 22-5.

3. In RSView ME Station, specify the printers to use.

For more information, see page 22-6.

4. In RSView ME Station, open the project you just transferred.

For more information, see page 22-8.

Once you’ve completed these steps, you’re ready to run the project.
For information about running your project, see Chapter 24.

Specifying time, date, and number formats

Time, date, and number formats are used by these graphic objects:

Numeric display

Time and Date display

Trend

If the runtime computer uses different time, date, or number formats
than the development computer, specify the time, date, and number
formats to use at runtime.

You can also change these formats after the project is running, but
you must stop and restart the project for the changes to take effect.

To specify time, date, and number formats:

1. On the Windows Start menu, select Settings, and then click
Control Panel.

2. Double-click Regional Options.

3. Specify the locale to use, and then select the number, time, and
date settings to use.

4. Click OK, and then close the Control Panel.

For more information, see your Windows documentation.
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Using the DeskLock tool
Use the DeskLock tool to prevent users from switching to another
software application or accessing the desktop at runtime.

This tool can have far-reaching effects on your operating system.
The DeskLock tool replaces the standard Windows 2000
non-configured desktop with a customized desktop. The customized
desktop is intended to prevent operators from accessing other
applications and operating system functions such as restarting
Windows or shutting down tasks.

IMPORTANT Before using the tool, read the DeskLock Help file
completely.

To open the DeskLock tool:

� On the runtime computer, on the Windows Start menu, select
Programs, Rockwell Software, RSView Enterprise, Tools, and
then click DeskLock.

For details about using the tool, see the tool’s Help.

Moving the project to the runtime computer
The runtime project file has the extension .mer. You can use any
standard file transfer method to copy your runtime project from the
development computer to the runtime computer.

You can:

copy the project file from the development computer to a floppy
disk, and then from the floppy disk to the runtime computer

if the project file is too large to fit on a floppy disk, use a larger
storage device such as a Zip� disk

if the development and runtime computers are on the same
network, use Windows Explorer or My Computer to move the
file

For information about creating the runtime project file, see
Chapter 20.

Starting RSView ME Station
Before running your project for the first time, use the RSView ME
Station dialog box to:

select the project to run
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configure the direct driver to use at runtime (if you have not
already done so)

specify the printers to use at runtime

To start RSView ME Station:

� On the Windows Start menu, select Programs, Rockwell
Software, RSView Enterprise, and then click RSView ME Station.

The RSView ME Station dialog box opens.

For information about other methods of starting RSView ME
Station, see page 22-8.

Configuring direct drivers in Windows 2000

Use RSLinx to configure direct drivers for your Windows 2000
runtime project. You can configure the drivers directly in RSLinx, or
open RSLinx via the RSView ME Station dialog box.

To configure the Windows 2000 driver to use at runtime:

1. In the RSView ME Station dialog box, click Configure Direct
Drivers.

2. RSLinx opens. Configure the driver.

For information about configuring RSLinx drivers, see the
RSLinx documentation.
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3. When you’re finished configuring the driver, close RSLinx.

You are returned to the RSView ME Station dialog box.

Once the driver is configured, RSView ME Station automatically
starts the driver software when you run the project.

Specifying the printers to use at runtime

You can use local or network printers to print activity messages,
alarm messages, and graphic displays at runtime. If desired, you can
use a different printer for each type of printing.

Printing alarm and activity messages

To print activity and alarm messages at runtime, you can use any
printer that has an FX-80-compatible mode, but a line printer is
recommended. Configure the printer to use this mode.

Printing graphic displays

To print graphic displays, use a page printer. Displays are printed in
gray-scale, even if you use a color printer.

To specify the printers to use at runtime:

1. In the RSView ME Station dialog box, click Print Setup.

2. Click the button for the type of printing to set up.
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3. To select the printer to use, click Printer.

4. In the Name box, select the local or network printer to use.

For detailed information about setting up network printers, refer
to your Windows documentation.

5. Click OK.

6. Modify the print options as required.

For detailed information about printer options, refer to your
Windows documentation.

7. Click OK.

8. Repeat steps 2 through 7 to set up additional printers.

9. Click OK to confirm the printer settings and return to the
RSView ME Station dialog box.
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Opening and running projects in Windows 2000

You can run any runtime project that is on the runtime computer.
Runtime projects have the extension .mer.

To open the project:

1. In the RSView ME Station dialog box, click Open.

2. Navigate to the folder containing the project’s .mer file, and then
click the file name.

3. Click Open.

The project name is displayed in the Project name box in the
RSView ME Station dialog box.

4. To run the project, click Run.

Other methods for starting RSView ME Station

This section describes the various methods you can use to start
RSView ME Station.

When you start RSView ME Station, you can use startup parameters
to:

start running a project

automatically delete a project’s log files before running the
project

You can also configure RSView ME Station to start automatically
when Windows starts.
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To start RSView ME Station, do one of the following:

On the Windows Start menu, select Programs, Rockwell
Software, RSView Enterprise, and then click RSView ME Station.

On the desktop, double-click the shortcut icon RSView ME
Station.

In the Windows Explorer, double-click MERuntime.exe.

This file is located in C:\Program Files\Rockwell Software\
RSView Enterprise.

On the Windows Start menu, click Run. In the Open box, type
the path to the MERuntime.exe file.

To search for the file, click Browse. When you’ve specified the
file to open, click OK.

The RSView ME Station dialog box opens.

Use the dialog box to configure direct drivers, edit channels and
nodes, specify printers, delete log files, and specify the project to
run. For information about editing channels, editing nodes, and
deleting log files, see Chapter 23.

To start RSView ME Station and start a project at the

same time:

� In Windows Explorer, double-click the project’s .mer file.

By default, this file is located in C:\Documents and Settings\All
Users\Documents\RSView Enterprise\ME\Runtime.

The RSView ME Station dialog box opens, with the project selected.

Using startup parameters

When you start RSView ME Station, you can use startup parameters
to start running a project at the same time, and to automatically
delete a project’s log files before running the project.

If you use startup parameters, the RSView ME Station dialog box is
bypassed.

You can use these startup parameters:

/r—runs the project

/d—deletes the project’s alarm and data log files before running
the project.
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For more information about deleting data log files, see page 23-5.

You can use the /r parameter alone, or with the /d parameter. You
cannot use the /d parameter alone.

To use the startup parameters, you must specify both the path to the
MERuntime.exe file and the path to the project’s .mer file.

To use startup parameters:

1. On the Windows Start menu, click Run.

2. In the Open box, type the path to the MERuntime.exe file, then a
space, then the path to the project’s .mer file, followed by the
startup parameters to use. If the paths contain spaces, enclose
them in double quotes.

If you accepted the default file locations, you would type this:

“C:\Program Files\Rockwell Software\RSView Enterprise\
MERuntime.exe” “C:\Documents and Settings\All
Users\Documents\RSView Enterprise\ME\
Runtime\ProjectName.mer” /r /d

If you don’t want to delete the project’s log files, omit the /d
parameter.

3. Click OK.

The project starts running.

Starting RSView ME Station when Windows
starts

If desired, you can set up RSView ME Station to start automatically
when Windows starts. You can also run a project automatically
when Windows starts.

To start RSView ME Station automatically:

1. On the Windows Start menu, select Settings, and then click
Taskbar & Start Menu.

2. Click the Advanced tab, and then click Add.

3. Browse to the location of the MERuntime.exe file.

This file is located in C:\Program Files\Rockwell Software\
RSView Enterprise.

4. Click Next.
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5. Click the Startup folder (in the Start menu\Programs folder), and
then click Next.

6. Type a name for the shortcut, such as RSView ME Station, and
then click Finish.

7. Click OK.

From now on, RSView ME Station starts automatically when
you start Windows.

To start RSView ME Station and run a project

automatically:

1. On the Windows Start menu, select Settings, and then click
Taskbar & Start Menu.

2. Click the Advanced tab, and then click Add.

3. In the “Type the location of the item” box, type the path to the
MERuntime.exe file, then a space, then the path to the project’s
.mer file, followed by the startup parameters to use. If the paths
contain spaces, enclose them in double quotes.

If you accepted the default file locations, you would type this:

“C:\Program Files\Rockwell Software\RSView Enterprise\
MERuntime.exe” “C:\Documents and Settings\All
Users\Documents\RSView Enterprise\ME\
Runtime\ProjectName.mer” /r /d

If you don’t want to delete the project’s log files, omit the /d
parameter.

4. Click Next.

5. Click the Startup folder (in the Start menu\Programs folder), and
then click Next.

6. Type a name for the shortcut, such as the project name, and then
click Finish.

7. Click OK.

From now on, RSView ME Station starts automatically when
you start Windows, and the specified project starts running.

For more information about configuring settings in Windows 2000,
see your Windows documentation.
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Starting, stopping, and
configuring projects at
runtime
This chapter describes:

storing temporary files on an external card (RAC6182 projects
only)

selecting the project to configure or run

editing channels

editing nodes

deleting log files

running projects

stopping projects

Using the RSView ME Station dialog box
Use the RSView ME Station dialog box to perform the tasks
described in this chapter. The dialog box opens when you start
RSView ME Station.

Windows 2000 RAC6182

23
Chapter
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If you configure a project to open directly when Windows starts,
this dialog box is bypassed. To open the dialog box, stop the project
and restart RSView ME Station.

For information about starting RSView ME Station in Windows
2000, see page 22-8. For information about starting RSView ME
Station on a RAC6182, see page 21-13.

Storing temporary files on an external card
(RAC6182 projects only)

RSView ME Station creates temporary files when you open your
project. If the project contains many bitmap images, the RAC6182
might run out of disk space because of the size of the temporary
files. If desired, you can store temporary files on an external
PCMCIA card while your project is running.

Performance using external PCMCIA storage might be slightly
slower than when using the RAC6182’s internal disk space for
storage.

To store temporary files on an external card:

1. In the RSView ME Station dialog box, click Temporary Files.

2. Click the storage card to use.

If only one PCMCIA card is inserted in the RAC6182, use
Storage Card2. If two cards are inserted, you can use either
Storage Card2 or Storage Card3.

3. Click OK.

Selecting the project to configure or run
You can run any runtime project that is on the runtime computer.
Runtime projects have the extension .mer.
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For information about:

creating the runtime project, see Chapter 20

transferring a RAC6182 project to the runtime computer, see
Chapter 21

transferring a Windows 2000 project to the runtime computer,
see Chapter 22

To select the project to configure or run:

1. In the RSView ME Station dialog box, click Open.

2. Navigate to the folder containing the project’s .mer file, and then
click the file name.

3. Click Open.

The project name is displayed in the Project name box in the
RSView ME Station dialog box.

4. To run the project now, click Run.

For information about editing channels, editing nodes, or
deleting log files before running the project, see the topics in the
remainder of this chapter.

Editing channels on the runtime computer
To change a channel’s configuration at runtime, use the Channels
editor in RSView ME Station. For example, if you set up a channel
without specifying a communication driver, you must specify the
driver before you start the project at runtime.

To edit a channel on the runtime computer:

1. In the RSView ME Station dialog box, click Channels.
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2. In the Channel box, select the channel to edit.

3. Modify the settings as required.

For information about configuring channels, see page 5-11.

4. Click OK to confirm your changes and return to the RSView
ME Station dialog box.

Editing nodes on the runtime computer

To change a node’s configuration at runtime, use the Nodes editor in
RSView ME Station. For example, you can change the node’s IP
address to use the project with a different processor than was
specified during project development. To do this, stop the project
and then use the Nodes editor to specify another IP address.

To edit a node on the runtime computer:

1. In the RSView ME Station dialog box, click Nodes.

2. In the Node box, select the node to edit.

3. Modify the settings as required.
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The settings that appear depend on whether the selected node
uses the Direct Driver or OPC Server data source. Settings that
you cannot change at runtime are dimmed.

For information about configuring direct driver nodes, see
page 5-15.

For information about configuring OPC nodes, see page 6-10.

4. Click OK to confirm your changes and return to the RSView
ME Station dialog box.

Deleting log files on the runtime computer
When you run your project, RSView ME Station stores log files for
alarms and data logging (if you use these features). When you start
RSView ME Station, you can delete the alarm and data log files for
the selected project, or for all the projects on the runtime computer.

Running a newer version of the project

If you run a newer version of a project, the alarm log file for the
older version is deleted automatically. The data log file for the older
version is retained, to allow the display of historical data in trends.

For more information about the alarm log file, see page 13-5. For
more information about data log files, see page 16-2.

Deleting log files at project startup

To delete log files for the selected project:

� In the RSView ME Station dialog box, check the “Delete log files
before running” box.

All alarm and data log files for the selected project are deleted.

To delete log files for all projects on the runtime computer:

� In the RSView ME Station dialog box, click Delete All Log Files.

Only log files for data log models that use the default path are
deleted when you use this option. All alarm log files are deleted

If you log to a different location than the default path, use “Delete
log files before running,” or else use standard Windows file
management methods to delete unwanted data log files.

For more information about data log files, see page 16-2.
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Running projects

To run the selected project:

� In the RSView ME Station dialog box, click Run.

For information about other methods of running a RAC6182
project, see page 21-13. For information about other methods of
running a Windows 2000 project, see page 22-8.

Stopping projects

To stop a project, use one of these methods:

Press a Shutdown button in a graphic display.

If the project is set up to use a title bar with a Control box, click
the Close button at the right end of the title bar.

If the project is set up to use a title bar with a Control box, on
the Control menu at the left end of the title bar, click Close.

Control menu

Control box

Close button

For information about using a title bar in graphic displays, see
page 4-10. For information about preventing unauthorized users
from stopping projects, see page 18-10.

What happens when the project stops

When the project stops:

If you assigned a shutdown macro (in the Startup editor), the
macro runs, assigning values to tags, and then the project stops.

For information about the Startup editor, see Chapter 20.

RSView ME Station closes.
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Running your project
This chapter describes:

logging in and logging out

entering numeric and string values

changing tag values

viewing tag data

viewing alarms and messages

viewing information about runtime communication errors

For information about navigating between displays, see Chapter 19.
For information about navigating between and using the graphic
objects in a display, see page 10-4.

Logging in to a Windows domain
To log data to a network location, the runtime computer must be
logged in to the same domain as the computer on the network. To
do this, the user must have access rights for the domain.

To log in to a domain from Windows 2000:

� When Windows starts, type a user name, password, and domain
name.

To log in to a domain from the RAC6182:

1. On the Windows Start menu, select Settings, and then click
Control Panel.

2. Double-click Network.

3. Click the Identification tab.

4. Type a user name, password, and domain name.

Logging in to the project
To log in, the user must have an account in the User Accounts editor.
If security is set up, the user must also have a password.

24
Chapter
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For information about setting up user accounts and passwords, see
Chapter 18.

You cannot change passwords at runtime. To change a password, use
the User Accounts editor in RSView Studio. For more information,
see page 18-9.

To log in:

1. Press the Login button.

The Login window opens.

2. Press the User button, or press F2 on an external keyboard.

The string pop-up keyboard opens. For information about using
the keyboard, see page 24-7.

3. Type your user name in the string pop-up keyboard, or on an
external keyboard, and then press Enter.

The name is not case sensitive.

4. To enter a password, press the Password button, or press F3 on
an external keyboard.

5. Type the password in the string pop-up keyboard, or on an
external keyboard, and then press Enter.
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The password is not case sensitive.

6. To close the Login window and complete the login, press Enter.

What happens when a user logs in

When a user logs in:

If the previous user did not log out, the previous user is logged
out now. If a logout macro is set up for the previous user, the
logout macro runs, assigning values to tags.

The new user is logged in.

If a login macro is set up for the new user, the macro runs,
assigning values to tags.

Problems with logging in

Login is unsuccessful under these circumstances:

If the graphic display changes remotely before the user has
finished logging in, the login is cancelled.

If the user name or password doesn’t match the settings in the
User Accounts editor, the user is not logged in.

If the screen resolution is smaller than 280 pixels wide by
84 pixels high, the Login window cannot open.

If the screen resolution is smaller than 236 pixels wide by
208 pixels high, the string pop-up keyboard cannot open.

Logging out
When the current user logs out, the DEFAULT user is logged in.

To log out:

� Press the Logout button.

Entering numeric values
The operator can enter numeric values at runtime using the Numeric
Input Enable button.

When the operator presses the button, the numeric pop-up keypad
or scratchpad opens, depending on how you configured the button.
To use the scratchpad, a keyboard must be attached to the runtime
computer, or the terminal must be a keypad terminal.
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For information about configuring the Numeric Input Enable
button, see Chapter 10.

Using the numeric pop-up keypad

The keypad can accept up to 17 digits, including the decimal point,
leading zero, and minus sign.

Scratchpad area

When the keypad is open, no other objects in the graphic display can
accept input.

Using the numeric pop-up scratchpad

The scratchpad can accept up to 17 digits, including the decimal
point, leading zero, and minus sign.

Scratchpad area

The scratchpad does not contain any buttons. If the runtime
computer does not have an external keyboard or keypad attached,
the operator will be unable to enter values or close the scratchpad.

When the scratchpad is open, no other objects in the graphic display
can accept input.
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Using buttons and keys with the numeric
pop-ups

You can use the following buttons and their keyboard or keypad
equivalents with the numeric pop-up keypad. For the pop-up
scratchpad, you can use the keys on an external keyboard or keypad
only.

Use this button

or key

To do this

Decimal (.) Type a decimal point.

This button is visible only if the decimal point type
for the Numeric Input Enable button is Implicit.

Minus (-) Toggle the value between positive and negative.

ESC Close the pop-up without writing the value to the
button’s Value control.

Backspace (←) Delete the right-most digit in the scratchpad. If no
digits are left, the minus sign, if any, is removed.

Enter (↵) Close the pop-up and write the value to the button’s
Value control.

If the Optional Expression control is assigned to the
Numeric Input Enable button, RSView calculates the
value of the expression and writes the result to the
Value control. For details, see page 12-20.

If Enter key handshaking is set up for the Numeric
Input Enable button, the button’s Enter control is set
to 1 and the handshaking timer begins timing. For
details, see page 10-12.

Delete Clear the scratchpad.

There is no Delete button in the pop-up keypad, but
you can use the Delete key on an external keyboard
or keypad.

How values are calculated

When the operator presses the Enter button in the pop-up keypad or
scratchpad, the value that is sent to the Value control depends on
how the Numeric Input Enable button is configured.

The value the operator enters is compared to the minimum and
maximum range for the button. If the value is within the range,
the value is written to the Value control.



Preface

24-6 � RSView Machine Edition User’s Guide

If the Optional Expression control is assigned, and the original
value is within the range but the expression result is a value
outside the range, the value is still written to the Value control.

If the decimal point type is Fixed Position, with a “Digits after
decimal” value that is greater than 0, the decimal point is stripped
from the value before comparing it to the minimum and
maximum range.

For example, if the entered value is 9.25, the stripped value is 925.

If the stripped value is within the range, the stripped value is sent
to the Value control (or substituted for the ? in the Optional
Expression).

If the decimal point type is Implicit, and the tag assigned to the
Value control uses an integer data type, floating point values are
rounded.

If the Optional Expression control is assigned, the floating point
value is substituted for the ? in the expression, and the expression
result is rounded.

For information about how values are rounded, see page 7-3.

Problems with the numeric pop-ups

Problems with the numeric pop-up keypad and scratchpad occur
under these circumstances:

If the graphic display changes remotely before the user has
pressed the Enter button, the pop-up closes without writing out
a value.

If the screen resolution is smaller than 124 pixels wide by
240 pixels high, the pop-up keypad cannot open.

If the screen resolution is smaller than 124 pixels wide by
68 pixels high, the pop-up scratchpad cannot open.

If the value is too large for the data type of the tag assigned to the
Value control, the pop-up remains open and the value is not
written to the control. The scratchpad area changes to red to alert
the operator of the error.

If the value is outside the minimum and maximum range
specified for the Numeric Input Enable button, the pop-up
remains open and the value is not written to the control. The
scratchpad area changes to red to alert the operator of the error.
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If Enter key handshaking is still in effect, the pop-up closes but
the value is not written to the control.

Entering string values
The operator can enter string values at runtime using the String
Input Enable button.

When the operator presses the button, the string pop-up keyboard
or scratchpad opens, depending on how you configured the button.
To use the scratchpad, a keyboard must be attached to the runtime
computer.

For information about configuring the String Input Enable button,
see Chapter 10.

Using the string pop-up keyboard

The string pop-up keyboard opens when the operator presses a
String Input Enable button or the User or Password button in the
Login dialog box.

Scratchpad area

If the operator opens the pop-up keyboard by pressing a String
Input Enable button, the number of characters the keyboard accepts
depends on how you configure the button.

When the keyboard is open, no other objects in the graphic display
can accept input.

Using the string pop-up scratchpad

The number of characters the scratchpad accepts depends on how
you configure the String Input Enable button.
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Scratchpad area

The scratchpad does not contain any buttons. If the runtime
computer does not have an external keyboard attached, the operator
will be unable to enter characters or close the scratchpad (unless the
runtime terminal is a keypad terminal). If the runtime terminal is a
keypad terminal, the operator can enter numbers (not letters) in the
scratchpad, and close the scratchpad.

When the scratchpad is open, no other objects in the graphic display
can accept input.

Using buttons and keys with the string
pop-ups

You can use the following buttons and their keyboard equivalents
with the string pop-up keyboard. For the pop-up scratchpad, you
can use the keys on an external keyboard only.

Use this

pop-up

keyboard

button

Or this

keyboard

equivalent

To do this

SHF none Capitalize a single letter, or type a
shifted character such as #.

CAP none Capitalize multiple letters.

INS Insert Toggle between insert and
overstrike modes.

SPACE Spacebar Insert a space.

<< Left Arrow (←) Move the cursor to the left.

>> Right Arrow (→) Move the cursor to the right.

ESC Esc Close the pop-up without writing
the string to the Login dialog box
or the String Input Enable
button’s Value control.

CLR Delete Clear the scratchpad.
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Use this

pop-up

keyboard

button

To do thisOr this

keyboard

equivalent

Backspace (←) Backspace Delete the character in front of the
cursor.

Enter (↵) Enter Close the pop-up and write the
string to the Login dialog box or
the String Input Enable button’s
Value control.

If Enter key handshaking is set up
for the String Input Enable button,
the button’s Enter control is set
to 1 and the handshaking timer
begins timing. For details, see
page 10-12.

What is written to the Value control

When the operator presses the Enter button in the pop-up keyboard
or scratchpad, the string that is sent to the Value control depends on
how the String Input Enable button is configured.

If a fill character is configured for the button, and the operator
enters fewer than the maximum number of input characters, the
fill characters are placed after the string the operator enters.

Spaces have a hex value of 20.

Zeroes have a hex value of 30.

FF characters have a hex value of FF.

Null characters have a hex value of 0. The null character
indicates the end of string input. It does not add to the actual
string length.

If the number of input characters is fewer than the number of
characters in the length of the string tag assigned to the Value
control, the remaining spaces are padded with the null character.

When the string is written to the Value control, the first character is
placed in the high order byte of the first word at the tag address, the
second character is placed in the low order byte of the first word,
and so on.
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Problems with the string pop-ups

Problems with the string pop-up keyboard and scratchpad occur
under these circumstances:

If the graphic display changes remotely before the user has
pressed the Enter button, the pop-up closes without writing out
a string.

If the screen resolution is smaller than 236 pixels wide by
208 pixels high, the pop-up keyboard cannot open.

If the screen resolution is smaller than 236 pixels wide by
64 pixels high, the pop-up scratchpad cannot open.

If the string pop-up is configured to accept more characters than
the Value control tag length, the pop-up remains open and the
string is not written to the control. The scratchpad area changes
to red to alert the operator of the error.

If Enter key handshaking is still in effect, the pop-up closes but
the value is not written to the control.

Changing tag values

This section gives an overview of the graphic objects you can use to
change tag values. For information about configuring the objects, see
Chapter 10.

The operator uses these objects to start and stop plant operations,
and to control machines and processes. Choose the objects that best
suit your process. Configure the data source to carry out the desired
actions in response to the changes in tag values.

The operator can use function keys with all of these objects except
Control List selectors, third-party ActiveX objects, and drawing
objects with slider animation.

For information about assigning function keys to graphic objects,
see page 10-5.

IMPORTANT Do not use push buttons for emergency stops.
Emergency stop buttons must be hard-wired.

You can also use macros to assign values to tags. For more
information, see page 7-32.
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The operator can change tag values at runtime using these graphic
objects:

Use this graphic

object

To do this

Momentary Push button Start a process or action by sending one value
to the tag when pressed, and another value
when released.

Maintained Push button Toggle between two values, by sending one
value to the tag when pressed, and a second
value the next time the button is pressed and
released.

This button is useful for changing a setting
within a machine or process, but not for
starting the machine or process.

Latched Push button Start a machine or process and remain set
(latched) until the process is completed, by
sending a value to the tag when pressed, and
retaining this value until reset (unlatched) by
the Handshake control.

Multistate Push button Cycle through a series of values. Each time
the operator presses the button, the value for
the next state is sent to the tag. When the
button is in its last state, pressing it causes
the button to change to its first state and
write out the first state value.

This button is useful when you want the
operator to see and select multiple options in
sequence, using a single button. The button
displays the current state of a process or
operation by showing a different color,
caption, or image to reflect the different
states.

Interlocked Push button Use a group of buttons to send values to the
same tag. When the operator presses a button
in the group, the button’s value is sent to the
tag, and the button remains highlighted as
long as the tag value is the same as the
button’s value. Pressing a new button in the
group releases the other button and sends a
new value to the tag.
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Use this graphic

object

To do this

Ramp button Increase or decrease the value of a tag by a
specified integer or floating point value.

Use two ramp buttons together to create a
raise/lower control.

Numeric Input Enable
button

Enter a numeric value and write the value to
a tag.

String Input Enable
button

Enter a string value and write the value to a
tag.

Drawing object with
horizontal or vertical
slider animation

Control the value of a tag by dragging the
slider object with a mouse. The pixel position
of the slider is translated into a value that is
written to the tag.

If the value of the tag is changed externally,
the position of the slider changes to reflect
this.

Control List selector Select from a list of states for a process or
operation. The list is highlighted to show the
current state, and the operator can scroll
through the list to select a different state. The
value assigned to the selected state is written
to the tag.

If the value of the tag is changed externally,
the position of the highlight changes to
reflect this.

ActiveX object A third-party object, connected to an analog,
digital, or string tag. When the object’s
property value changes, the new value is
written to the associated tag.

You can attach visibility animation to these graphic objects, to
display or hide the objects based on changes in tag or expression
values. For information about visibility animation, see page 11-10.

For information about creating graphic objects, see Chapter 9. For
information about configuring graphic objects, see Chapter 10.

Viewing tag data

This section gives an overview of the graphic objects you can use to
display tag data. For information about configuring the objects, see
Chapter 10.
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The operator can view tag data at runtime using these graphic
objects:

Use this graphic

object

To display this

Numeric display Numeric tag values. For example, display the
current temperature of an oven.

String display String tag values. For example, configure the
data source to generate strings that report on the
state of a process or operation, or that provide
the operator with instructions about what to do
next.

Bar Graph Numeric values in bar graph format. The bar
graph increases or decreases in size to show the
changing value.

Gauge Numeric values in dial format. The gauge’s
needle moves around the dial to show the
changing value.

Multistate indicator The state of a process, on a panel that changes its
color, image, or caption to indicate the current
state. Each state is configured to correspond to a
numeric tag value.

Symbol The state of a process, using a monochrome
image that changes color to indicate the current
state. Each state is configured to correspond to a
numeric tag value.

This object is useful for showing the state of a
process or operation at a glance.

List indicator The state of a process, using a list of possible
states with the current state highlighted. Each
state is represented by a caption in the list, and is
configured to correspond to a numeric tag value.

This indicator is useful if you want to view the
current state but also want to see the other
possible states. For sequential processes, the list
can alert the operator about what happens next
in the process.
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Use this graphic

object

To display this

Trend Historical or real-time numeric tag values,
plotted against time or displayed in an XY plot
where one or more tags’ values are plotted
against another tag’s values to show the
relationship between them.

Drawing object with
rotation, width, height,
fill, color, or
horizontal or vertical
position animation

Display the value of a tag using a pictorial
representation that shows the current value in
relation to a range of possible values. For
example, use rotation animation to show the tag
value as a needle’s position on a dial.

For color animation, assign different colors to
represent different values.

ActiveX object A third-party object, connected to an analog,
digital, or string tag. The data displayed depends
on the object.

Any of these objects can be configured to manipulate tag values
using expressions, and display the expression result rather than the
original tag value. For information about expressions, see
Chapter 12.

You can also attach visibility animation to these graphic objects, to
display or hide the objects based on changes in tag or expression
values. For information about visibility animation, see page 11-10.

For information about creating graphic objects, see Chapter 9. For
information about configuring graphic objects, see Chapter 10.

Displaying the date and time

To display the current date and time, create a Time and Date display.
This object uses the operating system’s date and time and therefore
does not use tags or expressions.

Viewing alarms and messages
The operator can view alarms and other messages at runtime using
these graphic objects and graphic displays:

This

information

Appears in this

object

In this default

graphic display

For

details

see

Alarm messages Alarm list [ALARM] Page 13-27

System activity Activity list [ACTIVITY] Page 15-8
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This

information

For

details

see

In this default

graphic display

Appears in this

object

Information
messages

Information
Message display

[INFORMATION] Page 14-12

Local messages Local Message
display

No default Page 8-29

The default alarm, information, and activity displays open
automatically when the assigned tags match messages’ trigger values.
If desired, you can configure your own graphic displays to open
automatically, instead of the default displays. You can also configure
any of the displays to open when an operator presses a Goto Display
button.

The operator can acknowledge alarm and information messages. The
operator can clear alarm and activity messages.

Viewing information about runtime communication
errors

RSView automatically notifies the operator about runtime
communication errors, unless you disable this feature.

The communication error banner

When a communication error occurs, a single-line banner opens at
the top of the project window, containing a message about the
communication error.

The message remains until the error has been resolved. If a new
communication error occurs, the newer message is displayed. The
operator can continue to change graphic displays and perform other
operations while the communication error banner is open.

To disable the communication error banner:

� In the Startup editor, clear the Communication status check box.

For information about the Startup editor, see Chapter 20.
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Direct driver communication error
messages

For direct driver communications, messages about communication
errors are displayed in this format:

Channel #: (StationNumber) ErrorMessage

Examples: Direct driver communication error messages

Channel 1: (02) Cannot guarantee delivery: link layer.

Channel 1: (10.0.0.1) Unable to communicate with remote station.

OPC communication error messages

For OPC communications, messages about communication errors
are displayed in this format:

OPC: ‘(ServerName) ErrorMessage.’

Examples: OPC communication error messages

OPC: ‘(RSLinx.data.1) OPC Server not registered properly.’

OPC: ‘(RSLinx.data.1) Client: Could not connect to the OPC
server.’

Displaying communication errors in the
Activity list

To display communication errors in the Activity list, configure
activity logging to log errors for the Communications category of
system activity.

For more information about activity logging, see Chapter 15.

Displaying communication information using
system tags

RSView uses system communication tags to monitor
communications. These tags are created automatically when you
create channels and OPC nodes.
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To view the tag information at runtime, create Numeric display or
String display objects in a graphic display. For information about
methods of displaying tag data, see page 24-12.

For more information about the system tags, see Appendix A. For
information about creating graphic objects, see Chapter 9.
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System tags
This appendix describes the system tags.

System tags are preconfigured tags created by RSView. System tags
are read-only. Display them as needed in your application.

Communications
The following tags record direct driver communication information.
These tags are added to the system folder when you configure a
channel in the Channels editor. Each channel you configure will
have these four tags. The number on the end identifies the tags for
each channel. For example, system\ComErrorString1 is for
channel 1.

Tag Name Type Displays information about

system\ComErrorString1 String Most recent device error
message.

system\ComErrorValue1 Analog Internal number of most
recent device error.

system\ComStatusString1 String Current status of device
communications. Will be the
same as system\
ComErrorString1 if the error
condition still exists.

system\ComStatusValue1 Analog Internal number indicating
current status of device
communications. Will be the
same as system\
ComErrorValue1 if the error
condition still exists.

The following tags record OPC communication information. These
tags are added to the system folder when you configure an OPC
node in the Nodes editor.

Tag Name Type Displays information about

system\ComErrorStringOPC String Most recent OPC error
message.

system\ComErrorValueOPC Analog Internal number of most
recent OPC error.

A
Appendix
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Tag Name Displays information aboutType

system\ComStatusStringOPC String Current status of OPC
communications. Will be the
same as system\
ComErrorStringOPC if the
error condition still exists.

system\ComStatusValueOPC Analog Internal number indicating
current status of OPC
communications. Will be the
same as system\
ComErrorValueOPC if the
error condition still exists.

Graphics

The following tags can be used to make graphic objects appear as
though they are blinking on and off:

Tag Name Type Function

system\BlinkFast Digital Toggles on and off every 100
ms (10 times per second).

system\BlinkSlow Digital Toggles on and off every 500
ms (twice per second).

A more efficient way to make graphic objects blink is to use the
blinking color option in color animation. For details, see page 11-12.
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Time

The following tags record time and date information in various
formats:

Tag Name Type Provides this data Read or

write

system\Date String System date. Read only

system\DateAndTime
Integer

Analog Number of seconds
elapsed since midnight
(00:00:00) January 1,
1970, coordinated
universal time (UTC).

Read only

system\DateAndTime
String

String Complete date and time
display.
For example:

Monday, December 12
2001 10:47:50 AM

Read only

system\DayOfMonth Analog Day of the month
(1 – 31).

Read only

system\DayOfWeek Analog Day of the week (1 – 7);
Sunday = 1.

Read only

system\DayOfYear Analog Day of the year (1 – 366). Read only

system\Hour Analog Hour of the day (0 – 23). Read and
write

system\Minute Analog Minutes (0 – 59). Read and
write

system\Month Analog Number for month
(1 - 12).

Read only

system\MonthString String Name of the month. Read only

system\Second Analog Seconds (0 – 59). Read and
write

system\Time String System time. Read only

system\Year Analog The year (1980 – 2099). Read only
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User

The following tag contains the name of the current user:

Tag Name Type Function

system\User String Contains name of logged-in user.

We recommend that you use the expression security function
CurrentUserName( ) instead of the system\User tag, especially if
you intend to convert the project to RSView Enterprise Supervisory
Edition. In distributed applications, system\User returns the name
of the user logged into the HMI server, not the user logged into the
display client.

For more information about the security functions, see page 12-17.
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Addressing syntax for
Allen-Bradley
programmable
controllers

This appendix contains:

addressing syntax for Allen-Bradley PLCs

addressing syntax for Allen-Bradley SLCs

addressing syntax for SoftLogix 5 controllers (Windows 2000
projects only)

mnemonic tables

The information here is applicable only to tags that have device as
their data source. For detailed information about creating tags, see
Chapter 7.

PLC addressing syntax

The following section provides addressing syntax for these types of
programmable controllers:

PLC-5, which includes the PLC-5/10, PLC-5/12, PLC-5/15, and
PLC-5/25

PLC-5 (Enhanced), which includes the PLC-5/11, PLC-5/20,
PLC-5/20C, PLC-5/20E, PLC-5/30, PLC-5/40, PLC-5/40C,
PLC-5/40E, PLC-5/60, PLC-5/60C, PLC-5/80, PLC-5/80C,
and PLC-5/80E

B
Appendix
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PLC-5 data files

Fnnn:eee/bb

F File type:
B = Binary
N = Integer
D = Decimal (BCD)
F = Floating point
A = ASCII

nnn File number: 3 – 999 decimal
For direct driver communication, binary, integer,
and floating point file types use the default file
number if the file number is absent. The default
numbers are 3 (binary), 7 (integer), and
8 (floating point).

eee Element number: 0 – 999 decimal

bb (optional) Bit offset within word: 0 – 15 decimal
Not applicable to floating point file types.

Example of bit address: B3:173/15

Example of word address: N7:12

PLC-5 binary files: optional syntax

Fnnn/bbbbb

F File type:
B = Binary

nnn File number: 3 – 999 decimal
For direct driver communication, the default file
number 3 is used if the file number is absent.

bbbbb Bit offset from start of file: 0 – 15999 decimal

Example: B3/1024
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PLC-5 I/O and status files

F:ee/bb

F File type:
O = Output
I = Input
S = Status

ee Element number:
For I/O files:
PLC-5/10: 0 – 037 octal
PLC-5/12: 0 – 037 octal
PLC-5/15: 0 – 037 octal
PLC-5/25: 0 – 077 octal
For status files: 0 – 31 decimal

bb (optional) Bit offset within word:
For I/O files: 0 – 17 octal
For status files: 0 – 15 decimal

Example: O:64/17

PLC-5 timers, counters, and control files

Fnnn:eee.MNE/bb

F File type:
C = Counter
T = Timer
R = Control

nnn File number: 3 – 999 decimal
For direct driver communication, timer, counter
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 999 decimal

MNE Member mnemonic (see mnemonic tables
starting on page B-22)

bb (optional) Bit number: 0 – 15 decimal
Only applies to analog word members.

Example: T57:38.ACC
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PLC-5 (Enhanced) I/O and status files

F:eee/bb

F File type:
I = Input
O = Output
S = Status

eee Element number:
For I/O files:
PLC-5/11: 0 – 037 octal
PLC-5/20: 0 – 037 octal
PLC-5/30: 0 – 077 octal
PLC-5/40: 0 – 177 octal
PLC-5/60: 0 – 277 octal
PLC-5/80: 0 – 277 octal
For status files:
0 – 127 decimal

bb (optional) Bit offset within word:
For I/O files: 0 – 17 octal
For status files: 0 – 15 decimal

Example: O:167/11
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PLC-5 (Enhanced) binary, BCD, integer,
ASCII, float, and string files

Fnnn:eee/bb
or
Fnnn:eeee/bb

F File type:
B = Binary
D = Decimal (BCD)
N = Integer
F = Floating point
A = ASCII
ST = String

nnn File number: 3 – 999 decimal
For direct driver communication, binary, integer,
and floating point file types use the default file
number if the file number is absent. The default
numbers are 3 (binary), 7 (integer), and 8 (floating
point).

eee Element number: 0 – 999 decimal

or

eeee Element number: 0 – 1999 decimal for PLC-5/80
Series E firmware

bb (optional) Bit offset within word: 0 – 15 decimal
Bit offset is not supported for floating point and
string file types.

Example: B84:113/13

PLC-5 (Enhanced) binary files: optional
syntax

Fnnn/bbbbb

F File type:
B = Binary

nnn (optional) File number: 3 – 999 decimal
For direct driver communication, the default file
number 3 is used if the file number is absent.

bbbbb Bit offset from start of file: 0 – 15999 decimal

Example: B27/248
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PLC-5 (Enhanced) timer, counter, control,
SFC status, message, PID, block transfer,
and token data files

FFnnn:eee.MNE[ss]/bb

FF File type:
T = Timer
C = Counter
R = Control
SC = SFC status
MG = Message
PD = PID control
BT = Block transfer
TD = Token data

nnn File number: 3 – 999 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 999 decimal

MNE Member mnemonic (see mnemonic tables
starting on page B-22)

ss Submember
Only applies to .ADDR and .DATA members of
PID structure and .DATA member of
MSG structure.

bb (optional) Bit number: 0 – 15 decimal
Only applies to analog word members.

Example: MG59:33.DATA[0]/15
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SLC addressing syntax

The following section provides addressing syntax for these types of
programmable controllers:

SLC 5, which includes the fixed I/O SLC 5, SLC 5/01, SLC 5/02,
and SLC 5/03 (OS300)

SLC 5 (Enhanced), which includes the SLC 5/03 (OS 301),
SLC 5/04, and SLC 5/05

SLC 5 I/O files

F:ss.www/bb

F File type:
I = Input
O = Output

ss I/O slot number: 0 – 30 decimal

www (optional) I/O word number expansion: 0 – 255 decimal

bb (optional) Bit offset within word: 0 – 15 decimal
When input slot is 0: 0 – 23 decimal

Example: I:22.254/13

IMPORTANT Writing to the output files of an SLC 5 is not
recommended. However, if you do, be sure the SLC is
not in RUN mode. If it is in RUN mode, the write fails
and an error message is sent to the activity log.

Important information for addressing SLC 5
I/O modules

The RSView I/O module addressing system differs from the
corresponding ControlView�, APS, A.I. 500, and RSLogix 5 or
RSLogix 500 addressing systems. The RSView I/O data section
addressing does not match the physical slot of the I/O module.

In RSView, the first physical module of each type (input or output)
is address slot number 0. The next module of the same type in the
next higher-numbered rack slot is address slot number 1, and so on.
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Example: SLC 5 I/O module addressing

SLC

Type

Rack

Configuration
CV for MS-DOS�

Address or

APS Address

RSView Address

Fixed
L40

I/O module slot 0
(fixed)

I:0.0 or I:0
I:0.1
O:0

I:0.0 or I:0
I:0.1 or I:1
O:0

I module slot 2 I:2 I:2
Fixed
L30

I/O module slot 0
(fixed)

I:0.0 or I:0
I:0.1
O:0

I:0.0 or I:0
I:0.1 or I:1
O:0

I module slot 1 I:1 I:2
O module slot 2 O:2 O:1

Fixed
L20

I/O module slot 0
(fixed)

I:0.0 or I:0
O:0

I:0.0 or I:0
O:0

I module slot 1 I:1 I:1
I module slot 2 I:2 I:2

Modular CPU slot 0 N/A N/A
O module slot 1 O:1 O:0
I module slot 2 I:2 I:0
O module slot 3 O:3 O:1

SLC 5 status files

F:ww/bb

F File type:
S = Status

ww Word address:
SLC 500: 0 – 15 decimal
SLC 5/01: 0 – 15 decimal
SLC 5/02: 0 – 32 decimal
SLC 5/03: 0 – 68 decimal

bb (optional) Bit offset within word: 0 – 15 decimal

Example: S:15/6
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SLC 5 binary and integer files

Fnnn:www/bb

F File type:
B = Binary
N = Integer

nnn (optional) File number:
Binary: 3, 9 – 255 decimal
Integer: 7, 9 – 255 decimal
For direct driver communication, binary and
integer file types use the default file number if
the file number is absent. The default numbers
are 3 (binary) and 7 (integer).

www Word address: 0 – 255 decimal

bb (optional) Bit offset within word: 0 – 15 decimal

Example: N17:129/2

SLC 5 binary files: optional syntax

Fnnn/bbbb

F File type
B = Binary

nnn (optional) File number: 3, 9 – 255 decimal
For direct driver communication, the default file
number 3 is used if the file number is absent.

bbbb Bit offset from start of file: 0 – 4095 decimal

Example: B3/3999
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SLC 5 timer, counter, and control files

Fnnn:eee.MNE/bb

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

MNE Member mnemonic (see mnemonic tables
starting on page B-22)

bb (optional) Bit number: 0 – 15 decimal
Applies to analog members only.

Example: R67:123.EN
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SLC 5 timer, counter, and control files
bit member addressing: optional syntax

Fnnn:eee/MNE

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

MNE Bit member mnemonic (see mnemonic tables
starting on page B-22)

Example: C77:99/OV
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SLC 5 timer, counter, and control files
bit member addressing by bit address:
optional syntax

Fnnn:eee/bb

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

bb Bit number:
Timer: 13 – 15
Counter: 10 – 15
Control: 8 – 11, 13, 15

Example: T87:133/14
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SLC 5 timer, counter, and control files
analog member addressing: optional syntax

Fnnn:eee.o/bb

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

o Word offset: 1 – 2 decimal

bb (optional) Bit number:
0 – 15 decimal

Example: R44:72.1/14

SLC 5 (Enhanced) I/O files

F:ss.www/bb

F File type:
I = Input
O = Output

ss I/O slot number: 0 – 30 decimal

www (optional) I/O word number expansion: 0 – 255 decimal

bb (optional) Bit offset within word: 0 – 15 decimal
When input slot is 0: 0 – 23 decimal

Example: I:22.254/13

IMPORTANT Writing to the output files of an SLC 5 is not
recommended. However, if you do, be sure the SLC is
not in RUN mode. If it is in RUN mode, the write fails
and an error message is sent to the activity log.
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SLC 5 (Enhanced) status files

F:ww/bb

F File type:
S = Status

ww Word address:
SLC 5/03: 0 – 68 decimal
SLC 5/04: 0 – 96 decimal

bb (optional) Bit offset within word: 0 – 15 decimal

Example: S:15/6

SLC 5 (Enhanced) binary, integer, float,
ASCII, and string files

Fnnn:www/bb

F File type:
B = Binary
N = Integer
F = Floating Point
A = ASCII
ST = String

nnn (optional) File number:
Binary: 3, 9 – 255 decimal
Integer: 7, 9 – 255 decimal
Floating Point: 8, 9 – 255 decimal
ASCII: 9 – 255 decimal
String: 9 – 255 decimal
For direct driver communication, binary, integer,
and floating point file types use the default file
number if the file number is absent. The default
numbers are 3 (binary), 7 (integer), and
8 (floating point).

www Word address: 0 – 255 decimal

bb (optional) Bit offset within word: 0 – 15 decimal
Bit offset is not supported for floating point and
string file types.

Example: F8:129
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SLC 5 (Enhanced) binary files: optional
syntax

Fnnn/bbbb

F File type
B = Binary

nnn (optional) File number: 3, 9 – 255 decimal
For direct driver communication, the default file
number 3 is used if the file number is absent.

bbbb Bit offset from start of file: 0 – 4095 decimal

Example: B3/3999

SLC 5 (Enhanced) timer, counter, and
control files

Fnnn:eee.MNE/bb

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

MNE Member mnemonic (see mnemonic tables
starting on page B-22)

bb (optional) Bit number: 0 – 15 decimal
Applies to analog members only.

Example: R67:123.EN
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SLC 5 (Enhanced) timer, counter, and
control files bit member addressing:
optional syntax

Fnnn:eee/MNE

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

MNE Bit member mnemonic (see mnemonic tables
starting on page B-22)

Example: C77:99/OV
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SLC 5 (Enhanced) timer, counter, and
control files bit member addressing by bit
address: optional syntax

Fnnn:eee/bb

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

bb (optional) Bit number:
Timer: 13 – 15
Counter: 10 – 15
Control: 8 – 11, 13, 15

Example: T87:133/14



Preface

B-18 � RSView Machine Edition User’s Guide

SLC 5 (Enhanced) timer, counter, and
control files analog member addressing:
optional syntax

Fnnn:eee.o/bb

F File type:
T = Timer
C = Counter
R = Control

nnn (optional) File number:
Timer: 4, 9 – 255 decimal
Counter: 5, 9 – 255 decimal
Control: 6, 9 – 255 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default numbers
are 4 (timer), 5 (counter), and 6 (control).

eee Element number: 0 – 255 decimal

o Word offset: 1 – 2 decimal

bb (optional) Bit number:
0 – 15 decimal

Example: R44:72.1/14
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SoftLogix 5 addressing syntax

The following section provides addressing syntax for SoftLogix 5
controllers. You can use SoftLogix 5 controllers with Windows 2000
projects only.

SoftLogix 5 I/O and status files

F:eee/bb

F File type:
I = Input
O = Output
S = Status

eee Element number:
For I/O files: 0 – 277 octal
For status files: 0 – 511 decimal

bb (optional) Bit offset within word:
For I/O files: 0 – 17 octal
For status files: 0 – 15 decimal

Example: O:167/11
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SoftLogix 5 binary, BCD, integer, long
integer, ASCII, float, and string files

Fnnnn:eeee/bb

F File type:
B = Binary
D = Decimal (BCD)
N = Integer
L = Long integer
A = ASCII
F = Floating point
ST = String

nnnn File number: 3 – 4095 decimal
For direct driver communication, binary, integer,
long integer, and floating point file types use the
default file number if the file number is absent.
The default numbers are 3 (binary), 7 (integer),
and 8 (floating point).

eeee Element number: 0 – 4095 decimal

bb (optional) Bit offset within word: 0 – 15 decimal
Bit offset is not supported for long integer,
floating point, and string file types.

Example: L4094:4090

SoftLogix 5 binary files: optional syntax

Fnnnn/bbbbb

F File type:
B = Binary

nnnn (optional) File number: 3 – 4095 decimal
For direct driver communication, the default file
number 3 is used if the file number is absent.

bbbbb Bit offset from start of file: 0 – 65535 decimal

Example: B4095/65308
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SoftLogix 5 timer, counter, control, SFC
status, message, PID, block transfer, and
token data files

FFnnnn:eeee.MNE[ss]/bb

FF File type:
T = Timer
C = Counter
R = Control
SC = SFC status
MG = Message
PD = PID control
BT = Block transfer
TD = Token data

nnnn File number: 3 – 4095 decimal
For direct driver communication, timer, counter,
and control file types use the default file number
if the file number is absent. The default
numbers are 4 (timer), 5 (counter), and 6
(control).

eeee Element number: 0 – 4095 decimal

MNE Member mnemonic (see mnemonic tables
starting on page B-22)

ss Submember
Only applies to .ADDR and .DATA members
of PID structure and .DATA member of
MSG structure.

bb (optional) Bit number: 0 – 15 decimal
Only applies to analog word members.

Example: MG4095:3000.DATA[0]/15
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Mnemonic tables

Timer mnemonics

Mnemonic Instruction Type

ACC 15 Accumulator Value Analog

DN Done Digital

EN Enable Digital

PRE Preset Value Analog

TT Timing Digital

Counter mnemonics

Mnemonic Instruction Type

ACC Accumulated Value Analog

CD Count Down Enable Digital

CU Count Up Enable Digital

DN Done Digital

OV Overflow Digital

PRE Preset Value Analog

UN Underflow Digital

For fixed I/O SLC only:

UA Update Accumulator
Value

Digital
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Control mnemonics

Mnemonic Instruction Type

DN Done Digital

EN Enable Digital

ER Error Digital

FD Found Digital

IN Inhibit Digital

LEN Length Analog

POS Position Analog

UL Unload Digital

For all programmable controllers except the fixed I/O SLC and the
SLC 5/01:

EM Empty Digital

EU Enable Unloading Digital
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PID mnemonics

Mnemonic Instruction Type Submember

range

ADDR[] Address of Master Loop
%

Analog 0 – 3

BIAS Output Bias % Analog

CA Control Action Digital

CL Cascaded Loop Digital

CT Cascaded Type Digital

DATA[] Reserved / Internal Use Analog 0 – 13

DB Deadband Analog

DO Derivative Of Digital

DVDB Deviation Alarm
Deadband

Analog

DVN Deviation Alarm - Analog

DVNA Deviation High Alarm Digital

DVP Deviation Alarm + Analog

DVPA Deviation Low Alarm Digital

EN Enable Digital

ERR Error Analog

EWD Error Within Deadband Digital

INI PID Initialized Digital

KD Derivative Time Analog

KI Integral Gain Analog

KP Proportional Gain Analog

MAXI Input Range Maximum Analog

MAXO Output Limit High % Analog

MAXS Setpoint Maximum Analog

MINI Input Range Minimum Analog

MINO Output Limit Low % Analog

MINS Setpoint Minimum Analog
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PID mnemonics (continued)

Mnemonic Instruction Type Submember

range

MO Mode Digital

OLH Output Limit High Digital

OLL Output Limit Low Digital

OUT Output Analog

PE PID Equation Digital

PV Process Variable Analog

PVDB Process Variable Alarm
Deadband

Analog

PVH Process Variable Alarm
High

Analog

PVHA Process Variable High
Alarm

Digital

PVL Process Variable Alarm
Low

Analog

PVLA Process Variable Low
Alarm

Digital

PVT Process Variable
Tracking

Digital

SO Set Output % Analog

SP Setpoint Analog

SPOR Setpoint Out of Range Digital

SWM Software A/M Mode Digital

TIE Tieback % Analog

UPD Update Time Analog
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Message mnemonics

Mnemonic Instruction Type Submember

range

AD Done Digital

AE Error Digital

CO Continuous Digital

DATA[] Reserved / Internal Use Analog 0 – 51

DLEN Done Length Analog

DN Synchronization Done Digital

EN Enable Digital

ER Synchronization Error Digital

ERR Error Code Analog

EW Enable Waiting Digital

NR No Response Digital

RLEN Request Length Analog

ST Start Transmission Digital

TO Time Out Digital
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Block transfer mnemonics

Mnemonic Instruction Type

CO Continue Digital

DLEN Done Length Analog

DN Done Digital

ELEM Element Number Analog

EN Enable Digital

ER Error Digital

EW Enable Waiting Digital

FILE File Number Analog

NR No Response Digital

RGS Rack Group Slot Analog

RLEN Requested Length Analog

RW Read Writes Digital

ST Start Digital

TO Time Out Digital
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Token data mnemonics

Mnemonic Instruction Type

LO Low Analog

HI High Analog

SFC status mnemonics

Mnemonic Instruction Type

DN Done Digital

ER Step Error Digital

FS Forced Scan Digital

LS Last Scan Digital

OV Timer Overflow Digital

PRE Preset Analog

SA Scan Active Digital

TIM Active Time Analog
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Station addressing for
nodes connecting to
Allen-Bradley devices

This appendix describes local station addressing.

Local station addressing

The following table lists valid address entries for a node connected
to the same network as RSView ME Station:

Communication

channel

Valid entries

DH+ 0 – 77 (octal)
physical station number

DH-485 0 – 31 (decimal)
physical station number

TCP/IP Host name (as described
below)

ControlNet 2 – 99 (decimal)
physical network address

Host name

When entering a host name, use one of the following:

A direct IP (Internet Protocol) address in the form
www.xxx.yyy.zzz where www, xxx, yyy, and zzz are numbers
from 000 to 255.

An alias for the address. An alias is an alphanumeric string from
one to eight characters. The first character must be a letter and
the name is case-sensitive.

C
Appendix
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Index

Symbols
.bmp files, 8-20

importing, 8-21
location of, 8-20
placing in graphic displays, 9-11
tips for using, 8-24
viewing, 8-22

.dxf files, 8-20

placing in graphic displays, 9-17
.mea files, 4-7

.med files, 4-1

.mer files, 4-1

See also Runtime project
creating, 20-4
default location, 20-5
transferring to RAC6182, 21-1, 21-6
transferring to Windows 2000, 22-1, 22-4

.wmf files, 8-20

placing in graphic displays, 9-17

Numbers
1784-PKTX, 5-3

A
AB_DF1-1, 5-3

configuring at runtime, 21-9
using to transfer projects, 21-5, 21-6

AB_ETH-1, 5-3, 5-4

configuring at runtime, 21-9
using to transfer projects, 21-5, 21-6

AB_KT-1, 5-3

configuring at runtime, 21-9, 21-11
using to transfer projects, 21-5, 21-6

Access path, specifying for OPC nodes,
6-13

Acknowledge Alarm button graphic object,
9-6, 10-23, 13-4

using with Alarm lists, 13-28
Acknowledge All Alarms button graphic

object, 9-6, 10-17, 13-4

using with Alarm lists, 13-28
ActiveX objects, 9-2

See also Graphic objects
animating, 11-2
at runtime, 24-12, 24-14
creating, 9-17
navigating to, 10-8
registering, 9-18
using to display tag values, 9-5, 9-7
using to set tag values, 9-4, 9-7

Activity bar, 2-4, 15-2

showing and hiding, 2-5
using to test displays, 8-10

Activity Clear All button graphic object,
9-6, 10-17

using with Activity lists, 15-9
Activity Clear button graphic object, 9-6,

10-23

using with Activity lists, 15-9
Activity list graphic object, 9-7, 10-142

at runtime, 15-8, 24-14
displaying communication errors in, 24-16
in the [ACTIVITY] display, 15-4
linking buttons to, 10-9
navigating to, 10-8
using buttons with, 15-9

Activity Log Setup editor, 15-5

Activity logging, 15-1

at runtime, setting up, 15-4
creating your own display for, 15-7
during project development, setting up, 15-3
monitoring communications with, 5-19, 6-14
tracking users with, 12-17
types of activities, 15-2
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Activity messages

displaying at runtime, 15-3, 15-5, 24-14
displaying during project development, 15-2
printing at runtime, 15-3

setting up printer, 22-6
types, 15-1

[ACTIVITY] display, 15-4

at runtime, 24-14
editing, 15-7
opening and closing, 15-8
window size, 4-10

Addresses

assigning to nodes, 5-13
for OPC items, 7-21
formats for OPC servers, 6-12
local station, C-1
specifying for tags, 7-20

Addressing syntax, B-1

ControlLogix, 7-22
PLC-5, B-2
PLC-5 (Enhanced), B-4
SLC 5, B-7
SLC 5 (Enhanced), B-13
SoftLogix 5, B-19

Adobe Acrobat Reader, 1-1

Alarm list graphic object, 9-7, 10-139, 13-3,
13-5

at runtime, 13-27, 24-14
in the [ALARM] display, 13-6
linking buttons to, 10-9
navigating to, 10-8
using buttons with, 13-28

Alarm log file, 4-3, 13-5

deleting at project startup, 21-14, 22-9, 23-5
size, 13-22

Alarm logging. See Alarms

Alarm messages

copying, 13-19
creating, 13-18
creating in a spreadsheet, 13-20
deleting, 13-19
printing at runtime, setting up printer, 22-6
viewing at runtime, 24-14

Alarm monitoring, turning on and off, 20-2

Alarm Setup editor, 13-15

Alarm triggers, 13-2

creating, 13-16
data types for, 13-6

[ALARM] display, 13-3

at runtime, 24-14
editing, 13-23
opening and closing, 13-26
window size, 4-10

Alarms, 13-1

acknowledging, 13-4, 13-11, 13-29
remotely, 13-12, 13-13

clearing, 13-4, 13-30
creating your own display for, 13-26
displaying, 13-3, 13-19, 13-21
expressions in, 12-2
keeping a permanent record of, 13-3
notification methods for, 13-3
printing, 13-19
queueing, 13-11
responding to, 13-4
setting up, 13-15
silencing, 13-5, 13-14, 13-21, 13-30

remotely, 13-14
testing on the development computer, 20-3

Analog tags, 7-2

configuring, 7-14
data types, 7-16
how floating point values are rounded, 7-3
logging values for, 16-2
monitoring for alarms, 13-2
using to generate a range of alarms, 13-6

Animation, 11-1

changing, 11-29
checking, 11-28
copying, 11-29
defining range of motion for, 11-8
for group objects, 9-43, 11-27
setting minimum and maximum values for,

11-7
testing, 11-6
using expressions, 11-7
using Object Smart Path, 11-6, 11-8
using tags and placeholders, 11-6

Animation dialog box, 11-2

Animation types, 11-1

color, 11-12
fill, 11-16
height, 11-21
horizontal position, 11-18
horizontal slider, 11-25
rotation, 11-22
vertical position, 11-19
vertical slider, 11-26
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visibility, 11-10
width, 11-20

Arc graphic object, 9-3, 9-12

Arithmetic operators, in expressions, 12-8

evaluation order of, 12-13

Arrow images, 8-20

Audio indicator, for alarms, 13-19

Auto repeat, 10-11

AutoCAD files. See .dxf files

B
Background Color toolbar, 9-29

Background scan period, for data logging,
5-17

Backspace button graphic object, 9-6,
10-22

Bar Graph graphic object, 9-5, 10-115,
10-117, 11-15

at runtime, 24-13

Bit trigger type, 13-7

Bitmap files. See .bmp files

Bitwise operators, in expressions, 12-11

evaluation order of, 12-13

Block tags, 7-2

configuring, 7-19
monitoring for alarms, 13-2
using to generate alarms based on priority

sequence, 13-9
using to generate multiple alarms, 13-7

Block transfer mnemonics, B-27

Bounding box, 10-5

Button graphic objects

See also Graphic object types; Graphic objects
bounding box, 10-5
creating touch margins for, 10-4
linking to specific objects, 10-9
repeating button presses, 10-11
selecting objects to send button presses to,

10-8, 10-9
using function keys with, 10-5
using with lists, 9-6
using with trends, 9-6, 17-24

Button presses

repeating, 10-11
sending to graphic objects, 10-8, 10-9

C
Channels, 5-1

configuring, 5-11
editing at runtime, 5-13, 23-3

Channels editor, 5-11

Circle graphic object, 9-3, 9-13

Clear Alarm History button graphic object,
9-6, 10-17, 13-4

using to delete the alarm log file, 13-5
using with Alarm lists, 13-28

Close Display button graphic object, 9-3,
10-17

and activity logging, 15-8
and alarms, 13-26
and information messages, 14-10, 14-11
using to navigate, 19-4, 19-6

Color

blinking, 11-14, A-2
for graphic objects, 9-29
in graphic displays, 8-14

animating, 11-12
in trends, 17-8

Color animation, 9-5, 11-12

at runtime, 24-14
Communication error banner, 24-15

Communication status, displaying, 20-2

Communications

devices, 5-1, 5-2
direct driver, setting up, 5-1, 5-9
errors, displaying, 5-19, 6-14

at runtime, 24-15
monitoring, 5-19, 6-14, A-1

turning on and off, 20-2
OPC, setting up, 6-1
testing on the development computer, 20-3
timeouts, preventing, 5-15, 6-11

Components, 2-8

adding into projects, 2-12
file locations, 4-2
printing, 2-14
working with, 2-10

Constants, in expressions, 12-8

Context menus, 8-6

Control List selector graphic object, 9-4,
10-126

at runtime, 24-12
linking buttons to, 10-9
navigating to, 10-8
using Enter key handshaking with, 10-13
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Control mnemonics, B-23

ControlLogix processors

addressing syntax for, 7-22
connecting to, 5-11, 6-3

ControlNet network, 5-11

connecting to at runtime, 21-9
local station addressing, C-1

Controls, 9-2

See also Expressions; Tags
assigning to graphic objects, 9-32

using the Property Panel, 9-27
for alarms, 13-10, 13-14

Counter mnemonics, B-22

D
Data log files, 4-3, 16-2

deleting, 21-14, 22-9
Data log models, 16-1

changing the model to use at runtime, 16-10
creating, 16-5
deleting tags from, 16-2
specifying how much data to store, 16-6
specifying the storage location, 16-7
specifying the tags to log, 16-9
specifying when to log data, 16-8
using with trends, 17-23

Data Log Models editor, 16-4

Data logging, 16-1

choosing the data to log, 16-2
methods, 16-2
problems with, 16-11
setting up, 16-4
storage locations, 16-3
turning on and off, 20-3

Data source

and communication channels, 5-2
ensuring values are read by, 10-12
for alarms, 13-2
for information messages, 14-2
for local messages, 8-30
for tags, 7-2, 7-3, 7-20
for trends, 17-2

Data types for analog tags, 7-16

Date and time. See Time and date

Default graphic displays. See [ACTIVITY]
display; [ALARM] display;
[INFORMATION] display

DEFAULT user, 18-8

DeskLock tool, 18-1, 22-4

Device tags, 7-4, 7-20, B-1

DH+ network, 5-3, 5-11

connecting to at runtime, 21-9
local station addressing, C-1

DH-485 network, 5-3, 5-11

connecting to at runtime, 21-9
local station addressing, C-1

Digital tags, 7-2

configuring, 7-17
logging values for, 16-2
monitoring for alarms, 13-2

DIN symbols, 8-20

Direct driver nodes, 5-4

assigning to tags, 7-20
creating, 5-15
editing at runtime, 5-17
enabling and disabling, 5-15
station addressing for, C-1

Direct drivers, 5-1

AB_DF1-1, 5-3
AB_ETH-1, 5-3, 5-4
AB_KT-1, 5-3
communications, runtime error messages,

24-16
configuring at runtime

in Windows 2000, 22-5
on the RAC6182, 21-8

configuring RSLinx
at runtime, 22-5
for transfer to RAC6182, 21-5, 21-7

None Loaded type, 5-13
setting up, 5-9
SOFT5, 5-3
using to connect to ControlLogix processors,

5-11
Display editor. See Graphics Display editor

Display List selector graphic object, 9-3,
10-96

linking buttons to, 10-9
navigating to, 10-8
using to navigate, 19-4, 19-6

Display number, specifying, 8-13, 19-8, 19-9

Display Print button graphic object, 8-36,
9-3, 10-17, 19-10

Display Settings dialog box, 8-12

Display size. See Window size

Display types, 8-10

and navigation, 19-4
default, 8-3
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Displays. See Graphic displays

Documentation for RSView, printing, 1-1

Drawing objects, 9-2

See also Graphic object types; Graphic objects
animating, 11-2
coloring, 9-30
creating, 9-10
flipping, 9-50
locking into position, 9-52
reshaping, 9-42
rotating, 9-51

E
Edit display mode, 8-9

Editor types

Activity Log Setup, 15-5
Alarm Setup, 13-15
Channels, 5-11
Data Log Models, 16-4
Expression, 12-3
Global Connections, 19-13
Graphics Display, 8-3
Graphics Library, 8-17
Images, 8-22
Information Messages, 14-5
Information Setup, 14-8
Local Messages, 8-33
Macros, 7-35
Nodes, 5-13, 6-10
Parameters, 8-28
Project Settings, 4-12
Scan Classes, 5-19
Startup, 20-2
Tag Database, 7-5
User Accounts, 18-5

Editors

printing in, 2-14
working with, 2-7

Ellipse graphic object, 9-3, 9-13

End button graphic object, 9-6, 10-22

using with Activity lists, 15-9
using with Alarm lists, 13-29
using with trends, 17-26

Enter button graphic object, 9-6, 10-22,
13-4

and Enter key handshaking, 10-12
using with Alarm lists, 13-29

Enter key handshaking, 10-12

Error messages. See Activity messages;
Communication error banner;
Problems at runtime

Ethernet network, 5-3, 5-11

connecting to at runtime, 21-9
local station addressing, C-1

Expression editor, 12-3

Expression results

for animation, 11-5
rounding, 12-1
types of values, 12-2

Expressions, 12-1

See also Write expressions
and animation, 11-7
assigning to controls, 7-30
assigning to graphic objects, 9-32

using the Property Panel, 9-27
checking syntax, 12-5
constants in, 12-8
copying, 12-6
creating, 12-5
evaluation order of operators, 12-13
formatting, 12-6
if-then-else logic in, 12-17
math functions in, 12-16
monitoring for alarms, 13-2
operators in

arithmetic, 12-8
bitwise, 12-11
logical, 12-10
relational, 12-9

security functions in, 12-17
tags and placeholders in, 11-4, 12-7
using in macros, 7-35

F
File names, 4-2

and spaces, 4-4
maximum length of, 4-4

Files, temporary, storing externally, 23-2

Fill animation, 9-5, 11-16

at runtime, 24-14
Folders, 7-4

adding tags to, 7-10
creating, 7-9
creating in the Tags dialog box, 7-25
deleting, 7-12
duplicating, 7-11
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nesting, 7-11
opening, 7-10

Fonts

in graphic displays, substitution at runtime,
9-10

in trends, 17-8
Foreground Color toolbar, 9-29

Foreground scan period, 5-17

Freehand graphic object, 9-3, 9-14

Function keys

assigning to button graphic objects, 10-5
changing, 10-7

G
Gauge graphic object, 9-5, 10-115, 10-120,

10-124

at runtime, 24-13
Global connections, 19-2, 19-9

setting up, 19-13
using to change displays remotely, 19-7, 19-9,

19-10
using to print displays remotely, 19-10
using to run macros, 7-34, 19-12

Global Connections editor, 8-36, 19-13

Goto Display button graphic object, 9-3,
10-90

and activity logging, 15-8
and alarms, 13-23, 13-26
and information messages, 14-11
assigning visibility animation to, 18-13
positioning displays with, 8-14
using parameter files with, 8-28
using to navigate, 19-4

Graphic displays, 8-1

assigning tag values for, 8-14
background color of, 8-14
changing remotely, 19-7

security issues, 19-8
setting up, 19-9
using global connections, 19-10
when a user logs out, 18-12, 19-8

creating, 8-3
creating a background for, 8-15
default. See [ACTIVITY] display; [ALARM]

display; [INFORMATION] display
developing a hierarchy for, 19-2
disabling input focus for, 8-13
illustrating, 9-3

limiting access to, 8-13, 18-4
navigating between, 19-1

objects for, 19-4
testing navigation, 19-3

numbering, 8-13, 19-8, 19-9
opening, 8-3
planning, 3-3, 8-2
positioning, 8-14
printing, 8-35

at runtime, 8-36
remotely, 8-36, 19-10
setting up printer, 22-6

setting up, 8-10
sizing, 4-8, 8-11, 8-13
specifying the first display to open, 20-3
testing, 8-9

animation, 11-6
title bar in, 4-10
types of, 8-10

default type, 8-3
using parameter files with, 8-26
viewing in detail, 8-9

Graphic images

importing, 8-20
monochrome, 8-20
removing, 8-24
selecting for a graphic object, 8-23
that come with RSView Studio, 8-20
viewing, 8-22

Graphic libraries, 8-16

changing file location for, 8-18
creating, 8-17
[HISTORY] library, 13-3, 13-24
opening, 8-17
Sliders library, 11-25
Trends library, 17-23

Graphic object types

See also Button graphic objects; Headings for
individual objects; Multistate graphic
objects

Acknowledge Alarm button, 9-6, 10-23
Acknowledge All Alarms button, 9-6, 10-17
ActiveX objects, 9-2, 9-4, 9-5, 9-7, 9-17

See also ActiveX objects
Activity Clear All button, 9-6, 10-17
Activity Clear button, 9-6, 10-23
Activity list, 9-7, 10-142
Alarm list, 9-7, 10-139
Backspace button, 9-6, 10-22
Bar Graph, 9-5, 10-115, 10-117
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Clear Alarm History button, 9-6, 10-17
Close Display button, 9-3, 10-17
Control List selector, 9-4, 10-126
Display List selector, 9-3, 10-96
Display Print button, 9-3, 10-17
drawing objects, 9-2

See also Drawing objects
arcs, 9-3, 9-12
circles, 9-3, 9-13
ellipses, 9-3, 9-13
freehand objects, 9-3, 9-14
images, 9-3, 9-11
lines, 9-3, 9-14
panels, 9-3, 9-12
polygons, 9-3, 9-14
polylines, 9-3, 9-14
rectangles, 9-3, 9-15
rounded rectangles, 9-3, 9-16
squares, 9-3, 9-15
text, 9-3, 9-10
wedges, 9-3, 9-12

End button, 9-6, 10-22
Enter button, 9-6, 10-22
Gauge, 9-5, 10-115, 10-120, 10-124
Goto Display button, 9-3, 10-90
Home button, 9-6, 10-22
Information Acknowledge button, 9-6, 10-17
Information Message display, 9-7, 10-144
Interlocked Push button, 9-4, 10-57
Latched Push button, 9-4, 10-43
List indicator, 9-5, 10-110
Local Message display, 9-7, 10-133
Login button, 9-3, 10-17
Logout button, 9-3, 10-17
Maintained Push button, 9-4, 10-37
Momentary Push button, 9-4, 10-30
Move Down button, 9-6, 10-22
Move Left button, 9-6, 10-22
Move Right button, 9-6, 10-22
Move Up button, 9-6, 10-23
Multistate indicator, 9-5, 10-101
Multistate Push button, 9-4, 10-49
Next Pen button, 9-6, 10-22
Numeric display, 9-7, 10-68
Numeric Input Enable button, 9-7, 10-73
Page Down button, 9-6, 10-23
Page Up button, 9-6, 10-23
Pause button, 9-6, 10-22
Ramp button, 9-4, 10-62

Return to Display button, 9-3, 10-17
Shutdown button, 9-3, 10-17
Silence Alarms button, 9-6, 10-17
String display, 9-7, 10-80
String Input Enable button, 9-7, 10-83
Symbol, 9-5, 10-106
Time and Date display, 9-5, 10-136
Trend, 9-5

Graphic objects, 8-1, 9-1

See also Group objects; Headings for
individual objects; Help

aligning, 9-47
animating, 11-2

See also Animation
arranging, 9-46, 9-50
assigning controls to, 9-32

using the Property Panel, 9-27
coloring, 9-29
configuring, 10-1

using the Properties dialog box, 9-22
using the Property Panel, 9-25

converting to wallpaper, 8-15
copying, 9-38
creating, 9-9, 9-10

selecting tools, 9-8
deleting, 9-43
deselecting, 9-19
duplicating, 9-40
editing, 9-37
grouping and ungrouping, 9-43
moving, 9-37
naming, 9-30
navigating between, 10-8
positioning, 9-46

with grid, 8-8
replacing tags and expressions in, 9-34
resizing, 9-40
selecting, 9-19
using at runtime, 10-4
using keys to work with. See Special keys
using to display alarms and messages, 9-7
using to display processes, 9-5
using to enter and display numeric and string

values, 9-7
using to illustrate displays, 9-3
using to navigate, 19-4
using to start and control processes, 9-4

Graphics Display editor, 8-3

undoing and redoing actions in, 8-9
Graphics Library editor, 8-17
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Graphics toolbar, 8-4

Grid

in graphic displays, 8-8
in trends, 17-8, 17-16, 17-18

Group objects

animating, 9-43, 11-27
configuring in the Property Panel, 9-25
creating, 9-43
editing, 9-45
naming, 9-31

H
Height animation, 9-5, 11-21

at runtime, 24-14
Historical trends, 16-1, 17-2

See also Trends
[HISTORY] library, 13-3

copying, 13-24
Home button graphic object, 9-6, 10-22

using with Activity lists, 15-9
using with Alarm lists, 13-29
using with trends, 17-26

Horizontal position animation, 9-5, 11-18

at runtime, 24-14
Horizontal slider animation, 9-4, 11-8, 11-25

at runtime, 24-12
Host name, C-1

I
If-then-else logic

in expressions, 12-17
nesting, 12-19

Image Browser dialog box, 8-22

Image graphic object, 9-3, 9-11

See also Graphic images
Images editor, 8-22

Indicators, 10-100

Information Acknowledge button graphic
object, 9-6, 10-17

at runtime, 14-10
Information Message display graphic

object, 9-7, 10-144

at runtime, 14-12, 24-15
in the [INFORMATION] display, 14-4

Information message files, 14-2, 14-5

changing the file to use at runtime, 14-12

Information messages, 14-1

copying, 14-6
creating, 14-5
creating in a spreadsheet, 14-6
creating your own display for, 14-11
deleting, 14-6
displaying, 14-8, 20-2
setting up, 14-4
viewing at runtime, 24-14

Information Messages editor, 14-5

Information Setup editor, 14-8

[INFORMATION] display, 14-4

at runtime, 24-15
editing, 14-10
opening and closing, 14-11
window size, 4-10

Initial values for tags

See also Tag values
assigning to memory tags, 7-21

Input focus

disabling for graphic displays, 8-13
giving to graphic objects, 10-8
specifying behavior of, 8-15

Interlocked Push button graphic object,
9-4, 10-57

at runtime, 24-11
Internet address, C-1

and SoftLogix 5, 5-3
changing at runtime, 21-9
specifying, 5-16

IP address. See Internet address

ISA symbols, 8-20

Keyboard button symbols, 8-20

Isolated graphing, in trends, 17-6

K
Keyboard navigation, 10-8

L
Latched Push button graphic object, 9-4,

10-43

at runtime, 24-11
Least Significant Bit trigger type, 13-9

Libraries. See Graphic libraries

Line graphic object, 9-3, 9-14

List indicator graphic object, 9-5, 10-110

at runtime, 24-13
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Local Message display graphic object,
8-29, 8-30, 9-7, 10-133

at runtime, 8-35, 24-15
Local message files, 8-30, 8-33

Local messages, 8-29

copying, 8-34
creating, 8-33
creating in a spreadsheet, 8-34
deleting, 8-34
viewing at runtime, 24-14

Local Messages editor, 8-33

Local station, C-1

Log files. See Alarm log file; Data log files

Logical operators, in expressions, 12-10

evaluation order of, 12-13
Login button graphic object, 9-3, 10-17,

18-9

locating in display hierarchy, 19-2
Login window, 24-2

See also Users
size, 4-9

Logout button graphic object, 9-3, 10-17,
18-9

locating in display hierarchy, 19-2
LSBit trigger type. See Least Significant

Bit trigger type

M
Macros

creating, 7-32
login and logout, 18-8
remote, running from the data source, 7-34,

19-12
startup and shutdown, 20-3

for graphic displays, 8-14
Macros editor, 7-35

Maintained Push button graphic object,
9-4, 10-37, 12-21

at runtime, 24-11
Math functions, in expressions, 12-16

Memory tags, 7-4, 7-21

Menus, in the Graphics Display editor, 8-6

Messages

See also Activity messages; Alarm messages;
Information messages; Local messages

displaying, 9-7
mnemonics, B-26

number of, on a channel, 5-12
Microsoft Excel

using to create alarm messages, 13-20
using to create information messages, 14-6
using to create local messages, 8-34
using to create tags, 7-23

Minimum and maximum values

for animation, 11-7
for trends, 17-4, 17-17

Mnemonic tables

block transfer, B-27
control, B-23
counter, B-22
message, B-26
PID, B-24
SFC status, B-28
timer, B-22
token data, B-28

Modicon devices, 6-1

Momentary Push button graphic object,
9-4, 10-30

at runtime, 24-11
Monochrome images, 8-20, 9-5

Move Down button graphic object, 9-6,
10-22

setting up auto repeat for, 10-12
using with Activity lists, 15-9
using with Alarm lists, 13-28
using with trends, 17-25

Move Left button graphic object, 9-6, 10-22

setting up auto repeat for, 10-12
using with trends, 17-25

Move Right button graphic object, 9-6,
10-22

setting up auto repeat for, 10-12
using with trends, 17-25

Move Up button graphic object, 9-6, 10-23

setting up auto repeat for, 10-12
using with Activity lists, 15-9
using with Alarm lists, 13-28
using with trends, 17-25

Multistate graphic objects

See also Graphic object types; Graphic objects
coloring, 9-29
setting up, 10-1
testing states, 9-31

Multistate indicator graphic object, 9-5,
10-101

at runtime, 24-13
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Multistate Push button graphic object, 9-4,
10-49

at runtime, 24-11
setting up auto repeat for, 10-12

N
Navigation

between graphic displays, 19-1
testing, 19-3

between graphic objects in a display, 10-8

Networks, 5-1

See also OPC
choosing, 5-11
DH+, 5-3
DH-485, 5-3
Ethernet, 5-3

Next Pen button graphic object, 9-6, 10-22

using to change trend’s vertical axis labels, 17-4,
17-19

using with trends, 17-25

Nodes, 5-1

See also Direct driver nodes; OPC nodes
editing at runtime, 23-4

Nodes editor, 5-13, 6-10

Normally closed push button, 10-30

Normally open push button, 10-30

Number format, at runtime, 21-3, 22-3

Numeric display graphic object, 9-7, 10-68,
17-23

at runtime, 24-13
displaying communication information in,

24-17
specifying number format for, 21-3, 22-3

Numeric Input Enable button graphic
object, 9-7, 9-28, 10-73

at runtime, 24-3, 24-12
how values are calculated, 24-5
using Enter key handshaking with, 10-13
using write expressions with, 12-20

Numeric pop-up keypad, window size, 4-9

Numeric pop-up scratchpad, window size,
4-9

Numeric pop-ups, using at runtime, 24-4

Numeric values

See also Tag values
using graphic objects to display and enter, 9-7

O
Object Explorer, 8-5, 9-20

opening, 9-21
using to select objects, 9-22
viewing objects in, 9-21

Object Smart Path, 11-6, 11-8

Objects toolbar, 8-4

On Top displays, 8-11

positioning, 8-14
sizing, 4-8, 8-13
using for activity logging, 15-7
using for alarms, 13-26
using for information messages, 14-11

OPC

and RSLinx, 6-1, 6-2
and Windows 2000 projects, 6-1
and Windows CE projects, 6-2
communications, runtime error messages,

24-16
update rate, 6-13
using to connect to ControlLogix processors,

6-3, 7-22
OPC nodes

assigning to tags, 7-20
creating, 6-10
editing at runtime, 6-13
enabling and disabling, 6-11
specifying an access path for, 6-13

OPC servers

address formats, 6-12
assigning to nodes, 6-10
items in, 7-21, 7-22

Operators. See Expressions

P
Page Down button graphic object, 9-6,

10-23

setting up auto repeat for, 10-12
using with Activity lists, 15-9
using with Alarm lists, 13-29

Page Up button graphic object, 9-6, 10-23

setting up auto repeat for, 10-12
using with Activity lists, 15-9
using with Alarm lists, 13-29

Panel graphic object, 9-3, 9-12

Parameter files, 9-36

assigning to graphic displays, 8-26
using Goto Display buttons, 8-28
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assigning to startup display, 20-3
creating, 8-29

Parameters editor, 8-28

Passwords, 18-1

changing, 18-9
setting up, 18-8

Pause button graphic object, 9-6, 10-22

using with trends, 17-25
PCMCIA card, storing temporary files on,

23-2

PID mnemonics, B-24

Placeholders. See Tag placeholders

PLC. See Programmable controllers

PLC-5 (Enhanced) addressing syntax, B-4

PLC-5 addressing syntax, B-2

Polygon graphic object, 9-3, 9-14

Polyline graphic object, 9-3, 9-14

Preconfigured graphic displays. See
[ACTIVITY] display; [ALARM] display;
[INFORMATION] display

Print Display button graphic object,
printing trend data with, 17-26

Printers

selecting on the development computer, 2-14
specifying at runtime, 22-6

in Windows CE, 21-12
Problems at runtime

data logging, 16-11
logging in, 24-3
running out of disk space, 23-2
using the numeric pop-ups, 24-6
using the string pop-ups, 24-10

Programmable controllers

address scanning, 5-17
addressing syntax

PLC, B-1
SLC, B-7
SoftLogix 5, B-19

and network types, 5-11
setting up communication with, 5-1
type, selecting for direct driver node, 5-16

Project Explorer, 2-3, 2-4

showing and hiding, 2-5
using, 2-6

Project files, 2-13, 4-2

viewing location of, 4-14
Project properties, viewing, 4-14

Project Settings editor, 4-12

Project Transport Wizard, 4-7

Project window size, 4-7

changing, 4-8
Projects, 2-1

See also Components; Runtime project
backing up and restoring, 4-7
closing, 4-6
copying, deleting, and renaming, 4-7
creating, 4-4
downloading, using RSLinx drivers, 5-4
opening, 4-5

multiple, 4-6
planning, 3-1
runtime, creating, 20-4
sample, opening, 2-2
testing on the development computer, 20-3
window size, 4-8

Properties dialog box

configuring objects in, 9-22
opening, 9-23
using to assign controls to graphic objects,

9-32, 9-34
Property Panel, 8-5

configuring objects in, 9-25
opening, 9-24
using to assign controls to graphic objects, 9-27

Push buttons, 10-29

R
RAC6182

running out of disk space, 23-2
running projects on, 21-1

Ramp button graphic object, 9-4, 9-34,
10-62

at runtime, 24-12
setting up auto repeat for, 10-12

Range of motion, for animation, 11-7, 11-8

Read control, 9-27

Read-write control, 9-27

Real-time trends, 16-1, 17-2

See also Trends
Rectangle graphic object, 9-3, 9-15

blinking, 11-15
Relational operators, in expressions, 12-9

evaluation order of, 12-13
Remote macros, 7-34, 19-12

Replace displays, 8-10

sizing, 4-8
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Return to Display button graphic object,
9-3, 10-17

using to navigate, 19-4, 19-5
Right-click menus, 8-6

Rotation animation, 9-5, 9-51, 11-22

at runtime, 24-14
Rounded rectangle graphic object, 9-3,

9-16

RSLinx, 1-1

and OPC, 6-1, 6-2
and SoftLogix 5, 5-3
configuring drivers in

at runtime, 22-5
for transfer to RAC6182, 5-4, 21-5, 21-7

using to connect to a device, 5-4
RSView Enterprise

RSView ME Station, 1-1
RSView Studio, 1-1

RSView Machine Edition, 1-1

installing. See RSView Machine Edition
Installation Guide

RSView ME Station

starting
in Windows 2000, 22-4, 22-8
on the RAC6182, 21-4, 21-13

stopping, 23-6
RSView ME Station dialog box, 23-1

bypassing, 21-14, 22-9
opening, 23-2

RSView Studio

main window, 2-3
opening and closing, 2-1

RSWho, using to select station addresses,
5-16

Runtime

changing tag values, 24-10
configuring direct drivers

in Windows 2000, 22-5
on the RAC6182, 21-8

deleting log files, 23-5
displaying tag values, 24-12
editing channels, 5-13, 23-3
editing nodes, 5-17, 6-13, 23-4
entering numeric values, 24-3
entering string values, 24-7
font substitution, 9-10
logging in and out, 24-1, 24-3

problems with logging in, 24-3
printing, 2-15

printing graphic displays, 8-36
project file, creating, 20-4
setting up printers, 22-6
time, date, and number formats, 21-3, 22-3
using graphic objects, 10-4
viewing alarms and messages, 24-14
viewing communication errors, 24-15

Runtime project

See also .mer files
configuring, 23-2
starting, 21-12, 22-8, 23-2, 23-6

in Windows 2000, 22-4, 22-8
on the RAC6182, 21-4, 21-13

stopping, 23-6
transferring to RAC6182, 21-1, 21-6
transferring to Windows 2000, 22-1, 22-4

Runtime screen resolution, 4-7

S
Sample projects, 2-2

Scan Classes editor, 5-19

Scan rate

assigning to tags, 7-20
for direct driver nodes, 5-17
for OPC nodes (update rate), 6-13

Screen resolution, at runtime, 4-7

Screen size. See Window size

Security, 18-1

See also Passwords
and remote display changes, 19-8
controlling who can stop the project, 18-10
logging in and out, 18-9
setting up, 18-4
using visibility animation, 11-11, 18-10, 18-13

Security codes, 18-2

assigning to graphic displays, 8-13, 18-4
assigning to user accounts, 18-8

Security functions

in expressions, 12-17
using, 11-11, 18-3, 18-13

SFC status mnemonics, B-28

Shutdown button graphic object, 9-3, 10-17

assigning visibility animation to, 18-13
limiting access to, 18-10
locating in display hierarchy, 19-2
using to navigate, 19-4, 19-7
using to stop project, 20-4, 23-6

Shutdown macro. See Macros
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Siemens devices, 6-1

Silence Alarms button graphic object, 9-6,
10-17, 13-5

using with Alarm lists, 13-28
SLC 5 (Enhanced) addressing syntax, B-13

SLC 5 addressing syntax, B-7

SOFT5 driver, 5-3

SoftLogix 5 controllers, 5-3

addressing syntax, B-19
specifying addresses for, 5-16

Special keys

arrows, using with graphic objects, 9-41
Ctrl

copying objects with, 9-38
drawing objects with, 9-13, 9-14, 9-15, 9-16
resizing objects with, 9-41
rotating objects with, 9-52
selecting objects with, 9-20

Shift, using with graphic objects, 9-38, 9-41
using to navigate at runtime, 10-8
using with numeric pop-ups, 24-5
using with string pop-ups, 24-8

Spreadsheets

using in the Tag Database editor, 7-12
working in, 2-9

Square graphic object, 9-3, 9-15

Standard toolbar, 2-3

Startup display, specifying, 20-3

Startup editor, 20-2

Startup macro. See Macros

Startup settings, 20-1

States. See Multistate graphic objects

States toolbar, 9-31

Station address

local, C-1
specifying, 5-16

Status bar, 2-4, 8-5

showing and hiding, 2-5
Storage Card directory, in Windows CE,

21-15

String display graphic object, 9-7, 10-80

at runtime, 24-13
displaying communication information in,

24-17
String Input Enable button graphic object,

9-7, 10-83

at runtime, 24-7, 24-12
how values are written, 24-9

using Enter key handshaking with, 10-13
String pop-up keyboard, window size, 4-9

String pop-up scratchpad, window size, 4-9

String pop-ups, using at runtime, 24-7

String tags, 7-2

configuring, 7-18
String values

See also Tag values
using graphic objects to display and enter, 9-7

Symbol graphic object, 9-5, 10-106

at runtime, 24-13
Syntax

addressing. See Addressing syntax
expression, checking, 12-5

System activity. See Activity logging

System tags, 7-2, A-1

for communications, 5-20, 6-14
direct driver, A-1
OPC, A-1

for making graphic objects blink, A-2
time and date, A-3
using to display communication information at

runtime, 24-16
viewing in the Tag Database editor, 7-9

System time and date. See Time and date

T
Tag Database editor, 7-5

Tag folders, 7-8

See also Folders
Tag Import and Export Wizard, 7-28

Tag placeholders, 8-25, 9-36

creating, 9-36, 11-7, 12-8
using in expressions, 12-7
using with animation, 11-6

Tag statistics, viewing, 7-7

Tag substitution, 7-31, 9-34

Tag values

assigning
when a display opens or closes, 8-14
when a project starts or stops, 20-3
when a user logs in or out, 18-8

assigning initial values, to memory tags, 7-21
changing at runtime, 24-10
displaying at runtime, 24-12
ensuring the data source has read, 10-12
logging, 7-31, 16-2
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updating, 5-17, 6-13
using graphic objects to display, 9-7
using graphic objects to set, 9-4, 9-7
using macros to assign, 7-32

Tags, 7-1

See also Analog tags; Block tags; Device tags;
Digital tags; Memory tags; String tags;
System tags

addresses, 7-20
assigning to controls, 7-29
assigning to graphic objects, 9-32

using the Property Panel, 9-27
creating, 7-10, 7-13, 7-23

in the Tags dialog box, 7-25
data sources, 7-3, 7-20
deleting, 7-14
duplicating, 7-13
editing, 7-14, 7-25
exporting, 7-28
importing, 7-23, 7-26, 7-28
merging databases, 7-28
naming, 7-4
searching for, 7-8
using in expressions, 11-4, 12-7

Tags dialog box, using, 7-25

TCP/IP

See also Ethernet network
station addressing, C-1

Test display mode, 8-9

Text graphic object, 9-3, 9-10

blinking, 11-14
editing, 9-11

Time and date

at runtime, 21-3, 22-3
setting using global connections, 19-11
system tags, A-3
updating, 19-11

Time and Date display graphic object, 9-5,
10-136

at runtime, 24-14
specifying time and date format for, 21-3, 22-3

Timer mnemonics, B-22

Title bar

and security, 18-10
in graphic displays, 4-10
in On Top displays, 8-13

Token data mnemonics, B-28

Toolbars, 2-3

Background Color toolbar, 9-29
Foreground Color toolbar, 9-29
Graphics toolbar, 8-4
in the Graphics Display editor, 8-4, 8-6
Objects toolbar, 8-4
showing and hiding, 2-5
Standard toolbar, 2-3
States toolbar, 9-31

Tools

DeskLock, 18-1, 22-4
Project Transport Wizard, 4-7
Tag Import and Export Wizard, 7-28
Transfer Utility, 21-6

Touch margins, using on buttons, 10-4

Touch screens, positioning objects for,
10-4

Transfer Utility tool, 21-6

and RSLinx drivers, 5-4
Trend data, printing at runtime, 17-26

remotely, 17-26
Trend graphic object, 9-5, 17-1

and data logging, 16-1
at runtime, 24-14
border, 17-3
chart, 17-4, 17-11

isolated graphing in, 17-6, 17-18
types, 17-5
XY Plot, 17-5

coloring, 17-8
configuring, 17-3, 17-10
creating, 17-10
grid, 17-16, 17-18
linking buttons to, 10-9
minimum and maximum values for, 17-4, 17-17
navigating to, 10-8
pens, 17-5

configuring, 17-21
icons, 17-5, 17-13
markers, 17-5

plotting values across the chart, 17-7
setting up, 17-9
specifying number, time, and date format for,

21-3, 22-3
specifying tags and expressions to plot data for,

17-20
specifying the amount of data to store, 17-14
testing, 17-9
troubleshooting. See Help
window, 17-4
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X (horizontal) axis, 17-4, 17-15
labels, 17-5, 17-16

Y (vertical) axis, 17-4, 17-17
labels, 17-4, 17-18

Trigger values

for alarms, 13-2, 13-6, 13-18
for information messages, 14-3, 14-5
for local messages, 8-32

Troubleshooting. See Problems at runtime

U
Update rate for OPC nodes, 6-13

User accounts, 18-2

DEFAULT user, 18-8
deleting, 18-9
displaying current user, 12-17
setting up, 18-8

User Accounts editor, 18-5

Users, logging in and out, 18-9, 24-1, 24-3

V
Value table, 7-1, 7-4

updating, 5-17, 6-13
Value trigger type, 13-6

Vertical position animation, 9-5, 11-19

at runtime, 24-14
Vertical slider animation, 9-4, 11-26

at runtime, 24-12

Visibility animation, 11-10

using to set up security, 11-11, 18-10, 18-13

W
Wallpaper

converting graphic objects to, 8-15
unlocking, 8-16

Wedge graphic object, 9-3, 9-12

Width animation, 9-5, 11-20

at runtime, 24-14
Wildcards, 7-4, 7-8

Window size

default graphic displays, 4-10
project, 4-8

Windows 2000, running projects in, 22-1

Windows CE

See also RAC6182
Storage Card directory, 21-15

Windows domain, logging in to, 24-1

Windows meta files. See .wmf files

Workbook Mode, 2-4

turning on and off, 2-5
Write control, 9-27

Write expressions, 9-28, 12-20

X
XY Plot trend, 17-5
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